Product Information
This document applies to IBM Cognos TM1 Version 10.2.2.3 and may also apply to subsequent releases.
Licensed Materials - Property of IBM
© Copyright IBM Corporation 2007, 2015.
US Government Users Restricted Rights – Use, duplication or disclosure restricted by GSA ADP Schedule Contract with IBM Corp.
Contents

Introduction .................................. xi

Chapter 1. What’s new ........................................ 1
What’s new for Cognos TM1 installation and configuration in version 10.2.2 .............. 1
  New samples are available ................................. 1
  New features in TM1 Mobile Contributor .................... 1
  Cognos TM1 Interoperability for Cognos BI installation program removed .................. 1
  New configuration files for using Cognos TM1 Web with Cognos security .................. 2
What’s new for Cognos TM1 installation and configuration in version 10.2.0 .............. 2
  New installation requirements in Cognos TM1 10.2.0 ........................................ 2
  Installation of translated documentation .................. 3
  Cognos TM1 Web now uses a Java-based web application server .......................... 3
  New Cognos TM1 Mobile Contributor app for Cognos TM1 10.2.0 ...................... 5
  New ways to open Cognos TM1 Performance Modeler ........................................ 5
  New scorecard samples ...................................... 5
  New integration with Cognos Analysis for Microsoft Excel .............................. 6
  New TM1 Admin Server Certificate Version parameter for SSL ....................... 6

Chapter 2. Planning your Cognos TM1 installation ........................................... 7
Available installation programs ........................................ 7
Available components ........................................ 8
  TM1 Application Tier installation component ........................................ 8
  Web Application Tier installation component ........................................ 9
  TM1 Client Tier installation component ......................................... 11
  Developer Tier installation component .......................................... 12
  Samples installation component ........................................ 13
  Translated documentation installation component ..................................... 13
  Additional installation components not listed ..................................... 14
TM1 client differentiation ........................................ 14
  End-user clients ........................................ 14
  Administration clients ...................................... 16
Software requirements ......................................... 17
Default installation values ...................................... 17
Configuration overview ........................................ 19
  Cognos Configuration and Cognos TM1 ........................................ 19
  Cognos TM1 configuration files and parameters ........................................ 20
User accounts for running Cognos TM1 services on Windows .................. 21
Installing TM1 on Networks without domains ................................ 21
  Local machine syntax .......................................... 22

Chapter 3. Architecture ........................................... 23
Cognos TM1 architecture ........................................ 23
  Cognos TM1 Admin Server overview ........................................ 24
  Cognos TM1 Server overview ........................................ 25
  Cognos TM1 files overview .......................................... 26
  Data directory overview ........................................ 27
Cognos TM1 Web architecture ........................................ 28
  Accessing multiple Cognos TM1 servers from Cognos TM1 Web .................. 30
  Limiting access to a single Cognos TM1 server from Cognos TM1 Web .............. 30
Cognos TM1 Applications architecture ........................................ 30
  Cognos TM1 Applications Tier 1: Web clients ..................................... 31
  Cognos TM1 Applications Tier 2: Web server ..................................... 33
  Cognos TM1 Applications Tier 3: Data .......................................... 33
<table>
<thead>
<tr>
<th>Variable Name</th>
<th>Page Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>DistributedPlanningOutputDir</td>
<td>271</td>
</tr>
<tr>
<td>DownTime</td>
<td>272</td>
</tr>
<tr>
<td>EnableODBCproxy</td>
<td>272</td>
</tr>
<tr>
<td>ExcelWebPublishEnabled</td>
<td>272</td>
</tr>
<tr>
<td>ExportAdminSrVRSSLCert</td>
<td>273</td>
</tr>
<tr>
<td>ExportSrVRSSLCert</td>
<td>273</td>
</tr>
<tr>
<td>ForceReevaluationOfFeedersForFedCellsOnDataChange</td>
<td>274</td>
</tr>
<tr>
<td>HTTPPortNumber</td>
<td>275</td>
</tr>
<tr>
<td>HTTPSessionTimeoutMinutes</td>
<td>275</td>
</tr>
<tr>
<td>IdleConnectionTimeOutSeconds</td>
<td>275</td>
</tr>
<tr>
<td>IntegratedSecurityMode</td>
<td>275</td>
</tr>
<tr>
<td>IPAddress</td>
<td>277</td>
</tr>
<tr>
<td>IPVersion</td>
<td>278</td>
</tr>
<tr>
<td>JavaClassPath</td>
<td>278</td>
</tr>
<tr>
<td>JavaVMArgs</td>
<td>278</td>
</tr>
<tr>
<td>JavaVMPath</td>
<td>279</td>
</tr>
<tr>
<td>JobQueuing</td>
<td>279</td>
</tr>
<tr>
<td>JobQueueMaxWaitTime</td>
<td>279</td>
</tr>
<tr>
<td>JobQueueThreadPoolSize</td>
<td>280</td>
</tr>
<tr>
<td>JobQueueThreadSleepTime</td>
<td>280</td>
</tr>
<tr>
<td>Language</td>
<td>280</td>
</tr>
<tr>
<td>LDAPHost</td>
<td>281</td>
</tr>
<tr>
<td>LDAPPasswordFile</td>
<td>281</td>
</tr>
<tr>
<td>LDAPPasswordKeyFile</td>
<td>281</td>
</tr>
<tr>
<td>LDAPPort</td>
<td>282</td>
</tr>
<tr>
<td>LDAPSearchBase</td>
<td>282</td>
</tr>
<tr>
<td>LDAPSearchField</td>
<td>282</td>
</tr>
<tr>
<td>LDAPSkipSSLCertVerification</td>
<td>282</td>
</tr>
<tr>
<td>LDAPSkipSSLCRLVerification</td>
<td>282</td>
</tr>
<tr>
<td>LDAPUseServerAccount</td>
<td>283</td>
</tr>
<tr>
<td>LDAPVerifyCertServerName</td>
<td>283</td>
</tr>
<tr>
<td>LDAPVerifyServerSSLCert</td>
<td>284</td>
</tr>
<tr>
<td>LDAPWellKnownUserName</td>
<td>284</td>
</tr>
<tr>
<td>LockPagesInMemory</td>
<td>285</td>
</tr>
<tr>
<td>LoggingDirectory</td>
<td>285</td>
</tr>
<tr>
<td>LogReleaseLineCount</td>
<td>285</td>
</tr>
<tr>
<td>MagnitudeDifferenceToBeZero</td>
<td>285</td>
</tr>
<tr>
<td>MaskUserNameInServerTools</td>
<td>286</td>
</tr>
<tr>
<td>MaximumCubeLoadThreads</td>
<td>286</td>
</tr>
<tr>
<td>MaximumLoginAttempts</td>
<td>287</td>
</tr>
<tr>
<td>MaximumMemoryForSubsetUndo</td>
<td>287</td>
</tr>
<tr>
<td>MaximumSynchAttempts</td>
<td>287</td>
</tr>
<tr>
<td>MaximumTILockObjects</td>
<td>288</td>
</tr>
<tr>
<td>MaximumUserSandboxSize</td>
<td>289</td>
</tr>
<tr>
<td>MaximumViewSize</td>
<td>289</td>
</tr>
<tr>
<td>MessageCompression</td>
<td>289</td>
</tr>
<tr>
<td>MTQ</td>
<td>289</td>
</tr>
<tr>
<td>MTQ.OperationProgressCheckSkipLoopSize</td>
<td>290</td>
</tr>
<tr>
<td>MTQ.SingleCellConsolidation</td>
<td>290</td>
</tr>
<tr>
<td>NetRecvBlockingWaitLimitSeconds</td>
<td>291</td>
</tr>
<tr>
<td>NetRecvMaxClientIOWaitWithinAPISSeconds</td>
<td>291</td>
</tr>
<tr>
<td>ODBCLibraryPath</td>
<td>291</td>
</tr>
<tr>
<td>OracleErrorForceRowStatus</td>
<td>291</td>
</tr>
<tr>
<td>ParallelInteraction</td>
<td>292</td>
</tr>
<tr>
<td>PasswordMinimumLength</td>
<td>292</td>
</tr>
<tr>
<td>PasswordSource</td>
<td>292</td>
</tr>
<tr>
<td>PerfMonIsActive</td>
<td>293</td>
</tr>
<tr>
<td>PerformanceMonitorOn</td>
<td>293</td>
</tr>
<tr>
<td>PersistentFeeders</td>
<td>293</td>
</tr>
<tr>
<td>PortNumber</td>
<td>294</td>
</tr>
<tr>
<td>PrivilegeGenerationOptimization</td>
<td>294</td>
</tr>
</tbody>
</table>
Appendix B. The Tm1p.ini Client Configuration File ........................................... 311
Location of the Tm1p.ini File .............................................................................. 311
Parameters in the Tm1p.ini file ........................................................................ 312
  AdminHost ................................................................................................. 312
  AdminSvrSSLCertAuthority ...................................................................... 312
  AdminSvrSSLCertID .................................................................................. 312
  AdminSvrSSLCertRevList ......................................................................... 313
  AdminSvrSSLExportKeyID ...................................................................... 313
  AdvancedRulesEditor .................................................................................. 313
  AllowImportCamClients ............................................................................. 313
  BrowseDisplayReadsRightToLeft .............................................................. 313
  ClassicSliceMode ..................................................................................... 313
  CognosGatewayURI .................................................................................. 313
  ConnectLocalAtStartup ............................................................................. 314
  DataBaseDirectory ..................................................................................... 314
  DimensionDownloadMaxSize .................................................................... 314
  DisplayApplications ................................................................................... 314
  DisableWritebackOnDisconnect ............................................................... 314
  DisableWritebackOnTM1Formulas ............................................................. 315
  DisplayChores ........................................................................................... 315
  DisplayControlCubes ............................................................................... 315
  DisplayCubes ............................................................................................ 315
  DisplayDimensions .................................................................................... 315
Introduction

This document describes how to install, upgrade, and configure IBM® Cognos® TM1® software components on Microsoft Windows and UNIX operating systems.

Audience

IBM Cognos TM1 integrates business planning, performance measurement, and operational data to enable companies to optimize business effectiveness and customer interaction regardless of geography or structure. Cognos TM1 provides immediate visibility into data, accountability within a collaborative process, and a consistent view of information, allowing managers to quickly stabilize operational fluctuations and take advantage of new opportunities.

To use this guide, you should be familiar with:

• installation concepts
• security issues
• basic Windows or UNIX administration skills
• the existing server environment and security infrastructure in your organization
• your Cognos TM1 system and network requirements

Finding information

To find documentation on the web, including all translated documentation, access IBM Knowledge Center (http://www.ibm.com/support/knowledgecenter).

Accessibility features

Accessibility features help users who have a physical disability, such as restricted mobility or limited vision, to use information technology products. The installation wizard has accessibility features. For information on these features, see the accessibility section in this document.

IBM Cognos HTML documentation has accessibility features. PDF documents are supplemental and, as such, include no added accessibility features.

Forward-looking statements

This documentation describes the current functionality of the product. References to items that are not currently available may be included. No implication of any future availability should be inferred. Any such references are not a commitment, promise, or legal obligation to deliver any material, code, or functionality. The development, release, and timing of features or functionality remain at the sole discretion of IBM.

Samples disclaimer

The Sample Outdoors Company, Great Outdoors Company, GO Sales, any variation of the Sample Outdoors or Great Outdoors names, and Planning Sample depict fictitious business operations with sample data used to develop sample applications for IBM and IBM customers. These fictitious records include sample data for sales transactions, product distribution, finance, and human resources.
Any resemblance to actual names, addresses, contact numbers, or transaction values is coincidental. Other sample files may contain fictional data manually or machine generated, factual data compiled from academic or public sources, or data used with permission of the copyright holder, for use as sample data to develop sample applications. Product names referenced may be the trademarks of their respective owners. Unauthorized duplication is prohibited.
Chapter 1. What's new

This section contains a list of new, changed, and removed features for this release.

For all currently available TM1 documentation, go to the TM1 welcome page (http://www.ibm.com/support/knowledgecenter/SS9RXT/welcome).

What's new for Cognos TM1 installation and configuration in version 10.2.2

The following list identifies new and changed installation and configuration features in IBM Cognos TM1 version 10.2.2.

New samples are available

The 10.2.2 release includes new sample databases.

The Proven Techniques is a new sample database that installed by default.

The GO_Scorecards sample database is also now installed by default.

See Chapter 13, “Cognos TM1 sample databases installation,” on page 169.

New features in TM1 Mobile Contributor

New features have been added to TM1 Mobile Contributor version 10.2.2.

TM1 Mobile Contributor includes the following new features:

• Scorecarding
• Watchlist
• Navigation
• Push notifications

See “Deploying Cognos TM1 Mobile Contributor” on page 41.

Cognos TM1 Interoperability for Cognos BI installation program removed

As of IBM Cognos TM1 version 10.2.2, the TM1 Interoperability for Business Intelligence (BI) installation program is no longer available. The files that it included are now included by default in the main Cognos TM1 installation program.

This change applies to all of the supported operating systems for Cognos TM1 version 10.2.2.

The files that were previously installed by the TM1 Interoperability for BI installation program are now included in the bi_interop.zip file that is located in the following directory:

\<TM1 installation location>\bi_interop
For example, on Windows:

C:\Program Files\IBM\cognos\tm1_64\bi_interop

To use the new bi_interop.zip file:

1. Extract and merge the content of the bi_interop.zip file into the root directory of your existing Cognos BI installation:

   For example: C:\Program Files\IBM\cognos\c10_64\\

   **Note:** The bi_interop.zip file contains a directory structure that merges files into the \templates and \webcontent subdirectories.

2. Edit the parameters in the extracted files for the component that you want to integrate with Cognos TM1 and Cognos BI.

   **Cognos TM1 Applications**

   The extracted files enable Cognos TM1 Applications to integrate with Cognos BI security and the Cognos Connection portal.

   For more information, see “Using Cognos TM1 Applications with Cognos security” on page 214 and “Cognos TM1 Applications integration with Cognos BI and the Cognos Connection portal” on page 70.

   **Cognos Analysis for Microsoft Excel**

   Cognos Analysis for Microsoft Excel uses the extracted files to access Cognos TM1 servers that are using Cognos BI authentication with single sign-on (SSO).

   For more information, see “Configuring Cognos TM1 for Cognos Analysis for Excel single sign-on” on page 69.

   **New configuration files for using Cognos TM1 Web with Cognos security**

   As of IBM Cognos TM1 version 10.2.2, the files that enable Cognos TM1 Web to use Cognos security authentication are provided in a new location.

   The files were previously provided in the tm1web_gateway.zip file but are now organized into two separate compressed files in a new location:

   • Old location: <TM1 installation location>\webapps\tm1web\gateway_files\n   • New location: <TM1 installation location>\webapps\tm1web\bi_files\

   For more information about using these files to enable Cognos BI security with Cognos TM1 Web, see “Configuring Cognos TM1 Web to use Cognos Security” on page 212.

   **What’s new for Cognos TM1 installation and configuration in version 10.2.0**

   The following list identifies new and changed installation and configuration features in IBM Cognos TM1 version 10.2.0.

   **New installation requirements in Cognos TM1 10.2.0**

   There are new software prerequisites for 10.2.0:
Review the latest list of environments supported by Cognos TM1, including information on operating systems, patches, web servers and web browsers, by visiting [Cognos TM1 Software Environments](http://www.ibm.com/support/docview.wss?uid=swg27038140).

**Installation on Microsoft Windows**

- Microsoft .NET Framework is needed for the Advanced Rules Editor and the publish to the Web feature in Cognos TM1 Architect and TM1 Perspectives.
- Microsoft Visual C++ 2010 Redistributable Package (x86 and x64)
  
  Both the x86 and x64 versions are required on a 64-bit Windows system if you plan to run any of the TM1 32-bit client applications such as Cognos TM1 Architect and TM1 Perspectives.

**Installation on UNIX**

Install your own copy of the Java™ Runtime Environment (JRE). The Cognos TM1 installation does not provide a JRE for UNIX installations.

**Installation of translated documentation**

During installation, you can choose to install specific language translations of the online documentation that you need. By default, the English version of the online documentation is always installed and cannot be unselected.

This option installs additional documentation, translated from English to selected languages, into the install location. Installation time increases with the number of languages selected. By default, English documentation is always installed. This option does not affect the Cognos TM1 user interface or messages issued by the software, which are always installed for all supported languages.

To install a specific language for the documentation help, during installation expand the [Translated Documentation](#) node and select the other languages that you want to install.

When any additional language translations are installed, Cognos TM1 detects the language to use for online help based on your environment settings. For example, if you installed the French translated documentation and your browser settings are set to French, the online help is in French.

**Remember**: The Installation Language Selection setting on the first screen of the installation wizard defines the language for the installation wizard only. The language that is used for the Cognos TM1 software is determined by the language settings in your operating system software and in the Cognos TM1 tm1s.cfg configuration file.

For more information on how Cognos TM1 detects which language to use, see "Cognos TM1 language configuration" on page 91.

**Cognos TM1 Web now uses a Java-based web application server**

IBM Cognos TM1 Web now runs on a Java web application server such as Apache Tomcat.

By default, the Cognos TM1 installation configures Cognos TM1 Web to use the Tomcat web application server provided with the Cognos TM1 installation.
Cognos TM1 Web architecture

For more information about Cognos TM1 Web architecture, see “Cognos TM1 Web architecture” on page 28.

Configuration steps for Microsoft .NET Framework not needed

Cognos TM1 Web version 10.2.0 does not require or use the Microsoft .NET Framework. The required configuration steps that were related to the .NET Framework by previous versions of Cognos TM1 Web are no longer necessary in version 10.2.0.

New default installation directory for TM1 Web

As of version 10.2.0, the default installation directory for Cognos TM1 Web is:

<TM1_install>\webapps\tm1web\n
New default URL for starting TM1 Web

Use the following new, default URL to open Cognos TM1 Web version 10.2.0:

http://localhost:9510/tm1web/

New TM1 Web configuration file and parameters

Cognos TM1 Web version 10.2.0 uses a new configuration file named tm1web_config.xml. This file replaces the web.config file from previous Cognos TM1 Web versions. The new file includes a subset of the previous parameters because the parameters related to Microsoft .NET Framework have been removed.

The location of the new configuration file is:

<TM1_install>\webapps\tm1web\web-inf\configuration

A new parameter named GzipCompressionEnabled has been added that specifies if the web server responses are compressed.

TM1 Web supports Microsoft Excel worksheets in .xlsm and .xlsx formats

Cognos TM1 Web version 10.2 uses the Open XML file formats (.xlsm and .xlsx files) for Microsoft Excel worksheets created using Excel 2007 or later.

If you are using existing Microsoft Excel files in the older .xls format, use the Cognos TM1 conversion tool in Cognos TM1 Architect to convert the files.

For more information, see “Microsoft Excel .xls worksheets” on page 59.

TM1 Web security configuration has changed

A number of steps have changed for configuring the different types of authentication and data transmission security for Cognos TM1 Web.

TM1 Web and Cognos authentication security
The steps to configure Cognos TM1 Web to use Cognos security have changed. For more information, see "Configuring Cognos TM1 Web to use Cognos Security" on page 212.

**TM1 Web and Microsoft Windows authentication with Kerberos**

The steps to configure Cognos TM1 Web to use Cognos security have changed. For more information, see "Configuring Integrated Login for Cognos TM1 Web using Kerberos" on page 196.

**TM1 Web and SSL configuration**

As of Cognos TM1 Web version 10.2.0, to enable SSL in IBM Cognos TM1 Web, you must add a certificate in the Java Runtime Environment (JRE) keystore. For more information, see "Configuring Cognos TM1 Web to use SSL" on page 228.

**New Cognos TM1 Mobile Contributor app for Cognos TM1 10.2.0**

IBM Cognos TM1 Mobile Contributor is a new mobile application for the Apple iPad.

The Cognos TM1 Mobile app connects to an IBM Cognos TM1 Server and coexists with other desktop and web programs that connect to the same server. Use the Mobile app to:

- Access all planning applications from Cognos TM1 Applications
- View submission status for all approval nodes
- Interact with cube views in a grid or chart format.
- Change values on the iPad and submit back to the plan where the data is updated on the Cognos TM1 server.

For more information, see "Deploying Cognos TM1 Mobile Contributor" on page 41.

**New ways to open Cognos TM1 Performance Modeler**

As of version 10.2, the installation process installs a shortcut to IBM Cognos TM1 Performance Modeler in the Microsoft Windows Start menu and on your Windows desktop.

To start the application from the Windows Start menu:

Click Start > IBM Cognos TM1 Performance Modeler > IBM Cognos TM1 Performance Modeler

To start the application from the desktop, locate the icon for IBM Cognos TM1 Performance Modeler.

**New scorecard samples**

There is a new sample database that can be used with the new Cognos TM1 Scorecard features.

The Go_Scorecards sample database can be added to the TM1 server instance in Cognos Configurations. The GO_Scorecards sample contains many sample data structures that can be used for TM1 Scorecarding. A sample application is also available for use with scorecards.
New integration with Cognos Analysis for Microsoft Excel

IBM Cognos Analysis for Microsoft Excel is now integrated with IBM Cognos TM1 data sources.

Use Cognos Analysis for Microsoft Excel with IBM Cognos TM1 data sources to enter and write back values to TM1 cubes. Cognos Analysis for Microsoft Excel enables Microsoft Excel users to directly access centrally controlled and secured IBM Cognos information for improved decision-making.

For information about deploying Cognos TM1 with Cognos Analysis for Microsoft Excel, see “Cognos TM1 and Cognos Analysis for Microsoft Excel” on page 68.

For more information about using Cognos Analysis for Microsoft Excel, see the IBM Cognos Analysis for Microsoft Excel User Guide, version 10.2.0.

New TM1 Admin Server Certificate Version parameter for SSL

A new parameter named TM1 Admin Server Certificate Version has been added to IBM Cognos Configuration to specify which version of the TM1 generated SSL certificates to use.

You can use this parameter to choose either the 1024-bit encryption or new 2048-bit encryption version of the default TM1 certificates. By default, the 1024-bit encryption version of the TM1 generated certificates is used.

For more information see, “Configuring the Cognos TM1 Admin Server to use SSL” on page 221.
Chapter 2. Planning your Cognos TM1 installation

The key to a successful installation is planning. This chapter describes choices that will make the implementation process proceed smoothly.

When implementing IBM Cognos TM1, decide how you will install and configure it to provide the best possible performance. The installation and configuration choices that you make depend on your requirements, resources, and preferences.

Available installation programs

IBM Cognos TM1 provides a collection of installation programs for installing and configuring Cognos TM1 components on different operating systems and for different deployment scenarios.

The installation programs and component options are organized by operating system and architecture tier to support deployment in single and multiple computer environments.

The available Cognos TM1 10.2.0 installation programs are described below.

**TM1 for Windows 32-bit**

- Includes a collection of all the 32-bit Cognos TM1 components that are available for Microsoft Windows.
- Use this installation program to install all components on a single 32-bit Windows system or to selectively install individual components, such as the Cognos TM1 Admin Server and Cognos TM1 Server, on separate 32-bit Windows systems.
- By default, this installation program automatically installs the IBM Cognos Configuration utility for managing the Cognos TM1 Admin Server, Cognos TM1 Server and Cognos TM1 Applications components.

**TM1 for Windows 64-bit**

- Includes a combined collection of 32-bit and 64-bit components for installation on a 64-bit Microsoft Windows system.
- This installation program will only run on a 64-bit Windows system.
- Use this installation program to install all components on a single 64-bit Windows system or to selectively install individual components, such as the Cognos TM1 Admin Server and Cognos TM1 Server, on separate 64-bit Windows systems.
- By default, this installation program automatically installs the IBM Cognos Configuration utility for managing the Cognos TM1 Admin Server, Cognos TM1 Server and Cognos TM1 Applications components.

**TM1 Client-only**

- Includes only the standard Cognos TM1 clients / user interfaces and related TM1 API support files. These components are only available as 32-bit versions.
  - Cognos TM1 Architect
  - Cognos TM1 Perspectives
Cognos TM1 APIs
Cognos TM1 Performance Modeler
Cognos Insight

Use this installation program to distribute and install Cognos TM1 clients to multiple end-user computers in your environment.

**Note:** You can also use the TM1 Client installation program to enable IBM Cognos BI reporting against Cognos TM1 data sources. Using the TM1 Client installation program for this purpose will install the required Cognos TM1 API files on your Cognos BI servers that are running report services on Microsoft Windows. For more details, see “Enabling Cognos BI reporting on Cognos TM1 data sources” on page 67.

**TM1 for UNIX and Linux**

Includes only the UNIX and Linux versions of the following Cognos TM1 components.
- Cognos TM1 Admin Server
- Cognos TM1 Server
- Cognos TM1 web application servers (Cognos TM1 Web, Cognos TM1 Applications, Cognos TM1 Operations Console)

Use the Cognos TM1 UNIX installation program to install these components on any of the supported UNIX or Linux operating systems. A separate installation program is available for each of these supported operating systems.

By default, this installation program automatically installs the IBM Cognos Configuration utility for managing the Cognos TM1 Admin Server and Cognos TM1 Server components.

**TM1 Package Connector for Business Intelligence**

Optional installation program

Installs components that support IBM Cognos TM1 connectivity to IBM Cognos Business Intelligence (BI) packages with SAP Business Warehouse data sources and other relational and ODBC data sources.

---

**Available components**

IBM Cognos TM1 includes a collection of server and client components for administering, monitoring, modeling, analyzing, and interacting with Cognos TM1 data.

The installation program organizes the different Cognos TM1 components into groups based on architecture tier. You can install different combinations of components onto a single computer or across multiple computers, depending on your specific requirements, operating system and environment. Each component requires a specific operating system and software environment. Refer to the following sections for information on the installation components.

**TM1 Application Tier installation component**

The Application Tier in the IBM Cognos TM1 installation program includes the fundamental components such as the Cognos TM1 Admin and Cognos TM1 server components.
The following table includes the description and operating system for each Cognos TM1 component in the application tier.

**Table 1. System requirements for Cognos TM1 Application tier components**

<table>
<thead>
<tr>
<th>Component</th>
<th>Operating System</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TM1 Server</td>
<td>32-bit Windows</td>
<td>The Cognos TM1 Server manages requests from Cognos TM1 clients. It loads the names of all available permanent objects, such as cubes and dimensions into memory. It responds to client requests by completing calculations, consolidations, and updates as required. The Cognos TM1 Server also manages security by granting or denying access to server objects and maintaining a log of changes to the database. See Chapter 8, “Cognos TM1 Server installation,” on page 83.</td>
</tr>
<tr>
<td></td>
<td>64-bit Windows</td>
<td></td>
</tr>
<tr>
<td></td>
<td>64-bit UNIX</td>
<td></td>
</tr>
<tr>
<td>TM Admin Server</td>
<td>32-bit Windows</td>
<td>A process that tracks all Cognos TM1 servers that run on a network. An Admin Server runs on an Admin Host server. When a Cognos TM1 server starts, the server registers itself with an Admin Server that is running on a specified Admin Host. Cognos TM1 clients reference the Admin Server to determine which Cognos TM1 servers are available on the network. See Chapter 8, “Cognos TM1 Server installation,” on page 83.</td>
</tr>
<tr>
<td></td>
<td>64-bit Windows</td>
<td></td>
</tr>
<tr>
<td></td>
<td>64-bit UNIX</td>
<td></td>
</tr>
<tr>
<td>TM1 Tools</td>
<td>Supported operating systems vary by tool.</td>
<td>Includes the following collection of tools and utilities for Cognos TM1 administrators, developers, and modelers: TIRunTI, TM1xfer. See Chapter 14, “Cognos TM1 tools installation,” on page 179.</td>
</tr>
</tbody>
</table>

**Web Application Tier installation component**

The Web Application Tier installation components require a web application server on which to run. By default, they are configured to work with the provided Java web application server.

The following table includes the description and operating system for each Cognos TM1 component in the web application tier.
<table>
<thead>
<tr>
<th>Component</th>
<th>Operating System</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cognos TM1 Application Gateway</td>
<td>32-bit Windows 64-bit Windows</td>
<td>Java web component that provides the provisioning of the Cognos TM1 Performance Modeler and Cognos Insight components to remote users. This component is installed with the Cognos TM1 Application Server component. See Chapter 11, “Cognos TM1 Application Server installation,” on page 131.</td>
</tr>
<tr>
<td>TM1 Application Server</td>
<td>32-bit Windows 64-bit Windows</td>
<td>Java web application that provides the primary support for IBM Cognos TM1 Applications. Cognos TM1 Applications component is used to design, deploy, and run managed planning and contribution-based applications on Cognos TM1 data. This component also interacts with Cognos TM1 Performance Modeler and Cognos Insight components. This component requires a Java web application server and the Java Runtime Environment (JRE). You can use the Apache Tomcat application server that is installed by default or your own instance of an application server such as WebSphere® Application Server. An IBM JRE is installed automatically with Cognos TM1 Applications. If you are using an application server, use the JRE that is installed with it. See Chapter 11, “Cognos TM1 Application Server installation,” on page 131.</td>
</tr>
<tr>
<td>TM1 Web</td>
<td>32-bit Windows 64-bit Windows</td>
<td>Web server and client components that run on the provided Java web application server. Cognos TM1 Web enables users to connect to Cognos TM1 servers and interact with data using one of the supported web browsers. See Chapter 10, “Cognos TM1 Web installation,” on page 109.</td>
</tr>
</tbody>
</table>
### Table 2. Web application tier components (continued)

<table>
<thead>
<tr>
<th>Component</th>
<th>Operating System</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TM1 Operations Console</td>
<td>32-bit Windows</td>
<td>Java web application that provides a web-based monitoring tool for Cognos TM1 administrators to monitor and act on TM1 server activity.</td>
</tr>
<tr>
<td></td>
<td>64-bit Windows</td>
<td>The IBM Cognos TM1 Operations Console provides a simple and effective way to understand how Cognos TM1 servers and user loads are working.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>You can use this component with the Apache Tomcat application server that is installed by default or your own installation of a supported application server.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>An IBM JRE is installed automatically with Cognos TM1 on Windows. If you are using an application server, use the JRE that is installed with it.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “Installing Cognos TM1 Operations Console using the provided Apache Tomcat webserver software” on page 101.</td>
</tr>
</tbody>
</table>

### TM1 Client Tier installation component

The client tier in the IBM Cognos TM1 installation program contains tools for end-users and a collection of Cognos TM1 APIs.

The following table includes the description and operating system for each Cognos TM1 component in the client tier.

### Table 3. Client tier components

<table>
<thead>
<tr>
<th>Component</th>
<th>Operating System</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TM1 Perspectives</td>
<td>32-bit Windows</td>
<td>Cognos TM1 add-in client for Microsoft Excel.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Enables you to use the features of Excel to perform complex analysis on data that is stored in a Cognos TM1 server. Can also create and maintain objects and data on both local and remote Cognos TM1 Servers.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “Installing Cognos TM1 Perspectives” on page 155.</td>
</tr>
</tbody>
</table>
### Table 3. Client tier components (continued)

<table>
<thead>
<tr>
<th>Component</th>
<th>Operating System</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cognos Insight</td>
<td>32-bit Windows</td>
<td>Java, Eclipse-based rich client interface that can be started independently or from the Cognos TM1 Applications portal page. Available as a selectable component in the Client-only, and 32-bit and 64-bit Windows installation programs. By default, this component is available but not selected in the 32-bit and 64-bit Windows installation programs. See “Installing Cognos Insight” on page 163.</td>
</tr>
<tr>
<td>TM1 APIs</td>
<td>Dependent upon specific APIs</td>
<td>Installs the required files that enable developers to work with the following Cognos TM1 application programming interfaces (APIs). <strong>TM1 API</strong> - Allows developers to create custom C, C++ and VB applications that interact with TM1. <strong>TM1 Java API</strong> - Allows developers to create custom Java applications that interact with TM1. <strong>TM1 .NET API</strong> - Allows developers to create custom Microsoft .NET applications that interact with TM1. See “Installing Cognos TM1 APIs” on page 167.</td>
</tr>
</tbody>
</table>

### Developer Tier installation component

The Developer Tier in the IBM Cognos TM1 installation program contains tools for the Cognos TM1 modeler and developer.

The following table includes the description and operating system for each TM1 component in the developer tier.

### Table 4. Developer tier components

<table>
<thead>
<tr>
<th>Component</th>
<th>Operating System</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TM1 Architect</td>
<td>32-bit Windows</td>
<td>A Windows desktop application for administering, creating, and maintaining data and metadata on both local and remote Cognos TM1 servers. See “Installing Cognos TM1 Architect” on page 156.</td>
</tr>
</tbody>
</table>
Table 4. Developer tier components (continued)

<table>
<thead>
<tr>
<th>Component</th>
<th>Operating System</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TM1 Performance Modeler</td>
<td>32-bit Windows</td>
<td>Java, Eclipse-based rich client interface that is started from the Cognos TM1 Applications portal page. Enables developers to build planning and analysis models in the Cognos TM1 environment. Available as a selectable component in the Client-only, and 32-bit and 64-bit Windows installation programs. By default, this component is available but not selected in the 32-bit and 64-bit Windows installation programs. See “Installing Cognos TM1 Performance Modeler” on page 138.</td>
</tr>
</tbody>
</table>

Samples installation component

A collection of sample IBM Cognos TM1 databases are provided with the installation.

The following table includes the description and operating system for the samples component.

Table 5. Sample database components

<table>
<thead>
<tr>
<th>Component</th>
<th>Operating System</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Samples</td>
<td>32-bit Windows</td>
<td>Installs Cognos TM1 samples databases:</td>
</tr>
<tr>
<td></td>
<td>64-bit Windows</td>
<td>Chapter 13, “Cognos TM1 sample databases installation,” on page 169.</td>
</tr>
<tr>
<td></td>
<td>64-bit UNIX</td>
<td></td>
</tr>
</tbody>
</table>

Translated documentation installation component

This component enables you to select and install translated documentation for the non-English languages that are supported in IBM Cognos TM1.

By default, English documentation is always installed and cannot be unselected. You can select or deselect specific languages, however the installation time increases with the number of languages selected.

For information about supported languages, see “Cognos TM1 language codes” on page 92.

The translated documentation option does not affect the languages for messages and user interfaces:

• This option does not affect messages issued by the software, which are always installed for all supported languages.
Additional installation components not listed

Some components are not listed or selectable in the installation program.

The following table includes the description and operating system for required components that are not listed or selectable in the installation program but are installed by default with the installation of other selectable components.

<table>
<thead>
<tr>
<th>Component</th>
<th>Operating System</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TM1 OLE DB Provider Application</td>
<td>32-bit Windows</td>
<td>Allows third party software to retrieve cube data from the Cognos TM1 server using MDX queries.</td>
</tr>
<tr>
<td></td>
<td>64-bit Windows</td>
<td></td>
</tr>
</tbody>
</table>

TM1 client differentiation

IBM Cognos TM1 provides multiple clients for both developers/administrators and end-users. Understanding these clients and differentiating between them can help you decide which client is most appropriate for your needs.

All clients are described fully in the IBM Cognos TM1 documentation.

- The Cognos TM1 Performance Modeler User Guide describes the development and administrative capabilities of Cognos TM1 Performance Modeler.
- The Cognos TM1 Developer Guide describes the development and administrative capabilities of Cognos TM1 Architect and Cognos TM1 Perspectives.
- The Cognos TM1 Operations Console Guide describes how to monitor and administer servers with the Cognos TM1 Operations Console.
- The Cognos TM1 User Guide describes the end-user analysis capabilities of Cognos TM1 Architect and Cognos TM1 Perspectives.
- The Cognos Insight User Guide describes the end-user analysis capabilities of Cognos Insight.
- The Cognos TM1 Web User Guide describes the end-user analysis capabilities of Cognos TM1 Web.
- The Cognos TM1 Applications Guide describes the end-user analysis capabilities of Cognos TM1 Application Web.

End-user clients

Several end-user clients are available to interact with IBM Cognos TM1 data.

IBM Cognos Insight

IBM Cognos Insight is both a client for TM1 Application Web and a personal analysis tool that you can use to analyze almost any set of data. In the context of Cognos TM1 Application Web, Cognos Insight is a full client application that is provisioned locally or as a remote download. When used as a client for Cognos TM1 Application Web there are two modes in which Cognos Insight can be used: Connected Mode and Disconnected Mode.
**Connected Mode** creates a live, bi-directional connection to the Cognos TM1 server. Any data that is updated on the TM1 server is updated in the Insight client when you perform a recalculation in Insight. This ensures that the data on the Insight client is always current when performing analysis or contributing to a plan. The trade-off for the live connection to the TM1 server is that more traffic is generated on the LAN and a heavier load is placed upon the TM1 server as compared to Disconnected Mode. Connected Mode should be used by users who have as fast connection to the TM1 server and do not suffer from any network latency.

**Disconnected Mode** is currently available only with child level nodes. Disconnected Mode downloads and creates a local copy of the Cognos TM1 server slice (TM1 model and data portion) with which you are working. This is beneficial in that it distributes the workload the TM1 server would have to maintain in any other connection mode. Processing is distributed between the client and the TM1 server in this mode. Disconnected Mode is beneficial to users on a high latency LAN or users who are geographically distant from the TM1 server. When a user opens Cognos Insight in Disconnected Mode the TM1 model slice is downloaded and cached. All interaction with data occurs against the local cache, greatly increasing the speed of response.

**IBM Cognos Analysis for Microsoft Excel**

IBM Cognos Analysis for Microsoft Excel is intended for users working in global networked environments. It is the client of choice for users who primarily employ Microsoft Excel for analyzing TM1 information and build their own custom layouts using native Microsoft Excel functionality. Cognos Analysis for Microsoft Excel is also beneficial for users who need to access both Cognos TM1 and Cognos Business Intelligence data from the same Excel client interface.

Cognos Analysis for Microsoft Excel offers the following benefits:

- **Optimized for wide area networks (WANs).**
- Provides a familiar spreadsheet environment that does not require a power-user level of knowledge in Excel to analyze and contribute to Cognos TM1 data.
- Combines the capabilities of Microsoft Excel with a drag and drop approach to analyzing Cognos TM1 cubes.
- Provides a flexible “range-based” mode that lets you add formats and user calculations directly within a spreadsheet.
- Provides native access to TM1 data objects, such as cubes, views, dimension subsets, aliases, and sandboxes.
- Provides the ability to combine read/write Microsoft Excel-based TM1 Planning with read-only analysis against Cognos Business Intelligence data sources in the same spreadsheet interface.

Use IBM Cognos TM1 Perspectives in place of Cognos Analysis for Microsoft Excel when you want to do the following:

- Use TM1 formula-based data retrieval and updates.
- Design and build TM1 Websheets and Active Forms.
- Use administrative tasks such as metadata updates and Action Buttons inside a workbook (Turbo Integrator Scripts).
- Use TM1 Perspectives VBA macro extensions to build custom Microsoft Excel applications.
For more information, see the IBM Cognos Analysis for Microsoft Excel Version User Guide.

IBM Cognos TM1 Application Web

IBM Cognos TM1 Application Web is a zero-footprint web client that allows you to open and work with Cognos TM1 Applications using any supported web browser. From the Cognos TM1 Application Web workflow page, you can open a node, take ownership, enter data, and contribute to a plan. Cognos TM1 Application Web is most useful when a corporate policy prohibits the installation of a local client, or when using an operating system other than Microsoft Windows, as all TM1 thick clients are Windows-based.

IBM Cognos TM1 Web

IBM Cognos TM1 Web is a zero-footprint web client that allows you to analyze and modify Cognos TM1 data from any supported web browser. Cognos TM1 Web does not allow you to access the Cognos TM1 Application Web workflow page. Consequently, you cannot participate in Cognos TM1 Applications with TM1 Web.

Administration clients

These IBM Cognos TM1 clients can be used to administer your Cognos TM1 data and models.

IBM Cognos TM1 Performance Modeler

IBM Cognos TM1 Performance Modeler is the newest Cognos TM1 modeling tool, which lets you quickly create or generate dimension, cubes, rules, processes, and other objects. Performance Modeler simplifies the modeling process by automatically generating the rules and feeders required for your applications. Performance Modeler also introduces guided import, a simplified process for importing data and metadata into a TM1 server. Performance Modeler should be used as the primary development and maintenance tool for all new and existing Cognos TM1 models.

IBM Cognos TM1 Architect

IBM Cognos TM1 Architect is an older Cognos TM1 modelling tool that supports the creation and maintenance of all TM1 objects. TM1 Architect does not support automatic feeder and rules generation, and does not provide guided import capabilities. Architect users are encouraged to transition to Cognos TM1 Performance Modeler as the primary development environment for all TM1 models.

IBM Cognos TM1 Perspectives

IBM Cognos TM1 Perspectives is the TM1 Excel Add-In. Cognos TM1 Perspectives is an older tool that can be used for both Cognos TM1 model development and for analyzing data via Microsoft Excel capabilities. Like Cognos TM1 Architect, Perspectives supports the creation and maintenance of all TM1 objects, but does not provide the advanced capabilities of Performance Modeler. End-users that require an Excel Add-In interface and the ability to use Microsoft Excel functionality, such as charting, while working with TM1 data can use Perspectives. Otherwise, administrators are encouraged to transition to Performance Modeler as the primary development environment for all TM1 models.
IBM Cognos TM1 Operations Console

IBM Cognos TM1 Operations Console is a web-based operations tool that is designed to facilitate the monitoring, support, and management of Cognos TM1 servers, providing greater insight into day-to-day server operations. The Cognos TM1 Operations Console allows you to dynamically monitor threads running on multiple TM1 servers at a given time. You can sort and filter thread activity, as well as schedule logging of server activity. The Operations Console also provides a health check feature which determines the current state of each TM1 server being monitored. The Operations Console should be the interface of choice for Cognos TM1 administrators who are managing an enterprise-scale TM1 environment.

Software requirements

Before you install IBM Cognos TM1 server or client components, review system requirements and set up resources in your environment so that the components can operate.

Review the latest list of environments supported by Cognos TM1, including information on operating systems, patches, web servers and web browsers, by visiting [Cognos TM1 Software Environments](http://www.ibm.com/support/docview.wss?uid=swg27040698).

Prerequisite software

Cognos TM1 requires the installation of specific software components before it can be installed and used.

<table>
<thead>
<tr>
<th>Prerequisite Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Excel</td>
<td>Required for Cognos TM1 Perspectives.</td>
</tr>
<tr>
<td>Microsoft .NET Framework</td>
<td>Required for Cognos TM1 Perspectives and Cognos TM1 Architect.</td>
</tr>
</tbody>
</table>

Download and install these components on the target system before installing the related Cognos TM1 components.

Default installation values

This topic describes the set of default values used by the IBM Cognos TM1 installation.

The Cognos TM1 installation uses the following default configuration values:

<table>
<thead>
<tr>
<th>Item</th>
<th>Description and Default Value</th>
</tr>
</thead>
</table>
| Default install location | On a 32-bit Microsoft Windows system:  
|                     | C:\Program Files\IBM\Cognos\TM1                 |
|                     | On a 64-bit Microsoft Windows system:  
<p>|                     | C:\Program Files\IBM\cognos\tm1_64             |</p>
<table>
<thead>
<tr>
<th>Item</th>
<th>Description and Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Admin Server port number</strong></td>
<td>The TCP/IP port number on which the Admin Server listens for client requests.</td>
</tr>
<tr>
<td></td>
<td>Default value is 5495 (unsecured).</td>
</tr>
<tr>
<td></td>
<td>This value is set in IBM Cognos Configuration.</td>
</tr>
<tr>
<td><strong>Admin Server SSL port number</strong></td>
<td>The TCP/IP port number on which all Cognos TM1 components communicate with the Cognos TM1 Admin Server using Secure Socket Layer (SSL).</td>
</tr>
<tr>
<td></td>
<td>Default value is 5498 (secured)</td>
</tr>
<tr>
<td></td>
<td>This value is set in IBM Cognos Configuration.</td>
</tr>
<tr>
<td><strong>Cognos TM1 server port number</strong></td>
<td>The port on which the Cognos TM1 server runs. This parameter is used to distinguish multiple Cognos TM1 servers running on the same computer. Valid port values fall between 5000 and 49151.</td>
</tr>
<tr>
<td></td>
<td>The default is 12345.</td>
</tr>
<tr>
<td></td>
<td>This value is set with the <strong>PortNumber</strong> parameter in the Tm1s.cfg server configuration file.</td>
</tr>
<tr>
<td><strong>Cognos TM1 Client Message port number</strong></td>
<td>This port number establishes a secondary port for client progress messages to use when a lengthy operation is waiting to be cancelled.</td>
</tr>
<tr>
<td></td>
<td>This value is set with the <strong>ClientMessagePortNumber</strong> parameter in the Tm1s.cfg server configuration file.</td>
</tr>
<tr>
<td></td>
<td>The default value is blank.</td>
</tr>
<tr>
<td></td>
<td>By default, this port number is automatically and dynamically assigned when the Cognos TM1 server starts. You do not have to set <strong>ClientMessagePortNumber</strong> to a specific number unless firewalls or other network issues require the listener port to be a well-known number.</td>
</tr>
<tr>
<td></td>
<td><strong>CAUTION:</strong></td>
</tr>
<tr>
<td></td>
<td>If you choose to set a specific value for the <strong>ClientMessagePortNumber</strong> parameter, instead of having it dynamically assigned, be sure to assign unique port numbers for all the Cognos TM1 server and client message ports you are using. If you have two servers running on the same machine using the same port number, the message activity may cause a system conflict or hang.</td>
</tr>
<tr>
<td><strong>Admin Server host name</strong></td>
<td>Specifies the computer name or IP address of the Admin Host on which a Cognos TM1 Admin Server is running.</td>
</tr>
<tr>
<td></td>
<td>Default value is blank which uses <strong>localhost</strong> to represent the computer on which the installation is run.</td>
</tr>
<tr>
<td></td>
<td>This value is set with the <strong>AdminHost</strong> parameter in the Tm1s.cfg and Tm1p.cfg configuration files.</td>
</tr>
</tbody>
</table>
Table 8. Default configuration values for Cognos TM1 installation (continued)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description and Default Value</th>
</tr>
</thead>
</table>
| Sample Cognos TM1 server names | Planning Sample  
SData  
GO_NewStores  
Login credentials:  
**User name:** admin  
**Password:** apple |
| Default data directory for sample Cognos TM1 servers | C:\Program Files\IBM\cognos\tm1\samples\tm1\PlanSamp  
C:\Program Files\IBM\cognos\tm1\samples\tm1\SData  
C:\Program Files\IBM\cognos\tm1\samples\tm1\GO_NewStores |
| Security mode | A Standard installation uses Cognos TM1 Authentication. In this mode, the Cognos TM1 server prompts users for a user name and password when they log in to Cognos TM1 components. |

**Configuration overview**

After installing IBM Cognos TM1, use the Cognos Configuration tool and the Cognos TM1 configuration file parameters to configure the program for optimal performance.

**Cognos Configuration and Cognos TM1**

The IBM Cognos Configuration tool is used to start, stop, configure, and save the setting for each IBM Cognos TM1 server.

Use Cognos Configuration to manage the following components and tasks:

Table 9. Cognos Configuration tasks

<table>
<thead>
<tr>
<th>Component/task</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cognos TM1 Admin Server</td>
<td>Start and stop the server.</td>
</tr>
<tr>
<td>Cognos TM1 Server</td>
<td>Start, stop and add Cognos TM1 Servers.</td>
</tr>
</tbody>
</table>
| Cognos TM1 Application Server | Start and stop the provided Apache Tomcat web application server that supports the following components:  
• IBM Cognos TM1 Web  
• IBM Cognos TM1 Applications  
• IBM Cognos TM1 Operations Console  
If you are using your own installation of Tomcat or another web application server, configure and run the Cognos TM1 Application Server outside of Cognos Configuration. |
Table 9. Cognos Configuration tasks (continued)

<table>
<thead>
<tr>
<th>Component/task</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Saving configuration information</td>
<td>When you save the configuration setting in the Cognos Configuration tool, the tool:</td>
</tr>
<tr>
<td></td>
<td>• verifies the configuration</td>
</tr>
<tr>
<td></td>
<td>• generates cryptographic information</td>
</tr>
<tr>
<td></td>
<td>• checks integrity of encrypted data</td>
</tr>
<tr>
<td></td>
<td>• saves configuration for Cognos TM1 servers</td>
</tr>
<tr>
<td></td>
<td>• backs up configuration files</td>
</tr>
<tr>
<td></td>
<td>• saves configuration parameters</td>
</tr>
<tr>
<td></td>
<td>• updates Tomcat configuration file</td>
</tr>
<tr>
<td>Creating war files for deployment</td>
<td>If you want to deploy the Cognos TM1 Application Server with your own web application server, use Cognos Configuration to create the required web application (war) file.</td>
</tr>
<tr>
<td></td>
<td>In Cognos Configuration click <strong>Actions &gt; Build Application Files.</strong></td>
</tr>
</tbody>
</table>

Cognos TM1 configuration files and parameters

IBM Cognos TM1 uses a collection of configuration files and parameters to control the behavior of the client and server components.

Table 10. Summary of configuration options for different Cognos TM1 components

<table>
<thead>
<tr>
<th>Configuration</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tm1s.cfg file</td>
<td>Cognos TM1 server configuration</td>
</tr>
<tr>
<td></td>
<td>See <a href="#">Appendix A, “The tm1s.cfg Server Configuration File,” on page 255</a>.</td>
</tr>
<tr>
<td>Tm1p.ini file</td>
<td>Client configuration for Cognos TM1 Architect and Cognos TM1 Perspectives</td>
</tr>
<tr>
<td></td>
<td>See <a href="#">Appendix B, “The Tm1p.ini Client Configuration File,” on page 311</a>.</td>
</tr>
<tr>
<td>Cognos TM1 Web</td>
<td>Cognos TM1 Web configuration and settings</td>
</tr>
</tbody>
</table>
| tm1web_config.xml | See "Modifying Cognos TM1 Web Configuration Parameters on page 114."
| Cognos TM1 Applications | Cognos TM1 Applications configuration files                                    |
| pmpsvc_config.xml | Client settings are stored in the pmpsvc_config.xml file.                    |
| fpmsvc_config.xml | Server settings are stored in the fpmsvc_config.xml file.                    |
|                 | See [Chapter 11, “Cognos TM1 Application Server installation,” on page 131](#) and "Backing up your Cognos TM1 Applications data" on page 245. |
| Cognos TM1 Operations Console | Cognos TM1 Operations Console configuration                                   |
|                 | See "Installing Cognos TM1 Operations Console using the provided Apache Tomcat webserver software" on page 101. |
User accounts for running Cognos TM1 services on Windows

When you use IBM Cognos Configuration to start the Cognos TM1 Admin Server and Cognos TM1 Server, they are registered to run as Windows services using the predefined Microsoft Windows Local System Account. You should manually change these services to run under a specific user account.

Run Cognos TM1 services under a specific Windows user account

By default, Cognos Configuration registers the following Cognos TM1 services to run under the Microsoft Windows Local System Account:

- Cognos TM1 Admin Server
- Cognos TM1 Server

**Important:** Change these Cognos TM1 services to run under a specific user account on Microsoft Windows.

For details on how to change the account for a Cognos TM1 component running as a Windows service, see "Changing Cognos TM1 services to run as a specific user account on Windows" on page 21.

After making these changes, you will still be able to use Cognos Configuration to start and stop these services.

Required privileges for a specific Windows user account

The user account for running Cognos TM1 services on Windows should be included in the database owner group to access SQL tables and views.

The account must have the following privileges on the local machine:

**Note:** Not all of these properties are available in all versions of Windows, such as Windows Server 2008 R2 and newer. Refer to Microsoft Windows documentation for the currently available properties.

- Act as part of the operating system
- Bypass traverse checking
- Increase quotas (Adjust memory quotas for a process)
- Replace a process level token
- Log on as a service
- Have read and write privileges on the Windows Registry item

Use the Security Settings and Group Policy features in Microsoft Windows to configure these security privileges. For example, in Microsoft Windows 7, click **Administrative Tools > Local Security Policy**, and then click to expand **Security Settings > Local Policies > User Rights Assignment**.

To set read and write privileges for the Windows Registry, use the Windows Registry editor.

Installing TM1 on Networks without domains

If you install IBM Cognos TM1 in a network that does not use a domain controller, you can set your Cognos TM1 services to use local accounts.
For details on configuring Cognos TM1 services, see “Changing Cognos TM1 services to run as a specific user account on Windows” on page 85.

If you use one or more local accounts for your Cognos TM1 services, you must be sure these accounts have the following privileges on their local machines:

- Act as part of the operating system
- Bypass traverse checking
- Increase quotas
- Replace a process-level token
- Log on as a service

If you set up file shares in your Windows network for use by Cognos TM1 components, be sure that each local account that you set up to run a Cognos TM1 service has access to those shares.

**Note:** If you install on a machine that does not participate in a Microsoft Windows domain, you cannot use Integrated Login.

**Local machine syntax**

Do not use dot (.) as an abbreviation for the local machine domain when you specify login information.

You must explicitly enter the machine name. In certain configurations, using the ".\username" syntax may cause serious problems.
Chapter 3. Architecture

To understand the architecture of the major IBM Cognos TM1 components, you should be familiar with your information technology infrastructure and with the business needs of people in your organization who will use IBM Cognos TM1.

For details about Cognos TM1 login authentication and communication security, see “Authentication security” on page 181.

Cognos TM1 architecture

IBM Cognos TM1 employs a distributed, client-server architecture that consists of the IBM Cognos TM1 server to which a combination of different clients can connect.

Cognos TM1 provides the following clients and user interfaces:

- Cognos TM1 Perspectives
- Cognos TM1 Architect
- Cognos TM1 Web client
- Cognos TM1 Application portal and workflow (using the Cognos TM1 Application Server)
- Cognos TM1 Performance Modeler
- Cognos Insight

In this environment, corporate data resides on remote servers, which authorized clients can access. Depending on how you set up the system, clients can access one or more remote TM1 servers to obtain different kinds of data. Cognos TM1 clients are described in detail in the IBM Cognos TM1 User Guide.
Windows desktop clients

TM1 Perspectives and TM1 Architect can connect to a local IBM Cognos TM1 server, which acts as a repository for private TM1 data. If you have the proper authority, you can copy data from a remote server to your local server by replicating that data, and then synchronize your updates back to the remote server.

TM1 Perspectives, TM1 Architect, and TM1 Client are standard TM1 clients. In a normal LAN or WAN environment, these clients all communicate with a remote server using the TCP/IP network protocol.

Cognos TM1 Admin Server overview

The IBM Cognos TM1 Admin Server is a process that keeps track of all Cognos TM1 servers running on a network. An Admin Server runs on a computer known as an Admin Host.

When the Cognos TM1 server starts, the server registers itself with an Admin Server that is running on a specified Admin Host. TM1 clients reference the Admin Server to determine which Cognos TM1 servers are available on the network.

The Admin Server maintains the following information for each available Cognos TM1 server:
- Server name
- IP address
- Protocol
- Port number

All this information is supplied by the Cognos TM1 server when the server registers itself on the Admin Server.

An Admin Server must be running before a Cognos TM1 server can start. If you have specified an Admin Host in the Tm1s.cfg file or the server command line, the Cognos TM1 server will attempt to connect to an Admin Server on that host. The Cognos TM1 server will fail to come up if it is unable to connect to the Admin Server for any reason.

If you have not specified an Admin Host, the Cognos TM1 server attempts to connect to an Admin Server on the local machine. If an Admin Server is not currently running on the local machine, the Cognos TM1 server starts a new Admin Server and connects to it.

The Admin Server becomes aware of Cognos TM1 servers on the network by listening for notification from the servers. Usually, the Cognos TM1 server sends notification of its presence at a regular interval called the "heartbeat interval," which is 60 seconds by default. When the Admin Server detects the Cognos TM1 server, that server becomes registered and available to clients on the network. However, if the Admin Server does not detect the presence of a registered Cognos TM1 server over a period equal to three times the heartbeat interval, that Cognos TM1 server is removed from the list of servers available on the network. Consequently, the Cognos TM1 server will not be available to clients on the network.

By default, the Admin Server uses port 5495. If port 5495 is already in use, you can assign a new port number by creating a new service called Tm1admsrv. All
Cognos TM1 applications look for a named service called Tm1admsrv, and if that service exists, the applications use the port number assigned to the service. If the service does not exist, Cognos TM1 applications use port 5495.

**Cognos TM1 Server overview**

The IBM Cognos TM1 Server manages access to the Cognos TM1 data directory for Cognos TM1 clients.

The following figure illustrates the operations of a remote Cognos TM1 server. These operations are explained in the text that follows.

![Figure 2. Operations of a remote server](image)

- On startup, the remote server loads dimensions and cubes from the data directory into the server machine RAM. At the same time, the server opens a new transactional log file called Tm1s.log in the data directory. After the cubes are loaded, the remote server is available.
- The remote Cognos TM1 server registers itself with one or more Admin Servers so that clients can connect to the remote Cognos TM1 server.
- Client applications contact Admin Servers to locate available Cognos TM1 servers. The clients log into the Cognos TM1 servers whose data they want to access.
- Clients edit the cube data, sending the values back to the Cognos TM1 server.
- As new values are received from clients, the Cognos TM1 server writes the records to the Tm1s.log file, keeping track of every data change, including the date and time the edit occurred, and the ID of the client who made the edit.
- As the server calculates new values in response to client requests, the server stores them in memory, increasing the amount of memory used by the server.
- When the server shuts down, all records in the Tm1s.log file are saved to disk, and the transaction log file is renamed by appending a date/time stamp to it. The Tm1s.log file is saved in the server's data directory to back out data transactions. For details, see the topic "Backing Out Records from the TransactionLog" in the *IBM Cognos TM1 Operation Guide*. 
If the server is intentionally shut down without saving the changes, the log file is saved with a time/date stamp and the extension is changed to .rej. You can process the Tm1syyyyymmddhhmss.rej file through TurboIntegrator to recover the transactions.

To save all changes to the data on a Cognos TM1 server at any time without shutting down the server, right-click a server in Server Explorer and Click Save Data. All records in the Tm1s.log file are immediately written to disk, the transaction log file is renamed by appending a date/time stamp to it, and a new Tm1s.log file is created to accept any subsequent edits to cube values. Any changes to the metadata, such as dimension definitions and cube definitions, are immediately saved to disk. The changes to the metadata are not written to the transaction log file.

Cognos TM1 files overview
IBM Cognos TM1 requires numerous object and system files, most of which are stored in the Cognos TM1 server’s data directory.

Some of these are installed with the product, while others are generated for each dimension and cube you create. Yet other files are generated by Cognos TM1 to store metadata, such as security information.

The following table lists the files that define cubes, dimensions, and other Cognos TM1 objects. These files are located in the data directory, which is described later in this section.

Table 11. Files that define cubes, dimensions, and other objects

<table>
<thead>
<tr>
<th>File Extension</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>.blb</td>
<td>Cube formatting file</td>
</tr>
<tr>
<td>.cho</td>
<td>Chore definition file</td>
</tr>
<tr>
<td>.cub</td>
<td>Cube database file</td>
</tr>
<tr>
<td>.dim</td>
<td>Compiled dimension</td>
</tr>
<tr>
<td>.dit</td>
<td>ASCII dimension source file</td>
</tr>
<tr>
<td>.pro</td>
<td>TurboIntegrator process definition file</td>
</tr>
<tr>
<td>.rux</td>
<td>Compiled rule</td>
</tr>
<tr>
<td>.sub</td>
<td>Dimension subset</td>
</tr>
<tr>
<td>.tbu</td>
<td>ASCII source for view file</td>
</tr>
<tr>
<td>.tqu</td>
<td>Saved query</td>
</tr>
<tr>
<td>.tru</td>
<td>ASCII source for a rule file</td>
</tr>
<tr>
<td>.vue</td>
<td>Saved view</td>
</tr>
<tr>
<td>.xdi</td>
<td>Excel dimension worksheet</td>
</tr>
</tbody>
</table>
Table 11. Files that define cubes, dimensions, and other objects (continued)

<table>
<thead>
<tr>
<th>File Extension</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>.xru</td>
<td>Excel rule worksheet</td>
</tr>
</tbody>
</table>

Data directory overview

The data directory contains the cubes, dimensions, and system information that are loaded into memory when a Cognos TM1 server is started. When you access a server from any Cognos TM1 client, Cognos TM1 reads data from that server’s data directory.

When you run Cognos TM1, the changes you make to cube values are immediately stored in memory and in the transaction log (Tm1s.log). Cognos TM1 then saves the data back to the data directory when any of the following occur:

- Cognos TM1 server is shut down.
- An administrator right-clicks a server icon in Server Explorer and choose Save Data from the pop-up menu. This directs Cognos TM1 to save the changes to the selected server.
- An administrator chooses File, Save Data All in Server Explorer. This directs Cognos TM1 to save the changes to all the connected servers, if you have the proper authority.
- A user saves the batch updates.

Choose the path for your data directory when you install Cognos TM1.

Table 12. Default Data Directory Paths

<table>
<thead>
<tr>
<th>Data Directory</th>
<th>Default Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cognos TM1 local server</td>
<td>installation_location\custom\tm1data\pdata</td>
</tr>
<tr>
<td>Windows Cognos TM1 remote server for</td>
<td>installation_location\custom\tm1data\sdata</td>
</tr>
<tr>
<td>sample data</td>
<td></td>
</tr>
<tr>
<td>UNIX Cognos TM1 server</td>
<td>installation_location/custom/tm1data/sdata</td>
</tr>
</tbody>
</table>

Required network access

A client’s ability to save data is determined by the IBM Cognos TM1 security scheme.

For information, see the IBM Cognos TM1 Developer Guide.

Important: Make this directory visible only to administrators and to the login that is used by the server.

Multiple data directories

You can specify that you want IBM Cognos TM1 to use multiple data directories by separating the directory names with semicolons. When you specify multiple data directories, Cognos TM1 does the following.
• Accesses cubes and dimensions from each of the specified directories. If there is a duplicate object, Cognos TM1 accesses the object from the first directory specified.
• Writes changes to the directory where the object is located. When you create a new object, Cognos TM1 writes to the first directory you had specified.

For example, suppose you want to store dimensions in a directory called tm1dims, and cubes in a directory called tm1cubes. You would specify the following in the Tm1s.cfg file:
DatabaseDirectory="c:\tm1dims;c:\tm1cubes"

By concatenating the two directories, you can access these objects through Server Explorer as if they were in a single location.

**Note:** You cannot store cube (.cub) and rules (.rux) files in separate data directories. The .rux file must reside in the same directory as the .cub file with which it is associated. If the .rux file is not in the same directory as the associated .cub file, rules will not load properly.

**Data directory location**
You specify the location of the data directory differently for local and remote servers.

• For a local server, specify the location of the data directory by naming this directory in the DatabaseDirectory parameter of the Tm1p.ini file.

  You can change the.ini file by using the IBM Cognos TM1 Options menu in Server Explorer.

  For more information, see [Appendix B, “The Tm1p.ini Client Configuration File,” on page 311](#).

• For a remote server, specify the location of the data directory by using either the DatabaseDirectory parameter in the Tm1s.cfg file or the -d command-line parameter when you bring up the server.

  For information on server parameters, see [Appendix A, “The Tm1s.cfg Server Configuration File,” on page 255](#).

A remote server must be able to recognize the drive where the data directory resides. If the directory is on a remote drive, you must map that drive to a local drive letter.

**Tip:** When you access a remote server, you do not need to map to the drive where the server data directory resides.

If you do not specify the location of the data directory, the Cognos TM1 server will not be able to start and the following error message displays:


---

**Cognos TM1 Web architecture**

IBM Cognos TM1 Web uses a multi-tiered architecture that enables users to access and interact with Cognos TM1 data using any supported web browser.

The IBM Cognos TM1 Web multi-tiered architecture includes web client, web application server and data component tiers.
Tier 1: Web clients

The web clients tier allows users to access and interact with Cognos TM1 data using any of the supported web browsers. Users can work with Cognos TM1 cubes and Cognos TM1 Websheets.

Visit Cognos TM1 Software Environments (http://www.ibm.com/support/docview.wss?uid=swg27040698) for currently supported web browsers.

Tier 2: Web application server

Cognos TM1 Web runs on a Java-based web application server.

This tier provides support for converting and displaying Microsoft Excel worksheets as Cognos TM1 Websheets. This service also exports Websheets back to Microsoft Excel and PDF formats.

Tier 3: Data

This tier includes the Cognos TM1 Admin Server and at least one Cognos TM1 Server.

IBM Cognos TM1 Admin server

The Cognos TM1 Admin Server can be installed on any computer on your LAN but it must reside in the same LAN segment as your Cognos TM1 Server. Typically, the Cognos TM1 Server and the Cognos TM1 Admin Server are installed on the same computer.

IBM Cognos TM1 server

The Cognos TM1 server can be installed on the same computer that hosts your Web server, but installing on a separate computer is more efficient.

The version of the Cognos TM1 server that is used in your Cognos TM1 Web environment must be equal to or more recent than the version of
Cognos TM1 Web that you are running. If the version of Cognos TM1 Web you are running is more recent than the version of the Cognos TM1 server, users will receive an error when attempting to log in to Cognos TM1 Web.

Accessing multiple Cognos TM1 servers from Cognos TM1 Web

IBM Cognos TM1 Web provides multi-database support, allowing users to access multiple Cognos TM1 servers that are registered on the same Cognos TM1 Admin Server and where users have the same user name and password combination.

When you log in, Cognos TM1 Web displays the Navigation pane for the primary server that you selected on the login screen. However, if your user name and password combination matches other Cognos TM1 servers registered under the same Cognos TM1 Admin Server, then IBM Cognos TM1 Web will automatically log you in to these other servers on an as-needed basis. This behavior is different from Cognos TM1 Architect and Cognos TM1 Perspectives where you have to log into other Cognos TM1 servers as a separate, manual step.

Multi-database support mainly applies to Websheets because they can contain Cognos TM1 formulas and references that point to other Cognos TM1 servers. For example, if you open a Websheet that does contain Cognos TM1 references to another server registered under the same Admin Server, Cognos TM1 Web will attempt to log you into this other server using your current user name and password.

Limiting access to a single Cognos TM1 server from Cognos TM1 Web

If you want to prevent IBM Cognos TM1 Web users from using multi-database support to access other Cognos TM1 servers under the same Admin Server, you can use a different Admin Server to register each Cognos TM1 server.

For example, with this configuration, if you log into Cognos TM1 Web and try to open a Websheet that references another Cognos TM1 server registered under a different Admin Server, the data will not display even if you have the same user name and password for that server.

Tip: If you configure your Cognos TM1 servers to run under separate Admin Servers, but still want to access them from Cognos TM1 Web, Cognos TM1 Architect, or Cognos TM1 Perspectives, you can use the AdminHost parameter. This parameter lets you specify multiple Admin Hosts so users can access any Cognos TM1 servers that are registered with the Admin Servers on the specified hosts.

• For information about configuring IBM Cognos TM1 Web to access multiple Admin Servers, see "Configuring the Login Page using AdminHostName and TM1ServerName" in the IBM Cognos TM1 Operation Guide.

• For information about configuring Cognos TM1 Architect and Cognos TM1 Perspectives to access multiple Admin Servers, see "Specifying multiple Cognos TM1 Admin Hosts" on page 96.

Cognos TM1 Applications architecture

IBM Cognos TM1 Applications has a multi-tiered architecture that consists of three tiers: Web clients, Web application servers, and data.
The following diagram shows the multi-tiered architecture and basic communication paths for all the Cognos TM1 Applications components.

![Cognos TM1 Applications architecture overview diagram](image)

The lines in the Cognos TM1 Applications architecture diagram are primarily intended to show the typical communication paths required for the tasks managed by the Cognos TM1 Application Server, such as keeping track of workflow states.

In addition to these communication lines, Cognos TM1 Performance Modeler and Cognos Insight also require a direct connection to the underlying Cognos TM1 Server at all times. As an exception, when using Cognos Insight in Distributed mode, it does not require a constant connection to the Cognos TM1 Server.

**Cognos TM1 Applications Tier 1: Web clients**

The Web clients tier contains all the user interfaces for IBM Cognos TM1 Applications. These user interfaces are used by end-users, administrators, and planning application developers.

**Cognos TM1 Applications**

The main Cognos TM1 Applications client is a web browser-based user interface supported by a Java-based web application server, such as IBM WebSphere or the provided installation of Apache Tomcat. The user interfaces for Cognos TM1 Applications are organized into two main sub-pages and three different data contribution clients.

**Cognos TM1 Applications page**

The Cognos TM1 Applications page (portal page) is the main starting point for both administrator and non-administrator users. This page provides a list of available applications that is filtered for the current user. Clicking on an application in this page opens the workflow page.
Administrators and application developers can also open Cognos TM1 Performance Modeler and Cognos Insight from the Cognos TM1 Applications toolbar.

Cognos TM1 Application page

The Cognos TM1 Application page (workflow page) allows you to manage tasks within a single application. This client displays each node that a user is responsible for contributing to and/or reviewing in a specific plan. Depending on how you configure the application, the user can open the Cognos Insight client or Cognos TM1 Application Web client for any accessible node in this client.

Data contribution clients

The following table summarizes the Cognos TM1 Applications data contribution clients that enable users to work with data in grid and chart formats.

Table 13. Cognos TM1 Applications - data contribution clients

<table>
<thead>
<tr>
<th>Client</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IBM Cognos TM1 Application Web</td>
<td>Default client. Processing is in real time with the server. Enables users to view and edit application data in a grid format using Cognos TM1 cube views or TM1 Websheets based on infrastructure from Cognos TM1 Web</td>
</tr>
<tr>
<td>IBM Cognos Insight - Connected</td>
<td>IBM Cognos Insight client. Processing is in real time with the server. Enables users to view and edit application data in a dashboard or workspace format.</td>
</tr>
<tr>
<td></td>
<td>This client can be provisioned and installed from the Cognos TM1 Application Gateway or installed remotely by a system administrator using a Windows Installer command line and other software management tools.</td>
</tr>
<tr>
<td>IBM Cognos Insight - Distributed</td>
<td>IBM Cognos Insight client with local processing of data. Data is updated to the server only when a commit data action is performed.</td>
</tr>
<tr>
<td></td>
<td>Same provisioning and installation options as the Cognos Insight - Connected client.</td>
</tr>
</tbody>
</table>

Cognos TM1 Performance Modeler

The Cognos TM1 Performance Modeler client provides the user interface for administrators and developers to design and deploy applications.

This user interface must be installed locally on the user's computer. Users can provision and install this client from the Cognos TM1 Application Gateway the first time they open the client. System administrators can also distribute and install the program remotely using Windows Installer and other software management tools. For details, see “Installing Cognos TM1 Performance Modeler” on page 158.

Cognos Insight

Cognos Insight can run separate from Cognos TM1 Applications to enable users to create workspaces to use within an application.

This user interface must be installed locally on the user's computer. It can be provisioned from the Cognos TM1 Application Gateway and installed by the user
the first time they open the client. System administrators can also distribute and install the program remotely using a Windows Installer command line and other software management tools. For details, see “Installing Cognos Insight” on page 163.

**Cognos TM1 Applications Tier 2: Web server**

The Web servers tier contains the required Java-based web application server.

**Java web application server**

The following components require a Java-based web application server. You can use the version of Apache Tomcat that is provided with the installation or your own installation of one of the supported Java-based web application servers.

**Cognos TM1 Application Server**
Java-based web application that provides the primary support for IBM Cognos TM1 Applications.

**Cognos TM1 Application Gateway**
Java-based web component that provides the provisioning of the Cognos TM1 Performance Modeler and Cognos Insight components to remote end users.

**Cognos TM1 Application Web client**
An optional user interface based on Cognos TM1 Web technology for viewing and editing application data. If you are using this option, the supporting files for it run on this same web application server.

**Using security and web server provided by Cognos BI**

If you use Cognos TM1 Applications with a Cognos TM1 Server that is using IBM Cognos security, you can deploy the Cognos TM1 Application Server with the Apache Tomcat web server that is supplied with IBM Cognos. For details, see “Using Cognos TM1 Applications with Cognos security” on page 214.

**Cognos TM1 Applications Tier 3: Data**

The data tier for IBM Cognos TM1 Applications includes the IBM Cognos TM1 Admin Server and one or more IBM Cognos TM1 servers running on either a Microsoft Windows or UNIX-based system. The Cognos TM1 Application Server and related client interfaces communicate with the components in the data tier to access Cognos TM1 data.

**Cognos TM1 Admin Server**

The Cognos TM1 Admin Server is a process that keeps track of all Cognos TM1 servers running on a network. The Cognos TM1 Application Server communicates with the Cognos TM1 Admin Server to determine which Cognos TM1 servers are available on the network.

**Cognos TM1 Server**

The Cognos TM1 Server contains the data for the applications that you build and deploy with Cognos TM1 Applications.
Chapter 4. Deployment

This section describes some of the typical installation and deployment scenarios for the available IBM Cognos TM1 components. Use this section help you plan the installation and configuration of Cognos TM1 in different computer environments and to maximize its performance.

You can install and deploy components on a single computer or across multiple computers in a networked environment.

For each component you want to install on a different computer, run the Cognos TM1 Installation Wizard on that computer.

**Server components**

You can install the following server components on separate dedicated computers:

- Cognos TM1 Admin Server and Cognos TM1 Server
- Cognos TM1 Web
- Cognos TM1 Application Server

**Client components**

You can install the following client components on multiple computers:

- Cognos TM1 Perspectives
- Cognos TM1 Architect
- Cognos TM1 Performance Modeler
- Cognos Insight

**Deploying Cognos TM1 on a single Windows computer**

Installing IBM Cognos TM1 components on one computer running Microsoft Windows is a practical approach for proof of concept, test, demonstration, development and training environments.

You can use either the Cognos TM1 32-bit or 64-bit installation program for Windows.

Installation on a single Windows computer is primarily intended for a single user on one of the supported 32-bit or 64-bit Windows operating systems. For example, Microsoft Windows XP, Windows Vista, or Windows 7. However these are not server class, production level operating systems and this type of deployment should only be used for individual use and not in a production environment with multiple users.

**Typical single computer installation**

A typical Cognos TM1 installation on a single Windows computer includes the following components:

**Application Tier**

- Cognos TM1 Admin server
• Cognos TM1 Server
• Cognos TM1 Tools

**Web Application Tier**
• Cognos TM1 Application Gateway
• Cognos TM1 Application Server
• Cognos TM1 Web
• Cognos TM1 Operations Console

**Client Tier**
• Cognos TM1 Perspectives
• Cognos Insight
• Cognos TM1 APIs

**Developer Tier**
• Cognos TM1 Architect
• Cognos TM1 Performance Modeler

**Samples**
Sample databases for Cognos TM1 and Cognos TM1 Applications

You can adjust which components you install based on your specific needs.

**Deployment differences between 64-bit and 32-bit installations**

Not all Cognos TM1 components are available for 64-bit systems. If the component is available as a 64-bit installation, the default installation directory is different from the default installation directory that is used in a 32-bit installation.

**Deploying Cognos TM1 Admin Server and TM1 Server**

You can install the IBM Cognos TM1 Admin Server and Cognos TM1 Server components on a separate Microsoft Windows and UNIX computer in your hardware environment.

For each component you want to install on a different computer, run the Cognos TM1 Installation Wizard on that computer.

You can install the Cognos TM1 Admin Server on the same computer on which the Cognos TM1 Server is installed or another computer on your network.

When a Cognos TM1 server is running, it registers itself on the specified Admin Server. Cognos TM1 clients then connect to this same Admin Server to obtain information about Cognos TM1 servers available on a network.

If you distribute the server components throughout your network, you must know certain information about where your components will be installed, and the configuration of those components. The following list provides information about what you need to know to install each component.
Table 14. Installing Cognos TM1 server components

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cognos TM1 Server</td>
<td>To install and configure the Cognos TM1 server, you must know the name of the computer on which the Cognos TM1 Admin Server is running.</td>
</tr>
<tr>
<td>Cognos TM1 Admin Server</td>
<td>This can be installed without any knowledge of your network topology.</td>
</tr>
</tbody>
</table>

**Important Notes on Distributed Installations**

Cognos TM1 services must run on computers set to the same locale. You cannot, for example, install some services on a computer running the US English locale, and other services on a computer running the German locale. Set the locale using the Standards and Formats option in Microsoft Windows Start Menu, Regional and Local Settings.

**Deploying Cognos TM1 Web**

Depending on your requirements, you can deploy IBM Cognos TM1 Web in a number of different ways.

How you deploy Cognos TM1 Web depends on how you plan to use the component. The typical deployment scenarios include:

- As the primary web-based user interface that enables users to access Cognos TM1 data using a web browser.
  
  For details, see Chapter 10, “Cognos TM1 Web installation,” on page 109.
- To support the IBM Cognos TM1 Application Web client in IBM Cognos TM1 Applications.
  
  The Cognos TM1 Application Web client uses the infrastructure of Cognos TM1 Web. For details, see “Cognos TM1 Applications architecture” on page 30 and Chapter 11, “Cognos TM1 Application Server installation,” on page 131.
- To support integration with IBM Cognos Business Intelligence (BI) components, such as using Cognos TM1 Viewer Portlets and iWidgets.
  
  For details, see “Cognos TM1 iWidgets and Cognos Workspace” on page 67.

**Deploying Cognos TM1 Applications**

Depending on your specific network environment and business requirements, you can install IBM Cognos TM1 Applications on a single computer or distribute the components to separate computers in a network.

**Security considerations when using Cognos TM1 Applications**

You can use either IBM Cognos TM1 standard security authentication or IBM Cognos security for the Cognos TM1 servers you use with Cognos TM1 Applications.

Do not use a combination of different security authentication modes for the same installation of Cognos TM1 Applications.
Determine the security mode before you configure Cognos TM1 Applications to use a Cognos TM1 server and use that same security mode with any additional servers you add.

For details about using Cognos security, see: "Using Cognos TM1 Applications with Cognos security" on page 214.

Using the IntegratedSecurityMode parameter with Cognos TM1 Applications

To set the Cognos TM1 security authentication mode use the IntegratedSecurityMode parameter in the Tm1s.cfg file of each Cognos TM1 server you want to use.

Important: The Cognos TM1 Applications component is compatible only with Cognos TM1 security authentication modes 1 and 5.

For example, to use Cognos TM1 standard security authentication, set the IntegratedSecurityMode parameter to 1 for each server.

IntegratedSecurityMode=1

To use IBM Cognos security, set the IntegratedSecurityMode parameter to 5.

IntegratedSecurityMode=5

For more details about the IntegratedSecurityMode parameter, see the “TM1 System Configuration” section in the IBM Cognos TM1 Operations Guide.

If IntegratedSecurityMode=5 is used for the IBM Cognos TM1 Server and IBM Cognos TM1 Applications, it is not possible to assign rights to native TM1 groups within the Manage rights dialog. Only Cognos Groups imported into the TM1 Server, are available. This means you cannot use native TM1 groups and Cognos groups in parallel because the SecMode is limiting which groups can be used.

Configuring Cognos TM1 Applications security for multiple Cognos TM1 Servers

If you want to use multiple Cognos TM1 servers with Cognos TM1 Applications, they must all be configured to use the same security authentication (either Cognos TM1 standard authentication or Cognos security) and include the same administrator user name and password.

For more details, see "Configuring Cognos TM1 Application Web to use Multiple Cognos TM1 Servers" on page 150.

Deploying all Cognos TM1 Applications components on a single computer

For development, testing, or demonstration purposes, you may want to install all of the required components for IBM Cognos TM1 Applications onto a single computer running Microsoft Windows.
**Installation program**

Deploying Cognos TM1 Applications to a single computer is the quickest way to get the program up and running.

Use either the 32- or 64-bit Cognos TM1 installation program for Windows to install Cognos TM1 Applications on a single Windows-based computer.

**Required Cognos TM1 components**

The following components are required to deploy and run Cognos TM1 Applications on a single Windows-based computer.

- Cognos TM1 Admin Server
- Cognos TM1 Server
- Cognos TM1 Application Server
- Cognos TM1 Application Gateway
- Cognos TM1 Web
- Cognos TM1 Sample databases (optional) - Allows you to easily run a sample Cognos TM1 server for testing purposes.

By default, the Cognos Configuration tool is required and automatically installed with this configuration. After completing the installation, you use Cognos Configuration to deploy and start the Cognos TM1 Application Server and manage your Cognos TM1 servers.

A version of Apache Tomcat web application server is also automatically installed for use with Cognos TM1 Applications.

Cognos TM1 Web is required if you plan to use the Cognos TM1 Applications Web client.

**Required web application servers**

Cognos TM1 Applications requires a Java-based web application server.

You can deploy Cognos TM1 Applications to one of the following Java-based web application servers:

- Use the version of Tomcat that is provided with the installation.
- Use your own instance of Tomcat
- Use your own instance of IBM Websphere

**Deploying Cognos TM1 Applications components on separate computers**

Deploying some or all of the IBM Cognos TM1 Applications components on separate, dedicated computers can improve performance, availability, and capacity.

Depending on your network environment and business requirements, you can distribute the web application servers tier and data tier across multiple computers in a number of different ways.
Deploy web application servers tier and data tier on separate computers.

This configuration combines the Java web application server for Cognos TM1 Applications and IBM Cognos TM1 Web on the same computer but locates the data tier (Cognos TM1 server) on a separate computer.

Deploy web application servers on separate computers

This configuration places the Java web application server for Cognos TM1 Applications and Cognos TM1 Web on their own computers. The data tier could also be installed on one of these computers or its own dedicated computer.

Deploy all components on separate computers

This configuration places the Java web application servers for Cognos TM1 Applications and Cognos TM1 Web and the Cognos TM1 Admin Server and the Cognos TM1 server(s) all on separate computers.

Checklist for deploying Cognos TM1 Applications

Use the following checklist to help you install the IBM Cognos TM1 Application Server and related components on separate computers.

Table 15. Installation scenarios for deploying IBM Cognos TM1 Applications

<table>
<thead>
<tr>
<th>Installation scenario</th>
<th>Installation steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>Running all the Java web applications together on a separate computer</td>
<td>Use the Cognos TM1 installation program to install the Cognos TM1 Application Server, Cognos TM1 Application Gateway, and Cognos TM1 Web on the computer running the Java web application server.</td>
</tr>
<tr>
<td>Running Cognos TM1 Web on a separate computer</td>
<td>Use the Cognos TM1 installation program to install Cognos TM1 Web on a separate computer. The Installation Wizard installs the required files for the Cognos TM1 Application Web client - one of the client interfaces for viewing and editing application data.</td>
</tr>
<tr>
<td>Running the data tier on a separate computer</td>
<td>Use the TM1 installation program to install the TM1 Admin Server and TM1 Server components on that computer. For more information, see “Deploying Cognos TM1 Admin Server and TM1 Server” on page 30.</td>
</tr>
</tbody>
</table>

Deploying Cognos TM1 client applications

This section describes how to deploy the different IBM Cognos TM1 client (user interfaces) in your network environment.

The different Cognos TM1 clients include:
- Cognos TM1 Perspectives
- Cognos TM1 Architect
- Cognos TM1 Performance Modeler
- Cognos Insight
- Cognos TM1 Web (using a URL or web link)
Deploying Cognos TM1 Mobile Contributor

IBM Cognos TM1 Mobile Contributor is a mobile application for the Apple iPad that connects to an IBM Cognos TM1 Server and coexists with other desktop and web applications that connect to the same server.

Mobile users can access all their planning applications from IBM Cognos TM1 Applications, view submission status for all approval nodes, and interact with cube views in a grid or chart format right in the iPad app. Users can also change values on the iPad and submit them back to the plan where the data is updated on the IBM Cognos TM1 server.

System overview

The mobile application connects to and interacts with a Cognos TM1 Server and Cognos TM1 Application Server. Submissions that are begun on one client (web browser, desktop application, or mobile) can be continued or completed on another.

For users, the concepts of Cognos TM1 Mobile Contributor are consistent with other contribution user interfaces except that the gestures are consistent with a touch-based, mobile device.

The main components of the system include:

- Cognos TM1 Mobile Contributor for iPad
- Cognos TM1 Server
- Cognos TM1 Application Server

A wireless network connection is required on the iPad to allow Cognos TM1 Mobile Contributor to connect with remote TM1 data.

Installation and configuration tasks for TM1 Administrators

You must have Cognos TM1 Server and Cognos TM1 Application Server installed and running before you can use Cognos TM1 Mobile Contributor.

Install Cognos TM1 Applications on a system that is available on your wireless network.

1. Install and run Cognos TM1 Applications.
   - Use IBM Cognos Configuration to make sure that the TM1 Application Server and TM1 Server are running.
   - Ensure that Cognos TM1 Application Server is accessible on your wireless network.
   - Deploy and activate a planning application with Cognos TM1 Applications.

2. Provide the Cognos TM1 Application Server host name and port number to the users of the app. Users must enter this information in the app on their iPads to connect to Cognos TM1.
   - The host name should have the format: `web_server_name.domain_name.com`
   - The default server port number for the standard Cognos TM1 installation is 9510.
3. If the web server that supports Cognos TM1 Mobile Contributor is configured for SSL, then users should set the Enable SSL option to ON.

**Configuring Cognos TM1 Mobile Contributor on the iPad**

As an iPad user, you install Cognos TM1 Mobile Contributor on your iPad directly from the Apple App Store. Open the App Store and search for “IBM Cognos TM1” to locate and then install the app.

After you install and run Cognos TM1 Mobile Contributor for the first time, configure the app so that it can connect to your Cognos TM1 Application Server.

1. On your iPad, open the Cognos TM1 Mobile Contributor.
2. On the welcome screen, tap the **Add new connection (+)** button.
3. In the **Connect** dialog, enter the following information to connect to your Cognos TM1 Application Server:
   - In the **Host** field, enter the name of the web server that supports Cognos TM1 Mobile Contributor.
     For example: `webserver.example.com`
   - In the **Connection Name** field, enter your own text description for this connection.
   - For the **Server Port**, use the default port number of 9510. If your TM1 installation is configured to use a different port number, enter that value.
   - If the web server that supports Cognos TM1 Mobile Contributor is configured for SSL security (https://), set the **Enable SSL** option to **ON**.
4. Tap **Connect** to save and start using the connection.
5. If prompted, enter your user name and password to complete the connection.

**Configuring Cognos TM1 Mobile Contributor to display TM1 servers and cubes**

You can explore Cognos TM1 servers and cubes directly in Cognos TM1 Mobile Contributor without creating and deploying a Cognos TM1 Application from Cognos TM1 Performance Modeler. However, in this case, the features that are supported by TM1 applications such as workflow and annotations are not available.

**Before you begin**

To log in to Cognos TM1 Mobile Contributor, you must have access to at least one Cognos TM1 server that is registered with the Cognos TM1 Applications planning service. Otherwise, you cannot sign in to Cognos TM1 Mobile Contributor.

**About this task**

To access and display Cognos TM1 servers and cubes directly in Cognos TM1 Mobile Contributor, you first add the server to the Cognos TM1 Applications Configuration window. After you configure Cognos TM1 Applications, you can log in to a connection in Cognos TM1 Mobile Contributor to see all of the available applications and servers.

**Procedure**

1. Open Cognos TM1 Applications and then open the configuration window.
2. Add a Cognos TM1 server to the list.
For more information, see Setting Cognos TM1 Applications configuration options [http://www.ibm.com/support/knowledgecenter/SS9RXT_10.2.2/com.ibm.swg.ba.cognos.tm1_cont_ug.10.2.2.doc/t_settingapplicationconfigurationoptions_na5571.html](http://www.ibm.com/support/knowledgecenter/SS9RXT_10.2.2/com.ibm.swg.ba.cognos.tm1_cont_ug.10.2.2.doc/t_settingapplicationconfigurationoptions_na5571.html).

3. Open Cognos TM1 Mobile Contributor and create a connection that points to the system that is running Cognos TM1 Applications.

4. Log in to the connection.
   The available applications and servers are displayed. A different icon is shown for applications and servers.

5. To see the available cubes and views, select a Cognos TM1 Server.

**Viewing Scorecarding cubes and Impact diagrams in Cognos TM1 Mobile Contributor**

You can view and interact with Scorecarding cubes and impact diagrams in Cognos TM1 Mobile Contributor. Use this feature to monitor the performance of your key metrics right on your tablet by viewing status, trend, and actual values in data grid and visualization diagram formats.

**About this task**

The Scorecarding cubes can be contained in a TM1 Application or directly in a TM1 Server.

**Procedure**

1. To open a Scorecarding cube:
   a. Open and log in to a connection on the Cognos TM1 Mobile Contributor sidebar menu.
b. Tap either a TM1 Application or a TM1 Server that contains at least one Scorecarding cube.
   - For a TM1 Server, select a Scorecarding cube and then select a view.
   - For a TM1 Application, select a node from the hierarchy and then select a view.

c. The Scorecarding cube shows metric indicator icons for Status and Trend right in the cells of the data grid. You can use the metric indicator icons to create Watchlist items. For more information, see “Creating and viewing Scorecarding watchlist items in Cognos TM1 Mobile Contributor” on page 45.

2. To view a Scorecarding impact diagram:
   a. Tap Settings and select a Layout option for either Chart or Both. The available layout options include the following display modes:
      - Grid displays a data grid only.
      - Chart displays a chart only.
      - Both displays both a data grid and chart.
   b. To zoom the impact diagram, use a two-finger pinch or squeeze gesture.
   c. To pan or move the diagram, use a tap and drag gesture.
   d. To expand and collapse the nodes in the diagram, tap the + and - icons.
Creating and viewing Scorecarding watchlist items in Cognos TM1 Mobile Contributor

You can use the Scorecarding watchlist in Cognos TM1 Mobile Contributor to monitor important metrics such as revenue and profit.

**About this task**

A watchlist item can be created only for cells that contain a Scorecarding metric indicator for Status or Trend.

When the value of a watchlist item is updated, a notification displays in the app and also in the iOS Notification Center list.

**Procedure**

1. To create a Scorecarding watchlist item:
   a. Open a cube view in Cognos TM1 Mobile Contributor.
      The cube view can be contained in a TM1 Application or directly from a TM1 Server.
   b. To add a watchlist item, tap and hold a Status or Trend cell in the data grid.
      Wait for the cell to be highlighted and automatically added to the watch list.
2. To view your watchlist:
   a. Click the menu icon to display the sidebar.
   b. Click the watchlist icon.
3. To view the watchlist item in the related cube, tap the item and then tap Go.
4. To change the name of a watchlist item, double-tap the item and enter a new name.
5. To delete a watchlist item, swipe across the item in the watchlist, then tap Delete.
Chapter 5. Upgrading

Upgrading an earlier version of IBM Cognos TM1 to the newest version should be considered a process that you perform in stages.

You should treat upgrading as an IT project that requires careful planning, adequate time, and resources.

Upgrading from version 10.2.0

Upgrading from Cognos TM1 version 10.2.0 to version 10.2.2 requires a full manual uninstall, and then a full installation of the new version.

For more information, see “Upgrading from Cognos TM1 version 10.2.0” on page 49.

Upgrading from version 10.1.x

Upgrading from Cognos TM1 version 10.1 or 10.1.1 to version 10.2.2 requires a full manual uninstall, and then a full installation of the new version.

One main difference between versions 10.1.x and 10.2.x, is the required web application server for Cognos TM1 Web. Starting with version 10.2.0, Cognos TM1 Web does not use Microsoft Internet Information Services (IIS) but instead uses a Java web application server, such as the provided version of Apache Tomcat.

For more information, see “Upgrading from Cognos TM1 version 10.1.x” on page 50.

Upgrading from version 9.x

Upgrading from Cognos TM1 version 9.0.x, 9.1.x, or 9.5.x to version 10.2.2 requires a full manual uninstall, and then a full installation of the new version.

Note: TM1 9.0.x and 9.1.x databases are automatically converted to Unicode when they are opened (started) with a TM1 server version 9.4 or higher. Once an older TM1 database is converted to Unicode, it can no longer be opened in the earlier versions of TM1.

For more information, see “Upgrading from Cognos TM1 version 9.x” on page 51.

Upgrade process

When you upgrade, you perform several distinct activities:
1. Stopping all related services.
2. Backing up your existing data and applications.
3. Removing the previous version of the product.
4. Installing the new version of the product.
5. Restoring your data, configuration settings, and applications with the new version of the product.
Planning the upgrade

The steps to upgrade an existing IBM Cognos TM1 installation depend on the Cognos TM1 components you currently use and have deployed.

Additional steps are required if you are also upgrading a previous version of Cognos TM1 Contributor to Cognos TM1 Applications.

Before you upgrade

Review the following considerations before you upgrade.

Cognos TM1 Admin Server

As of IBM Cognos TM1 version 10.1.0, the TM1 Admin Server configuration file, Tm1admsrv.ini, is no longer used or supported by Cognos TM1. You must use Cognos Configuration to configure the Cognos TM1 Admin Server.

Cognos TM1 Server

- TM1 9.0.x and 9.1.x databases are automatically converted to Unicode when they are opened (started) with a Cognos TM1 server version 9.4 or higher. Once an older TM1 database is converted to Unicode, it can no longer be opened in the earlier versions of TM1.
- In IBM Cognos TM1 version 10.1.0, you can use Cognos Configuration to start, stop, and manage your Cognos TM1 servers.

Cognos TM1 Web

As of IBM Cognos TM1 version 10.2.0, Cognos TM1 Web now runs on a Java web application server, such as the provided version of Apache Tomcat. Cognos TM1 Web version 10.2.0 and later does not require or use the Microsoft .NET Framework.
- As of Cognos TM1 Web version 10.2.0, the default installation directory for Cognos TM1 Web has changed from C:\inetpub\wwwroot\TM1Web to <TM1_Install>\tm1web.
- Cognos TM1 Web version 10.2.0 and later uses a new configuration file named tm1web_config.xml. This file replaces the web.config file from previous Cognos TM1 Web versions. The new file includes a subset of the previous parameters because the parameters related to Microsoft .NET Framework have been removed.
  The location of the new configuration file is:
  <TM1_install>\webapps\tm1web\web-inf\configuration
  If you want to use any settings from your previous Cognos TM1 Web configuration file, you can selectively merge parameters settings from your previous Web.config file into the new tm1web_config.xml file.
- A number of steps have changed for configuring the different types of authentication and data transmission security for TM1 Web.

Cognos TM1 Applications

- Attention: You will need to edit your previous applications in Cognos TM1 Performance Modeler if they use the following features:
  - Dynamic Subsets cannot be used as the approval hierarchy in Cognos TM1 Applications.
  - Applications cannot share the same approval cubes in Cognos TM1 Applications.
A version of Apache Tomcat web application server is installed with the new version of Cognos TM1. You can use this instance of Tomcat to run Cognos TM1 Applications and manage it using Cognos Configuration.

If you plan to use Cognos TM1 Applications without Microsoft Excel installed on the web server where you are running Cognos TM1 Web, you will need to explicitly set the ExcelWebPublishEnabled parameter to True (T) in the tm1s.cfg configuration file for your Cognos TM1 servers. Earlier versions of Cognos TM1 Contributor did not require this parameter to be set.

**Backing up your existing data**

Before you upgrade, ensure that you back up your existing data, application, and configuration files to a safe place. Depending on your network architecture and deployment of Cognos TM1, your Cognos TM1 data might reside on more than one computer. Make a list of where this data is located and create a plan to back up the data.

The following files need to be backed-up:

- Cognos TM1 Admin Server configuration files
- Cognos TM1 Server configuration and database files
- Cognos TM1 Web server configuration and custom files
- Cognos TM1 Architect client configuration file
- Cognos TM1 Perspectives client configuration file
- Cognos TM1 Contributor application and configuration files

**Upgrading from Cognos TM1 version 10.2.0**

When you upgrade IBM Cognos TM1 version 10.2.0 to version 10.2.2, you need to uninstall the previous version and then install the current version. You cannot install IBM Cognos TM1 version 10.2.2 directly over version 10.2.0. You should also plan to back up existing data and configuration files before uninstalling the previous version.

**About this task**

The following steps provide an overall guide for upgrading Cognos TM1 version 10.2.0 to the current version.

**Procedure**

1. Back up existing data and configuration files:
   
   You should plan to back up existing data and configuration files to a safe location for all computers where Cognos TM1 components were installed. For details see the following topics:
   
   - “Backing up data and configuration files for Cognos TM1” on page 241
   - “Backing up your Cognos TM1 Applications data” on page 245

2. Uninstall all Cognos TM1 components:
   
   If you installed the previous version of Cognos TM1 in a distributed environment, you will need to uninstall the TM1 components from each computer.

   - “Uninstalling Cognos TM1” on page 243
   - “Uninstalling and undeploying Cognos TM1 Applications” on page 244
3. Install the current version of IBM Cognos TM1:
   Refer to the following topics, depending on your computer environment and which Cognos TM1 components you want to install.
   - Chapter 7, “Cognos TM1 single-computer installation,” on page 73
   - Chapter 8, “Cognos TM1 Server installation,” on page 83
   - Chapter 10, “Cognos TM1 Web installation,” on page 109
   - Chapter 11, “Cognos TM1 Application Server installation,” on page 131
   - Chapter 12, “Cognos TM1 client and developer tier installation,” on page 155
   - “Installing Cognos TM1 Operations Console using the provided Apache Tomcat webserver software” on page 101

4. To upgrade Cognos TM1 Mobile Contributor, use the update feature available in the Apple App Store on your iPad.

5. After installing the new version of Cognos TM1 Applications, remove the cache of your web browser. If the cache is not removed, the browser may mix old Cognos TM1 Applications and new Cognos TM1 Applications files together.

6. Restore previous Cognos TM1 data and configuration files:
   Depending on which components you installed, update each computer with your previous data and configuration files.
   - “Restoring data and configuration files in Cognos TM1 version 10.2.2” on page 248
   - “Restoring application and configuration files in Cognos TM1 Applications” on page 250

**Upgrading from Cognos TM1 version 10.1.x**

When you upgrade IBM Cognos TM1 version 10.1.x to version 10.2.2, you need to uninstall the previous version and then install the current version. You cannot install IBM Cognos TM1 version 10.2.2 directly over version 10.1.x. You should also plan to back up existing data and configuration files before uninstalling the previous version.

**Before you begin**

Review the changes in the current version of Cognos TM1 in the following topics:
   - “Planning the upgrade” on page 48
   - “What's new for Cognos TM1 installation and configuration in version 10.2.2” on page 1
   - “What's new for Cognos TM1 installation and configuration in version 10.2.0” on page 2

One main difference between versions 10.1.x and 10.2.x, is the required web application server for Cognos TM1 Web. Cognos TM1 Web version 10.2.x does not use Microsoft Internet Information Services (IIS) but instead uses a Java web application server, such as the provided version of Apache Tomcat.

**About this task**

The following steps provide an overall guide for upgrading Cognos TM1 version 10.1.x to the current version.

**Procedure**

1. Back up existing data and configuration files:
You should plan to back up existing data and configuration files to a safe location for all computers where Cognos TM1 components were installed. For details see the following topics:

- “Backing up data and configuration files for Cognos TM1” on page 241
- “Backing up your Cognos TM1 Applications data” on page 245

2. Uninstall all Cognos TM1 components:
   If you installed the previous version of Cognos TM1 in a distributed environment, you will need to uninstall the TM1 components from each computer.

- “Uninstalling Cognos TM1” on page 243
- “Uninstalling and undeploying Cognos TM1 Applications” on page 244

3. Install the current version of IBM Cognos TM1:
   Refer to the following topics, depending on your computer environment and which Cognos TM1 components you want to install.

- Chapter 7, “Cognos TM1 single-computer installation,” on page 73
- Chapter 8, “Cognos TM1 Server installation,” on page 83
- Chapter 10, “Cognos TM1 Web installation,” on page 109
- Chapter 11, “Cognos TM1 Application Server installation,” on page 131
- Chapter 12, “Cognos TM1 client and developer tier installation,” on page 155
- “Installing Cognos TM1 Operations Console using the provided Apache Tomcat webserver software” on page 101

4. After installing the new version of Cognos TM1 Applications, remove the cache of your web browser. If the cache is not removed, the browser may mix old Cognos TM1 Applications and new Cognos TM1 Applications files together.

5. Restore previous Cognos TM1 data and configuration files:
   Depending on which components you installed, update each computer with your previous data and configuration files.

- “Restoring data and configuration files in Cognos TM1 version 10.2.2” on page 248
- “Restoring application and configuration files in Cognos TM1 Applications” on page 250

---

**Upgrading from Cognos TM1 version 9.x**

Upgrading IBM Cognos TM1 from version 9.x to version 10.2.2 requires a full uninstall and install procedure.

**Before you begin**

Review the differences between Cognos TM1 version 9.x and the current version. A number of configuration steps and installation directories have changed between version 9.x and 10.x. For details, see the following topics:

- “Planning the upgrade” on page 48
- “What’s new for Cognos TM1 installation and configuration in version 10.2.2” on page 1
- “What’s new for Cognos TM1 installation and configuration in version 10.2.0” on page 2
About this task

The following steps provide an overall guide for upgrading Cognos TM1 version 9.x to the current version.

Procedure
1. Stop services for Cognos TM1 9.x components.
2. Back up data and configuration files.
3. Uninstall Cognos TM1 version 9.x.
4. Install the current version.
5. Restore data and configuration files.

Stopping Cognos TM1 9.x services before upgrading

All services for IBM Cognos TM1 version 9.x must be stopped before upgrading to the new version.

Procedure
1. Use Windows Services to stop all Cognos TM1 9.x services. This includes:
   - Cognos TM1 Admin Server
   - Cognos TM1 Excel service
   - Cognos TM1 Server services
2. If you were using Cognos TM1 Contributor, stop the Cognos TM1 Contributor pmpsvc application.
   To do this, use the management tools for the web application server that is running Cognos TM1 Contributor.
3. If you are using IBM Cognos Business Intelligence security with Cognos TM1 Applications, stop the IBM Cognos BI service.

What to do next

Back up your existing data and applications. For more information, see "Backing up data for a previous version of Cognos TM1 9.x."

Backing up data for a previous version of Cognos TM1 9.x

This topic provides guidelines for backing up data and configuration files for all IBM Cognos TM1 9.x components.

Before you begin

Stop all related services. For more information, see "Stopping Cognos TM1 9.x services before upgrading."

About this task

If you are currently using a previous version of Cognos TM1 9.x, you must back up your Cognos TM1 data directory and configuration files before installing the new 10.x version of Cognos TM1.

If you are using Cognos TM1 Web 9.x or Cognos TM1 Contributor 9.5.x, you should also back up the related data and configuration files for those components.
Procedure

1. Back up Cognos TM1 Admin Server configuration files you may want to retain, such as the \tmadmrsrv.ini file located in the <TM1_Install>\bin\ directory.

2. Back up Cognos TM1 Server data and configuration files <TM1_Install>\Custom\TM1Data data directory and subdirectories to a secure location.

   Tip: The default data location for Cognos TM1 9.5 was: C:\Program Files\Cognos\TM1\Custom\TM1Data.

3. Back up Cognos TM1 Architect and Cognos TM1 Perspectives configuration files:
   a. Back up the system default \Tm1p.ini file located here:
      %ALLUSERSPROFILE%\Application\Data\Applix\TM1\Tm1p.ini
      For example: C:\Documents and Settings\All Users\Application\Data\Applix\TM1\Tm1p.ini
   b. Back up the user-specific \Tm1p.ini file located here:
      %APPDATA%\Applix\TM1\Tm1p.ini
      For example: C:\Documents and Settings\user name\Application\Data\Applix\TM1\Tm1p.ini

4. Back up Cognos TM1 Web configuration and custom files to a secure location. The default location of Cognos TM1 Web 9.x was C:\inetpub\wwwroot\TM1Web
   a. Back up a copy of the web.config file.
      Tip: You might want to use some of the settings in this file when you configure your new installation of Cognos TM1 Web.
   b. Backup any custom web server pages you might have created.

5. Back up your Cognos TM1 Contributor 9.5.x applications folder and \pmpsvc_config.xml configuration file to a safe location.
   a. Back up the folder \webapps\pmpsvc\WEB-INF\applications.
   b. Backup your configuration file \webapps\pmpsvc\WEB-INF\configuration\pmpsvc_config.xml.

      If you deployed with your own installation of Apache Tomcat, check here: Program Files\Apache Software Foundation\Tomcat 6.0.
      If you deployed with the Apache Tomcat provided with IBM Cognos Business Intelligence (BI), check here: Program Files\cognos\c8.

What to do next

Remove the previous version of the product. For more information, see “Uninstalling a previous version of IBM Cognos TM1 9.x.”

Uninstalling a previous version of IBM Cognos TM1 9.x

All components of a previous version of IBM Cognos TM1 must be removed and uninstalled.

Before you begin

Make sure that you have backed up all of your data and configuration files. For more information, see “Backing up data for a previous version of Cognos TM1 9.x” on page 52.
**About this task**

Perform these steps on every computer that is to be upgraded.

**Procedure**

1. To uninstall an earlier version of Cognos TM1 Server, Cognos TM1 Architect, Cognos TM1 Perspectives, and Cognos TM1 Web:
   a. From the Windows Control Panel, click **Add or Remove Programs**.
   b. In the list of currently installed programs, select **IBM Cognos TM1**.
   c. Click **Remove** and follow the instructions to complete the process.

2. To uninstall Cognos TM1 Contributor:
   - Undeploy Cognos TM1 Contributor from the web application server you are using.
   - Uninstall the Cognos TM1 Contributor 9.5.x Administration tool and IBM Cognos Rich Client Framework.

   For details, see "Upgrading Cognos TM1 Contributor to Cognos TM1 Applications" on page 55.

**What to do next**

Install the new version of the product.

**Upgrading a single computer installation of Cognos TM1**

This topic describes how to upgrade IBM Cognos TM1 on a single computer running on Microsoft Windows operating system.

After removing the previous version of the product, you are ready to install.

When that is done, complete the upgrade by restoring your data, configuration settings, and applications.

**Related concepts:**

- Chapter 7, "Cognos TM1 single-computer installation," on page 73

This type of installation puts IBM Cognos TM1 on a single computer running the Microsoft Windows operating system and using default settings. Use this kind of installation to get up and running quickly with Cognos TM1 or to install a test or evaluation environment.

**Upgrading Cognos TM1 Server on UNIX or Linux**

You can upgrade the Cognos TM1 server components on a 64-bit computer running either a UNIX or Linux operating system.

After removing the previous version of the product, you are ready to install.

When that is done, complete the upgrade by restoring your data, configuration settings, and applications.

**Related concepts:**

- "Installing Cognos TM1 Server on UNIX or Linux" on page 86

You can install the Cognos TM1 server components on a 64-bit computer running either a UNIX or Linux operating system. Use this type of installation to install and run the Cognos TM1 server on a dedicated computer that remote users can access.
Upgrading Cognos TM1 Server on Windows

You can upgrade the Cognos TM1 server components on either 32-bit or 64-bit computers running the Microsoft Windows operating system.

After removing the previous version of the product, you are ready to install.

When that is done, complete the upgrade by restoring your data, configuration settings, and applications.

Related concepts:
“Installing Cognos TM1 Server on Windows” on page 83
You can install the Cognos TM1 server components on either 32-bit or 64-bit computers running the Microsoft Windows operating system. Use this type of installation to install and run the Cognos TM1 server on a dedicated computer that remote users can access.

Upgrading Cognos TM1 Architect and Perspectives clients

You can upgrade IBM Cognos TM1 client components using the Cognos TM1 server installation program or the Cognos TM1 client installation program.

After removing the previous version of the product, you are ready to install.

When that is done, complete the upgrade by restoring your data, configuration settings, and applications.

Related concepts:
Chapter 12, “Cognos TM1 client and developer tier installation,” on page 155
You can install IBM Cognos TM1 client and developer tier components using the Cognos TM1 server installation program or the Cognos TM1 client installation program.

Upgrading Cognos TM1 Web

If you have IBM Cognos TM1 Web on a computer that is separate from the computer where you installed the Cognos TM1 server then do these steps to upgrade the web server.

After removing the previous version of the product, you are ready to install.

When that is done, complete the upgrade by restoring your data, configuration settings, and applications.

Related concepts:
Chapter 10, “Cognos TM1 Web installation,” on page 109
You can install IBM Cognos TM1 Web on a computer that is separate from the computer where you installed the Cognos TM1 server and other Cognos TM1 components.

Upgrading Cognos TM1 Contributor to Cognos TM1 Applications

Upgrading Cognos TM1 Contributor to Cognos TM1 Applications requires a series of steps. These steps include a process to move your old application files into Cognos TM1 Applications.
Before you begin

Review the following considerations before you upgrade your application files from Cognos TM1 Contributor to Cognos TM1 Applications.

Attention: You might need to edit your old applications to make them compatible with the newer version.
- Dynamic Subsets cannot be used as the approval hierarchy in Cognos TM1 Applications.
- Applications cannot share the same approval cubes in Cognos TM1 Applications.

If an application cannot be upgraded, a message is displayed during the upgrade process and the application is moved to an undeployed state. Undeployed applications do not appear in the Cognos TM1 Applications portal, but instead, appear in the Cognos TM1 Performance Modeler application design tab. You can use Cognos TM1 Performance Modeler to edit and fix the application and then validate and deploy it.

Procedure

1. Stop related services.
   See “Stopping Cognos TM1 9.x services before upgrading” on page 52.

2. Back up your Cognos TM1 Contributor 9.5.x applications folder and pmpsvc_config.xml configuration file to a safe location.
   a. Back up the folder \webapps\pmpsvc\WEB-INF\applications.
   b. Back up your configuration file \webapps\pmpsvc\WEB-INF\configuration\pmpsvc_config.xml.

   If you deployed with your own installation of Apache Tomcat, check here: Program Files\Apache Software Foundation\Tomcat 6.0.
   If you deployed with the Apache Tomcat provided with IBM Cognos Business Intelligence (BI), check here: Program Files\cognos\c8.

3. Uninstall IBM Cognos TM1 9.5.x.
   See “Uninstalling a previous version of IBM Cognos TM1 9.x” on page 53.

4. Uninstall the Cognos TM1 Contributor 9.5.x Administration tool and IBM Cognos Rich Client Framework:
   Tip: You will need to repeat these steps for each computer where the Cognos TM1 Contributor 9.5.x Administration tool was installed.
   a. In Microsoft Windows, open Add or Remove Programs.
      Attention: Depending on how the Administration tool was installed, you might only see one entry.
   b. If the entry exists, first remove IBM Cognos TM1 Contributor Administration.
   c. Remove the IBM Cognos Rich Client Framework.

5. Undeploy the Cognos TM1 Contributor pmpsvc web application:
   • If you deployed with your own installation of Apache Tomcat or IBM Websphere, use the respective management tool to undeploy the pmpsvc web application.
   • If you deployed with IBM Cognos BI, the program files are located in the following locations:
     - C:\Program Files\cognos\c8\webapps\pmpsvc
6. Install Cognos TM1 Applications.
   For details, see Chapter 11, “Cognos TM1 Application Server installation,” on page 131.

7. Restore your data files for each Cognos TM1 server you plan to use with Cognos TM1 Applications.
   For details, see “Restoring data and configuration files from Cognos TM1 version 9.x into the current version” on page 58.

8. Edit the tm1s.cfg configuration file for each Cognos TM1 server that you want to use with Cognos TM1 Applications:
   a. Configure the ExcelWebPublishEnabled parameter.
      
      **Important:** Earlier versions of Cognos TM1 Contributor always considered this parameter was set to True and did not use the actual setting in the Cognos TM1 server tm1s.cfg file. As of Cognos TM1 10.1, Cognos TM1 Applications uses this parameter, requiring you to explicitly configure the parameter in the tm1s.cfg file.
      
      For more details, see “ExcelWebPublishEnabled” on page 272.
   b. Configure the AllowSeparateNandCRules and DistributedPlanningOutputDir parameters.
      
      For more details, see “Configuring a Cognos TM1 Server to work with Cognos TM1 Application Web” on page 138.

9. If you want to use any of your old configuration settings, manually copy them from your old file into the new configuration files for Cognos TM1 Applications.
   
   **Attention:** In Cognos TM1 Applications, the contents of the previous pmpsvc_config.xml configuration file has been reorganized into two separate files; pmpsvc_config.xml and fpmsvc_config.xml.
   
   a. Copy client settings from the old pmpsvc_config.xml file into the new pmpsvc_config.xml file.
   b. Copy server related settings from the old pmpsvc_config.xml file into the new fpmsvc_config.xml file.

10. Copy your previous Cognos TM1 Contributor 9.5.x applications folder into the new location for Cognos TM1 Applications:
    
    For example, C:\Program Files\IBM\cognos\tm1\webapps\pmpsvc\WEB-INF\applications

11. Start the related Cognos TM1 services using IBM Cognos Configuration.
    
    a. TM1 Admin Server
    b. TM1 Application Server
    c. Start any Cognos TM1 servers you are using with Cognos TM1 Applications.

12. Log in to the Cognos TM1 Applications portal as an administrator to upgrade your applications.
    
    During the login process, the application files in the webapps/pmpsvc/WEB-INF/application folder will be upgraded from Cognos TM1 Contributor 9.5.2 to Cognos TM1 Applications.
Note: The upgrade process may take some time depending on the amount of rights that need to be applied in the application. For more information, see “Saving security rights when importing or restoring a Cognos TM1 Application” on page 60.

13. If you are prompted about dynamic subsets during the upgrade process, edit the application to make it compatible.
   a. Open Cognos TM1 Performance Modeler.
   b. Change the subset from dynamic to static or select a new static subset to use.
   c. Redeploy the application and review the security for the application. Some security may have changed requiring you to recreate the security assignments using the Manage Rights options.
      For details, see the IBM Cognos TM1 Performance Modeler User Guide.

14. If you are prompted about shared views during the upgrade process, edit the application to make it compatible.
   a. Open Cognos TM1 Performance Modeler.
   b. To fix the issue, you will need to reorganize the TM1 data so that approval cubes are not shared by applications.
   c. Save and deploy the application.
      For details, see the IBM Cognos TM1 Performance Modeler User Guide.

**Restoring data and configuration files from Cognos TM1 version 9.x into the current version**

After installing the newer version of IBM Cognos TM1, complete these steps to restore your previous Cognos TM1 9.x configuration and database files.

**Before you begin**

Install the new version of the product.

**Procedure**

1. **Restore your Cognos TM1 Admin Server configuration files:**
   **Attention:** As of IBM Cognos TM1 version 10.1.0, the TM1 Admin Server configuration file, Tm1adsrv.ini, is no longer used or supported by Cognos TM1. The configuration settings for the Cognos TM1 Admin Server are now exclusively configured and stored in the IBM Cognos Configuration tool. You must use Cognos Configuration to configure the Cognos TM1 Admin Server.
   a. Open IBM Cognos Configuration.
   b. In the Cognos Configuration Explorer pane, expand Local Configuration > Environment and click TM1 Admin Server. The parameters for the Admin Server display in the Properties pane.
   c. Open the old Tm1adsrv.ini file.
   d. For each parameter you want to use with your new installation, copy the value of the parameter from the Tm1adsrv.ini file into the matching parameters in Cognos Configuration. For example, if you were using custom SSL settings with your previous installation, copy the values for these parameters into Cognos Configuration.
   e. In Cognos Configuration, click File > Save.

2. **Restore your Cognos TM1 Server data and configuration files:**
Tip: As of IBM Cognos TM1 version 10.1.0, you can use Cognos Configuration to start, stop, and manage your CognosTM1 servers.

a. For each Cognos TM1 server that you want to restore, copy its data directory and subdirectories to the new location for data:
   `<TM1_Install>\samples\tm1`.

b. Add each CognosTM1 server in Cognos Configuration where you can start, stop, and manage the server. For details, see “Adding an existing Cognos TM1 server in Cognos Configuration” on page 95.

3. Restore your Cognos TM1 Architect and Cognos TM1 Perspectives configuration files:

   If you want to restore any settings from your previous installation of Cognos TM1 Architect or Cognos TM1 Perspectives, copy the values from your old Tm1p.ini file into the new Tm1p.ini file.

   **Attention:** If you leave your old Tm1p.ini files in place, you might need to update the directory path in the file for the `AdminSvrSSLCertAuthority` parameter. For example, if you are using the default Cognos TM1 SSL certificate, manually change the value for this parameter to the new install path `C:\Program Files\IBM\cognos\tm1\bin\ssl\applixca.pem`.

   a. Update the new system default Tm1p.ini file located here:
      ```
      %ALLUSERSPROFILE%\Application Data\Applix\TM1\Tm1p.ini
      ```
      For example: `C:\Documents and Settings\All Users\Application Data\Applix\TM1\Tm1p.ini`

   b. Update the new user-specific Tm1p.ini file located here:
      ```
      %APPDATA%\Applix\TM1\Tm1p.ini
      ```
      For example: `C:\Documents and Settings\user name\ApplicationData\Applix\TM1\Tm1p.ini`

4. Restore your Cognos TM1 Web files:

   If you are using the new version of Cognos TM1 Web, you can restore some of the configuration settings that you want to use.

   Open your old Web.config file and selectively merge the lines and parameters that you want to use into the new tm1web_config.xml file located in `<TM1_install>\webapps\tm1web\web-inf\configuration`.

   **Note:** Cognos TM1 Web version 10.2.0 uses a new configuration file named tm1web_config.xml. This file replaces the web.config file from previous Cognos TM1 Web versions. For more information, see “Modifying Cognos TM1 Web Configuration Parameters” on page 114.

5. Restore your application and configuration files in Cognos TM1 Applications:

   To restore application and configuration files from Cognos TM1 Contributor 9.5.x into the current version of Cognos TM1 Applications, see “Upgrading Cognos TM1 Contributor to Cognos TM1 Applications” on page 55.

---

**Microsoft Excel .xls worksheets**

IBM Cognos TM1 Web versions 10.2.0 and later use the Open XML file formats for Microsoft Excel worksheets created using Excel 2007 or later.

If you are using existing Microsoft Excel files in the older .xls format, use the Cognos TM1 conversion tool to convert the files. If your original file contained macros, the Cognos TM1 conversion tool converts the original file into a macro-enabled .xlsm file, otherwise it is converted into a standard .xlsx file.
The Convert Excel files to OpenXML Excel format option in Cognos TM1 Architect Server Explorer converts a single .xls worksheet or all worksheets in a folder. Only administrative users have this option available. The conversion renames the files to preserve as many links as possible after the conversion. Some links and action buttons need to be updated depending on permissions that may have changed as a result of the move to cell-based security that occurred in version 10.2.0.

In some cases, the Named Ranges from the original file could be renamed in the converted file during the conversion process.

By default a backup of the pre-converted worksheets is saved. By default a log file is also generated.

### Saving security rights when importing or restoring a Cognos TM1 Application

In IBM Cognos TM1 Applications 10.2, the operation to save security rights in a Cognos TM1 Application for the very first time may be significantly slower than in previous releases. You may experience this delay when performing an upgrade and either manually restoring application files or importing an application and the related security rights.

This is a known effect of a new security design for TM1 Applications that provides greater application design flexibility. Specifically, the ability to share an Approval Hierarchy dimension across more than one application has been added to Cognos TM1 Applications 10.2. Cognos TM1 Applications now also allows you to deploy multiple applications, independently secured, for different cycles of your business process. For example, to operate a Budgeting application and a Forecasting application at the same time, based on the same underlying cube, permitting real-time Budget versus Forecast variances.

It is important to note that the significant performance delay is only seen the very first time that rights are saved for an application. The rights-saving operation is also performed when manually restoring application files or when an application is imported in the Cognos TM1 Applications portal and you select the option to include security rights during the import process.

On subsequent saving of the rights, a differential analysis is performed to ensure that the time taken to process the rights is a function of the degree of change being made. For example, a small change to the rights will be processed quickly. This is the key factor in the day-to-day operation of a TM1 Application, where you are likely to routinely update rights to reflect incremental changes to your business. Large-scale changes are unusual after an application is in production, so you will see routine changes to the rights processed quickly.

**Note:** You previously had to change these rights manually from the Cognos TM1 Performance Modeler or Cognos TM1 Applications portal user interface. However, the Cognos TM1 10.2 release gives you the ability to automate these changes from the command line for the first time.
Chapter 6. Cognos TM1 integration with other IBM Cognos software

There are a number of different ways that you can integrate IBM Cognos TM1 with IBM Cognos Business Intelligence (BI) and other IBM Cognos applications. This topic summarizes some of the most typical integration approaches and includes links to the related documentation.

The main options for integrating Cognos TM1 with Cognos software include authentication security, data reporting, and data/object interaction. Configuring integration between Cognos TM1 and Cognos BI involves a combination of installation and configuration tasks on the computers hosting the server and web server components. In some cases, installation and configuration is required on individual end-user computers.

**TM1 integration points with IBM Cognos software**

- **Authentication security**
  - IBM Cognos Business Intelligence

- **Import data into TM1 from Cognos BI**
  - IBM Cognos TM1 Package Connector

- **Use TM1 as a datasource**
  - IBM Cognos Business Intelligence
  - IBM Cognos Analysis for Microsoft Excel

- **Display and interact with TM1 data objects**
  - IBM Cognos Insight
  - IBM Cognos Workspace
  - IBM Cognos TM1 Mobile Contributor

**Figure 5. Overview of Cognos TM1 integration with other IBM Cognos applications**

**Authentication Security**

You can configure the Cognos TM1 server to authenticate users using Cognos BI security. With this configuration, any Cognos TM1 user interface or other custom application must use a valid user name and password from the Cognos BI server to access Cognos TM1 data.

**Importing Cognos BI data into Cognos TM1**
The IBM Cognos TM1 Package Connector is currently supported for use with IBM Cognos Business Intelligence packages against SAP Business Warehouse and other relational and ODBC data sources. You can use the Cognos TM1 Package Connector to import data from these sources into Cognos TM1 using a Cognos TM1 TurboIntegrator process.

Using Cognos TM1 as a datasource with Cognos software

You can configure IBM Cognos BI to access Cognos TM1 servers and cubes from Cognos BI applications such as Cognos Report Studio and Cognos Query Studio.

You can also access TM1 data inside of IBM Cognos Analysis for Microsoft Excel.

Displaying and interacting with Cognos TM1 data objects

You can access, view, and interact with the following Cognos TM1 data objects in IBM Cognos Workspace and IBM Cognos Insight:

- TM1 cube views and charts
- TM1 Websheets
- TM1 Scorecarding cubes and diagrams

Cognos TM1 and Cognos BI security

You can configure the Cognos TM1 server to authenticate users using Cognos BI security. With this configuration, any Cognos TM1 user interface or other custom application must use a valid user name and password from the Cognos BI server to access Cognos TM1 data. You can also configure IBM Cognos TM1 Applications to use Cognos BI security.

For details, see the following topics:

- “Using Cognos security with Cognos TM1” on page 205
- “Using Cognos TM1 Applications with Cognos security” on page 214

Using the Cognos TM1 Package Connector to import Cognos BI data into Cognos TM1

The IBM Cognos TM1 Package Connector is currently supported for use with IBM Cognos Business Intelligence (BI) packages against SAP Business Warehouse and other relational and ODBC data sources. You can use the Cognos TM1 Package Connector to import data from these sources into Cognos TM1 using a Cognos TM1 TurboIntegrator process.

The IBM Cognos TM1 Package Connector is an optional component, separate from the main TM1 installation, available as its own CD or download. This component must be installed on both the TM1 server and the administrative client machines where TurboIntegrator processes are being created against a BW package.

For more details, see the following documentation:

- See “Cognos TM1 Package Connector installation” on page 63 for installation instructions.
- See the “Importing Data Using the IBM Cognos TM1 Package Connector” chapter in the IBM Cognos TM1 TurboIntegrator Guide for more information about using the TM1 Package Connector.

See Cognos TM1 Software Environments (http://www.ibm.com/support/docview.wss?uid=swg27040698) for specifics on supported software.

See the IBM Cognos Framework Manager User Guide about creating packages.

See your SAP documentation for SAP related topics.

Cognos TM1 Package Connector installation

IBM Cognos TM1 supports connectivity to IBM Cognos Business Intelligence (BI) packages against certain data sources.

The Cognos TM1 Package Connector is an optional 32-bit component available as a separate CD or download from the main Cognos TM1 installation. This component should be installed into its own directory.

For information about the supported data sources, see Cognos TM1 Software Environments (http://www.ibm.com/support/docview.wss?uid=swg27040698).

For information about using the Cognos TM1 Package Connector, see the “Importing Data Using the IBM Cognos TM1 Package Connector” chapter in the IBM Cognos TM1 TurboIntegrator Guide.

Cognos TM1 Package Connector requirements

Refer to the IBM Cognos Business Intelligence and IBM Cognos TM1 Information Centers for more details on the supported platforms, versions, and requirements.

The Cognos TM1 Package Connector requires the following components:

- Cognos TM1 9.5.1 or later.
  The Cognos TM1 Package Connector must be installed on both the Cognos TM1 server and the administrative client machines where TurboIntegrator processes are being created for any datasource you are using.
  For information, see Cognos TM1 Software Environments (http://www.ibm.com/support/docview.wss?uid=swg27040698).
- IBM Cognos Business Intelligence Server.
  For information about the specific supported versions, see Cognos Business Intelligence (http://www.ibm.com/support/knowledgecenter/SSEP7J/wel com e).
- IBM Cognos Framework Manager for package creation.
- If your datasource is SAP, then SAP Business Warehouse is required. See the Information Center for specific versions supported.
- 32-bit database client software is required on all platforms where the Cognos TM1 Package Connector is installed for the specific data source being used. For SAP BW, this requires the SAP GUI or the SAP RFCSDK library files and DLLs. See “Enabling connectivity to SAP from Cognos TM1” on page 64.

Installing the Cognos TM1 Package Connector

Follow these steps to install the IBM Cognos TM1 Package Connector:

Procedure

1. Insert the Cognos TM1 Package Connector disc into the Cognos TM1 server machine.
2. Run `issetup.exe` found in the system folder for your operating system, for example win32.
   This launches the Cognos Installer.
3. Complete the installation prompts as appropriate for your installation.
   Install the Cognos TM1 Package Connector into its own directory. Do not install it into an existing Cognos BI folder.
4. On the Finish screen, select the **Start IBM Cognos Configuration** check box to launch the configuration window automatically. If you prefer, you can leave this box unchecked and launch the Cognos Configuration manually after you have installed.

**Installing the Cognos TM1 Package Connector on Windows 7 or Vista:**

By default, the temp directory for the IBM Cognos TM1 Package Connector in Cognos Configuration is in the Program Files location.

Microsoft Vista or Windows 7 applications are not allowed to write in the Program Files location. This can result in an error when choosing the Cognos TM1 Package Connector from Cognos TM1 Perspectives on Windows 7 and Vista.

To avoid this problem, choose **Run as Administrator** when running Microsoft Excel. Or, in the Cognos Configuration for Cognos TM1 Package Connector you can change the **Temporary files location** setting to a directory that is writable by the user.

**Enabling connectivity to SAP from Cognos TM1**

To enable connectivity to the SAP server requires the 32-bit SAP RFCSDK library files and DLLs on both the IBM Cognos TM1 Admin Client and the IBM Cognos TM1 server.

To obtain these files on Microsoft Windows, install the SAP GUI. For UNIX see “Installing the Cognos TM1 Package Connector on UNIX” on page 66.

**Configuring the Cognos TM1 Package Connector**

Once you have installed the IBM Cognos Business Intelligence (BI) TM1 Package Connector, you have access to the IBM Configuration tool.

If the Cognos Configuration tool did not launch automatically, you can use the **Start Menu > IBM Cognos > IBM Cognos Configuration** option to launch it.

**Procedure**

1. Launch or open Cognos Configuration.
2. Select the **Environment** node on the Local Configuration Explorer window. The current settings for URI display.
3. Set the **Gateway URI** to point to the Cognos BI server where packages are deployed.
   The Gateway URI is in the form of `http[s]://<host IP address>:<port>/<BI_SERVER_virtual_dir>/cgi-bin/cognos.cgi`. See the IBM Cognos TM1 Operation Guide or the Cognos BI documentation for more information on URIs.
4. Enter the URI in the Value column of the **Other URI settings** node.
   The Dispatch URI is in the form of `http[s]://<host IP address>:<port>/p2pd/servlet/dispatch`. 
5. Once the URI is set, **Save** the configuration.
   
   The configuration progress window checks the status of your entries. When it is complete, click **Close**. If you encountered an error, check your settings and re-enter the values.

6. Close the Cognos Configuration window.

**Setting the environment variable:**

On Microsoft Windows, after you have installed the IBM Cognos TM1 Package Connector, the `TM1_PACKAGE_CONNECTOR` system environment variable is set to the installation directory specified in the installation, for example `C:\Program Files\ibm\Cognos\c10\bin`.

You can change this location if necessary by editing the variable or creating a system environment variable.

The system variable is created by the most recent installation of the Cognos TM1 Package Connector.

The default Microsoft Windows installation location for Cognos TM1 Package Connector10 is `C:\program Files\ibm\cognos\c10`.

**Setting the Cognos TM1 server configuration parameter (optional):**

For the IBM Cognos TM1 TurboIntegrator process to run on the Cognos TM1 server, add the `CognosTM1InterfacePath` parameter to the TM1 server configuration file (`tm1s.cfg`) for the Cognos TM1 server where your data will reside after the import from the Cognos Business Intelligence (BI) package.

**Attention:** The following information applies only when using a Microsoft Windows operating system.

The value of `CognosTM1InterfacePath` tells the Cognos TM1 Server where to find the Cognos TM1 Package Connector. This is not needed if the `TM1_PACKAGE_CONNECTOR` environment variable is defined. If this parameter is defined, it overrides the `TM1_PACKAGE_CONNECTOR` environment variable.

Enter the Cognos TM1 Package Connector location into the Cognos TM1 server `tm1s.cfg` file where the Cognos TM1 Package Connector is installed, for example: `CognosTM1InterfacePath=C:\Program Files\ibm\cognos\c10\bin`

**Remember:**

`CognosTM1InterfacePath` variable is required only when using the Cognos TM1 Package Connector on UNIX (AIX®, Solaris, Linux).

The `TM1_Package_CONNECTOR` is a system environmental variable that identifies the Cognos TM1 Package Connector installation location on a Windows operating system.

`cognosTM1InterfacePath` is used in the Cognos TM1 server's `tm1s.cfg` on UNIX, however if it is added to a TM1 server's `tm1s.cfg` file on Windows, it can overwrite the value set in `TM1_Package_Connector`. 
Cognos TM1 Package Connector on the client computer:

After you have installed and configured the IBM Cognos TM1 Package Connector on the Cognos TM1 server, install and configure another copy on the admin client computer. Use the same settings for both installations.

**Running the TM1 Package Connector**

See "Importing Data Using the IBM Cognos TM1 Package Connector" chapter of the *IBM Cognos TM1 TurboIntegrator Guide* for details on how to run the Cognos TM1 Package Connector.

**Installing the Cognos TM1 Package Connector on UNIX**

To install the IBM Cognos TM1 Package Connector on UNIX follow the same instructions as for the Microsoft Windows installation making the following adjustments:

**Procedure**

2. Set the environment variable `JAVA_HOME=<java_location>` where `<java_location>` is the 32-bit Java installation location.
3. Copy the files at `<Package_Connector_install_location>/bin/jre/6.0/lib/ext` to `JAVA_HOME/jre/lib/ext`.
4. Start cogconfig.sh from the `<Package_Connector_install_location>/bin`.
5. Place the 32-bit SAP RFCSDK library files and DLLs on the UNIX machine.
6. Set a locale that uses the UTF-8 code page to handle Unicode data. This is optional.
7. Configure the Cognos TM1 server by adding the parameter to the `tm1s.cfg` file:
   
   ```
   CognosTM1InterfacePath=/<Package_Connector_install_location>/bin
   ```
8. Configure your environment to use the SAP DLLs and the Cognos TM1 Package Connector:
   a. Include RFCSDK's lib directory in the search path of; `$LD_LIBRARY_PATH` or `$LIBPATH`
   b. Export (make public) these variables: `$LIBPATH` and `$LD_LIBRARY_PATH`
      • Where the libraries are found is different on various UNIX platforms:
      - Solaris and Linux: LD_LIBRARY_PATH
      - HPUX: SHLIB_PATH
      - AIX: LIBPATH

---

**Cognos TM1 as a datasource with Cognos BI**

You can configure IBM Cognos Business Intelligence (BI) to access Cognos TM1 servers and cubes from Cognos Report Studio and Cognos Query Studio.

To enable Cognos BI reporting against Cognos TM1 data sources, install the required Cognos TM1 API files on all Cognos BI servers that are running query and report services on Microsoft Windows. See “Enabling Cognos BI reporting on Cognos TM1 data sources” on page 67.

For more details about Cognos BI, see the following resources:

- [IBM Cognos Business Intelligence 10.2.1 Information Center](http://pic.dhe.ibm.com/infocenter/cbi/v10r2m1/index.jsp).
Enabling Cognos BI reporting on Cognos TM1 data sources

To enable Cognos Business Intelligence (BI) reporting against Cognos TM1 data sources, use the Cognos TM1 Client installation program to install the required Cognos TM1 API files on all Cognos BI servers that are running query and report services on Microsoft Windows.

About this task

These steps apply to new installations of Cognos TM1 10.2.x and existing Cognos TM1 10.2.x installations that subsequently set up Cognos BI on systems running Microsoft Windows.

Procedure

1. Run the IBM Cognos TM1 Client installation program:
   - On Microsoft Windows Vista, Windows 7, or Windows Server 2008 operating system software, right-click the issetup.exe file and click Run as Administrator.
   - For other Windows operating systems, double-click the issetup.exe file.
2. On the Installation Location page, select an adjacent directory on the Cognos BI server that is running query or report services on Microsoft Windows.
3. On the Component Selection page, expand TM1 Client Tier, and select the following option:
   - TM1 APIs
   - Leave all the other check boxes unselected.
4. Follow the prompts and click Finish to complete the installation.

Cognos TM1 iWidgets and Cognos Workspace

You can display IBM Cognos TM1 Web data objects, such as cube views, charts, and Websheets, in IBM Cognos Workspace.

After successfully installing and running Cognos TM1 Web, you configure and work with Cognos TM1 iWidgets in your IBM Cognos Business Intelligence and Cognos Workspace environment.

Configuring Cognos Workspace to use Cognos TM1 iWidgets

To use IBM Cognos TM1 data in IBM Cognos Workspace, you must modify the following configuration files in your IBM Cognos BI installation.

- tm1_contribution.atom
- tm1_en.properties

For more information, see the topic [Configuring IBM Cognos Workspace to use IBM Cognos TM1 data](http://pic.dhe.ibm.com/infocenter/cbi/v10r2m1/topic/com.ibm.swg.ba.cognos.inst_cr_winux.10.2.1.doc/c_conf4tm1.html) in the IBM Cognos Business Intelligence Installation and Configuration Guide 10.2.1 on the IBM Cognos Business Intelligence 10.2.1 Information Center [http://pic.dhe.ibm.com/infocenter/cbi/v10r2m1/index.jsp].
Working with Cognos TM1 data in Cognos Workspace

You can access data objects developed in Cognos TM1 from within Cognos Workspace in real time. In Cognos Workspace, you can navigate TM1 content in the Content tab and add TM1 reports to the workspace under the following conditions:

- Cognos TM1 is installed and configured as part of your IBM Cognos Business Intelligence environment. If you change the BI environment to use SSL, you must also change TM1 Web to use SSL.
- You have the permissions and capabilities to view and interact with Cognos TM1 content

For more information about using TM1 data in Cognos Workspace, see the following topics in the IBM Cognos Workspace User Guide 10.2.0 on the IBM Cognos Business Intelligence 10.2.1 Information Center (http://pic.dhe.ibm.com/infocenter/cbi/v10r2m1/index.jsp):

- [Cognos TM1 content](http://pic.dhe.ibm.com/infocenter/cbi/v10r2m1/topic/com.ibm.swg.ba.cognos.ug_buxc.10.2.1.doc/c_ug_buxc_tm1_content.html)
- [Adding Cognos TM1 content to Cognos Workspace](http://pic.dhe.ibm.com/infocenter/cbi/v10r2m1/topic/com.ibm.swg.ba.cognos.ug_buxc.10.2.1.doc/c_ug_buxc_tm1_content_adding.html)

Cognos TM1 and Cognos Analysis for Microsoft Excel

Use IBM Cognos Analysis for Microsoft Excel with IBM Cognos TM1 data sources to enter and write back values to TM1 cubes. You can also create a command button in Cognos Analysis for Microsoft Excel to replicate the action button functionality from IBM Cognos TM1 Perspectives.

IBM Cognos Analysis for Microsoft Excel enables Microsoft Excel users to directly access centrally controlled and secured IBM Cognos information for improved decision-making. Cognos Analysis for Microsoft Excel is a Microsoft Excel-based tool that professional report authors use to build sophisticated, multiple-sheet, multiple-query reports against multiple databases. With IBM Cognos Analysis for Microsoft Excel, you can use IBM Cognos data inside Excel to explore and analyze data and create reports, such as invoices, statements, and weekly sales and inventory reports.

For more information, see the IBM Cognos Analysis for Microsoft Excel, Version 10.2.2, User Guide.

Using Cognos TM1 data in Cognos Analysis for Microsoft Excel

You can use Cognos TM1 data with Cognos Analysis for Microsoft Excel in the following ways.

Use flex views for complex IBM Cognos TM1 reports

When you work with a Cognos TM1 data source, you can use flex views to combine data from multiple crosstabs, or multiple crosstab cubes, on a worksheet and then enhance the data using Microsoft Excel formulas, formats, and cell references.

Make contributions to a plan on an IBM Cognos TM1 server
You can use IBM Cognos Analysis for Microsoft Excel to create an exploration to review, analyze, and update the portion of the enterprise-wide plan that was assigned to you.

**Run IBM Cognos TM1 TurboIntegrator functions**

In Cognos Analysis for Microsoft Excel, you can create a command button to replicate the action button functionality from IBM Cognos TM1 Perspectives. The command button can run a Cognos TM1 TurboIntegrator process or other custom process.

**Connecting Cognos Analysis for Microsoft Excel to Cognos TM1 data**

Use the Options icon in the toolbar of Cognos Analysis for Microsoft Excel to configure a connection to a Cognos TM1 server.

Configure the connection with a URL in the following format:

```
http://server_name:port_number
```

where `server_name` is either the IP address of the computer or the computer name and `port_number` is the port where the Cognos TM1 Application Server is running. The default port number for Cognos TM1 is 9510.

For example:

```
http://mysystem:9510
```

For more information, see the following topics in the *IBM Cognos Analysis for Microsoft Excel, Version 10.2.2, User Guide*:

- “Configure connections to IBM Cognos systems”
- “Set up user authentication”
- “Logging on to an IBM Cognos server”

**Configuring Cognos TM1 for Cognos Analysis for Excel single sign-on**

Allowing single sign on (SSO) that is configured for the IBM Cognos Business Intelligence authentication to work through IBM Cognos Analysis for Microsoft Excel when accessing a Cognos BI secured IBM Cognos TM1 server requires some additional configuration steps to be applied to the Cognos TM1 installation.

**About this task**

Similar to the steps required to allow access to BI secured TM1 servers for TM1 Web, Cognos Analysis for Excel access requires some files to be dropped into the IBM Cognos BI Gateway install and some configuration settings to be implemented as well.

Cognos Analysis for Excel requires an instance of Cognos BI Gateway for a dedicated entry point. This Cognos BI Gateway instance must be enabled according to the steps described in ["Using Cognos TM1 Applications with Cognos security" on page 214](#). In particular, this ensures that the Gateway installation will be supplemented by the three files that are required (pmhub.html, planning.html, and variables_plan.xml).
**Note:** The required files are included in the `bi_interop.zip` file that is located in the directory `<TM1 installation location>\bi_interop`.

**Procedure**

1. On the Cognos BI Gateway installation that is selected for the Cognos Analysis for Excel entry point, navigate to `Cognos_root\templates\ps\portal\` where `Cognos_root` is the directory that Cognos BI has been installed to.
2. Open the file `variables_plan.xml`.
3. Verify that the `<url>../pmhub.html</url>` tag exists below `<url>../planning.html</url>`. The following text is an example of the `variables_plan.xml` file:

```xml
<?xml version="1.0" encoding="UTF-8"?>
<CRNenv>
  <urls>
    <url>../planning.html</url>
    <url>../pmhub.html</url>
  </urls>
  <cookies>
    <param name="cam_passport"/>
    <param name="CRN"/>
  </cookies>
</CRNenv>
```
5. Navigate to `Cognos_root\webcontent` where `Cognos_root` is the directory that Cognos BI has been installed to.
6. Open `pmhub.html` to edit it.
7. Add the PMHub service locations. This enables SSO to operate.
8. Make sure that the user account that is running the web server has permission to access `pmhub.html`. If you cannot access the `pmhub.html` in a web browser, check the `pmhub.html` file properties.
9. Edit the PMHub configuration screen.
   a. In a web browser, enter `http://servername:port number/pmhub/pm/admin` to open the configuration screen. For example: `http://localhost:9510/pmhub/pm/admin`
   b. Expand the node for `configurations` > `com.ibm.ba.pm.resource.security.dictionary` and enter values for the following properties:
      - CAMBIURL
      - CAMGatewayURL

---

**Cognos TM1 Applications integration with Cognos BI and the Cognos Connection portal**

If your TM1 installation uses Cognos security for authentication, your Cognos BI users can use the Cognos Connection portal to open TM1 applications instead of the TM1 Applications portal. However, administrators still need to use TM1 Applications to configure and manage applications.

When you configure TM1 Applications to use Cognos security, you also enable the Cognos Connection portal to display a folder that contains links to the available TM1 applications. The exact list of displayed applications depends on the rights of the current user.
The planning.html file provides the information for Cognos BI and the Cognos Connection portal to display links to TM1 Applications. For more information, see "Using Cognos TM1 Applications with Cognos security" on page 214.

Note: You must have the TM1_PATH environment variable specified before connecting to Cognos TM1 under a UNIX environment.
Chapter 7. Cognos TM1 single-computer installation

This type of installation puts IBM Cognos TM1 on a single computer running the Microsoft Windows operating system and using default settings. Use this kind of installation to get up and running quickly with Cognos TM1 or to install a test or evaluation environment.

To configure and install the full features and optional components of Cognos TM1, see the comprehensive installation guide found at Cognos TM1 Welcome page (http://www.ibm.com/support/knowledgecenter/SS9RXT/welcome). Select the version of TM1 you are using, then select the Install > TM1 Installation and Configuration Guide.

The single computer installation explains how to install and run:
• Cognos TM1 Admin Server
• Cognos TM1 Server
• Cognos TM1 Perspectives
• Cognos TM1 Architect
• Cognos TM1 Web
• Cognos TM1 Application Server
• Cognos TM1 Application Web
• Cognos Insight
• Cognos TM1 Performance Modeler

This installation scenario assumes:
• You are on a single 32- or 64-bit computer running the Microsoft Windows operating system.
• You use the Apache Tomcat web server software installed by the Cognos TM1 installation.
• You use the default, standard Cognos TM1 authentication.
• You accept the default configurations including English as the language.

Not all Cognos TM1 components are available for 64-bit systems. If the component is available as a 64-bit installation, it is installed in a directory identified as a 64-bit location instead of in the default 32-bit installation directory location. For example, bin64 instead of bin.

Remember: Your browser may use a slightly different interface than the browser used in the steps described here.

Related concepts:
“Upgrading a single computer installation of Cognos TM1” on page 54
This topic describes how to upgrade IBM Cognos TM1 on a single computer running on Microsoft Windows operating system.

Install the prerequisite software

You need the prerequisite software before you install IBM Cognos TM1.
About this task

If you do not have these prerequisites in place, the Cognos TM1 Installation wizard displays a message about them. If you are missing any of the prerequisites, you need to install them before you can continue. You may already have this software installed.

Procedure

For Cognos TM1 Perspectives or Cognos TM1 Architect, install or confirm that you have:
- Microsoft .NET Framework
- Microsoft Visual C++ 2010 Redistributable Package
- Microsoft Excel

Review the latest list of environments supported by Cognos TM1, including information on operating systems, patches, web servers and web browsers, by visiting [Cognos TM1 10.2.2 Software Environments](http://www.ibm.com/support/docview.wss?uid=swg27040698).

Install the basic Cognos TM1 components

Use the installation program to select the components you want to install and the location on your computer where you want to install them.

Before you begin

- Ensure that you have administrator privileges for the computer on which you are installing software.
- Ensure that the computer has a TEMP system variable that points to the directory where you want to store temporary files. During installation, files are temporarily copied to this directory.
- Some Microsoft Windows web server software does not support non-ASCII characters in directory names. Ensure that the directories where you install IBM Cognos TM1 components contain only ASCII characters in the path name.
- Ensure that all of the prerequisite software has been installed.
- There are several varieties of installation program available to you. Depending on which operating system you are using, go to the directory where the one you want to install is stored:
  - TM1 for 32-bit Windows
  - TM1 for 64-bit Windows

Procedure

1. To start the installation:
   - Go to the download location for the Cognos TM1 installation program that you want to use.
   - Or, insert the IBM Cognos TM1 product disk.
     If the installation wizard does not open automatically, go to the operating system directory to locate the `issetup.exe` command.
2. Depending on your operating system software, right-click or double-click the `issetup.exe` file:
On Microsoft Windows Vista, Windows 7, or Windows Server 2008 operating system software, right-click the \issetup.exe file and click Run as Administrator.

For all other Windows operating system software, double-click \issetup.exe.

3. Follow the directions in the installation wizard to select all of the components. The components that you need to run the software are selected by default. If you do not want to install Cognos Insight or Cognos TM1 Performance Modeler, skip to Step 5.

4. To include Cognos Insight in the installation, expand the TM1 Client Tier and select Cognos Insight.

5. To include Cognos TM1 Performance Modeler in the installation, expand the TM1 Developer Tier and select TM1 Performance Modeler.

6. Click Next until the installation begins. The installation runs until all components have been installed. This may take a significant amount of time.

Tip: For earlier Windows operating systems, you can check Start Cognos Configuration on the last screen of the installation to immediately run the configuration tool. On Microsoft Windows Vista, Windows 7, or Windows Server 2008 operating system software, do not check that box and instead use the Start menu so you can choose Run as Administrator when launching the Cognos Configuration tool.

7. Click Finish.

Use Cognos Configuration to start the Cognos TM1 components

Before you can use Cognos TM1, you need to start the IBM Cognos TM1 Admin Server, the TM1 Application Server, and at least one IBM Cognos TM1 sample database server. This action registers the servers in the Windows service registry. Then you need to configure the services so that they run under a specific user. Servers that are running in a Microsoft Windows environment are referred to as “services.”

Procedure

1. If it is not already running, start the configuration tool by clicking Start > All Programs > IBM Cognos TM1 > IBM Cognos Configuration.

   Remember: Right-click and use Run as Administrator on Windows Vista, Windows 7, and Windows Server 2008 operating system software.

2. In the Cognos Configuration Explorer pane, expand Local Configuration > Environment.

3. Right-click each component that you want to start and select Start:

   a. TM1 Admin Server It is best to start the TM1 Admin Server first since that server must be running before any sample database can run. The Cognos Configuration tool prompts you to save any edits made to the configuration settings. This process will take longer the first time you save a setting as the cryptographic settings and other actions take place for the first time. Click Yes in response to the message asking you to save the settings. You will also see this type of message when you close Cognos Configuration.

   b. TM1 Application Server
4. Expand the **Data Access > TM1 Server** node and right-click each Cognos TM1 sample database server that you want to start and select **Start**. For example, start the provided sample databases:
   a. **SData**
   b. **Planning Sample**
   c. **GO_New_Stores**

5. Click **File > Save.**

6. Now that the services are all registered in the Windows services registry, you can reconfigure them to use a specific user account:
   a. In Cognos Configuration, right-click each service you want to change and select **Stop**.
   b. Open Windows Services.
   c. Right-click on each service and select **Properties**.
   d. Enter a user name and password valid on your system with the appropriate rights for the service. See “User accounts for running Cognos TM1 services on Windows” in the “Planning your Cognos TM1 installation” chapter of the IBM Cognos TM1 Installation and Configuration Guide for details about the rights that this user account should have.

   You can find the TM1 Installation Guide for the version of TM1 you are using at Cognos TM1 Welcome page (http://www.ibm.com/support/knowledgecenter/SS9RXT/welcome).
   e. Close Windows Services.

7. In Cognos Configuration, right-click each server and select **Start**.

8. Close Cognos Configuration.

### Run Cognos TM1 Perspectives

After installation, you can run IBM Cognos TM1 Perspectives.

**Procedure**

1. From the Windows **Start** menu, click **IBM Cognos TM1 > Perspectives**. If the component does not start, ensure that the servers you started with Cognos Configuration are still running.
2. Click **Enable Macros** when the security warning displays.
3. Click **TM1 > Server Explorer**, then expand **TM1** to see the servers that are available.
4. Double-click a Cognos TM1 Server to log in.

   For SData, Planning Sample, or GO_New_Stores use these login credentials:
   - **User name**: admin
   - **Password**: apple

   **Tip:** To load Cognos TM1 Perspectives automatically whenever you start Microsoft Excel, add `TM1_location/Tm1p.xla` to Microsoft Excel’s add-in tool list, where `TM1_location` is the file directory where Cognos TM1 is installed. After completing this step, "TM1" displays on the Microsoft Excel menu bar.

### Run Cognos TM1 Architect

After installation, you can run the non-Microsoft Excel version of IBM Cognos TM1 called IBM Cognos TM1 Architect.
Procedure
1. From the Windows Start click All Programs > IBM Cognos TM1 > Architect. If Cognos TM1 Architect does not start up, ensure that the servers you started with Cognos Configuration are still running.
2. Expand TM1 to see the servers that are available.
3. Double-click a Cognos TM1 Server to log in.
4. Use these credentials to log into the SData, Planning Sample, or GO_New_Stores sample databases:
   - User name: admin
   - Password: apple

---

Run Cognos TM1 Web

The IBM Cognos TM1 installation configures IBM Cognos TM1 Web to run with the provided version of the Apache Tomcat web application server.

Procedure
1. In a web browser, enter the following URL: http://localhost:9510/tm1web/
   You can use the “localhost” term to make the computer location default to use your current computer. Or you can explicitly enter the IP address or name for the computer where you installed Cognos TM1.
2. Depending on what other components you have launched, the Log In box values will usually be automatically entered for you. If they are not, you can enter or change those values as needed.
3. Click Log In.

---

Run the Cognos TM1 Application Web

IBM Cognos TM1 Application Web is the web-based client and portal used to run planning applications built using IBM Cognos TM1 data.

About this task

Cognos TM1 Application Web is also used to launch IBM Cognos TM1 Performance Modeler and can be used to launch IBM Cognos Insight.

Procedure
1. In a web browser, enter the following URL: http://localhost:9510/pmpsvc
   where 9510 is the usual port used by Cognos TM1 Application Server. If you used a different port when you installed, enter that other value here.
2. Specify the configuration settings the Admin Host, server, types of clients, and the URL for Cognos TM1 Application Web.
3. Click OK.
4. Enter admin and apple for the username and password for the sample TM1 servers.
5. To complete the installation, dismiss the message about editing the following parameters in the tm1s.cfg file:
   • AllowSeparateNandCRules
   • ForceReevaluationOfFeedersForFedCellsOnDataChange
   • DistributedPlanningOutputDir
You do not need to edit these parameters until you begin working with the clients.
The portal is empty until you build an application using Cognos TM1 Performance Modeler or import an existing application.

Run Cognos TM1 Performance Modeler

IBM Cognos TM1 Performance Modeler is available as an unselected component of the IBM Cognos TM1 installation. You launch Cognos TM1 Performance Modeler from the IBM Cognos TM1 Applications portal.

About this task

After Cognos TM1 Performance Modeler is installed, you can also start the program from the desktop icon that gets installed or from the Microsoft Windows Start menu. Click Start > All Programs > IBM Cognos TM1 Performance Modeler > IBM Cognos TM1 Performance Modeler.

Procedure

1. From the Cognos TM1 Applications portal, click the Open Performance Modeler icon.

   Remember: Depending on your browser, you may see slightly different steps used to install downloaded components such as Cognos TM1 Performance Modeler.

2. Click OK with the Open with IBM Cognos RCP Application Updater selected on the provagent.cogrcp_modeler dialog box.

3. Click OK to dismiss the configuration settings message and complete the installation.

   You do not need to edit those parameters until you begin working with the clients.

4. Click the Model Design tab to see the GO_New_Stores data cubes and structure.

5. Click the Application Design tab to build a new application using GO_New_Stores.

   See Cognos TM1 Welcome page (http://www.ibm.com/support/knowledgecenter/SS9RXT/welcome). Select the version of TM1 you are using, then the Model and Design category. The IBM Cognos TM1 Performance Modeler User Guide provides details on building models.

Run Cognos Insight

IBM Cognos Insight is available as an unselected component of the IBM Cognos TM1 installation. Cognos Insight can be used as a client for contributing to applications and also as a dynamic workspace builder for creating interactive contributing user experiences.

Procedure

1. To run Cognos Insight, complete one of the following actions:

   • From the Cognos TM1 Applications portal, click the Cognos Insight icon.

   Or you can:
Right-click a node of an application that has been configured to use Cognos Insight.
You can also click the Cognos Insight desktop icon that gets installed.
Use the Microsoft Windows Start menu. Click Start > All Programs > IBM Cognos Insight > IBM Cognos Insight.
Cognos Insight can also be installed as a stand-alone component.

**Remember:** Depending on your browser, you may see slightly different steps used to install downloaded components such as Cognos Insight.

2. Click OK with the **Open With IBM Cognos RCP Application Updater** selected on the provagent.cogrcp_insight dialog box.
3. If you see an Executable file warning, click OK to proceed with the installation.

**What to do next**

See the **Cognos Insight Knowledge Center** (http://www.ibm.com/support/knowledgecenter/SSVJ22/welcome) for details about creating Cognos Insight workspaces and using Cognos Insight as a client for contributing to applications.

---

**Use Cognos TM1 Application Web**

The IBM Cognos TM1 Application Web is a web-based client used to contribute to planning applications and to work with IBM Cognos TM1 Websheets.

**Before you begin**

You need a planning application before you can use Cognos TM1 Application Web. The application designer identifies which clients can be used with a particular application.

**Tip:** You can see which clients the designer made available for an application by right-clicking a node of the application when it is displayed in the IBM Cognos TM1 Application Web.

**Procedure**

1. In Cognos TM1 Application Web, click a planning application.
2. Click **Open Cognos TM1 Application** to launch the Cognos TM1 Application Web client.

   See the **IBM Cognos TM1 Web User Guide** for details on how to contribute to an application using Cognos TM1 Application Web. Go to **Cognos TM1 Welcome page** (http://www.ibm.com/support/knowledgecenter/SS9RXT/welcome), select the version of TM1 you are using, select the **Analyze and Create** category, then **TM1 Applications Guide**.

---

**Other Cognos TM1 components**

The IBM Cognos TM1 installation makes many other components available and has many other ways to customize the installation.

See the following the documentation and components for details about other ways to install, deploy, and configure Cognos TM1:
Other Cognos TM1 components

See the related documentation for details on these additional components for Cognos TM1.

IBM Cognos TM1 Operations Console

The IBM Cognos TM1 Operations Console is a tool used by administrators to monitor the activity of TM1 servers on the network. See the IBM Cognos TM1 Operations Console Guide for more information.

IBM Cognos TM1 Mobile Contributor

IBM Cognos TM1 Mobile Contributor is a new mobile application for the Apple iPad that connects to an IBM Cognos TM1 Server and enables mobile users to access all their planning applications from IBM Cognos TM1 Applications.

Scorecarding with IBM Cognos TM1

Scorecarding with IBM Cognos TM1 integrates scorecarding and strategy management capabilities into Cognos TM1 to provide better integration of performance management with planning. You can create scorecard solutions that contain interactive impact diagrams, strategy maps, and custom diagrams that monitor your key performance indicators (KPIs). For more information, see the IBM Cognos TM1 Performance Modeler Guide.

Cognos TM1 integration with other IBM Cognos software

See the “Cognos TM1 integration with other IBM Cognos software” chapter for details on the following ways to integrate Cognos TM1 with other IBM Cognos software.

IBM Cognos Business Intelligence security

You can configure the Cognos TM1 server to authenticate users using IBM Cognos Business Intelligence (BI) security.

IBM Cognos BI reporting

You can configure IBM Cognos Business Intelligence (BI) to access Cognos TM1 servers and cubes from Cognos BI applications such as Cognos Report Studio and Cognos Query Studio.

iWidgets in IBM Cognos Workspace

You can display IBM Cognos TM1 Web data objects, such as cube views, charts, and Websheets as iWidgets in IBM Cognos Workspace.

IBM Cognos Analysis for Microsoft Excel

Use IBM Cognos Analysis for Microsoft Excel with IBM Cognos TM1 data sources to enter and write back values to TM1 cubes.

IBM Cognos TM1 Package Connector

The IBM Cognos TM1 Package Connector is used to import IBM Cognos Framework Manager packages. See the IBM Cognos TM1 TurboIntegrator Guide for more information.
Configuring client computers to export Cognos TM1 data in PDF format

To export IBM Cognos TM1 data to Adobe PDF format from IBM Cognos TM1 client applications running in Microsoft Windows, set PDFCamp as your default printer. These steps apply to IBM Cognos TM1 Perspectives, IBM Cognos TM1 Architect, and IBM Cognos TM1 Web.

Before you begin

Verify that PDFCamp is installed correctly by confirming that PDFCamp Printer Driver exists in the Windows Printers and Faxes configuration.

Procedure
1. In Windows, open the Printers and Faxes configuration window.
2. Right-click PDFCamp Printer Driver and select Set as Default Printer.
Chapter 8. Cognos TM1 Server installation

Use this section to install and configure the IBM Cognos TM1 Admin Server and IBM Cognos TM1 Server on a dedicated computer running either the Microsoft Windows, UNIX, or Linux operating system.

The Cognos TM1 Admin Server can reside on the same computer as the Cognos TM1 Server or another computer on your network.

The server components can be installed on either 32-bit or 64-bit computers running the Microsoft Windows operating system. For UNIX or Linux operating systems, only 64-bit computers are supported.

For more details on deployment scenarios and options, see “Deploying Cognos TM1 Admin Server and TM1 Server” on page 36.

Server components

The Cognos TM1 server components include the following:
- Cognos TM1 Admin Server - required
- Cognos TM1 Server - required
- Cognos TM1 Tools - optional

These components are grouped together under the TM1 Application Tier in the installation program.

IBM Cognos Configuration

By default, IBM Cognos Configuration is also installed with the required components on Windows, UNIX, and Linux as the primary tool for managing the Cognos TM1 Admin Server and Cognos TM1 Server. This tool provides a user interface for stopping and starting the server components.

Installing Cognos TM1 Server on Windows

You can install the Cognos TM1 server components on either 32-bit or 64-bit computers running the Microsoft Windows operating system. Use this type of installation to install and run the Cognos TM1 server on a dedicated computer that remote users can access.

Related concepts:
- “Upgrading Cognos TM1 Server on Windows” on page 55

You can upgrade the Cognos TM1 server components on either 32-bit or 64-bit computers running the Microsoft Windows operating system.

Install Cognos TM1 Server components on Windows

Install the IBM Cognos TM1 Server components on a computer that uses Microsoft Windows.

Procedure

1. Choose the installation program that matches the type of computer being used for the Cognos TM1 Server:
2. On Microsoft Windows Vista, Windows 7 or Windows Server 2008 operating system software, right-click the issetup.exe file and click Run as Administrator. For other operating systems, double-click the issetup.exe file to start the installation wizard.

3. Follow the directions in the installation wizard and advance to the Component Selection page.

4. Unselect all the components. By default, all components are initially selected.

5. Expand the TM1 Application Tier and select the following components:
   - TM1 Server
   - TM1 Admin Server
   - TM1 Tools - Optional

6. Follow the directions in the installation wizard to complete the installation.

7. In the Finish page of the installation wizard, click Finish.

Use Cognos Configuration to start Cognos TM1 servers on Windows

Before you can use the Cognos TM1 Server, you need to start the IBM Cognos TM1 Admin Server in IBM Cognos Configuration. Servers that are running in a Microsoft Windows environment are referred to as "services."

About this task

By default, Cognos Configuration registers TM1 server components to run as Windows services using the predefined Local System account. However, the TM1 components should be run as a specific user.

Important: Change the following Cognos TM1 services that are created by Cognos Configuration so that the services run under a specific user account on Microsoft Windows:
   - Cognos TM1 Admin Server
   - Cognos TM1 Server

For details, see "User accounts for running Cognos TM1 services on Windows" on page 21.

Procedure

1. If it is not already running, start the configuration tool by clicking Start > All Programs > IBM Cognos TM1 > IBM Cognos Configuration.

   Remember: Right-click and use Run as Administrator on Windows Vista, Windows 7, and Windows Server 2008 operating system software.

2. In the Cognos Configuration Explorer pane, expand Local Configuration > Environment.

3. Right-click each server that you want to start and select Start:
   a. TM1 Admin Server

   Tip: The Cognos Configuration tool prompts you to save any edits made to the configuration settings. This process will take longer the first time you save a setting as the cryptographic settings and other actions take place for
the first time. Click Yes in response to the message asking you to save the settings. You will also see this type of message when you close Cognos Configuration.

4. Expand the Data Access > TM1 Server node and right-click each Cognos TM1 sample database server that you want to start and select Start. For example, start the provided sample databases:
   a. SData
   b. Planning Sample
   c. GO_New_Stores

5. Click File > Save.

6. Edit the entries for the Cognos TM1 components in Windows Services so that they run under a specific user account.
   For details, see “Changing Cognos TM1 services to run as a specific user account on Windows.”

### Changing Cognos TM1 services to run as a specific user account on Windows

When using IBM Cognos Configuration to manage Cognos TM1 services, you need to change the default user account that runs the Microsoft Windows services for the Cognos TM1 Admin Server and any Cognos TM1 servers that you start with Cognos Configuration. By default, Cognos Configuration registers these services under the predefined Microsoft Windows Local System account. However, these services should be changed to run as a specific user account.

**Before you begin**

Review the required account privileges for using a user account other than Local System account. For details, see “User accounts for running Cognos TM1 services on Windows” on page 21.

**About this task**

Use Windows Services to change the user account for a Cognos TM1 component that is configured to run as a service.

**Procedure**

1. Open IBM Cognos Configuration.
2. Expand the Explorer > Local Configuration tree:
   a. Expand the Local Configuration > Environment node.
   b. Expand the Data Access > TM1 Server node.
3. Right-click on each Cognos TM1 component you want to change and select Stop.
   • TM1 Admin Server
   • Cognos TM1 Server name - the name for each server you have in Cognos Configuration.

   **Tip:** You do not need to stop the TM1 Application Server component.

5. Locate the Cognos TM1 component that you want to update and change the user account for the Windows service that runs it:
   a. Right-click on the service, select Properties and then click the Log On tab.
b. Enter a new user name and password for the service.

c. Repeat these steps for any other Cognos TM1 component running as a Windows service that you want to change.

7. In Cognos Configuration, restart each service that you changed:
   Right-click on the item and select **Start**.

8. Close Cognos Configuration.

---

**Installing Cognos TM1 Server on UNIX or Linux**

You can install the Cognos TM1 server components on a 64-bit computer running either a UNIX or Linux operating system. Use this type of installation to install and run the Cognos TM1 server on a dedicated computer that remote users can access.

**Managing components after installing**

After completing the installation, you can use IBM Cognos Configuration to manage the servers you want to run. You can also use the start and stop scripts that are provided with the installation.

**Accessing and viewing data**

To view and interact with the data stored in a Cognos TM1 server running on a UNIX system, use one of the Cognos TM1 clients on a computer running Microsoft Windows.

**Tip:** You can use Cognos TM1 Architect on a computer running Microsoft Windows to remotely log into a server running on a UNIX system.

**Related concepts:**

“Upgrading Cognos TM1 Server on UNIX or Linux” on page 54

You can upgrade the Cognos TM1 server components on a 64-bit computer running either a UNIX or Linux operating system.

---

**Install Cognos TM1 Server components on UNIX or Linux operating systems**

Use the installation wizard to select the server components for installation and the install location on your computer.

For a complete list of supported UNIX and Linux operating systems, click the IBM Cognos TM1 see [Cognos TM1 Software Environments](http://www.ibm.com/support/docview.wss?uid=swg27040698).

**Before you begin**

When installing Cognos TM1 on UNIX or Linux operating systems, configure the components to run as a user with appropriate permissions for Cognos TM1 binaries and TM1 databases.

To prepare to install Cognos TM1, you should complete the tasks described in the following checklist:

- Familiarize yourself with Cognos TM1 terms and concepts.
  See the IBM Cognos TM1 Users Guide and the IBM Cognos TM1 Developers Guide.
- Determine which components you want to install and how they should be distributed across your hardware environment.

**Remember:** Only the Cognos TM1 server components can run on UNIX or Linux. You cannot run Cognos TM1 clients on UNIX.

For details on how to design the optimal TM1 environment, see Chapter 3, “Architecture,” on page 23 and Chapter 4, “Deployment,” on page 35.

- Determine your hardware and software requirements.

Review the latest list of environments supported by Cognos TM1, including information on operating systems, patches, web servers and web browsers, by visiting Cognos TM1 Software Environments (http://www.ibm.com/support/docview.wss?uid=swg27040698).

If you plan to import data from another relational database, install your database software first.

If you are running Oracle on UNIX, install the appropriate UNIX client software for your Oracle database on the UNIX machine. Use the Oracle Network Configuration Assistant to specify a local net service name.

- Install your own copy of the Java Runtime Environment (JRE). The Cognos TM1 installation does not provide a JRE for UNIX installations.

- Check the X-server software on your UNIX machine.

To run the Graphical User Interface UNIX Installation Wizard, X-server software must be installed on the machine that will host your TM1 components. You must have X-server client software installed on the machine from which you run the TM1 Installation Wizard. If X-server software is not installed on the UNIX machine, run the console installation.

If you do not use X-server software, you must use an unattended installation. For more information, see Appendix C, “Setting up unattended installations and configurations,” on page 321.

- Install and configure the Cognos TM1 components to run as a user with appropriate permissions for Cognos TM1 binaries and TM1 databases.

**Procedure**

1. Go to the location where the installation files were downloaded and extracted, or insert the product disk.
2. Go to the operating system directory and then type
   ```
   ./issetup
   ```
3. Follow the directions in the installation wizard and copy the required files to your computer.
4. Select the components you want to install. By default, all components will be installed.
5. In the Finish page of the installation wizard, click Finish.
6. If you are installing the IBM Cognos TM1 Application server on Linux with a Sun Java Runtime Environment, you must also complete the following steps to install additional required Xerces files.
   b. Download the binary distribution for Java: Xerces-J-bin.2.11.0.zip.
   c. Extract xercesimpl.jar and xml-apis.jar and copy them to your tm1_install_dir/webapps/pmpsvc/WEB-INF/lib directory.
   d. Restart the TM1 Applications service.
**Update your Java environment**
To be able to start IBM Cognos Configuration on UNIX and Linux operating systems you must set the `JAVA_HOME` environment variable.

**Procedure**

Ensure that the `JAVA_HOME` environment variable is set to a valid JRE location.

**Start Cognos Configuration on UNIX or Linux operating systems**
Use IBM Cognos Configuration to configure your Cognos TM1 components and to start and stop services.

**Before you begin**

You must have set the `JAVA_HOME` environment variable before you can start IBM Cognos Configuration.

**Procedure**

Go to the `install_location/bin64` directory and then type 
```
./cogconfig.sh
```

**Starting a Cognos TM1 Server on UNIX**
You can use IBM Cognos Configuration to start and stop your Cognos TM1 servers on UNIX or Linux. You can also use the start and stop scripts that are provided with the installation.

**About this task**

On UNIX, you can also use the following commands and scripts to start and stop Cognos TM1 server components. See “Starting a UNIX TM1 Server” and “Stopping a UNIX TM1 Server” in the IBM Cognos TM1 Operation Guide for more details.

- `startup_tm1admsrv.sh` - start Cognos TM1 Admin Server
- `shutdown_tm1admsrv.sh` - shutdown Cognos TM1 Admin Server
- `startup_tm1s.sh` - start Cognos TM1 Server
- `tm1srvstop.exe` - utility for stopping a Cognos TM1 Server
- `shutdown_tm1s.sh` - alternate method to shut down a Cognos TM1 Server
- `startup_pmpsvc.sh` - start Cognos TM1 Application Server
- `shutdown_pmpsvc.sh` - shutdown Cognos TM1 Application Server

**Procedure**

1. Start IBM Cognos Configuration.
2. In the Explorer window, click Local Configuration > Environment.
3. Right-click Cognos TM1 Admin Server, and click Start.
4. Under Data Access > Cognos TM1 Server, right-click a server, and click Start.

**Running Cognos TM1 on IBM AIX**

This section contains technical considerations about running Cognos TM1 on the IBM AIX operating system.

**Setting IBM AIX memory resource limits for Cognos TM1**
If you are running IBM Cognos TM1 on IBM AIX, check the AIX memory resource limits to see how much memory is available for Cognos TM1.
Cognos TM1 is configured to make use of the maximum amount of memory available to the IBM AIX operating system as allowed by the AIX hard limit memory resource setting. To check the current hard limit on AIX, use the AIX ulimit command as follows:

```
ulimit -d -H
```

If you have root user authority, you can use this command to change the hard limit. For more information about using the `ulimit` command, see the AIX documentation.

**Performance tuning for Cognos TM1 on IBM AIX**

If you are running IBM Cognos TM1 on IBM AIX, tune your environment to improve performance.

Depending on application and usage, tests show that the changes described in this topic can result in a 5-25% improvement in performance over earlier versions of TM1.

**Environment settings**

The following environment settings are appropriate for all TM1 releases on AIX as of September 2014.

- `export AIXTHREAD_SCOPE=S`
- `export AIXTHREAD_MNRATIO=1:1`
- `export MALLOCOPTIONS=multiheap:32,pool:0x20000000`
- `export SPINLOOPTIME=300`
- `export AIXTHREAD_MUTEX_FAST=ON`
- `export LDR_CNTRL=DATAPSIZE=16M@TEXTPSIZE=16M@STACKPSIZE=16M`
- `export AIXTHREAD_AFFINITY=first-touch`
- `export MEMORY_AFFINITY=MCM`
- `export OBJECT_MODE=64`  
- `export YIELDLOOPTIME=0`

**Virtual Memory Manager (VMM)**

The Virtual Memory Manager (VMM) must be tuned for the size and number of large pages to reserve. Only root users or users that have the necessary privileges can adjust the VMM. See the AIX documentation for the complete set of `vmo` options you can use to tune VMM parameters.

**Note:** Enabling large pages increases the TM1 Server memory by 10-15%.

The following command enables large pages with the suggested settings for the TM1 Server:

```
vmo -o lgpg_regions=2000 -o lgpg_size=16777216
```

To grant privileges to non-root users, use the following command:

```
chuser capabilities=CAP_BYPASS,RAC_VMM,CAP_PROPAGATE userid
```

To verify that the TM1 Server is running with large pages enabled, run the following command:

```
ps -Zdef | grep tm1
```

**Enabling object alignment for the IBM Power® platform**

The `CacheFriendlyMalloc` parameter in the `tm1s.cfg` file allows for memory alignment that is specific to the Power platform. Testing shows that enabling this
option provides the most benefit for high user count usage scenarios. Single or low user count usage scenarios might see little to no benefit. By default, the option is disabled. To enable the option, add the following line to your tm1s.cfg file:

CacheFriendlyMalloc=T

Using IBM AIX commands that do not support file names for Cognos TM1 Control Objects

Some commands in the IBM AIX operating system, such as sysck, do not work with IBM Cognos TM1 control object file names because these file names start with the closing brace } character.

For example, Cognos TM1 control objects typically have file names like }Clients.dim, }Groups.dim or }ClientsGroups.cub.

This issue applies for all standard IBM AIX commands that read file names from stdin, including AIX commands and tools that backup data. These AIX commands fail and produce an error when the command is used with these Cognos TM1 files.

Cognos TM1 Object Names and Character Encoding for Cognos TM1 Servers on UNIX and Windows Systems

The following guidelines are related to ensuring correct and consistent character encoding in your Cognos TM1 object names for objects such as cubes, views, dimensions, and subsets.

Moving Cognos TM1 Databases Between Windows and UNIX Systems

Do not manually move and use Cognos TM1 database files from a Microsoft Windows system to a UNIX system (or from UNIX to Windows) when your Cognos TM1 object names contain non-ASCII characters (characters beyond the original 128 ASCII character set).

Instead of manually moving files, use the tm1xfer utility to move TM1 data between different platforms.

tm1xfer utility

The tm1xfer utility compresses and moves TM1 server objects from one platform to another platform while preserving mixed case names for objects on both Microsoft Windows and UNIX platforms. For more information, see the “tm1xfer” topic in the IBM Cognos TM1 Operation Guide.

Manually moving files

Manually moving files is an issue because of the possible incompatible character encoding or mapping between these two platforms. The Windows operating system stores directory and file names in UTF-16 character encoding, while the UNIX operating system can store names using different character encodings, depending on which locale is currently being used.

For example, Cognos TM1 object names for cubes and dimensions that include non-ASCII characters would not display correctly in Cognos TM1 client applications if the Cognos TM1 database files were copied from one platform and run on another where different character encoding is used.
Use the same locale as the UNIX system when starting a Cognos TM1 Server with non-ASCII characters in the name

If your Cognos TM1 object names (for cubes, views, dimensions, subsets, etc.) include non-ASCII characters, use the same locale when starting up a Cognos TM1 server on a UNIX system.

This ensures that Cognos TM1 object names and the related Cognos TM1 directory and file names on the UNIX system always use the same character encoding. Starting the Cognos TM1 server under a different locale than previously used could cause Cognos TM1 object names to display incorrectly if the names were originally created and stored in a different locale.

For example, Cognos TM1 object names for cubes and dimensions that are saved when the server is running under the en_US locale might not display correctly if the server is re-started using the ja_JP locale.

Cognos TM1 language configuration

IBM Cognos TM1 automatically configures language for the Cognos TM1 Server, client user interfaces, and messages by detecting the current language of the operating system user account or web browser where they are running. You can override this automatic configuration and configure Cognos TM1 to use a specific language from any of the supported languages.

For details about supported languages, see "Cognos TM1 language codes" on page 92.

Automatic detection of language

Cognos TM1 uses the following process to automatically detect and configure language at runtime:

1. The Cognos TM1 server and clients that run in Microsoft Windows try to detect and use the language that is configured in the locale of the operating system for the current user. On Windows, this is configured with Regional and Language Options. The detected language will be used if it matches one of the supported languages.

   Important: By default, any Cognos TM1 Server that you start with IBM Cognos Configuration is initially configured to run as a Windows service using the Windows Local System reserved user account. If you want the Cognos TM1 Server to use the language based on a specific user account, change the service to run as that user and configure the language for the user with the Windows Regional and Language Options. For details, see "Changing Cognos TM1 services to run as a specific user account on Windows" on page 85.

2. The server and client components also check for an override based on the Cognos TM1 Language configuration parameter:
   • The server checks the Language parameter in the Tm1s.cfg configuration file. If a valid language code is configured, that language is used for the server messages.
   • The client components check the Language parameter in the Tmplp.ini configuration file. If a valid language code is configured, that language is used in the user interface.

3. If the language configured in any of the above does not match a valid supported language, English is used.
Language configuration for Cognos TM1 components

Languages are set separately for the following Cognos TM1 components.

Table 16. Summary of language configuration for Cognos TM1 components

<table>
<thead>
<tr>
<th>Component</th>
<th>Language Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cognos TM1 Server</td>
<td>Use the Language parameter in the Tm1s.cfg file to configure a specific language for a Cognos TM1 Server. For details, see “Configuring language for the Cognos TM1 server” on page 93.</td>
</tr>
<tr>
<td>Cognos TM1 Architect, Cognos TM1 Perspectives</td>
<td>Use the Language parameter in the Tm1p.ini file to configure a specific language for Cognos TM1 clients that run on Microsoft Windows. For details, see “Configuring language for Cognos TM1 clients on Windows” on page 93.</td>
</tr>
<tr>
<td>Cognos TM1 Web</td>
<td>Use the language settings in your web browser to select a specific language for Cognos TM1 Web. For details, see “Configuring web browser language for Cognos TM1 Web” on page 94.</td>
</tr>
</tbody>
</table>

Cognos TM1 language codes

The following table summarizes the language codes for the supported languages in IBM Cognos TM1.

<table>
<thead>
<tr>
<th>Language</th>
<th>Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Brazilian Portuguese</td>
<td>bra</td>
</tr>
<tr>
<td>Croatian</td>
<td>hrv</td>
</tr>
<tr>
<td>Czech</td>
<td>csy</td>
</tr>
<tr>
<td>Chinese (Simplified)</td>
<td>sch</td>
</tr>
<tr>
<td>Chinese (Traditional)</td>
<td>tch</td>
</tr>
<tr>
<td>Danish</td>
<td>dan</td>
</tr>
<tr>
<td>Dutch</td>
<td>nld</td>
</tr>
<tr>
<td>German</td>
<td>deu</td>
</tr>
<tr>
<td>Finnish</td>
<td>fin</td>
</tr>
<tr>
<td>French</td>
<td>fra</td>
</tr>
<tr>
<td>Hungarian</td>
<td>hun</td>
</tr>
<tr>
<td>Italian</td>
<td>ita</td>
</tr>
<tr>
<td>Japanese</td>
<td>jpn</td>
</tr>
<tr>
<td>Kazakh</td>
<td>kaz</td>
</tr>
<tr>
<td>Korean</td>
<td>kor</td>
</tr>
<tr>
<td>Norwegian</td>
<td>nor</td>
</tr>
<tr>
<td>Polish</td>
<td>pol</td>
</tr>
<tr>
<td>Romanian</td>
<td>rom</td>
</tr>
<tr>
<td>Russian</td>
<td>rus</td>
</tr>
<tr>
<td>Spanish</td>
<td>esp</td>
</tr>
</tbody>
</table>
### Configuring language for the Cognos TM1 server

Use the **Language** parameter in the `Tm1s.cfg` file to configure a specific language for the IBM Cognos TM1 Server.

**About this task**

The **Language** configuration parameter for the Cognos TM1 Server controls the language for messages generated by the server. The parameter also applies to the user interface of the dialog box when you run the server as an application instead of a Windows service.

For more details about the Cognos TM1 Server **Language** parameter, see [Language parameter in the Tm1s.cfg file](#).

**Note:** If you want the Cognos TM1 Server to use a language based on a user account instead of the **Language** parameter, change the Microsoft Windows service that runs the Cognos TM1 Server to run as a specific user. For details, see "Changing Cognos TM1 services to run as a specific user account on Windows" on page 85.

**Procedure**

1. Use a text editor to open the Cognos TM1 Server configuration file, `Tm1s.cfg`. For location details, see ["Location of the tm1s.cfg File" on page 255.](#)
2. Edit or add the **Language** parameter with the language code you want to use. For example:
   ```
   Language=deu
   ```
   For a list of supported language codes, see ["Cognos TM1 language codes" on page 92.](#)
3. Save and close the `Tm1s.cfg` file.
4. Restart the Cognos TM1 Server.

### Configuring language for Cognos TM1 clients on Windows

Use the **Language** parameter in the `Tm1p.ini` file to configure a specific language for IBM Cognos TM1 clients that run on Microsoft Windows such as Cognos TM1 Architect and Cognos TM1 Perspectives.

**About this task**

For details about this parameter, see [**Language parameter in the Tm1p.ini file**](#).

**Note:** The **Language** parameter for Cognos TM1 clients is separate from the parameter of the same name for the Cognos TM1 Server.
Procedure
1. Use a text editor to open the Cognos TM1 client configuration file, Tm1p.ini.
   For location details, see "Location of the Tm1p.ini File" on page 311.
2. Edit or add the Language parameter with the language code you want to use.
   For example:
   Language=sch
   For a list of supported language codes, see "Cognos TM1 language codes" on page 92.
3. Save and close the Tm1p.ini file.
4. Restart the Cognos TM1 client.

Configuring web browser language for Cognos TM1 Web

The language settings in your web browser determine which language is used in the IBM Cognos TM1 Web interface.

About this task

Follow these general steps to configure Microsoft Internet Explorer and Mozilla Firefox to display IBM Cognos TM1 Web in your primary language. For more detailed information, see the documentation for your web browser.

Procedure
1. Depending on which web browser you are using, use the available language options to select and configure your primary language.
   • In Internet Explorer, the language options are typically located under Tools menu > Internet Options > General > Languages.
   • In Firefox, the language options are typically located under Tools menu > Options > Content > Languages.
2. Add your language to the language list.
3. Organize the list so that your preferred language is at the top of the list.

Creating a new empty Cognos TM1 server in Cognos Configuration

You can use IBM Cognos Configuration to create a new empty Cognos TM1 server.

About this task

These steps create the tms.cfg configuration file and other required files for a new empty Cognos TM1 Server. Perform these steps only on an empty directory that does not contain any other files.

Tip: If you want to add an existing TM1 Server to Cognos Configuration, see "Adding an existing Cognos TM1 server in Cognos Configuration" on page 95.

Procedure
1. Use your operating system to create an empty folder for the new Cognos TM1 Server files.
2. Open IBM Cognos Configuration.
3. In the Explorer panel, under Data Access, right click TM1 Server, and click New Resource > TM1 Server Instances.
4. In the Name box, enter a name for your server.
5. In the Type box, select TM1 Server instance and click OK.
The new server is added under the TM1 Server node and the properties for it are displayed in the TM1 Server instances - Resource Properties list.

6. In the Resource Properties list, click the entry box and click the edit icon.
7. Enter or browse to the path for the empty folder where you want to create the new Cognos TM1 server.

   Tip: Do not include the file name in this path. You only need to select the folder.

8. Click Select.
9. Click File > Save.
   A new tms.cfg file is automatically created in the folder. Values for the following configuration parameters are automatically added to the file.
   • The ServerName parameter is set to the server name that you specified.
   • The DatabaseDirectory parameter is set to the data directory that you specified.
   • The PortNumber parameter is set to a random auto-generated port number.

10. If you are using this database with Cognos TM1 Applications, edit the tms.cfg file with the required parameter values. For details, see "Configuring a Cognos TM1 Server to work with Cognos TM1 Application Web" on page 138.

11. In the Cognos Configuration Explorer panel, right-click the new server and click Start.
   The basic files for the new Cognos TM1 server are created in the folder.

12. To test the new Cognos TM1 server, start Cognos TM1 Architect and log in to the database with user name admin and no password.

---

**Adding an existing Cognos TM1 server in Cognos Configuration**

You can manage an existing Cognos TM1 server by adding it to IBM Cognos Configuration.

**Before you begin**

This procedure requires that you have an existing Cognos TM1 data directory with a valid tmls.cfg file.

**Procedure**

1. Open IBM Cognos Configuration.
2. In the Explorer panel, under Data Access, right click TM1 Server, and click New Resource > TM1 Server Instances.
3. In the Name box, enter the same name that is set for the ServerName parameter in the tmls.cfg file.
4. In the Type box, select TM1 Server instance and click OK.
   The new server is added under the TM1 Server node and the properties for it are displayed in the TM1 Server instances - Resource Properties list.
5. In the Resource Properties list, click the box to the right of the TM1 Server configuration path and click the edit icon.
6. Enter or browse to the path for the existing Cognos TM1 data directory.

   Tip: Do not include the file name in this path. You only need to select the folder.
7. Click Select.
8. Click File > Save.
9. In the Cognos Configuration Explorer panel, right-click the new server and click Start.
10. To test this Cognos TM1 server, start Cognos TM1 Architect and log in to the database.

## Specifying the location of the Cognos TM1 Admin Host

You specify the location of the IBM Cognos TM1 Admin Host differently for clients (user interfaces) and remote servers.

### About this task

The Admin Host is the computer where the Cognos TM1 Admin Server is running.

### Procedure

1. To specify the Admin Host referenced by clients such as Cognos TM1 Architect or Cognos TM1 Perspectives:
   - Change the Tm1p.ini file by using the Cognos TM1 Options menu in Server Explorer.
   - You can also manually edit the AdminHost parameter in the Tm1p.ini client configuration file.
     For more information, see Appendix B, “The Tm1p.ini Client Configuration File,” on page 311.
2. To specify the Admin Host with which remote servers register, use one of the following methods:
   - Edit the AdminHost parameter in the Tm1s.cfg file.
   - Use the -v command-line parameter when you bring up the Windows version of the Cognos TM1 server.
     For information, see Appendix A, “The tm1s.cfg Server Configuration File,” on page 255.

## Specifying multiple Cognos TM1 Admin Hosts

You can configure an IBM Cognos TM1 client to reference multiple Admin Hosts by separating host names with semicolons.

### About this task

A client that specifies multiple Admin Hosts can access any Cognos TM1 servers that are registered with the Cognos TM1 Admin Servers on the specified hosts.

### Procedure

To specify multiple Admin Hosts referenced by clients such as Cognos TM1 Architect or Cognos TM1 Perspectives, separate the host names with semicolons:
- Change the Tm1p.ini file by using the Cognos TM1 Options menu in Server Explorer.
- You can also manually edit the AdminHost parameter in the Tm1p.ini client configuration file.
Advanced Cognos TM1 Admin Server and Cognos TM1 Server configuration

This section describes advanced configuration to customize IBM Cognos TM1 for your specific business requirements and environment after you have completed the initial installation steps.

Changing default port numbers for Cognos TM1 Admin Server

If you change the default values for the **TM1 Admin Server host port number** or the **TM1 Admin Server SSL port number** in IBM Cognos Configuration, you need to manually update the new values in the UNIX and Microsoft Windows services file across all the affected computers in your environment. This operating system file is not updated by Cognos TM1.

About this task

Update the operating system services file on any computer running Cognos TM1 components that need to communicate with the Cognos TM1 Admin Server. For example:

- Cognos TM1 Server
- Cognos TM1 desktop clients such as Cognos TM1 Architect or Cognos TM1 Perspectives
- Custom Cognos TM1 applications created with the Cognos TM1 API.
- Cognos TM1 Web (web server only)

Procedure

1. Locate and open the services file for the specific operating system.
   - For UNIX, the typical location of the services file is:
     `/etc/services`
   - For Windows, the typical location of the services file is:
     `C:\Windows\System32\drivers\etc\services`
2. Add or edit the following entries in the services file with the new port numbers. For example:
   - `tm1admsvr 5400/tcp # Added by IBM Cognos TM1`
   - `tm1admsrv_ssl 5403/tcp # Added by IBM Cognos TM1`
3. Save and close the file.
4. Repeat these steps for each computer running Cognos TM1 components that communicate with the Cognos TM1 Admin Server.
5. Edit the `tm1web_config.xml` file to specify the port number of the Admin Server.
   - If you are using SSL, edit the AdminHostSSLPort parameter.
   - If you are not using SSL, edit the AdminHostPort parameter.

   The `tm1web_config.xml` file is located in `<TM1 install location>\webapps\tm1web\WEB-INF\configuration\`. For more details about the `tm1web_config.xml` file, see “Editing the Cognos TM1 Web configuration file” on page 118 and “Cognos TM1 Web Configuration Parameters” on page 115.
**Configuring Cognos TM1 to use IPv6**

To use IBM Cognos TM1 with internet protocol version 6 (IPv6), you configure a combination of Cognos TM1 parameters and an operating system environment variable.

**About this task**

By default, Cognos TM1 uses IPv4.

You can configure Cognos TM1 to use one of the following modes to specify which internet protocol that you want Cognos TM1 to use with your network.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ipv4</td>
<td>Default setting. Used for IPv4 networks.</td>
</tr>
<tr>
<td>dual</td>
<td>Used to transition from IPv4 to IPv6. Both protocols are supported.</td>
</tr>
<tr>
<td>ipv6</td>
<td>Used for IPv6 networks.</td>
</tr>
</tbody>
</table>

**Procedure**

1. Configure the Cognos TM1 Admin Server:
   a. On the computer where the Cognos TM1 Admin Server is running, open Cognos Configuration.
   b. Expand the Local Configuration > Environment node and click TM1 Admin Server.
   c. In the Component Properties pane, set the TM1 Admin Server IP support option to either Dual (IPv4 and IPv6), IPv4, or IPv6.
   d. If needed, add the IPv6 address to the /etc/hosts operating system file on UNIX and Microsoft Windows. In some cases, depending on your network environment and DNS configuration, you may need to perform this additional step to successfully run the Cognos TM1 Admin Server and Cognos TM1 Server in IPv6 mode.
   e. Add the TM1_IPVersion environment variable as described in step 3.

2. Configure the Cognos TM1 Server:
   a. On the computer where the Cognos TM1 Server is running, open the tm1s.cfg file.
   b. Set the IPversion parameter to the IP mode that you want to use.
      For example, to specify that your network uses the IPv6 protocol, add the parameter as follows:
      ```
      IPVersion=ipv6
      ```
      For more details, see [IPVersion](#) on page 278.
   c. If needed, add the IPv6 address to the /etc/hosts operating system file on UNIX and Microsoft Windows.
   d. Add the TM1_IPVersion environment variable as described in step 3.

3. Add the TM1_IPVersion environment variable to the operating system for each computer that communicates directly with the Cognos TM1 Admin Server and/or TM1 Server.
   Use the following variable name and value format:
   ```
   TM1_IPVersion=ip_mode
   ```
   where `ip_mode` can be one of the following values:
   - Dual
   - IPv6
   - IPv4
The **TM1_IPVersion** environment variable is required on any computer that is running any of the following Cognos TM1 components:

- Cognos TM1 Admin Server
- Cognos TM1 Server
- Cognos TM1 administrator tools, such as TM1 Top, ETLDAP, or the `tm1srvstop.exe` utility.
- Cognos TM1 Web (web server only)
- Cognos TM1 Application server
- Cognos TM1 clients:
  - Cognos TM1 Architect
  - Cognos TM1 Perspectives
  - Cognos Insight
  - Cognos TM1 Performance Modeler
- Custom applications that use the Cognos TM1 API.

**Note:** You do not need to set this environment variable on computers that use only a web browser to access Cognos TM1 Web.

4. Restart any Cognos TM1 servers that you modified.
5. Test the connection between your Cognos TM1 server and client applications.
Chapter 9. Cognos TM1 Operations Console installation

The IBM Cognos TM1 installation program installs the IBM Cognos TM1 Operations Console with the provided web application server. You can also install TM1 Operations Console with your own web application server. The TM1 Operations Console is a Java-based, optional component used to monitor the activity of Cognos TM1 servers.

Installing Cognos TM1 Operations Console using the provided Apache Tomcat webserver software

The IBM Cognos TM1 Operations Console is a Java-based, optional component used to monitor the activity of Cognos TM1 servers.

Before you begin

The Cognos TM1 Operations Console is installed by default when you install Cognos TM1 and uses the provided Apache Tomcat web server software.

Before installing the Cognos TM1 Operations Console:

- Ensure that the Cognos TM1 prerequisite software is installed.
- Ensure that the Cognos TM1 Admin Server, the TM1 Application Server, the Cognos TM1 server that you want to monitor, and the TM1 Sdata server are installed and running.
- Ensure that you can start Cognos TM1 Architect and can log in as an administrator to the Cognos TM1 server that you want to monitor.
- All services must be running under a single domain account. The Cognos TM1 Installation Wizard sets the parameters of the domain account for you, but you must create the account under which the services run before you run the installation. If services are running under different accounts, they will not be able to communicate with each other.
- It is possible to monitor Cognos TM1 version 9.5.2 servers using Cognos TM1 Operations Console. However, because not all the functionality is available within the 9.5.2 system, you can only run the basic monitoring and view a heartbeat status for either running or offline 9.5.2 servers.
- Upgrading: because of the changes to configuration, in particular shared log schedule files, it is not possible to use Cognos TM1 Operations Console configuration files from a 9.x version. The server data, user configuration, and schedule information must be re-entered.

Procedure

1. On Microsoft Windows Vista, Windows 7 or Windows Server 2008 operating system software, right-click the issetup.exe command and click Run as Administrator. For other operating systems, double-click the issetup.exe file on the IBM Cognos TM1 installation disk or from the location where the Cognos TM1 installation files were downloaded and extracted.
2. Ensure the Web Application Tier > Cognos TM1 Operations Console component is selected.
Remember: Install IBM Cognos TM1 components in a directory that contains only ASCII characters in the path name. Some Windows web servers do not support non-ASCII characters in directory names.

Using Cognos Configuration to deploy Cognos TM1 Operations Console

Start the TM1 Applications Server in Cognos Configuration to deploy the Apache Tomcat needed to run the TM1 Operations Console.

Before you begin

If you installed the product from the Program Files (x86) directory on a computer running Microsoft Windows Vista, Windows 7, or Windows 2008 operating system software, start IBM Cognos Configuration as an Administrator.

Procedure

1. Click Start > All Programs > IBM Cognos TM1 > IBM Cognos Configuration.
2. Right-click TM1 Application Server and click Start.
   This step starts the version of Tomcat provided with Cognos TM1, and automatically deploys the Cognos TM1 Operations Console.
3. Save the configuration data by clicking File > Save.

Advanced Cognos TM1 Operations Console installation

The following topics provide additional information about other ways to install Cognos TM1 Operations Console.

Installing Cognos TM1 Operations Console on a separate machine

You can install only the Cognos TM1 Operations Console on a machine that is separate from the servers being monitored.

Procedure

1. Install Cognos TM1 following the usual process, but select only the TM1 Operations Console from the Web Components list. By default this also installs the Cognos TM1 Applications Server and other services.
2. After installation, on the separate machine stop the TM1 Application Service.
3. Delete the installation_location/webapps/pmpsvc directory and the installation_location/webapps/p2pd directories.
4. Restart the TM1 Application Service.

Installing Cognos TM1 Operations Console with your own installation of Apache Tomcat web application server

This section describes how to install Cognos TM1 Applications on a separate computer and deploy it with your own installation of Apache Tomcat.

When you deploy Cognos TM1 Operations Console, Performance Management Hub is also deployed.
This installation is intended for an environment where the TM1 Admin Server and TM1 Server are running on another computer. When using your own web server software, you must install certificates and deploy the war files.

See "Using SSL when monitoring the TM1 Applications Server" in the Cognos TM1 Operations Console Guide for more information about installing certificates.

**Verify JRE user environment variable**

Cognos TM1 Operations Console needs the classpath user environment variable set.

If you are using your own installation of Apache Tomcat, verify that you have the following Microsoft Windows user environment variable for the JRE path.

- **Variable name:** classpath
- **Variable value:** .;C:\Program Files\Java\jre7\bin

If you are using the Tomcat provided with the Cognos TM1 installation, the variable is set for you.

**Add certificates to the JRE keystore**

The IBM Cognos TM1 Operations Console requires a certificate in the Java Runtime Environment (JRE) keystore.

**Procedure**

1. Run the Java keytool command to import the certificate into the keystore.
   a. Open a command prompt and change to the following directory:
      
      `location \bin\jre\7.0\bin`
      
      where `location` is the file directory where Cognos TM1 is installed.
      
      **CAUTION:**
      
      On 64-bit computers, be sure to add the certificates to the `bin64` folder.
      
   b. Run the following command line. For formatting purposes the command is shown here with line breaks but you should enter the command all on one line.
      
      ```
      keytool -import -file "C:\location\bin\ssl\applixa.pem" 
      -keystore "C:\location\bin\jre\7.0\lib\security\cacerts" 
      -storepass "changeit"
      ```
      
      For 64-bit installations, target the 64-bit folder when dealing with the certificates. For example, this sample command targets the 64-bit jre:
      
      ```
      cd C:\Program Files\ibm\cognos\TM1_64\bin64\jre\7.0\bin
      ```
      
      The following command is an example used on 64-bit systems. For formatting purposes this command is shown with line breaks but you should enter the command all on one line.
      
      ```
      keytool -import -file "C:\Program Files\ibm\cognos\TM1_64\bin64\ssl\tm1ca_v2.pem" -keystore "C:\Program Files\ibm\cognos\TM1_64\bin64\jre\7.0\lib\security\cacerts" -storepass "changeit"
      ```
      
      If you do not correctly target the 64-bit locations for certificates when running a 64-bit installation, you receive a warning message indicating that you cannot contact the servers.
      
   c. Enter yes when prompted to trust or add the certificate.
      
   The following message displays: **Certificate was added to keystore**

2. You may need to restart Apache Tomcat to have the change take effect.

   **Remember:** Re-add certificates any time you re-install Cognos TM1.
Deploy the Cognos TM1 Operations Console to Apache Tomcat

If you are using your own installation of Apache Tomcat, you must deploy IBM Cognos TM1 Operations Console to Tomcat.

Before you begin

- Start an instance of Apache Tomcat on the computer where you want to deploy the Cognos TM1 Operations Console.
- Ensure that you can access the Apache Tomcat Manager console.
- If you have not used Tomcat Manager before, add a user and role to the `tomcat-users.xml` file before you can log in. For more information, see your Apache Tomcat documentation.
- Build the application files using IBM Cognos Configuration. See “Building application files for a Tomcat server” on page 141

Procedure

1. With Apache Tomcat running, click Start > Programs > Tomcat Manager. Enter the username and password if they are required by your Apache Tomcat instance.
2. In Tomcat Manager, scroll down to the Deploy section and locate the WAR file to deploy subsection.
   
   **Remember:** If an earlier version of the Cognos TM1 Operations Console has already been deployed, use the undeploy option in Tomcat Manager to undeploy the earlier version.
3. Click Browse to locate the Cognos TM1 Operations Console web application archive file that you built using IBM Cognos Configuration.
4. Click OK.
5. In Tomcat Manager, click Deploy.

When the deployment is complete, the Cognos TM1 Operations Console displays as `/tm1operationsconsole` in the Applications section of Tomcat Manager.

Installing Cognos TM1 Operations Console to IBM WebSphere

You can deploy Cognos TM1 Operations Console to IBM WebSphere Application Server.

When you deploy Cognos TM1 Operations Console, Performance Management Hub is also deployed.

This installation is intended for an environment where the TM1 Admin Server and TM1 servers are running on another computer.

To deploy Operations Console to WebSphere, complete these tasks:

- Build the application files using Cognos Configuration. See “Building application files for an IBM WebSphere server” on page 144. A pmhub.war file is created in the same location as the tm1web.war and pmpsvc.war files. The default location is `<your installation location>\ibm\cognos\TM1\pmhub.war`.

  **Note:** You can use the EAR file format instead of WAR.

- Deploy the pmhub.war file to the Websphere application server
- Retrieve certificates from the TM1 Admin Server and TM1 servers
- Configure outgoing communications from Websphere to the TM1 Admin Server
Deploying Cognos TM1 Operations Console to an IBM WebSphere Application Server

Use the IBM WebSphere administrative console to deploy and run TM1 Operations Console on a WebSphere Application Server.

**Before you begin**

- Install IBM WebSphere Application Server.
- Create a profile using the Profile Management Tool.
- Start the WebSphere Application Server using the profile that you created.

In Microsoft Windows, click **Start > All Programs > IBM WebSphere Application Server > Profiles > [Profile Name] > Start the server.**

A command window opens and displays the start up progress. After the start up process is complete, the command window displays the message, "Server started." You can minimize this command window, but do not close it. This window must remain open while WebSphere is running.

- Build the application files using Cognos Configuration. See "Building application files for an IBM WebSphere server" on page 144. Operations Console and Performance Management Hub are contained in the pmhub.war file.

For information about installing WebSphere and creating a profile, see the WebSphere documentation.

**About this task**

These steps are based on IBM WebSphere Application Server 8.5.5. The steps for version 8.5 are similar.

**Note:** After you start completing steps in the WebSphere application installation wizard, click **Cancel** to exit if you decide not to install the application. Do not simply move to another administrative console page without first clicking **Cancel** on an application installation page.

**Procedure**

1. Open the WebSphere administrative console.
   - In Windows, click **Start > All Programs > IBM WebSphere Application Server > Profiles > [Profile Name] > Administrative console.** Or, go to https://localhost:9043/ibm/console/.
   - In UNIX, click **Applications > IBM WebSphere > IBM WebSphere Application Server > Profiles > [Profile Name] > Admin Console.** Or, go to https://localhost:9043/ibm/console/.

2. Log in using the WebSphere profile that you created. The administrative console opens.

3. Set the JVM stack memory size.
   a. Click **Servers > Server Types > WebSphere application servers.**
   b. Click the server where you are deploying Operations Console.
   c. Under Server Infrastructure, click **Java and Process Management > Process Definition.**
   d. Under Additional Properties, click **Java Virtual Machine.**
   e. In the **Generic JVM arguments** field, add `-Xms512k`. 
**Note:** Do not deploy Operations Console until you have set the stack memory. If you do so, Operations Console will be deployed but the WebSphere Application Server will not start.

Do not use the startServer.sh file to set the stack memory size.
WebSphere removes the -Xms0 setting from the file when the server starts and overrides it with the default value, which is too small.

1. Click **Apply**, and then click **OK**. Click **Save**.
2. Click **Applications > New Application**, and then click **New Enterprise Application**.
3. Click **Browse** to locate and select the pmhub.war file that you generated using the Build Application File command in Cognos Configuration. Click **Open**.
4. Click Next.
5. Click **Fast Path**, and then click **Next**.
6. Click **Next**.
7. Click **Finish**. WebSphere installs the application. This process can take a few minutes to complete.
   When installation is complete, WebSphere displays "Application pmhub_war installed successfully."
8. Click **Save**.
9. Click **Applications > Application Types > Websphere Enterprise Applications**.
10. Select the check box next to pmhub_war, and then click **Start**. WebSphere displays "Application pmhub_war on server server_name and node node started successfully. The collection may need to be refreshed to show the current status."

**What to do next**

The next step is to [retrieve SSL certificates from the TM1 Admin Server and TM1 servers](#).

**Retrieving SSL certificates from the TM1 Admin Server and TM1 servers**

After you have deployed the applications file, pmhub.war, to the IBM WebSphere Application Server, the next step is to retrieve SSL certificates from the TM1 Admin Server and TM1 servers.

**Procedure**

1. In the IBM WebSphere administrative console, expand **Security** and then click **SSL certificate and key management**.
2. Under Related Items, click **Key stores and certificates**.
3. Click the **NodeDefaultTrustStore** keystore.
4. Under Additional Properties, click **Signer certificates**.
5. Click **Retrieve from port**. Enter the following information:
   - In the **Host** field, enter the host name of the TM1 Admin Server.
   - In the **Port** field, enter 5498, the port number of the TM1 Admin Server.
   - In the **Alias** field, enter TM1AdminServer_cert.
6. Click **Retrieve signer information**. Websphere retrieves the SSL certificate from the TM1 Admin Server.
7. Verify that the certificate information is for a certificate that you can trust.
8. Click **Apply**, and then click **Save**.
9. Repeat these steps for the TM1 servers you want to monitor with Operations Console. For example:
   - In the **Host** field, enter the host name of the TM1 server.
   - In the **Port** field, enter the port number of the TM1 server.
   - In the **Alias** field, enter `TM1ServerName_cert`.

**Tip:** The port number of a TM1 server is configured in the `tm1s.cfg` file in the `PortNumber` parameter
10. Save your changes.

### What to do next

The next step is to configure outgoing communications between Websphere and the TM1 Admin Server.

### Configuring outgoing communications to the TM1 Admin Server

After you have deployed the applications file, `pmhub.war`, to the IBM WebSphere Application Server and retrieved SSL certificates, the next step is to set up outgoing communications from WebSphere to the TM1 Admin Server.

#### Procedure

1. In the WebSphere administrative console, expand Security and click **SSL certificate and key management**.
2. Under Configuration settings, click **Manage endpoint security configurations**.
3. Expand **Outbound > [node]Node01Cell > nodes**.
4. Click `[(node)Node01Cell]`, where `node` is the name of the server where you are deploying Operations Console.
5. Under Related Items, click **Dynamic outbound endpoint SSL configurations**.
6. Click the **NodeDefaultTrustStore** keystore.
7. Click **New**.
8. In the **Name** field, enter `tm1admin`.
9. In the **Description** field, enter `ssl connection`.
10. Under Connection Information, enter `*,*,5498`, and then click **Add**.

**Note:** The value 5498 is the SSL port number of the TM1 Admin Server as specified in Cognos Configuration.
11. Click **Apply**, and then click **OK**.
12. Save your changes.
13. Restart the WebSphere Application Server.
14. In a web browser, enter the URL to run Operations Console,
   `http://localhost:port/pmhub/pm/opsconsole/`. Replace `port` with the port number of the virtual host where you deployed `pmhub.war`. For example:
   `http://localhost:9080/pmhub/pm/opsconsole/`. The Operations Console login page is displayed.
Configuring the Cognos TM1 Operations Console

By default the Cognos TM1 Operations Console is configured to use a sample adminhost of localhost, server of sdata, and group called admin for authentication so you can get up and running quickly. If you prefer, you can edit these configurations to customize the authentication server.

Procedure
1. Enter http://servername:port number/pmhub/pm/admin to open the configuration screen.
2. To change the default adminhost, server, and group for monitoring, expand the com.ibm.ba.pm.opsconsole.monitor.tm1.TM1OpsConsoleMonitor node and select the com.ibm.ba.pm.opsconsole.monitor.tm1.TM1OpsConsoleMonitor.dictionary option. Click in each setting to change it. If you want to use Microsoft Internet Explorer 8 with the Cognos TM1 Operations Console see the Microsoft Internet Explorer documentation and ensure these settings:
   • Enable the option to refresh web pages with every visit
   • Disable the options for script debugging

Starting and logging into the Cognos TM1 Operations Console

To open the IBM Cognos TM1 Operations Console, enter the URL that identifies the port and server name for the component.

Procedure
1. In a web browser, type the following web address: http://servername:port number/pmhub/pm/opsconsole
   where
   • server_name is the computer where the Cognos TM1 Operations Console and your web application server are installed. You can use the keyword localhost if you are currently logged on to the Web server that is running Cognos TM1 Application Web. Or you can use the machine name, domain name, or IP address of the Web server hosting the application.
   • port_number is the port number where your web application server is running. For the version of Apache Tomcat that is provided with the Cognos TM1 installation, the default port number is 9510. For a different version of Apache Tomcat, open the Apache Tomcat server.xml file in the C:\Program Files\Apache Software Foundation\Tomcat 6.0\conf\ location to determine the port setting that your version of Tomcat is using.
2. On the log in page, enter values for the following fields, and then click Log In. To use the default monitoring group, enter
   • Namespace: Use the pull-down to select the available Namespace. If the system is a CAM-secured system, the namespace is the BI namespace that the TM1 system is secured against. If the system isn’t CAM secured the namespace is adminhost/tm1 server for example localhost/SData
   • User Name: admin
   • Password: apple
   See Configuring the TM1 Operations Console to get started.
Chapter 10. Cognos TM1 Web installation

You can install IBM Cognos TM1 Web on a computer that is separate from the computer where you installed the Cognos TM1 server and other Cognos TM1 components.

You can deploy TM1 Web on an Apache Tomcat application server or on IBM WebSphere Application Server. See:

- “Installing TM1 Web with the provided Apache Tomcat application server”
- “Installing TM1 Web with IBM WebSphere” on page 112

When you install TM1 Web, TM1 Applications Web is also installed.

For details about Cognos TM1 Web architecture, see “Cognos TM1 Web architecture” on page 28.

Checklist for installing Cognos TM1 Web

The following items are an overall checklist for installing Cognos TM1 Web.

- Install Cognos TM1 Web.
- If you are using Tomcat, use IBM Cognos Configuration to start the web application server for Cognos TM1 Web. If you are using WebSphere Application Server, use the WebSphere administrative console to start the application server.
- Run and test Cognos TM1 Web from your network environment.
- Edit the Cognos TM1 Web configuration file to support a multiple computer environment. See “Configuring the Cognos TM1 Web Login Page using AdminHostName and TM1ServerName parameters” on page 118.
- Configure additional options in the Cognos TM1 Web configuration file. See “Modifying Cognos TM1 Web Configuration Parameters” on page 114.
- Configure the web browsers in your environment. See “Web browser configuration for Cognos TM1 Web” on page 128.

Related concepts:

“Upgrading Cognos TM1 Web” on page 55

If you have IBM Cognos TM1 Web on a computer that is separate from the computer where you installed the Cognos TM1 server then do these steps to upgrade the web server.

Installing TM1 Web with the provided Apache Tomcat application server

You can install Cognos TM1 Web on a separate computer and deploy it with the instance of Apache Tomcat that is provided with the installation.

The IBM Cognos TM1 installation configures Cognos TM1 Web to run with the provided version of the Apache Tomcat web application server.
After you have installed the Cognos TM1 Web on the separate computer, edit the Cognos TM1 Web configuration file to identify the remote computer where the Cognos TM1 Admin Server is running.

Installing and configuring Cognos TM1 Web on Microsoft Windows

These steps describe how to install IBM Cognos TM1 Web on a separate computer that is running Microsoft Windows. These steps apply when you are using the provided Apache Tomcat application server.

About this task

This procedure also installs the IBM Cognos Configuration utility. You use Cognos Configuration to start and stop the application server.

When IBM Cognos TM1 Web is installed on a separate computer, edit the configuration file to identify the IBM Cognos TM1 Admin Server and IBM Cognos TM1 servers in your network that you want to use with Cognos TM1 Web.

Procedure

1. Run the installation program that matches the type of computer being used for Cognos TM1 Web:
   - 32-bit for Windows
   - 64-bit for Windows
2. On Microsoft Windows Vista, Windows 7 or Windows Server 2008 operating system software, right-click the issetup.exe file and click Run as Administrator. For other operating systems, double-click the issetup.exe file.
3. Select only the Web Application Tier > TM1 Web component. Deselect all the other components.
4. Follow the prompts in the installation wizard to complete the installation.
5. Start IBM Cognos Configuration.
   
   **Attention:** If you installed the product from the Program Files (x86) directory on a computer running Windows Vista, Windows 7, or Windows Server 2008 operating system software, start IBM Cognos Configuration as an Administrator.
6. In the Cognos Configuration Explorer panel, expand the Local Configuration > Environment node, right-click TM1 Application Server and select Start.
   
   This starts the provided web application server for Cognos TM1 Web.
7. Confirm that Cognos TM1 Web is running by entering the URL for Cognos TM1 Web in a web browser. For example:
   
   http://localhost:9510/tm1web/
   
   On a remote computer, replace localhost with the name or IP address of the computer where Cognos TM1 Web is running.
8. Configure Cognos TM1 Web to connect to remote Cognos TM1 servers in your network.

   If you want Cognos TM1 Web to connect to a specific Cognos TM1 Admin Server or Cognos TM1 server in your network, configure the AdminHostName and TM1ServerName parameters in the Cognos TM1 Web configuration file, tm1web_config.xml.

   See [Configuring the Cognos TM1 Web Login Page using AdminHostName and TM1ServerName parameters](#) on page 118.
   You can configure authentication security, such as Integrated Login or IBM
   Cognos Security, and data transmission security, such as SSL, depending on
   your system and network environment.

10. Configure additional options in the Cognos TM1 Web configuration file.
    See “Modifying Cognos TM1 Web Configuration Parameters” on page 114.

11. Review the steps for web browser configuration.
    You can configure web browser options such as language and regional settings
    for your users.
    See “Web browser configuration for Cognos TM1 Web” on page 128.

**Installing and configuring Cognos TM1 Web on UNIX**

Installing IBM Cognos TM1 Web on a UNIX system requires that you import the
certificate to the Java keystore on UNIX. These steps apply if you are using the
provided Apache Tomcat application server.

**Before you begin**

You must set the JAVA_HOME environment variable before you can start IBM
Cognos Configuration. Cognos Configuration is used for starting the web
application server for Cognos TM1 Web.

**About this task**

Importing the certificate to the Java keystore on UNIX is required to enable Cognos
TM1 Web to display the list of the available Cognos TM1 servers.

**Procedure**

1. Run the installation program:
   a. Go to the location where the installation files were downloaded and
      extracted, or insert the product disk.
   b. Go to the operating system directory and then type
      ./issetup
   c. Advance to the Component Selection screen.
   d. Select only the Web Application Tier > TM1 Web component.
      Deselect all the other components.
   e. Follow the prompts in the installation wizard to complete the installation.

2. Import the certificate to the Java keystore on UNIX.
   a. Change directory to the bin location that is associated to JAVA_HOME.
   b. Run the following command:
      keytool -import -file "/bin64/ssl/applixca.pem" -keystore
      "/usr/java7/jre/lib/security/cacerts" -storepass "changeit"

3. Start IBM Cognos Configuration:
   Go to the install_location/bin64 directory and then type the following
   command:
   ./cogconfig.sh

4. Start the web application server for Cognos TM1 Web:
In the Cognos Configuration **Explorer** panel, expand the **Local Configuration > Environment** node, right-click **TM1 Application Server** and select **Start**.

5. Confirm that Cognos TM1 Web is running by entering the URL for Cognos TM1 Web in a web browser on a remote computer. For example:

```
http://<unix_web_server>:9510/tm1web/
```

Replace `<unix_web_server>` with the name or IP address of the computer where Cognos TM1 Web is running.

**What to do next**

Depending on your system and network environment, perform the following additional configuration steps:

- Configure Cognos TM1 Web to connect to a specific Cognos TM1 Admin Server or Cognos TM1 server in your network.
  
  See "Configuring the Cognos TM1 Web Login Page using AdminHostName and TM1ServerName parameters" on page 118.

- Configure security options for Cognos TM1 Web.
  

- Configure additional options in the Cognos TM1 Web configuration file.
  
  See "Modifying Cognos TM1 Web Configuration Parameters" on page 114.

- Review the steps for web browser configuration.
  
  See "Web browser configuration for Cognos TM1 Web" on page 128.

**Installing TM1 Web with IBM WebSphere**

You can deploy Cognos TM1 Web to IBM WebSphere Application Server. When you install TM1 Web, TM1 Applications Web is also installed.

To install TM1 Web and TM1 Applications Web on a WebSphere application server, complete these tasks:

- Build the application files using Cognos Configuration. See "Building application files for an IBM WebSphere server" on page 144. A tm1web.war file is created. The default location is `<your installation location>/ibm/cognos/TM1/tm1web.war`.

**Note:** You can use the EAR file format instead of WAR.

- **Deploy the tm1web.war file to the WebSphere application server**
- **Import the TM1 SSL certificate to WebSphere**

**Deploying TM1 Web to an IBM WebSphere Application Server**

Use the IBM WebSphere administrative console to deploy and run TM1 Web and TM1 Applications Web on a WebSphere Application Server.

**Before you begin**

- Install IBM WebSphere Application Server.
- Create a profile using the Profile Management Tool.
- Start the WebSphere Application Server using the profile that you created.

  In Microsoft Windows, click **Start** > **All Programs** > **IBM WebSphere Application Server** > **Profiles** > `[Profile Name]` > **Start the server**.

  A command window opens and displays the start progress. After the start process is complete, the command window displays the message, "Server
started." You can minimize this command window, but do not close it. This window must remain open while WebSphere is running.

- Build the application files using Cognos Configuration. See "Building application files for an IBM WebSphere server" on page 144.

For information about installing WebSphere and creating a profile, see the WebSphere documentation.

**About this task**

These steps are based on IBM WebSphere Application Server 8.5.5. The steps for version 8.5 are similar.

**Note:** After you start completing steps in the WebSphere application installation wizard, click **Cancel** to exit if you decide not to install the application. Do not simply move to another administrative console page without first clicking **Cancel** on an application installation page.

**Procedure**

1. Open the WebSphere administrative console.
   - In Windows, click **Start** > **All Programs** > **IBM WebSphere Application Server** > **Profiles** > [Profile Name] > **Administrative console**. Or, go to https://localhost:9043/ibm/console/.
   - In UNIX, click **Applications** > **IBM Websphere** > **IBM Websphere Application Server** > **Profiles** > [Profile Name] > **Admin Console**. Or, go to https://localhost:9043/ibm/console/.

2. Log in using the WebSphere profile that you created. The administrative console opens.

3. Click **Applications** > **New Application**, and then click **New Enterprise Application**.

4. Click **Browse** to locate and select the tm1web.war file that you generated using the Build Application File command in Cognos Configuration. Click **Open**.

5. Click **Next**.
6. Click **Fast Path**, and then click **Next**.
7. Click **Step 4: Map context roots for Web modules**.
8. In the Context Root box, enter /tm1web. Click **Next**.
9. Click **Finish**. WebSphere installs the application. This process can take a few minutes to complete.

   When installation is complete, WebSphere displays "Application tm1web_war installed successfully."

10. Click **Save**.
11. Click **Applications** > **Application Types** > **Websphere Enterprise Applications**.
12. Select the check box next to tm1web_war, and then click **Start**. WebSphere displays "Application tm1web_war on server server_name and node node started successfully. The collection may need to be refreshed to show the current status."

**What to do next**

The next step is to import TM1 certificates to the keystore.
Importing SSL certificates for TM1 Web

After you have deployed the applications file, tm1web.war, to the IBM WebSphere Application Server, the next step is to import the TM1 SSL certificates to the keystore.

About this task

For TM1 Web, all root certificates must be installed in the certificate store on the computer where TM1 Web is running.

Procedure

1. In the IBM WebSphere administrative console, expand Security and then click SSL certificate and key management.
2. Under Related Items, click Key stores and certificates.
3. Click the NodeDefaultTrustStore keystore.
5. Click Add.
6. Enter the following information:
   • In the Alias field, enter applixca.pem.
   • In the File name field, enter the full path and file name of the SSL certificate for TM1, for example TM1_install_dir\bin\SSL\applixca.pem

   Note: If you are using your own SSL certificates, enter the path and file name of the root certificate
   • For the Data type field, keep the default value.
7. Click Apply, and then click OK.
8. Confirm that Cognos TM1 Web is running by entering the URL for Cognos TM1 Web in a web browser. For example:
   http://host:port/tm1web/
   On a remote computer, replace host with the name or IP address of the computer where Cognos TM1 Web is running. Replace port with the port number of the virtual host where you deployed tm1web.war. For example: http://server1:9080/tm1web.

What to do next

The next step is to configure TM1 Web. See "Modifying Cognos TM1 Web Configuration Parameters" and "Web browser configuration for Cognos TM1 Web" on page 128.

Modifying Cognos TM1 Web Configuration Parameters

The tm1web_config.xml file is an XML file that contains configuration parameters for IBM Cognos TM1 Web.

As of Cognos TM1 Web version 10.2, the new tm1web_config.xml file replaces the web.config file from previous Cognos TM1 Web versions.

The parameters in this file control the following IBM Cognos TM1 Web features.
   • View node
   • Cube Viewer page size
• Number of sheets to export from a Cube Viewer
• IBM Cognos TM1 Web startup and appearance settings

**Cognos TM1 Web Configuration Parameters**

The configuration parameters for IBM Cognos TM1 Web are stored in the `tm1web_config.xml` file.

The `tm1web_config.xml` file is located in the following location:

```<TM1 install location>/webapps/tm1web/WEB-INF/configuration/```

The following parameters are available.

**AdminHostName**
If set, users will not be asked to enter a value for Admin Host during login.

See "Configuring the Cognos TM1 Web Login Page using AdminHostName and TM1ServerName parameters" on page 118.

**AdminHostPort**
If set, the client will try to use this port instead of the default Admin Host port.

**AdminHostSSLPort**
If set, the client will try to use this port instead of the default Admin SSL Host port.

**CrossDomainAccessList**
Specifies the domain name where TM1 iWidgets are running. For example, add the name of the domain where IBM Cognos Workspace is running.

Use an asterisk (*) to allow Cognos TM1 Web and Cognos Workspace to access each other across different domains.

If you specify multiple URLs, separate each one using a comma.

**CubeViewerColumnPageSize**
Specifies the number of columns to fetch in a page of cubeviewer.

See "Changing the Cube Viewer Page Size" on page 126.

**CubeViewerRowPageSize**
Specifies the number of rows to fetch in a page of cubeviewer.

See "Changing the Cube Viewer Page Size" on page 126.

**CubeviewerStringWrap**
Settings for string cell wrapping in the cubeviewer.

See "Wrapping string values in cube views" on page 127.

**CustomCAMLogoutUrl**
Specifies the URL of a dedicated Logout page for CA SiteMinder when TM1 is configured to use CAM security (mode 4 or 5). This Logout page must be accessed on logout so that the SiteMinder session cookie can be invalidated.

When a user clicks **Logoff** in TM1 Web, the CAM logout occurs first. Then the SiteMinder Logout page is called.
**GzipCompressionEnabled**
Determines if the web server responses will be compressed. Valid values are true/false.

**HideCubeviewerToolBar**
If set to true, all Cubeviewer toolbars will not be displayed.
See “HideCubeviewerToolBar Parameter” on page 126.

**HideTabBar**
If set to true, multiple tabs will not be displayed.
See “HideTabBar Parameter” on page 125.

**HideWebsheetToolBar**
If set to true, all websheet toolbars will not be displayed.
See “HideWebsheetToolBar Parameter” on page 125.

**HomePageObject**
If set, the object of type of Websheet, Cubeviewer or URL will be displayed after a user logs in.
See “Configuring a Global Homepage for All Users” on page 121.

**IntegratedSecurityModuleName**
Specifies the name of the login module in the file pointed to by the java.security login configuration file.

**MaximumSheetsForExport**
Maximum number of sheets allowed to Export.
See “Setting the Maximum Number of Sheets to Export from a Cube Viewer” on page 127.

**NavTreeCollapsedOnStart**
Determines if the navigation panel will be collapsed or expanded after a user logs in.
See “NavTreeCollapsedOnStart Parameter” on page 124.

**NavTreeDisplayServerView**
Specifies whether to display the Server View node in the navigation tree. Valid values are Y and N.
See “Displaying or Hiding the Views Node in the Navigation Pane” on page 126.

**NavTreeHidden**
Determines if the navigation panel will be displayed after a user logs in.
See “NavTreeHidden Parameter” on page 124.

**RecalcOnDataValidationChange**
Specifies whether the default recalculation behavior will be overridden when changing the value of a data validation list.
If set to true, a recalculation will be triggered when a value in a data validation list is changed.
If set to false, a recalculation will not be triggered when a value in a data validation list is changed.

**RecalcOnPicklistChange**
Specifies whether the default recalculation behavior will be overridden when changing the value of a picklist.

If set to true, a recalculation will be triggered when a value in a picklist is changed.

If set to false, a recalculation will not be triggered when a value in a picklist is changed.

**TM1ServerName**

If set, users will not be asked to select a TM1 Server to connect to during login.

See "Configuring the Cognos TM1 Web Login Page using AdminHostName and TM1ServerName parameters" on page 118.

**UseBookRecalcSetting**

The UseBookRecalcSetting parameter is included in the tm1web_config.xml file. When set to true, the web server honors the mode in which the Excel sheet was published. If the Excel sheet was published in Manual recalc mode, websheet data is not re-sent to the client until a recalculation is performed.

The UseBookRecalcSetting parameter uses the following format in the tm1web_config.xml file:

```xml
<add key="UseBookRecalcSetting" value="false" />
```

where value is either "false" or "true"

If you set UseBookRecalcSetting to true, TM1 Web will honor the recalculation settings in the Excel worksheet.

When Calculation Options is set to Automatic:

- if you set UseBookRecalcSetting = "true", the websheet is recalculated automatically when you change the SUBNM function.
- if you set UseBookRecalcSetting = "false", the websheet is recalculated automatically when you change the SUBNM function.

When Calculation Options is set to Manual:

- if you set UseBookRecalcSetting = "true", the websheet is not recalculated automatically. To recalculate, you must manually click the recalc button.
- if you set UseBookRecalcSetting = "false", the websheet is recalculated automatically when you change the SUBNM function.

**WebsheetBackgroundRecalculationMode**

Specifies the level of background recalculation that occurs for a websheet. WebSheetService.scrollWebSheet calls can take several seconds because the data is not readily available. Use the WebsheetBackgroundRecalculationMode parameter to recalculate the book in the background so that the necessary data is ready when it is requested.

If set to 0 (default value), only the buffered (visible) area is calculated on a refresh of a sheet.

If set to 1, the area adjacent to the buffered area is calculated, in addition to the buffered area. This improves wait times if the user scrolls slightly away from the initially visible area.
If set to 2, the entire current worksheet is calculated. This improves wait times if the user scrolls to any area of the current sheet.

If set to 3, the entire current workbook is calculated. This improves wait times if the user moves to any area of the current worksheet or to another worksheet.

*Note:* The higher the setting number, the more cells are calculated meaning that there would be a higher load on the web server.

### Editing the Cognos TM1 Web configuration file

You can edit the IBM Cognos TM1 Web configuration file to configure different parameters.

The Cognos TM1 Web configuration file is an xml file and should be opened only with an XML-type editor. Opening it using a regular text editor such as Microsoft Wordpad can result in incorrect characters being added that may corrupt the file.

As of Cognos TM1 Web version 10.2, the new `tm1web_config.xml` file replaces the `web.config` file from previous Cognos TM1 Web versions.

**Procedure**

1. Locate and open the `tm1web_config.xml` file in the following location:
   ```
   <TM1 install location>\webapps\tm1web\WEB-INF\configuration\n   ```

   *Note:* The `tm1web_config.xml` file is an xml file and should be opened only with an XML-type editor. Opening it using a regular text editor such as Microsoft WordPad can result in incorrect characters being added that may corrupt the file.

2. Edit the parameters and save your changes.
3. Log in to IBM Cognos TM1 Web to see the result of your edits.

### Configuring the Cognos TM1 Web Login Page using AdminHostName and TM1ServerName parameters

The `AdminHostName` and `TM1ServerName` parameters control whether or not the IBM Cognos TM1 Web login page prompts the user to enter values for the TM1 Admin Host and TM1 server.

If you set a value for either of these parameters in the `tm1web_config.xml` file, then the login process uses the specified value and does not prompt the user for this information.

**AdminHostName Parameter**

This parameter specifies the name of the Admin Host on which a TM1 Admin Server is running. Edit the `AdminHostName` parameter in the `tm1web_config.xml` file using the following format:

```
<add key="AdminHostName" value="HostName"/>
```

where `HostName` can be one of the following values:
- If `HostName` is blank (default value), then the login page displays the Admin Host prompt.
• If `HostName` is set to the name of a valid TM1 Admin Host, then IBM Cognos TM1 Web uses that Admin Host for the login process and does not prompt the user.

**TM1ServerName Parameter**

This parameter sets the name of the TM1 server. Edit the `TM1ServerName` parameter in the `tm1web_config.xml` file using the following format:

```xml
<add key="TM1ServerName" value="ServerName"/>
```

where `ServerName` can be one of the following values:

- If `ServerName` is blank (default value), then the TM1 server prompt is displayed on the IBM Cognos TM1 Web login page.
- If `ServerName` is set to a valid TM1 server name, then the login page does not display a prompt for either the Admin Host or the TM1 server.
- If the `AdminSvrSSLCertID` parameter is incorrectly configured, the server name pull-down displays as empty and an error is logged in the Cognos TM1 Web log file. See “Running TM1 in Secure Mode using SSL” the IBM Cognos TM1 Operation Guide for more information.

After the user enters a valid User Name and Password, IBM Cognos TM1 Web will login to the TM1 server specified by the `TM1ServerName` parameter in the `tm1web_config.xml` file.

For example, the `TM1ServerName` parameter could be set to planning sample, as shown in the following code.

```xml
<add key="TM1ServerName" value="planning sample"/>
```

**Configuring a Custom Homepage for IBM Cognos TM1 Web**

You can configure a custom homepage for IBM Cognos TM1 Web to display a Websheet, cube view, or a URL after users have successfully logged into IBM Cognos TM1 Web. This homepage can provide users with a starting point for accessing and working with TM1 data.

A homepage can be configured globally for all IBM Cognos TM1 Web users or assigned individually for different users or sets of users. For example, if you configure the homepage option to display an HTML file or other type of web page, then you can provide users with instructions, tasks, links, or any other content that can be displayed in a web page.

If a homepage is configured, it displays on the first tab in IBM Cognos TM1 Web and cannot be closed by users. When configured, a Home link is displayed in the header area of IBM Cognos TM1 Web that allows users to easily return to the homepage.

An IBM Cognos TM1 Web homepage can be configured in one of the following two ways:

- **Different homepage for different IBM Cognos TM1 Web users** - Use the Client Settings dialog in TM1 Architect and Server Explorer to configure a startup homepage for different clients (users) of IBM Cognos TM1 Web.
- **Global homepage for all IBM Cognos TM1 Web users** - Use the HomePageObject parameter in the `tm1web_config.xml` file to configure a homepage that applies globally to all IBM Cognos TM1 Web users.
Configuring Different Homepages for Individual Users

The Client Settings dialog, in Architect and Server Explorer, configures a startup homepage for different IBM Cognos TM1 Web clients (users).

For example, you can assign one homepage for IBM Cognos TM1 Web users in the Sales department and another homepage for users in the Finance department.

Note: You can use the Client Settings dialog to assign homepages for specific users, over-riding the global homepage setting for the HomePageObject parameter in the tm1web_config.xml file.

Procedure

1. In Architect or Server Explorer, right click on the server and select Security, Clients/Groups.
   The Clients/Groups dialog opens.
2. Click Settings.
   The Client Settings dialog opens.
3. Select the client from the Current Client list for which the homepage setting will apply.
4. Enter a Websheet, cube view, or URL for the homepage as follows:
   - To display a URL, type the URL address, including the http:// protocol, into the Homepage box. You can enter a URL for either a website or an individual file.
   - To select a Websheet or cube view as the homepage, click Browse. The Select an IBM Cognos TM1 Web Homepage dialog opens where you can select a reference to a Websheet or cube view from the Application tree.
     After selecting a Websheet or cube view reference, click OK to return to the Client Settings dialog.
5. Select the settings that control the appearance of the Navigation pane.

Note: The Navigation pane settings you set here will only apply if the corresponding parameter in the tm1web_config.xml file is set to AllowOverwrite=true. For details, see "Configuring IBM Cognos TM1 Web Startup and Appearance Settings" on page 124.

The available settings for controlling the appearance of the Navigation pane include:

- Include the Navigation Pane - Determines if the Navigation pane is displayed or not displayed when the selected client logs in to IBM Cognos TM1 Web.
- Open pane on Login - Sets the Navigation pane to display in the expanded mode when the selected client logs in to IBM Cognos TM1 Web.
- Close pane on Login - Sets the Navigation pane to display in its minimized mode when the selected client logs in to IBM Cognos TM1 Web.
- Save Client’s Navigation Pane Settings - Determines if the personal settings for the Navigation pane are saved when the client logs out of IBM Cognos TM1 Web.
6. Select one of the options from the **Apply To** list to configure which client or clients will be able to view the homepage.
   - **Current Client** - Applies the homepage setting for only the client selected in the current Client list.
   - **Selected Clients** - Enables the Select button so you can open the Subset Editor to select a collection of clients that will use the same homepage setting.
   - **All Clients** - Applies the same homepage setting to all TM1 clients.

   If you choose **Selected Clients**, and then click **Select**, the Subset Editor opens so you can select a subset of TM1 clients that can use the homepage.

   Use the Subset Editor to select a subset of clients and then click **OK** to return to the Client Settings dialog. The number of clients selected in the Subset Editor is summarized in the Client Settings dialog.

7. Click **Apply Settings** to configure the homepage for the client or clients that you selected in the **Apply To** list.

8. Repeat steps 4, 5, 6, and 7 to configure a homepage for a different set of TM1 clients.

9. Click **OK** to close the Client Settings dialog.

You have now configured a homepage for IBM Cognos TM1 Web. The selected IBM Cognos TM1 Web clients will see the assigned homepage the next time they successfully log in to IBM Cognos TM1 Web.

### Configuring a Global Homepage for All Users

The **HomePageObject** parameter, in the `tm1web_config.xml` file, enables a global homepage that displays for all IBM Cognos TM1 Web users.

**Note:** You can override the global **HomePageObject** parameter by using the Client Settings dialog to assign different homepage's for individual Cognos TM1 users. For details, see [“Configuring Different Homepages for Individual Users” on page 120](#).

The **HomePageObject** parameter works for three types of objects:
- Cubeviewer
- Websheet
- URL

The homepage object displays after the user successfully logs in to IBM Cognos TM1 Web.

### Using the **HomePageObject** Parameter:

How to use the **HomePageObject** parameter.

The **HomePageObject** parameter uses the following format:

```xml
<add key="HomePageObject" value="ObjectPath ;Type=ObjectType ;Description=ObjectTitle ; AllowOverwrite =true" />
```

**where:**

- **ObjectPath** is the path to the Websheet, cube view, or URL object that you want to open. The exact format of the path depends on the type of object.
- **ObjectType** is the keyword for the object you want to open; websheet, cubeviewer, or URL.
• *ObjectTitle* is a brief title you assign to the object that displays in the title bar of the web browser and on the homepage tab in IBM Cognos TM1 Web.

• *AllowOverwrite* can be set to a value of true or false as follows:

If you set *AllowOverwrite=true* then the *HomePageObject* parameter can be overridden by setting a different homepage for individual clients using the Client Settings dialog in Architect and Server Explorer.

If you set *AllowOverwrite=false* then the *HomePageObject* parameter applies globally to all TM1 users and can not be individually configured with the Client Settings dialog in Architect and Server Explorer.

The following sections describe using the *HomePageObject* parameter for Websheets, cube views, and URLs.

**Setting a Global IBM Cognos TM1 Web Homepage to a Cube View:**

Use the following format to set a cube view as the homepage for IBM Cognos TM1 Web.

```
value=CubeName$$ViewName$$Status
```

where the following arguments are separated by $$ characters:

• *CubeName* is the name of cube to which the view belongs.
• *ViewName* is the name of the cube view to display.
• *Status* is the public or private status of the cube view.

**Note:** You must include a value of either PUBLIC or PRIVATE to correctly identify the specific cube view that you want to open.

For example, to open a public view named Price from the SalesCube:

```
&lt;add key="HomePageObject" value="SalesCube$$Price$$Public;Type=cubeviewer;
   Description=MyStartCube;AllowOverwrite=true"
   /&gt;
```

**Setting a Global IBM Cognos TM1 Web Homepage to a Websheet:**

You can assign a Websheet as the IBM Cognos TM1 Web homepage, depending on how the Excel file was added to TM1.

*Opening a Websheet that references an Excel file outside of TM1:*  

You can open a Websheet that references an Excel file.

**Procedure**

Use the format:

```
value=*WebsheetPath*
```

where *WebsheetPath* is the location and name of the Excel file. This can be either a path for a local file, or a UNC path for a file located on a network.

For example, to set a UNC network path for Websheet:

```
value=//MySystem/Samples/classic_slice.xls
```
Results

The complete HomePageObject parameter looks like this:

```
<add key="HomePageObject" value="/MySystem/Samples/classic_slice.xls;Type=websheet;
Description=MyWebsheet;AllowOverwrite=true"/>
```

Opening a Websheet object that was uploaded to the TM1 server:

You can open a Websheet object that was uploaded.

Procedure

1. In Server Explorer, use the Properties pane to find the TM1 assigned name for the uploaded Excel file.

![Figure 6. Example of an assigned name for an uploaded Excel file in Server Explorer](image)

2. Set the value parameter using the following format:

   ```
   value="TM1://ServerName/blob/PUBLIC/\}Externals\TM1_Filename"
   ```

   where:
   - `ServerName` is the name of the TM1 sever where the Excel file is located.
   - `TM1_Filename` is the name that TM1 assigned to the uploaded Excel file.

   For example:
   ```
   value="TM1://sdata/blob/PUBLIC/\}Externals\Report_2006.xls_20070123212746.xls"
   ```

   The complete HomePageObject parameter line looks like this:

   ```
   <add key="HomePageObject" value="TM1://sdata/blob/PUBLIC/\}Externals\Report_2006.xls_20070123212746.xls;Type=websheet;Description=My Uploaded Websheet;AllowOverwrite=true"/>
   ```

Setting a Global IBM Cognos TM1 Web Homepage to a URL:

You can set the HomePageObject parameter to a URL.

Use this format:

```
value="URL_Path"
```

Where `URL_Path` can point to a web site or an individual web page file.

For example:
• To set the homepage to a URL that points to a file:
  <addkey="HomePageObject" value="homepage.html;Type=URL;
  Description=MyStart Page;AllowOverwrite=true"
  />

• To set the homepage to a URL that points to a web site:
  <addkey="HomePageObject" value="http://www.ibm.com;Type=URL;
  Description=IBM;AllowOverwrite=true"/>

**Configuring IBM Cognos TM1 Web Startup and Appearance Settings**

You can control the appearance of the Navigation pane, tab bar, and Websheet and Cubeviewer toolbars when users log in to IBM Cognos TM1 Web.

These parameters are located in the `tm1web_config.xml` file and apply globally to all users of IBM Cognos TM1 Web.

**Note:** For details on using the `HomePageObject` parameter to set a custom homepage, see "Configuring a Custom Homepage for IBM Cognos TM1 Web" on page 119.

**NavTreeHidden Parameter**

The `NavTreeHidden` parameter determines if the Navigation pane displays when users log in to IBM Cognos TM1 Web.

This can be helpful if you are displaying a custom homepage for users and you want to completely hide the Navigation pane.

The `NavTreeHidden` parameter uses the following format in the `tm1web_config.xml` file:

```
<add key="NavTreeHidden" value="false;AllowOverwrite=true"
  />
```

where:

value can be either true or false

- If set to false, the Navigation pane will be displayed when user's log in to IBM Cognos TM1 Web.
- If set to true, the Navigation pane will not be displayed when user's log in to IBM Cognos TM1 Web.

`AllowOverwrite` can be set to true or false as follows:

- If you set `AllowOverwrite=true`, the `NavTreeHidden` parameter is assigned globally to all users, but can be overridden for individual clients using the Client Settings dialog in Architect and Server Explorer.
- If you set `AllowOverwrite=false`, the `NavTreeHidden` parameter applies globally to all TM1 users and can not be overridden for individual clients using the Client Settings dialog in Architect and Server Explorer.

**NavTreeCollapsedOnStart Parameter**

The `NavTreeCollapsedOnStart` parameter determines if the Navigation pane will be minimized or expanded when users log in. If collapsed, a small vertical bar displays to provide the user with a way to restore the pane.
The NavTreeCollapsedOnStart parameter uses the following format in the tm1web_config.xml file:

```xml
<add key="NavTreeCollapsedOnStart" value="false;AllowOverwrite=true" />
```

where:

- value can be either true or false.
  - If value is set to false, the Navigation pane will be expanded and display in its default mode when user's log in to IBM Cognos TM1 Web.
  - If value is set to true, the Navigation pane will be collapsed when user's log in to IBM Cognos TM1 Web.

AllowOverwrite can be set to true or false as follows:
- If you set AllowOverwrite=true, the NavTreeCollapsedOnStart parameter is assigned globally to all users, but can be overridden for individual clients using the Client Settings dialog in TM1 Architect and Server Explorer.
- If you set AllowOverwrite=false, the NavTreeCollapsedOnStart parameter applies globally to all TM1 users and cannot be overridden for individual clients using the Client Settings dialog in TM1 Architect and Server Explorer.

**HideTabBar Parameter**

The HideTabBar parameter determines if IBM Cognos TM1 Web can display multiple tabs when a user opens multiple IBM Cognos TM1 Web objects, or if only one view is displayed.

This can be useful if you want to limit users to one view at a time.

The HideTabBar parameter uses the following format in the tm1web_config.xml file:

```xml
<add key="HideTabBar" value="false;AllowOverwrite=true" />
```

where value can be either true or false.
- If value is set to false, multiple tabs can be displayed. This is the default behavior of IBM Cognos TM1 Web.
- If value is set to true, multiple tabs are not displayed and only one object can be opened at a time.

The AllowOverwrite option is not currently used for this parameter.

**HideWebsheetToolBar Parameter**

The HideWebsheetToolBar parameter determines if the Websheet toolbar is displayed when users open a Websheet.

The HideWebsheetToolBar parameter uses the following format in the tm1web_config.xml file:
where value can be either true or false.

- If value is set to false, the Websheet toolbar will display in IBM Cognos TM1 Web.
- If value is set to true, the Websheet toolbar will not display in IBM Cognos TM1 Web.

The AllowOverwrite option is not currently used for this parameter.

**HideCubeviewerToolBar Parameter**

The HideCubeviewerToolBar parameter determines if the Cubeviewer toolbar is displayed when users open a cube view.

The HideCubeviewerToolBar parameter uses the following format in the tm1web_config.xml file:

```xml
<add key="HideCubeviewerToolBar" value="false;AllowOverwrite=true" />
```

where value can be either true or false.

- If value is set to false, the Websheet toolbar will display in IBM Cognos TM1 Web.
- If value is set to true, the Websheet toolbar will not display in IBM Cognos TM1 Web.

The AllowOverwrite option is not currently used for this parameter.

**Displaying or Hiding the Views Node in the Navigation Pane**

You can display or hide the Views node in the Navigation pane.

**Procedure**

1. Edit tm1web_config.xml in the IBM Cognos TM1 Web virtual directory.
2. Locate the NavTreeDisplayServerView, which controls the display of the Server View node. The default value, Y, displays the Views node in the Navigation pane.

```xml
<!--NavTreeDisplayServerView: Y/N - Whether to display "Server View" node in navigation tree -->
<add key="NavTreeDisplayServerView" value="Y" />
```
3. To hide the Views node, change the NavTreeDisplayServerView value to N.
4. Save tm1web_config.xml.
5. Log in to IBM Cognos TM1 Web.

Now the Navigation pane displays without the View node.

**Changing the Cube Viewer Page Size**

You can change the number of rows and columns displayed in the Cube Viewer of TM1 the IBM Cognos TM1.

By default, Web Cube Viewer displays pages of TM1 data with 20 columns and 100 rows, and includes the dimensions list in the row count.
**Procedure**

1. Edit tm1web_config.xml.
2. Locate the following code:
   - CubeViewerRowPageSize
   - CubeViewerColumnPageSize
3. Change the value for the row and/or column page size.
4. Save tm1web_config.xml.
5. Log in to IBM Cognos TM1 Web.
   
   For example, if you set the row page size to 10, the Cube Viewer displays nine rows of data, plus the row of dimensions.

**Setting the Maximum Number of Sheets to Export from a Cube Viewer**

By default, the maximum number of sheets you can export from a Cube Viewer to a printer is 100. You can configure IBM Cognos TM1 Web to export more sheets.

**Procedure**

1. Edit tm1web_config.xml.
2. Locate the following code:
   - MaximumSheetsForExport
3. Change the value for the maximum number of sheets to export.
4. Save tm1web_config.xml.
5. Log in to IBM Cognos TM1 Web.

**Wrapping string values in cube views**

Use CubeviewerStringWrap to set the parameters used when viewing string element cells in a Web Cube View.

To control the way a view is displayed and wrapped, set the values using the CubeviewerStringWrap parameter and save the web configuration file. Cells that are not displayed are still editable in a scrollable area by clicking in the wrapped region.

**Enabled**

Turn wrapping of string cells in this view on or off. When set to "False" the column width is as wide as the longest string for any row in the current view. Set to "True" by default to turn on wrapping using these default parameters.

**MinCharactersToWrap**

Set the minimum number of characters needed before wrapping. For instance, string values with less than 50 characters will not wrap within a cell. Set to 50 by default.

**MaxDisplayCharacters**

Set the maximum number of characters to display within the string cell. The cell may contain more than this number of characters, but they will only be displayed when double-clicking on the cell. If the MinCharactersToWrap is 50 and the MaxDisplayCharacters is 200, string cells containing 200 or more characters will consume approximately 4 lines. Set to 200 by default.
WidthOfWrapCell
Set the number of characters used in the wrapped portion of the display.
Set to 240 by default.

Use the following format in the tm1web_config.xml file (the following listing has a
return in it for clarity but you should not enter a return).
<add key="CubeviewerStringWrap" value="Enabled=true;MinCharactersToWrap=50;
MaxDisplayCharacters=200;WidthOfWrapCell=240" />

Remember: CubeviewerStringWrap does not apply to Websheets.

Web browser configuration for Cognos TM1 Web

This section describes web browser configuration steps for IBM Cognos TM1 Web
that may be needed for your environment after you complete the initial
installation.

Users connect to Cognos TM1 Web using one of the supported web browsers
running on their own computers. Some additional configuration may be required.

Configuring web browser language for Cognos TM1 Web

The language settings in your web browser determine which language is used in
the IBM Cognos TM1 Web interface.

About this task

Follow these general steps to configure Microsoft Internet Explorer and Mozilla
Firefox to display IBM Cognos TM1 Web in your primary language. For more
detailed information, see the documentation for your web browser.

Procedure

1. Depending on which web browser you are using, use the available language
   options to select and configure your primary language.
   • In Internet Explorer, the language options are typically located under Tools
     menu > Internet Options > General > Languages.
   • In Firefox, the language options are typically located under Tools menu >
     Options > Content > Languages.
2. Add your language to the language list.
3. Organize the list so that your preferred language is at the top of the list.

Displaying and entering numbers in Cognos TM1 Web based
on Regional Settings

If you are running the IBM Cognos TM1 Web client in a language other than the
language of your operating system, you must ensure that your web browser
language and Microsoft Windows regional setting are set to the same value.

This will enable you to display and enter numbers in Cognos TM1 Web based on a
specific regional setting.

For example, if you have an English OS, but want to run Cognos TM1 Web in
French, your browser language must be set to French and your computer's regional
setting language must be set to French.
Windows Regional and Language Settings

Access the Windows regional settings by opening the Regional and Language Options feature in the Windows Control Panel.

Web Browser Language Settings

Access the web browser language setting as described in the section “Configuring web browser language for Cognos TM1 Web” on page 94.

Configuring Internet Explorer for Cognos TM1 Web

If you are using IBM Cognos TM1 Web with Microsoft Internet Explorer, make sure you have this security setting enabled to allow Cognos TM1 Web dialog windows to display correctly.

Change the security settings as follows:
• Allow websites to open windows without address bars or status bars.
• Allow script-initiated windows without size or position constraints.

If Internet Explorer is not configured correctly, some Cognos TM1 Web dialogs can appear truncated.

Running Cognos TM1 Web on a WAN Server and exporting Excel and PDF files

If you are running IBM Cognos TM1 Web on a WAN (Wide Area Network) server and want to allow users to export Microsoft Excel and PDF files from Cognos TM1 Web, you need to configure specific security settings in Microsoft Internet Explorer.

Because a WAN server resides in the Internet zone, Internet Explorer applies a different security profile as compared to servers in the Local Intranet zone. To successfully export files from Cognos TM1 Web in a WAN environment, you must add the Cognos TM1 Web server as a trusted site in the security settings for Internet Explorer.

Adding Cognos TM1 Web as a trusted site in Internet Explorer

If you are using Microsoft Internet Explorer and running IBM Cognos TM1 Web on a WAN server, you must add the Cognos TM1 Web server as a trusted site and then customize the security settings for trusted sites.

Procedure

1. Open Microsoft Internet Explorer.
2. Click Tools > Internet Options.
   The Internet Options dialog opens.
3. Click the Security tab.
4. Click Trusted Sites and then click the Sites button.
5. Enter the URL of the Cognos TM1 Web server in the Add this Web site to the zone box.
6. Click Add.
7. Close the Trusted Sites dialog box.
8. On the Security tab of the Internet Options dialog, click Trusted sites and then click the Custom Level button.
   The Security Settings - Trusted Sites Zone dialog opens.
9. Locate the settings for Downloads and click Enable for the Automatic prompting for file downloads option.
10. Click OK.
Chapter 11. Cognos TM1 Application Server installation

You can install the web application server components for IBM Cognos TM1 on a separate, dedicated computer so that users in a network environment can access the program. These components include the Cognos TM1 Application Server and the Cognos TM1 Application Gateway.

The Cognos TM1 Application Server requires deployment on a Java-based web application server. When installing Cognos TM1 Application Server, first determine which of the following web application servers you want to use:

- the provided Apache Tomcat web application server
- your own installation of Apache Tomcat
- your own installation of IBM WebSphere Application Server

For details about Cognos TM1 Application Server architecture and deployment, see:

- “Cognos TM1 Applications architecture” on page 30
- “Deploying Cognos TM1 Applications” on page 37

Deploying with the provided version of Tomcat

The fastest and easiest way to install and deploy Cognos TM1 Application Server is to use the version of Apache Tomcat that is provided and installed with the IBM Cognos TM1 installation program. This way uses Cognos Configuration to start and stop the Cognos TM1 Application Server.

For details, see “Installing Cognos TM1 Application Server with the provided Apache Tomcat” on page 132.

Deploying to your own web application server

To deploy Cognos TM1 Application Server with your own instance of a Java-based web application server, use IBM Cognos Configuration to first create the pmpsvc.war web application archive file, and then manually deploy the file.

For details, see the following topics:

- “Install Cognos TM1 Application Server with your own installation of Apache Tomcat web application server” on page 141
- “Install Cognos TM1 Application Server with your own installation of IBM Websphere” on page 144

Cognos TM1 Application Server with x64 Windows

When running Cognos TM1 Application Server on an x64 Microsoft Windows system with Apache Tomcat, use the same 32-bit or 64-bit versions of the Java Runtime Environment (JRE) and Apache Tomcat web server. Do not mix platform versions. For example, if you are using the 64-bit version of JRE, then you should also use the 64-bit version of Apache Tomcat.
Integrating Cognos TM1 Application Server with Cognos BI and Cognos Connection portal

If your TM1 installation uses Cognos security for authentication, your Cognos BI users can use the Cognos Connection portal to open TM1 applications instead of the TM1 Applications Web portal. However, administrators still need to use TM1 Applications Web to configure and manage applications.

When you configure TM1 Application Server to use Cognos security, you also enable the Cognos Connection portal to display a folder that contains links to the available TM1 applications. The exact list of displayed applications depends on the rights of the current user.

The planning.html file provides the information for Cognos BI and the Cognos Connection portal to display links to TM1 applications. For more information, see “Using Cognos TM1 Applications with Cognos security” on page 214.

Installing Cognos TM1 Application Server with the provided Apache Tomcat

You can install Cognos TM1 Application Server on a separate computer and deploy it with the instance of Apache Tomcat that is provided with the installation.

This installation is intended for an environment where the Cognos TM1 Admin Server and Cognos TM1 Server are running on another computer.

Installing Cognos TM1 application tier components

This topic provides the steps to install the required files for IBM Cognos TM1 Application Server and its components on a separate computer.

About this task

Use one of the following installation programs to install Cognos TM1 application tier components:
- IBM Cognos TM1 32-bit for Windows
- IBM Cognos TM1 64-bit for Windows

Remember: If you plan to use the Cognos TM1 Web client, you need an installation of Cognos TM1 Web on either the same computer or different computer in your network. To install Cognos TM1 Web on a different computer, see Chapter 10, “Cognos TM1 Web installation,” on page 109.

Procedure

1. On Microsoft Windows Vista, Windows 7 or Windows Server 2008 operating system software, right-click the issetup.exe file and click Run as Administrator. For other operating systems, double-click the issetup.exe file.
2. In the installation program select only the following components:
   - TM1 Application Gateway
   - TM1 Application Server
   - TM1 Web - This component is optional. Select this to install Cognos TM1 Web on the same computer as Cognos TM1 Application Server.
3. Follow the prompts to complete the installation.
Deploying the Cognos TM1 Application Server with the provided Tomcat web application server

The IBM Cognos TM1 Application Server runs in the Apache Tomcat web application server that is provided with the installation. Use Cognos Configuration to deploy and start Apache Tomcat and Cognos TM1 Application Server.

Procedure
1. Click Start > All Programs > IBM Cognos TM1 > IBM Cognos Configuration.
   If you installed the product from the Program Files (x86) directory on a computer running Windows Vista, Windows 7, or Windows 2008 operating system software, start IBM Cognos Configuration as an Administrator.
2. In the Cognos Configuration Explorer panel, expand the Local Configuration > Environment node, right-click TM1 Application Server and select Start.
   This will start the provided version of Tomcat and then deploy and start the Cognos TM1 Application Server.
3. Click File > Save and close IBM Cognos Configuration.

Configuring authentication security for Cognos TM1 Application Web

For the IBM Cognos TM1 servers used with Cognos TM1 Application Web, use either TM1 standard security authentication or IBM Cognos security.

About this task

Configure the authentication login mode using the `IntegratedSecurityMode` parameter in the `Tm1s.cfg` file of each Cognos TM1 server that you want to use.

Cognos TM1 Application Web is compatible only with the following TM1 security authentication modes:
- Authentication mode 1 - TM1 standard security authentication
- Authentication mode 5 - IBM Cognos security

Important: Do not use a combination of different security authentication modes for the same installation of Cognos TM1 Application Web.

For best practice, determine the security mode before you configure Cognos TM1 Application Web to use a Cognos TM1 server and use that same security mode with any additional servers you add.

For more details about security authentication and the `IntegratedSecurityMode` parameter, see:
- “Authentication security” on page 181
- “IntegratedSecurityMode” on page 275

Procedure
1. Open the file `TMI server data directory/Tm1s.cfg`
2. Set the `IntegratedSecurityMode` parameter for the Cognos TM1 Server.
   - To use Cognos TM1 standard security authentication, set `IntegratedSecurityMode=1`
   - To use IBM Cognos security, set `IntegratedSecurityMode=5`
For details about using IBM Cognos security, see:
3. Save and close the tmis.cfg file.
4. Restart the Cognos TM1 Server.
5. Repeat these steps for any other Cognos TM1 Server you want to use with Cognos TM1 Application Web.

Configuring the server and client environment for Cognos TM1 Application Web

Before you use IBM Cognos TM1 Application Web, you need to specify the TM1 Admin Host, TM1 Server, and client user interfaces that you want to use. The first time that you start Cognos TM1 Application Web, the program prompts you to configure these options.

Before you begin

Ensure that the TM1 Admin Server and at least one TM1 Server is running on the local computer or a remote computer that you can access.

Ensure that each TM1 Server that you want to use is configured with the required parameter values. For details, see “Configuring a Cognos TM1 Server to work with Cognos TM1 Application Web” on page 138.

If you plan to use Cognos TM1 Application Web, ensure that you know the web server name and port number where Cognos TM1 Web is running.

Procedure

1. Start and log in to Cognos TM1 Application Web:
   a. In a web browser, type the URL for Cognos TM1 Application Web:
      http://localhost:9510/pmpsvc
   b. Replace localhost with the name of the computer where the Cognos TM1 Application Server is installed.
2. Open the Cognos TM1 Application Configuration page:
   • If this is the first time that Cognos TM1 Application Web has been started since the installation, the Configuration page opens.
   • If Cognos TM1 Application Web has already been configured, you are prompted for a user name and password and then you can open the configuration page by clicking the Administer IBM Cognos TM1 Applications button on the toolbar of the Cognos TM1 Application Web main page.
3. In the Admin Host field, enter the name or IP address of the computer where the Cognos TM1 Admin Server is running.
   
   Note: The Admin Host and Server Name fields appear blank if you have not started the Cognos TM1 Admin Server and at least one Cognos TM1 server.
4. In the Server Name field, enter the name of the TM1 Server that you want to use with Cognos TM1 Application Web.
   For example, you could specify the sample TM1 server GO_New_Stores.
   Click the Refresh button to refresh the list of available servers.
5. Select the data contribution clients that you want to use with Cognos TM1 Application Web.
These clients will be available when you create applications with IBM Cognos TM1 Performance Modeler.

- **Include Cognos Insight - Connected** - IBM Cognos Insight client using real time processing with the TM1 server.
- **Include Cognos Insight - Distributed** - IBM Cognos Insight client with local processing of data. Data is updated to the TM1 server only when a commit data action is performed.
- **Include TM1 Application Web** - Default client. Processing is in real time with the server. This option uses the data grid and charting client infrastructure from Cognos TM1 Web and requires that you enter a value for the **TM1 Application Web URL** option.

6. If you selected the **Include TM1 Application Web** option, enter a value for the **TM1 Application Web URL** option.
   
   This URL points to the Contributor.jsp file on the web server that is hosting Cognos TM1 Web.
   
   For example:
   
   http://WebServer:9510/tm1web/Contributor.jsp
   
   where WebServer is the name of the computer where Cognos TM1 Web is installed.

7. Click **OK**.

8. If prompted, enter the **username** and **password** for the server and click **Login**.

   **Tip:** Use `admin` and `apple` for the user name and password if you are using one of the installed sample databases.

   The Cognos TM1 Application Web main page displays. This page appears blank until you build and deploy applications inside of Cognos TM1 Application Web. For more details, see the IBM Cognos Performance Modeler and IBM Cognos Insight documentation.

**Results**

The following message indicates that the Cognos TM1 server that you are using is not properly configured for use with Cognos TM1 Application Web:

> The new server can be added but it may not be configured with all the options required by IBM Cognos TM1 Applications.

For information on how to configure this server, see “Configuring a Cognos TM1 Server to work with Cognos TM1 Application Web” on page 138.

**Cognos TM1 Application Server settings in Cognos Configuration**

You can configure settings for Cognos TM1 Application Server in Cognos Configuration.

In Cognos Configuration, click **Environment > TM1 Application Server**.

**Session timeout (min)**

Time after which if there is no activity that the TM1 server disconnects. Default is 60 minutes.
Force qualified paths
When set to True, a machine name that is provided as the Admin Host resolves to a fully qualified domain name. When set to False, only the machine name is used.

Notifications provider
- DLS (Delivery Service): If a mail server is configured, emails are sent but no notifications display in the Cognos Inbox.
- HTS (Human Task Service): Notifications are sent to the Cognos Inbox, and emails also sent if a mail server is configured.

By default left blank for no notifications.

Enable Business Viewpoint
True means Business Viewpoint can interact with this installation. False prevents Business Viewpoint from interacting.

Cognos Connection Folder Name
Specifies the name of the Cognos Connection folder in which hyperlinks to deployed TM1 applications are contained. Default is IBM Cognos TM1 Application - My Applications

TM1 Application Service Dispatcher URI
The URI used for the dispatcher servlet, for example http://localhost:9510/pmpsvc/dispatcher/servlet

User ID and Password
User ID and Password used to authenticate.

Under TM1 Application Server, click TM1 Clients.

Provisioning URI
Specifies a URI to use to manually set the msi locations.

Allow provisioned installs
True permits users without the clients installed to provision and install them from TM1 Application Server. False blocks users from provisioning and installing client software.

Allow provisioned updates
True permits updates that are installed on the TM1 Application Server such as a Fix Pack version to be provisioned to clients when users next connect. False prevents updates from being provisioned.

Enable publish from Cognos Insight
True permits a user with Admin rights to publish from Cognos Insight. False disallows the Publish operation for all users.

Cognos Insight ping frequency (seconds)
Determines the frequency with which Cognos Insight verifies connectivity to the TM1 Application Server. If Cognos Insight receives no response while in Distributed mode, it is implicitly placed in Offline mode. Default is 30 seconds.

Determining the URL startup link for Cognos TM1 Application Web
The exact link to start and log on to Cognos TM1 Application Web depends on which web server you are running and how it is configured.

You can see the default startup URL for Cognos TM1 Application Web in IBM Cognos Configuration.
1. Open Cognos Configuration.
2. Click to expand **Local Configuration > Environment** and then select **TM1 Application Server**.
3. The URL is listed in the value column for the **TM1 Application Server Gateway URI** field.
   For example: http://localhost:9510/pmpsvc

**Link Parameters**

Use the following format for the URL to log in to Cognos TM1 Application Web.

https://WebServer:PortNumber/pmpsvc

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>WebServer</td>
<td>Can be one of the following:</td>
</tr>
<tr>
<td></td>
<td>The keyword <strong>localhost</strong> if you are currently logged on to the web server</td>
</tr>
<tr>
<td></td>
<td>that is running Cognos TM1 Application Server.</td>
</tr>
<tr>
<td></td>
<td>The machine name or domain name of the web server hosting the Cognos TM1</td>
</tr>
<tr>
<td></td>
<td>Application Server.</td>
</tr>
<tr>
<td></td>
<td>The IP address of the web server hosting the Cognos TM1 Application Server.</td>
</tr>
<tr>
<td>PortNumber</td>
<td>The port number you configured with web application server.</td>
</tr>
<tr>
<td></td>
<td>IBM WebSphere - Click the <strong>Web Server</strong> link in the WebSphere Administrative</td>
</tr>
<tr>
<td></td>
<td>Console to view and edit port settings.</td>
</tr>
<tr>
<td></td>
<td>Apache Tomcat - Open the Apache Tomcat server.xml file in the following</td>
</tr>
<tr>
<td></td>
<td>location to view and edit the port settings:</td>
</tr>
<tr>
<td></td>
<td>C:\Program Files\Apache Software Foundation\Tomcat 6.0\conf\server.xml.</td>
</tr>
</tbody>
</table>

**Link Examples**

Table 18. Cognos TM1 Application Web - link examples

<table>
<thead>
<tr>
<th>Web Application Server</th>
<th>Header</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apache Tomcat provided with the installation</td>
<td>The default link when using the provided version of Tomcat is: <a href="http://localhost:9510/pmpsvc">http://localhost:9510/pmpsvc</a></td>
</tr>
<tr>
<td>Apache Tomcat</td>
<td>The usual link for Cognos TM1 Application Web with Apache Tomcat is:</td>
</tr>
<tr>
<td></td>
<td><a href="http://localhost:8085/pmpsvc">http://localhost:8085/pmpsvc</a></td>
</tr>
<tr>
<td>IBM WebSphere Application Server</td>
<td>The usual link for Cognos TM1 Application Web running on IBM WebSphere Application Server is:</td>
</tr>
<tr>
<td></td>
<td><a href="https://localhost:8443/pmpsvc">https://localhost:8443/pmpsvc</a></td>
</tr>
</tbody>
</table>
Configuring a Cognos TM1 Server to work with Cognos TM1 Application Web

Before using the IBM Cognos TM1 Server with IBM Cognos TM1 Application Web, edit the TM1 server’s configuration file to include the required parameters and values.

**About this task**

The following configuration parameters in the Cognos TM1 Server Tm1s.cfg file support different subcomponents of Cognos TM1 Application Web.

- **AllowSeparateNandCRules** parameter - supports Cognos TM1 Performance Modeler with Cognos TM1 Application Web.  
  See “AllowSeparateNandCRules” on page 258.
- **DistributedPlanningOutputDir** parameter - supports Cognos Insight - Distributed client with Cognos TM1 Application Web.  
  See “DistributedPlanningOutputDir” on page 271.
- **ForceReevaluationOfFeedersForFedCellsOnDataChange** parameter - supports Cognos TM1 Performance Modeler with Cognos TM1 Application Web. When this parameter is set, a feeder statement is forced to be re-evaluated when data changes.  
  See “ForceReevaluationOfFeedersForFedCellsOnDataChange” on page 274.

**Procedure**

1. Open the Cognos TM1 Server configuration file, Tm1s.cfg.
2. To support Cognos TM1 Performance Modeler, edit or add the following line:  
   AllowSeparateNandCRules=T
3. To support the Cognos Insight – Distributed client, edit or add the following line:  
   DistributedPlanningOutputDir=\unit
4. Edit or add the ForceReevaluationOfFeedersForFedCellsOnDataChange parameter.
5. Save the Tm1s.cfg file.
6. Restart the Cognos TM1 Server.
7. Repeat these steps for any other Cognos TM1 servers you want to use with Cognos TM1 Application Web.

Configuring IBM Cognos TM1 Application Web

IBM Cognos TM1 uses IBM Cognos TM1 Web to support the Cognos TM1 Application Web client. Cognos TM1 Application Web enables users to view and edit planning application data in grid format. If you want to allow users to use Cognos TM1 Application Web, you need to configure this option.

**About this task**

When you install Cognos TM1 Web, the required files for Cognos TM1 Application Web are copied to the Cognos TM1 Web installation location.

The main file for Cognos TM1 Application Web is:

Contributor.jsp
The default install location is:

`TM1_install_location\webapps\tm1web`

Configure the Cognos TM1 Application Web URL parameter in Cognos TM1 Application Web to point to the `Contributor.jsp` file in this location.

**Procedure**

1. Open the Configuration page in Cognos TM1 Application Web:
   - If you are running Cognos TM1 Application Web for the first time, use the Configuration page that opens when you start the program.
     
     For more details, see "Configuring the server and client environment for Cognos TM1 Application Web" on page 134.
   - If you are already using Cognos TM1 Application Web, you can re-open the Configuration page by clicking the Administer IBM Cognos TM1 Applications button on the toolbar in Cognos TM1 Application Web.

2. In the **TM1 Application Web URL** field, enter the URL location of the `Contributor.jsp` file.
   
   Use the format:
   
   `http://WebServer:port_number/tm1web/Contributor.jsp`
   
   For example:
   
   `http://webserver.example.com:9510/tm1web/Contributor.jsp`

3. Click **OK**. The Login page for Cognos TM1 Application Web is displayed.

---

**Cognos TM1 Application Server Logging**

You can monitor the activity and performance of IBM Cognos TM1 Application Server by configuring and viewing the TM1 Application Server log file.

Cognos TM1 Application Server uses the log4j framework to control the Planning Services (pmpsvc) logging. The logging settings are dynamic - any changes you make to the logging properties file will be detected while the service is running.

**Logging properties file**

Logging is configured in the following file:

```
<tm1_installation_location>\webapps\pmpsvc\WEB-INF\configuration\log4j.properties
```

For example, the default installation location on a 32-bit Microsoft Windows system is:

```
C:\Program Files\IBM\cognos\tm1\webapps\pmpsvc\WEB-INF\configuration\log4j.properties
```

On a 64-bit Windows system:

```
C:\Program Files\IBM\cognos\tm1_64\webapps\pmpsvc\WEB-INF\configuration\log4j.properties
```
Log file output

By default, the service is configured to log only **ERROR** messages into a text file which contains all the log entries for a 24 hour period. The log file and directory are located here:

\<tm1_installation_location>\webapps\pmpsvc\WEB-INF\logs\pmpsvc.log

Older log files for previous days are named with the format:

pmpsvc.log.YYYY-MM-DD

Log file message levels

There are four levels of detail which can be logged. Each level contains all log entries for that level and each higher level.

**Table 19. Level Description**

<table>
<thead>
<tr>
<th>Level</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>ERROR</strong></td>
<td>Outputs exceptional events which cause the service not to be able to complete the current operation.</td>
</tr>
<tr>
<td><strong>WARNING</strong></td>
<td>Outputs conditions from which the service can continue but should be addressed by an administrator.</td>
</tr>
<tr>
<td><strong>INFO</strong></td>
<td>Outputs information for each of the service operations.</td>
</tr>
<tr>
<td><strong>DEBUG</strong></td>
<td>Outputs details tracing information for the service operations.</td>
</tr>
</tbody>
</table>

Examples of enabling logging

The logging level of information is controlled by changing the level under the following two roots of the service:

- `log4j.logger.com.ibm.cognos`
- `log4j.logger.com.cognos`

All the components of the service are situated beneath these trees, so changing the logging level for these will log all events at that level.

For example, to change the service to log at the **INFO** level, change these entries to the following:

```bash
#System logging settings
log4j.rootLogger=ERROR, TextFile
log4j.logger.com.ibm.cognos=INFO
log4j.logger.com.cognos=INFO
```

More specific logging is available by changing the logging level for classes lower than these top levels. For example, it is possible to get **WARNING** logging for everything but to log TurboIntegrator process calls at the **DEBUG** level.

```bash
#System logging settings
log4j.rootLogger=ERROR, TextFile
log4j.logger.com.ibm.cognos=WARNING
log4j.logger.com.cognos=WARNING
```
You can enable performance logging in the service by commenting out the standard logging and including the following performance entries in the properties file:

```
# System logging settings
log4j.rootLogger=ERROR, Console, TextFile
log4j.logger.com.ibm.cognos=DEBUG
log4j.logger.com.cognos=DEBUG
log4j.logger.com.cognos.org=ERROR
log4j.logger.com.ibm.cognos.perf=ERROR

# Performance logging settings
log4j.rootLogger=ERROR, perfConsole, perfText
log4j.logger.com.ibm.cognos.perf=DEBUG
```

**Note:** You can also monitor TM1 Application Server using TM1 Operations Console. See the IBM Cognos TM1 Operations Console Guide.

---

**Cognos TM1 Application Server advanced installation and configuration**

You can perform advanced installation and configuration tasks to customize your installation of the IBM Cognos TM Application Server components.

**Install Cognos TM1 Application Server with your own installation of Apache Tomcat web application server**

This section describes how to install Cognos TM1 Application Server on a separate computer and deploy it with your own installation of Apache Tomcat.

This installation is intended for an environment where the TM1 Admin Server and TM1 Server are running on another computer.

**Building application files for a Tomcat server**

You use IBM Cognos Configuration to build the application files to deploy to your Apache Tomcat server.

**About this task**

You can create a Web archive (WAR) file or an Enterprise archive (EAR) file. For information about WAR and EAR files and which is supported by your application server, see the documentation for your application server.

**Procedure**

1. Click **Start > All Programs > IBM Cognos TM1 > IBM Cognos Configuration.**
2. Click **Action > Build Application Files.**
3. Under Applications, select **TM1 Application Server.**
4. Check the application server type **Apache Tomcat.** Click **Next.**
5. Select the file type and the location to save the files. The default location is `<your installation location>\ibm\cognos\TM1\`. Click **Next.**
6. Wait for the **Build Application Wizard** to complete the process. Click **Finish.**

**What to do next**

You can deploy the application file to your application server.
Configuring authentication security for Cognos TM1 Application Web

For the IBM Cognos TM1 servers used with Cognos TM1 Application Web, use either TM1 standard security authentication or IBM Cognos security.

About this task

Configure the authentication login mode using the IntegratedSecurityMode parameter in the Tm1s.cfg file of each Cognos TM1 server that you want to use.

Cognos TM1 Application Web is compatible only with the following TM1 security authentication modes:
- Authentication mode 1 - TM1 standard security authentication
- Authentication mode 5 - IBM Cognos security

Important: Do not use a combination of different security authentication modes for the same installation of Cognos TM1 Application Web.

For best practice, determine the security mode before you configure Cognos TM1 Application Web to use a Cognos TM1 server and use that same security mode with any additional servers you add.

For more details about security authentication and the IntegratedSecurityMode parameter, see:
- “Authentication security” on page 181
- “IntegratedSecurityMode” on page 275

Procedure

1. Open the file TMI server data directory/Tm1s.cfg
2. Set the IntegratedSecurityMode parameter for the Cognos TM1 Server.
   - To use Cognos TM1 standard security authentication, set IntegratedSecurityMode=1
   - To use IBM Cognos security, set IntegratedSecurityMode=5
   For details about using IBM Cognos security, see:
     - “Using Cognos TM1 Applications with Cognos security” on page 214
     - “Using Cognos security with Cognos TM1” on page 205
3. Save and close the Tm1s.cfg file.
4. Restart the Cognos TM1 Server.
5. Repeat these steps for any other Cognos TM1 Server you want to use with Cognos TM1 Application Web.

Configuring the server and client environment for Cognos TM1 Application Web

Before you use IBM Cognos TM1 Application Web, you need to specify the TM1 Admin Host, TM1 Server, and client user interfaces that you want to use. The first time that you start Cognos TM1 Application Web, the program prompts you to configure these options.

Before you begin

Ensure that the TM1 Admin Server and at least one TM1 Server is running on the local computer or a remote computer that you can access.
Ensure that each TM1 Server that you want to use is configured with the required parameter values. For details, see “Configuring a Cognos TM1 Server to work with Cognos TM1 Application Web” on page 138.

If you plan to use Cognos TM1 Application Web, ensure that you know the web server name and port number where Cognos TM1 Web is running.

**Procedure**

1. Start and log in to Cognos TM1 Application Web:
   a. In a web browser, type the URL for Cognos TM1 Application Web:
      
      http://localhost:9510/pmpsvc
   b. Replace localhost with the name of the computer where the Cognos TM1 Application Server is installed.

2. Open the Cognos TM1 Application Configuration page:
   - If this is the first time that Cognos TM1 Application Web has been started since the installation, the Configuration page opens.
   - If Cognos TM1 Application Web has already been configured, you are prompted for a user name and password and then you can open the configuration page by clicking the Administer IBM Cognos TM1 Applications button on the toolbar of the Cognos TM1 Application Web main page.

3. In the **Admin Host** field, enter the name or IP address of the computer where the Cognos TM1 Admin Server is running.

   **Note:** The **Admin Host** and **Server Name** fields appear blank if you have not started the Cognos TM1 Admin Server and at least one Cognos TM1 server.

4. In the **Server Name** field, enter the name of the TM1 Server that you want to use with Cognos TM1 Application Web.
   For example, you could specify the sample TM1 server **GO_New_Stores**.
   Click the **Refresh** button to refresh the list of available servers.

5. Select the data contribution clients that you want to use with Cognos TM1 Application Web.
   These clients will be available when you create applications with IBM Cognos TM1 Performance Modeler.
   - **Include Cognos Insight - Connected** - IBM Cognos Insight client using real time processing with the TM1 server.
   - **Include Cognos Insight - Distributed** - IBM Cognos Insight client with local processing of data. Data is updated to the TM1 server only when a commit data action is performed.
   - **Include TM1 Application Web** - Default client. Processing is in real time with the server. This option uses the data grid and charting client infrastructure from Cognos TM1 Web and requires that you enter a value for the **TM1 Application Web URL** option.

6. If you selected the **Include TM1 Application Web** option, enter a value for the **TM1 Application Web URL** option.
   This URL points to the **Contributor.jsp** file on the web server that is hosting Cognos TM1 Web.
   For example:
   
   http://WebServer:9510/tm1web/Contributor.jsp
   where **WebServer** is the name of the computer where Cognos TM1 Web is installed.
7. Click OK.
8. If prompted, enter the **username** and **password** for the server and click **Login**.

   **Tip:** Use `admin` and `apple` for the user name and password if you are using one of the installed sample databases.

The Cognos TM1 Application Web main page displays. This page appears blank until you build and deploy applications inside of Cognos TM1 Application Web. For more details, see the IBM Cognos Performance Modeler and IBM Cognos Insight documentation.

**Results**

The following message indicates that the Cognos TM1 server that you are using is not properly configured for use with Cognos TM1 Application Web:

The new server can be added but it may not be configured with all the options required by IBM Cognos TM1 Applications.

For information on how to configure this server, see “Configuring a Cognos TM1 Server to work with Cognos TM1 Application Web” on page 138.

**Install Cognos TM1 Application Server with your own installation of IBM Websphere**

This section describes how to install Cognos TM1 Application Server on a separate computer and deploy it with your own installation of IBM WebSphere.

This installation is intended for an environment where the TM1 Admin Server and TM1 Server are running on another computer.

To deploy the TM1 Application Server to WebSphere, complete these tasks:

- Build the application files using Cognos Configuration. See “Building application files for an IBM WebSphere server.” A pmsvc.war file is created. The default location is `<your installation location>/ibm/cognos/TM1`.

  **Note:** You can use the EAR file format instead of WAR.

- **Deploy the pmsvc.war file to the WebSphere application server**

**Building application files for an IBM WebSphere server**

You use IBM Cognos Configuration to build application files to deploy to an IBM WebSphere server.

**About this task**

You can create a web archive (WAR) file or enterprise archive (EAR) file for the following TM1 applications:

- TM1 Planning Services: pmsvc.war/ear
- TM1 Web and TM1 Applications Web tm1web.war/ear
- IBM Performance Management Hub and TM1 Operations Console: pmhub.war/ear

You can then deploy the WAR or EAR files to WebSphere.
Procedure

1. Click Start > All Programs > IBM Cognos TM1 > IBM Cognos Configuration.
2. Click Actions > Build Application Files.
3. Under Applications, select TM1 Application Server.
4. Under Application Server Type, select IBM Websphere. Click Next.
5. Select the file type.
6. Specify where to save the application files. The default location is <your installation location>/ibm/cognos/TM1. Click Next.
7. Wait for the Build Application Wizard to complete the process. Click Finish.

What to do next

You can deploy the application files to your WebSphere Application Server. See “Deploying TM1 Application Server to an IBM WebSphere Application Server,” “Installing TM1 Web with IBM WebSphere” on page 112 and “Installing Cognos TM1 Operations Console to IBM WebSphere” on page 104.

Deploying TM1 Application Server to an IBM WebSphere Application Server

You can deploy and run IBM Cognos TM1 Application Server to an IBM WebSphere Application Server.

Before you begin

- Install IBM WebSphere Application Server.
- Create a profile using the Profile Management Tool.
- Start the WebSphere Application Server using the profile that you created.
  
  In Microsoft Windows, click Start > All Programs > IBM WebSphere Application Server > Profiles > [Profile Name] > Start the server.
  
  A command window opens and displays the start progress. After the start process is complete, the command window displays the message, “Server started.” You can minimize this command window, but do not close it. This window must remain open while WebSphere is running.
- Build the application files using Cognos Configuration. See “Building application files for an IBM WebSphere server” on page 144.

For information about installing WebSphere and creating a profile, see the WebSphere documentation.

About this task

These steps are based on IBM WebSphere Application Server 8.5.5. The steps for version 8.5 are similar.

Note: After you start completing steps in the WebSphere application installation wizard, click Cancel to exit if you decide not to install the application. Do not simply move to another administrative console page without first clicking Cancel on an application installation page.

Procedure

1. Verify that you have a minimum of 6 GB of free disk space on the computer where WebSphere is installed.
On UNIX, ensure that the disk mounted to /tmp has at least 6 GB available. Use df to check both the total space and percent used for tmpfs.

**Note:** Do not deploy TM1 Application Server until you have verified that sufficient disk space is available.

2. Open the WebSphere administrative console.
   - In Windows, click **Start > All Programs > IBM WebSphere Application Server > Profiles > [Profile Name] > Administrative console.** Or, go to https://localhost:9043/ibm/console/.
   - In UNIX, click **Applications > IBM Websphere > IBM Websphere Application Server > Profiles > [Profile Name] > Admin Console.** Or, go to https://localhost:9043/ibm/console/.

3. Log in using the WebSphere profile that you created. The administrative console opens.

4. Set the JVM stack memory size.
   a. Click **Servers > Server Types > WebSphere application servers.**
   b. Click the server where you are deploying TM1 Application Server.
   c. Under Server Infrastructure, click **Java and Process Management > Process Definition.**
   d. Under Additional Properties, click **Java Virtual Machine.**
   e. In the **Generic JVM arguments** field, add `-Xms512k`

   **DANGER**
   
   Do not deploy TM1 Application Server until you have set the stack memory.

   Do not use the startServer.sh file to set the stack memory size. WebSphere removes the `-Xms` setting from the file when the server starts and overrides it with the default value, which is too small.
   f. Click **Apply**, and then click **OK.** Click **Save.**

5. Click **Applications > New Application**, and then click **New Enterprise Application.**

6. Click **Browse** to locate and select the pmpsvc.war file that you generated using the Build Application File command in Cognos Configuration. Click **Open.**

7. Click **Next.**

8. Click **Fast Path**, and then click **Next.**

9. Click **Step 4: Map context roots for Web modules.**

10. In the Context Root box, enter `/pmpsvc`. Click **Next.**

11. Click **Finish.** WebSphere installs the application. This process can take a few minutes to complete.

    When installation is complete, WebSphere displays "Application pmpsvc_war installed successfully."

12. Click **Save.**

13. Click **Applications > Application Types > WebSphere Enterprise Applications.**

14. Select the check box next to pmpsvc_war, and then click **Start.** WebSphere displays "Application pmpsvc_war on server server_name and node node started successfully. The collection may need to be refreshed to show the current status."
Troubleshooting TM1 Application Server deployment on IBM WebSphere:

If the TM1 Application Server (pmpssvc.war) deployment fails with a Java heap space error message, try adjusting the Java parameters in the WebSphere administrative console.

**Note:** You may have to reapply this change if you upgrade or modify your installation of WebSphere at a later date.

**Procedure**

1. Open the WebSphere administrative console.
   * In Windows, click **Start > All Programs > IBM WebSphere Application Server > Profiles > [Profile Name] > Administrative console**. Or, go to https://localhost:9043/ibm/console/.
   * In UNIX, click **Applications > IBM Websphere > IBM Websphere Application Server > Profiles > [Profile Name] > Admin Console**. Or, go to https://localhost:9043/ibm/console/.
2. Log in using the WebSphere profile that you used to deploy TM1 Application Server. The administrative console opens.
3. Click **Servers > Server Types > WebSphere application servers**.
4. Click the server where you deployed TM1 Application Server.
5. Under Server Infrastructure, click **Java and Process Management > Process Definition**.
6. Under Additional Properties, click **Java Virtual Machine**.
7. In the **Initial heap size** field, type 1024.
8. In the **Maximum heap size** field, type 2048.
9. Click **Apply**, and then click **OK**. Click **Save**.
10. Restart WebSphere.

Configuring authentication security for Cognos TM1 Application Web

For the IBM Cognos TM1 servers used with Cognos TM1 Application Web, use either TM1 standard security authentication or IBM Cognos security.

**About this task**

Configure the authentication login mode using the **IntegratedSecurityMode** parameter in the Tm1s.cfg file of each Cognos TM1 server that you want to use.

Cognos TM1 Application Web is compatible only with the following TM1 security authentication modes:

- Authentication mode 1 - TM1 standard security authentication
- Authentication mode 5 - IBM Cognos security

**Important:** Do not use a combination of different security authentication modes for the same installation of Cognos TM1 Application Web.

For best practice, determine the security mode before you configure Cognos TM1 Application Web to use a Cognos TM1 server and use that same security mode with any additional servers you add.

For more details about security authentication and the **IntegratedSecurityMode** parameter, see:
Procedure
1. Open the file TM1 server data directory/Tm1s.cfg
2. Set the **IntegratedSecurityMode** parameter for the Cognos TM1 Server.
   - To use Cognos TM1 standard security authentication, set `IntegratedSecurityMode=1`
   - To use IBM Cognos security, set `IntegratedSecurityMode=5`
   For details about using IBM Cognos security, see:
   - “Using Cognos TM1 Applications with Cognos security” on page 214
   - “Using Cognos security with Cognos TM1” on page 205
3. Save and close the Tm1s.cfg file.
4. Restart the Cognos TM1 Server.
5. Repeat these steps for any other Cognos TM1 Server you want to use with Cognos TM1 Application Web.

**Configuring the server and client environment for Cognos TM1 Application Web**

Before you use IBM Cognos TM1 Application Web, you need to specify the TM1 Admin Host, TM1 Server, and client user interfaces that you want to use. The first time that you start Cognos TM1 Application Web, the program prompts you to configure these options.

**Before you begin**

Ensure that the TM1 Admin Server and at least one TM1 Server is running on the local computer or a remote computer that you can access.

Ensure that each TM1 Server that you want to use is configured with the required parameter values. For details, see “Configuring a Cognos TM1 Server to work with Cognos TM1 Application Web” on page 138.

If you plan to use Cognos TM1 Application Web, ensure that you know the web server name and port number where Cognos TM1 Web is running.

**Procedure**
1. Start and log in to Cognos TM1 Application Web:
   a. In a web browser, type the URL for Cognos TM1 Application Web:
      ```html
      http://localhost:9510/pmpsvc
      ```
   b. Replace `localhost` with the name of the computer where the Cognos TM1 Application Server is installed.
2. Open the Cognos TM1 Application Configuration page:
   - If this is the first time that Cognos TM1 Application Web has been started since the installation, the Configuration page opens.
   - If Cognos TM1 Application Web has already been configured, you are prompted for a user name and password and then you can open the configuration page by clicking the Administer IBM Cognos TM1 Applications button on the toolbar of the Cognos TM1 Application Web main page.
3. In the **Admin Host** field, enter the name or IP address of the computer where the Cognos TM1 Admin Server is running.
Note: The **Admin Host** and **Server Name** fields appear blank if you have not started the Cognos TM1 Admin Server and at least one Cognos TM1 server.

4. In the **Server Name** field, enter the name of the TM1 Server that you want to use with Cognos TM1 Application Web.
   For example, you could specify the sample TM1 server **GO_New_Stores**.
   Click the **Refresh** button to refresh the list of available servers.

5. Select the data contribution clients that you want to use with Cognos TM1 Application Web.
   These clients will be available when you create applications with IBM Cognos TM1 Performance Modeler.
   - **Include Cognos Insight - Connected** - IBM Cognos Insight client using real time processing with the TM1 server.
   - **Include Cognos Insight - Distributed** - IBM Cognos Insight client with local processing of data. Data is updated to the TM1 server only when a commit data action is performed.
   - **Include TM1 Application Web** - Default client. Processing is in real time with the server. This option uses the data grid and charting client infrastructure from Cognos TM1 Web and requires that you enter a value for the **TM1 Application Web URL** option.

6. If you selected the **Include TM1 Application Web** option, enter a value for the **TM1 Application Web URL** option.
   This URL points to the **Contributor.jsp** file on the web server that is hosting Cognos TM1 Web.
   For example:
   - `http://WebServer:9510/tm1web/Contributor.jsp`
   where **WebServer** is the name of the computer where Cognos TM1 Web is installed.

7. Click **OK**.

8. If prompted, enter the **username** and **password** for the server and click **Login**.

   **Tip:** Use **admin** and **apple** for the user name and password if you are using one of the installed sample databases.

The Cognos TM1 Application Web main page displays. This page appears blank until you build and deploy applications inside of Cognos TM1 Application Web. For more details, see the IBM Cognos Performance Modeler and IBM Cognos Insight documentation.

**Results**

The following message indicates that the Cognos TM1 server that you are using is not properly configured for use with Cognos TM1 Application Web:

The new server can be added but it may not be configured with all the options required by IBM Cognos TM1 Applications.

For information on how to configure this server, see "Configuring a Cognos TM1 Server to work with Cognos TM1 Application Web" on page 138.
Configuring Cognos TM1 Application Web to use Multiple Cognos TM1 Servers

When you start IBM Cognos TM1 Application Web for the first time, you can enter only one Cognos TM1 server with which you want to work.

To enter additional servers, use the Configuration page in Cognos TM1 Application Web.

**Important:** In order to use multiple Cognos TM1 servers in Cognos TM1 Application Web, the servers must all use the same security authentication (either Cognos TM1 standard authentication or Cognos BI security) and include the same administrator user name and password. For details, see “Security considerations when using Cognos TM1 Applications” on page 37.

After you add multiple Cognos TM1 servers, they are available when you use IBM Cognos TM1 Performance Modeler to design your planning applications.

For more details, see the *IBM Cognos TM1 Performance Modeler User Guide*.

**Procedure**

1. Log in to Cognos TM1 Application Web.
2. On the toolbar of the, click the Administer Cognos TM1 Applications button. The *IBM Cognos TM1 Applications Configuration* page opens.
3. In the Server Names section, click Add. The Add Server dialog box opens.
4. Enter values for the following:
   - **Admin Host** - Specify the computer name or IP address of the Admin Host on which the Cognos TM1 Admin Server is running. Click the Refresh button to update the Server Name list with the available servers for the Admin Host you entered.
   - **Server Name** - Select a Cognos TM1 server to use with Cognos TM1 Application Web. For example: Planning Sample.
5. Click OK. If you receive a warning message about the configuration of the TM1 Server, make a note of the warnings and then click Close to continue. For information about the required settings, see “Configuring a Cognos TM1 Server to work with Cognos TM1 Application Web” on page 138. The Admin Host and Cognos TM1 server name you entered are added to the Server Names section.
6. To add more servers, click Add and repeat the steps.
7. When you are finished adding TM1 servers, click OK on the IBM Cognos TM1 Applications Configuration page.

**Results**

The Cognos TM1 servers you added can now be used to design your planning applications.

**Using a proxy**

You can set up a proxy server that forwards requests from IBM Cognos TM1 client applications to the TM1 Application Server.
A proxy server (sometimes called a reverse proxy) can provide benefits such as the following:

- Hide the existence and characteristics of the application server
- Optimize request processing
- Distribute load
- Perform front-end auditing
- Perform additional security

Also, a proxy is required when the internal domains and ports of the TM1 Application Server are not available for direct access from the Internet where TM1 client applications are used.

A proxy environment consists of the following components:

- The TM1 client application, such as IBM Cognos Analysis for Microsoft Excel, in the Internet
- Proxy server, TM1 Application Server, and TM1 Server in the internal network
- If you are using Cognos security with TM1, the Cognos Business Intelligence server in the internal network

For more details, see "Running IBM Cognos Analysis for Microsoft Excel (CAFE) behind a proxy server" [http://www-01.ibm.com/support/docview.wss?uid=swg27045323]

Configuring Cognos TM1 TurboIntegrator function security in Insight

When you open an IBM Cognos Insight workspace that has been shared through IBM Cognos Connection, you may want to restrict the execution of some TurboIntegrator functions, particularly those that can destroy or modify data files.

Several TurboIntegrator functions exist that can write files, delete files, and execute commands. When you receive a shared Insight workspace, it is possible that TurboIntegrator processes within the workspace could include functions that perform undesirable actions. To prevent processes from performing potentially harmful actions, your Insight installation includes a configuration file named TMIFunctions.cfg, which can be used to prevent or restrict the execution of TurboIntegrator functions.

Any TurboIntegrator function can be entirely prevented from executing. The ASCIIOutput, TextOutput, and ASCIIDelete functions can also be configured to run in restricted mode. When a function runs in restricted mode, it is limited to acting upon files within the TM1 server data directory and its subdirectories.

When you install IBM Cognos Insight, a default version of TMIFunctions.cfg is created in C:\Documents and Settings\<user>\Application Data\IBM\Cognos Insight\bins\bin_xxx. <user> is the username under which you installed Insight and xxx is the version of your installation.

The default version of TMIFunctions.cfg appears as follows:

```plaintext
ExecuteCommand=0
AsciiOutput=1
TextOutput=1
AsciiDelete=1
```
When a function is set to 0 in TM1Functions.cfg, the function is prevented from executing. Any attempt to execute that function will cause TurboIntegrator to throw a security exception.

When a function is set to 1 in TM1Functions.cfg, the function runs in restricted mode. Only the ASCIIOutput, TextOutput, and ASCIIDelete functions can be set to run in restricted mode.

When a function is not present in TM1Functions.cfg, it runs completely unrestricted.

**Examples of functions running in restricted mode**

When a function is configured to run in restricted mode, any relative path passed as an argument to the function is assumed to be rooted in the TM1 server data directory and is allowed. Any absolute path to a directory above the TM1 server data directory prevents the function from executing and causes a security exception to be thrown at runtime.

For example, assume `AsciiDelete=1` in TM1Functions.cfg. In this case, the function

```
ASCIIDelete('logs\sample.log');
```

is allowed and deletes the file sample.log from the logs subdirectory of the TM1 server data directory.

However, the function

```
ASCIIDelete('c:\autoexec.bat');
```

will not execute and will cause a security exception, as it specifies a file at the root level of the drive, which is above the TM1 server data directory.

Similarly, assume `TextOutput=1` in TM1Functions.cfg. In this case, the function

```
TextOutput('logs\sample.txt', 'this is sample text');
```

is allowed and writes a string to the sample.txt file in the logs subdirectory of the TM1 server data directory.

Conversely, the function

```
TextOutput('c:\autoexec.bat', 'del *.* -r -f');
```

is not allowed due to the path being specified at the root level of the drive. This function will cause a security exception to be thrown at runtime.

**Editing the TM1Functions.cfg file**

The TM1Functions.cfg file lets you prevent or restrict the execution of potentially harmful TurboIntegrator functions contained within a shared IBM Cognos Insight workspace.

**About this task**

When you install IBM Cognos Insight, a default version of TM1Functions.cfg is created in `C:\Documents and Settings\<user>\Application Data\IBM\Cognos\`

**Installation and Configuration Guide**
Insight\bins\bin_xxxx. <user> is the username under which you installed Insight and xxxx is the version of your installation. You can modify this configuration file to further restrict function execution or allow function execution.

Procedure
1. Open TM1Functions.cfg in a text editor.
2. To completely prevent a function from executing, set the function name equal to 0. For example, ExecuteCommand=0 or ServerShutdown=0.
3. To allow a function to run in restricted mode, set the function name equal to 1. For example, AsciiDelete=1. Only the ASCIIOutput, TextOutput, and ASCIIDelete functions can be set to run in restricted mode.
4. To allow a function to run unimpeded, delete the function name from TM1Functions.cfg.
5. Save and close TM1Functions.cfg.
Chapter 12. Cognos TM1 client and developer tier installation

You can install IBM Cognos TM1 client and developer tier components using the Cognos TM1 server installation program or the Cognos TM1 client installation program.

You can install the following client and developer components:
- Cognos TM1 Perspectives
- Cognos TM1 Architect
- Cognos TM1 Performance Modeler
- Cognos Insight
- Cognos TM1 APIs

For information about using the TM1 APIs to enable Cognos BI reporting against Cognos TM1 data sources, see “Cognos TM1 as a datasource with Cognos BI” on page 66 and “Enabling Cognos BI reporting on Cognos TM1 data sources” on page 67.

Related concepts:
- “Upgrading Cognos TM1 Architect and Perspectives clients” on page 55

You can upgrade IBM Cognos TM1 client components using the Cognos TM1 server installation program or the Cognos TM1 client installation program.

Installing Cognos TM1 Perspectives

You can install IBM Cognos TM1 Perspectives by performing the following steps.

Before you begin

Before you install IBM Cognos TM1 Perspectives, complete the following tasks:
1. Install the software that is necessary for you to run Cognos TM1 Perspectives. For more information, see “Install the prerequisite software” on page 73.
2. Ensure that the Cognos TM1 Admin Server and the Cognos TM1 Server that you want to connect to are running on an accessible computer in your network. For details, see Chapter 8, “Cognos TM1 Server installation,” on page 83.
3. Ensure that users have access to the Cognos TM1 servers that they need to use running under that Cognos TM1 Admin Server. As a Cognos TM1 administrator, you must set up a user name and password for each user before a user can access that server.

About this task

The following steps install Cognos TM1 Perspectives on a single computer, configure it to locate a Cognos TM1 Administration Server on your network, and then connect to a server. You can also create an unattended installation.

Attention: If you are upgrading and leave your old Tm1p.ini client configuration files in place, you might need to update the directory path in the file for the AdminSvrSSLCertAuthority parameter. For example, if you are using the default Cognos TM1 SSL certificate, manually change the value for this parameter to the new install path C:\Program Files\IBM\cognos\tm1\bin\ssl\applixca.pem.
Procedure

1. Install Cognos TM1 Perspectives:
   a. On Microsoft Windows Vista, Windows 7 or Windows Server 2008 operating system software, right-click the istsetup.exe file and click Run as Administrator. For other operating systems, double-click the istsetup.exe file on the IBM Cognos TM1 client installation disk or from the location where the Cognos TM1 client installation files were downloaded and extracted.
   b. On the Component Selection page, expand TM1 Client Tier, and select the TM1 Perspectives check box. Leave all the other check boxes unselected.
   c. Follow the prompts and click Finish to complete the installation.

2. Run Cognos TM1 Perspectives:
   a. Click Start > IBM Cognos TM1 > Perspectives for MS Excel. If the component does not start, ensure that the servers you started with Cognos Configuration are still running.
   b. Click Enable Macros when the security warning displays.

3. Configure Cognos TM1 Perspectives to locate a Cognos TM1 Admin Server:
   a. In Microsoft Excel, click TM1 > Options. The TM1 Options dialog box opens.
   b. In the Admin Host field, specify the name of the computer on which the Cognos TM1 Admin Server is running. If you want to access servers registered on different Admin Servers, use a semicolon to separate the name of each Admin Host. You must enter a name, not an IP address, in the Admin Host field.
   c. Click OK.
   d. When prompted about disconnecting from currently accessed servers, click Yes if you want to access a new list of servers. Servers available through Admin Server on the specified Admin Host appear. If you want to continue to see the current list of remote servers during this session, click No.

4. Launch Server Explorer.

5. Double-click a Cognos TM1 Server to log in.
   For either Planning Sample or SDATA, use these login credentials:
   • User name: admin
   • Password: apple

   Tip: To load Cognos TM1 Perspectives automatically whenever you start Microsoft Excel, add TM1_location/Tm1p.x1a to Microsoft Excel’s add-in tool list, where TM1_location is the file directory where Cognos TM1 is installed. After completing this step, "TM1" displays on the Microsoft Excel menu bar.

6. If you want to install Cognos TM1 Perspectives on multiple computers, use the previous steps to create an unattended installation that can. For details, see Appendix C, “Setting up unattended installations and configurations,” on page 321.

Installing Cognos TM1 Architect

You can install IBM Cognos TM1 Architect by performing the following steps.
Before you begin

Before you install Cognos TM1 Architect, complete the following tasks:

- Install the software that is necessary for you to run Cognos TM1 Architect. For more information, see “Install the prerequisite software” on page 73.
- Ensure that the Cognos TM1 Admin Server and the Cognos TM1 Server that you want to connect to are running on an accessible computer in your network. For details, see Chapter 8, “Cognos TM1 Server installation,” on page 83.
- Ensure that users have access to the Cognos TM1 servers that they need to use running under that Cognos TM1 Admin Server. As a Cognos TM1 administrator, you must set up a user name and password for each user before a user can access that server.

About this task

You can configure IBM Cognos TM1 Architect to locate a Cognos TM1 Administration Server on your network, and then connect to a server. You can also create an unattended installation.

Attention: If you are upgrading and leave your old Tm1p.ini client configuration files in place, you might need to update the directory path in the file for the AdminSvrSSLCertAuthority parameter. For example, if you are using the default Cognos TM1 SSL certificate, manually change the value for this parameter to the new install path C:\Program Files\IBM\cognos\tm1\bin\ssl\applixca.pem.

Procedure

1. Install Cognos TM1 Architect:
   a. On Microsoft Windows Vista, Windows 7, or Windows Server 2008 operating system software, right-click the issetup.exe file and click Run as Administrator. For other operating systems, double-click the issetup.exe file on the IBM Cognos TM1 client installation disk or from the location where the IBM Cognos TM1 client installation files were downloaded and extracted.
   b. On the Component Selection page, expand Developer Tier, and select the TM1 Architect check box. Leave all the other check boxes unselected.
   c. Follow the prompts and click Finish to complete the installation.
2. Run Cognos TM1 Architect:
   a. Click Start > IBM Cognos TM1 > Architect. If the component does not start, ensure that the servers you started with Cognos Configuration are still running.
3. Configure Cognos TM1 Architect to locate a Cognos TM1 Admin Server:
   a. Open Server Explorer.
   b. Select TM1.
   c. Click File > TM1 Options.
   d. In the Admin Host field, specify the name of the computer on which the TM1 Admin Server is running. You must enter a name, not an IP address, in the Admin Host field.
   Tip: If you want to access servers registered on different Admin Servers, use a semicolon to separate the name of each Admin Host.
   e. Click OK.
f. When prompted about disconnecting from currently accessed servers, click **Yes** if you want to access a new list of servers. Servers available through Admin Server on the specified Admin Host appear. If you want to continue to see the current list of remote servers during this session, click **No**.

4. Double-click a Cognos TM1 Server to log in.
   For either Planning Sample or SData, use these login credentials:
   - **User name**: admin
   - **Password**: apple

5. If you want to install Cognos TM1 Architect on multiple computers, use the previous steps to create an unattended installation. For details, see Appendix C, “Setting up unattended installations and configurations,” on page 321.

### Installing Cognos TM1 Performance Modeler

You can choose different ways to distribute and install IBM Cognos TM1 Performance Modeler across multiple computers.

The following table summarizes the different ways to distribute and install Cognos TM1 Performance Modeler across multiple computers.

| Table 20. Multiple computer installation options for Cognos TM1 Performance Modeler |
|----------------------------------|---------------------------------------------------------------|
| **Installation option**          | **Description**                                               |
| "Installing Cognos TM1 Performance Modeler using the installation program" | Administrators or end users can install Cognos TM1 Performance Modeler on a single computer using the IBM Cognos TM1 Client-only installation program. Optionally, use these steps to create an unattended installation to install Cognos TM1 Performance Modeler on multiple computers. |
| "Installing Cognos TM1 Performance Modeler from the Cognos TM1 Applications portal" on page 159 | As a prerequisite, an administrator must install Cognos TM1 Applications. This allows Cognos TM1 users to install Cognos TM1 Performance Modeler onto their computers the first time that they launch it from the IBM Cognos Applications Portal. This is called a provisioned installation. For more information about publishing workspaces, see the IBM Cognos TM1 Performance Modeler User Guide. |
| "Remotely installing Cognos TM1 Performance Modeler on multiple computers" on page 160 | An administrator can use third-party network installation tools to push Cognos TM1 Performance Modeler out to multiple remote client systems. |

#### Installing Cognos TM1 Performance Modeler using the installation program

You can interactively install a stand-alone version of IBM Cognos TM1 Performance Modeler on one or more computers.

**Procedure**

1. Run the installation program:
• On Microsoft Windows Vista, Windows 7, or Windows Server 2008 operating system software, right-click the issetup.exe file and click Run as Administrator.
• For other operating systems, double-click the issetup.exe file on the IBM Cognos TM1 client installation disk or from the location where the IBM Cognos TM1 client installation files were downloaded and extracted.

2. On the Component Selection page, expand Developer Tier, and select the Performance Modeler check box. Leave all the other check boxes unselected.

3. Follow the prompts and click Finish to complete the installation.

4. To test the installation, open Cognos TM1 Performance Modeler from the toolbar of the Cognos TM1 Applications portal page.
   a. In a web browser, type the Cognos TM1 Applications URI:
      For example, http://localhost:9510/pmpsvc
      • Replace localhost with the name of the computer where the Cognos TM1 Application Server is installed.
      • If required, change the port number if you used a different value in IBM Cognos Configuration for the TM1 Application Server Gateway URI property.
   b. From the Cognos TM1 Applications portal, click the Open Performance Modeler icon.

5. If you want to install the program on multiple computers, use the previous steps to create an unattended installation. For details, see Appendix C, “Setting up unattended installations and configurations,” on page 321.

Installing Cognos TM1 Performance Modeler from the Cognos TM1 Applications portal

You can install IBM Cognos TM1 Performance Modeler the first time you run the component from the IBM Cognos TM1 Applications portal.

Before you begin

Before you install Cognos TM1 Performance Modeler from the Cognos TM1 Applications portal, the administrator must install Cognos TM1 Applications.

Procedure

1. In a web browser, type the Cognos TM1 Applications portal URI:
   For example, http://localhost:9510/pmpsvc
   a. Replace localhost with the name of the computer where the Cognos TM1 Application Server is installed.
   b. If required, change the port number if you used a different value in IBM Cognos Configuration for the TM1 Application Server Gateway URI property.

2. From the Cognos TM1 Applications portal, click the Open Performance Modeler icon.
   If this is the first time you have used Cognos TM1 Performance Modeler, the Install Now icon displays to indicate that you are about to install the Cognos TM1 Performance Modeler client to your computer.

3. Click Install Now.

4. Click Finish to complete the installation.
What to do next

For information on using IBM Cognos TM1 Performance Modeler, see the IBM Cognos TM1 Performance Modeler User Guide.

Remotely installing Cognos TM1 Performance Modeler on multiple computers

As an administrator, you can push the IBM Cognos TM1 Performance Modeler installation to users automatically. First, you make the Cognos TM1 Performance Modeler installer file available in a shared folder on your network. You can then use an application such as Microsoft Active Directory to automatically install the client application to authenticated users.

About this task

Cognos TM1 Performance Modeler is installed using an installer file that you put in a shared location. You can use Active Directory to install Cognos TM1 Performance Modeler directly to users' computers.

Use the PerformanceModeler.msi file to install Cognos TM1 Performance Modeler. This file is installed to the following location when you install the Cognos TM1 Application Gateway component:

\tm1 location\webapps\pmpsvc\rcp_installs

You can use the PerformanceModeler.msi file with Windows Installer command line options and also use Active Directory or other software management tools to push the install out to remote computers.

The PerformanceModeler.msi file is a standard Microsoft Windows Installer file. You can use the PerformanceModeler.msi file with Windows Installer command line options and also use Active Directory or other software management tools to push the install out to remote computers.

The following table lists some of the property values that administrators can use to install the PerformanceModeler.msi file. For complete details, see the Microsoft developer web site for documentation about the “Windows Installer Guide” and “Windows Installer Property Reference”.

Table 21. Property values for Cognos TM1 Performance Modeler

<table>
<thead>
<tr>
<th>Property Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALLUSERS=1</td>
<td>Installs the MSI for all users. This property value ensures that the registry entries for Cognos TM1 Performance Modeler are located in HKEY_LOCAL_MACHINE. Note: You must use this property with the TARGETDIR property.</td>
</tr>
<tr>
<td>ALLUSERS=&quot;&quot;</td>
<td>Installs the MSI only for the user who is running the installation. Only that user will have access to the application</td>
</tr>
<tr>
<td>(default value)</td>
<td></td>
</tr>
</tbody>
</table>
Table 21. Property values for Cognos TM1 Performance Modeler (continued)

<table>
<thead>
<tr>
<th>Property Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TARGETDIR= &quot;Performance Modeler_install location&quot;</td>
<td>Specifies the install location for the MSI. For example, TARGETDIR=&quot;C:\Program Files&quot;</td>
</tr>
<tr>
<td>TARGETDIR= (default value)</td>
<td>When used with ALLUSERS=&quot;&quot; On Windows XP, the install location is C:\Documents and Settings\username\Application Data\IBM\Cognos TM1 Performance Modeler On Windows 7, the install location is C:\Users\username\AppData\Roaming\IBM\Cognos TM1 Performance Modeler When used with ALLUSERS=1 On Windows XP, the install location is C:\Documents and Settings\All Users\Application Data\IBM\Cognos TM1 Performance Modeler On Windows 7, the install location is C:\Program Data\IBM\Cognos TM1 Performance Modeler</td>
</tr>
<tr>
<td>NOUPDATE=Yes</td>
<td>Prevents Cognos TM1 Performance Modeler users from receiving automatic updates. This value is recommended when end users do not have write access to the application install location. Auto-updating requires that Cognos TM1 Performance Modeler users can write to the location specified, or defaulted to, by the TARGETDIR property.</td>
</tr>
<tr>
<td>NOUPDATE=No (default value)</td>
<td>Allows Cognos TM1 Performance Modeler users to receive automatic updates.</td>
</tr>
</tbody>
</table>

An example is shown in the following steps.

**Procedure**
1. Open a command prompt, and navigate to the location of the PerformanceModeler.msi file.
2. To install Cognos TM1 Performance Modeler for all users, type the following command
   ```shell
   PerformanceModeler.msi TARGETDIR="install_location" ALLUSERS=1
   ```

**Configuring logging for Cognos TM1 Performance Modeler**
You can enable logging for IBM Cognos TM1 Performance Modeler using the same logging framework as other components in IBM Cognos TM1.
Procedure

1. Locate the provagent_NOT.ini and rename the file to provagent.ini.
   This file is located here:
   C:\Users\<user_name>\AppData\Roaming\IBM\Cognos Performance Modeler
2. Edit the provagent.ini to uncomment the following line.
   Change #app-debug=true to app-debug=true.
3. In this same directory location, open and edit the defaultLog.properties file to configure logging.

   Note: By default, logging is configured to log ERROR level messages for day-to-day purposes and typically does not need to be adjusted. This can be changed to WARNING, INFO, or DEBUG level messages to get varying levels of logging information. Work with IBM Customer Support to change the logging configuration to record more specific messages.

Results

Log files are typically written out to the following location:

%appdata%\IBM\application_name\logs

Avoiding OutOfMemory Exceptions thrown by TM1 Performance Modeler

When using IBM Cognos TM1 Performance Modeler with limited memory installed, you might encounter an OutOfMemory Exception.

While it is not possible to completely avoid exceptions without installing additional memory, you can minimize the risk of getting the errors by setting the free.memory.error.threshold.percent parameter in the PerformanceModeler.ini file.

By setting the free.memory.error.threshold.percent parameter, a warning message is displayed that asks you to save your work and log off when the amount of free space falls below the configurable threshold. Then you must restart TM1 Performance Modeler and continue working.

The warning message is displayed on the screen and is also included in the log files. No checking is done if the parameter is not set. A memory check is carried out whenever you alter the model. Examples of model alterations include adding a new member to a dimension, or creating a new model object.

To create a threshold, follow this procedure:

Procedure

1. Close TM1 Performance Modeler.
2. Locate the PerformanceModeler.ini file, which is in the same directory as PerformanceModeler.exe.
3. Set the threshold by adding the following line:
   "-free.memory.error.threshold.percent 10.0"

   Note: This sets the threshold to 10%.
4. Save the file, close it, and launch TM1 Performance Modeler.
Installing Cognos Insight

You can choose different ways to distribute and install IBM Cognos Insight across multiple computers.

Depending on your computer network environment and business needs, you can install the application, allow users to install as needed, or remotely push the application out.

The following table summarizes the different ways to distribute and install IBM Cognos Insight across multiple computers.

<table>
<thead>
<tr>
<th>Table 22. Multiple computer installation options for Cognos Insight</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Installation option</strong></td>
</tr>
<tr>
<td>“Installing Cognos Insight using the installation program”</td>
</tr>
<tr>
<td>“Installing Cognos Insight from the Cognos TM1 Applications portal” on page 164</td>
</tr>
<tr>
<td>“Remotely installing Cognos Insight on multiple computers” on page 164</td>
</tr>
</tbody>
</table>

Installing Cognos Insight using the installation program

You can interactively install a stand-alone version of IBM Cognos Insight on one or more computers.

Procedure

1. On Microsoft Windows Vista, Windows 7, or Windows Server 2008 operating system software, right-click the issetup.exe file and click Run as Administrator. For other operating systems, double-click the issetup.exe file on the IBM Cognos TM1 client installation disk or from the location where the IBM Cognos TM1 client installation files were downloaded and extracted.
2. On the Component Selection page, expand TM1 Client Tier and select the Cognos Insight check box. Leave all the other check boxes unselected.
3. Follow the prompts and click Finish to complete the installation.
4. To test the installation, open Cognos Insight from Start > Programs > IBM Cognos Insight > IBM Cognos Insight.
5. To install the program on multiple computers, use the previous steps to create an unattended installation. For details, see Appendix C, “Setting up unattended installations and configurations,” on page 321.
Installing Cognos Insight from the Cognos TM1 Applications portal

You can install IBM Cognos Insight the first time you run the component from the toolbar of the IBM Cognos TM1 Applications portal.

Before you begin

Before you install Cognos Insight from Cognos TM1 Applications, the administrator must install Cognos TM1 Applications.

Procedure

1. In a web browser, type the Cognos TM1 Applications portal URI:
   For example, http://localhost:9510/pmpsvc
   a. Replace localhost with the name of the computer where the Cognos TM1 Applications Portal is installed.
   b. If required, change the port number if you used a different value in IBM Cognos Configuration for the TM1 Application Gateway URI property.

2. From the Cognos TM1 Applications portal, click the Open IBM Cognos Insight icon.
   If this is the first time you have used Cognos Insight, the Install Now icon displays to indicate that you are about to install the Cognos Insight client to your computer.

3. Click Install Now.

4. Click Finish to complete the installation.

What to do next

Cognos Insight is now installed in a folder on your computer. You will be able to run and use Cognos Insight in the following ways:

- You can launch Cognos Insight using the Open Cognos Insight icon in Cognos TM1 Applications.
- You can launch the Cognos Insight client by right-clicking a node of an application that has been configured to use Cognos Insight.
- Cognos Insight is available as a client from an application only if you configured the client environment for Cognos TM1 Applications to use the Cognos Insight Distributed or Connected client. For more information, see “Configuring the server and client environment for Cognos TM1 Application Web” on page 134.
- You can launch Cognos Insight as a stand-alone product from the Windows Start > Programs > IBM Cognos Insight menu.

Remotely installing Cognos Insight on multiple computers

As an administrator, you can push the IBM Cognos Insight installation to users automatically. First, you make the Cognos Insight installer file available in a shared folder on your network. You can then use an application such as Microsoft Active Directory to automatically install the client application to authenticated users.

About this task

Cognos Insight is installed using an installer file that you put in a shared location. You can use Active Directory to install Cognos Insight directly to users’ computers.
Use the CognosInsight.msi file to install Cognos Insight. This file is installed to the following location when you install the IBM Cognos TM1 Application Gateway component:

\tm1 location\webapps\pmpsvc\rcp_installs

You can use the CognosInsight.msi file with Windows Installer command line options and also use Active Directory or other software management tools to push the install out to remote computers.

The CognosInsight.msi file is a standard Microsoft Windows Installer file. You can use the CognosInsight.msi file with Windows Installer command line options and also use Active Directory or other software management tools to push the install out to remote computers.

The following table lists some property values that administrators can use to install the CognosInsight.msi file. For complete details, see the Microsoft developer web site for documentation about the “Windows Installer Guide” and “Windows Installer Property Reference”.

Table 23. Property values for Cognos Insight

<table>
<thead>
<tr>
<th>Property Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALLUSERS=1</td>
<td>Installs the MSI for all users. This property value ensures that the registry entries for Cognos Insight are located in HKEY_LOCAL_MACHINE. <strong>Note</strong>: You must use this property with the TARGETDIR property.</td>
</tr>
<tr>
<td>ALLUSERS=&quot;&quot;</td>
<td>(default value) Installs the MSI only for the user who is running the installation. Only that user will have access to the application</td>
</tr>
<tr>
<td>TARGETDIR=&quot;CognosInsight_install location&quot;</td>
<td>Specifies the install location for the MSI. For example, TARGETDIR=&quot;C:\Program Files&quot;</td>
</tr>
</tbody>
</table>
Table 23. Property values for Cognos Insight (continued)

<table>
<thead>
<tr>
<th>Property Value</th>
<th>Description</th>
</tr>
</thead>
</table>
| TARGETDIR=     | When used with ALLUSERS=""
| (default value) | On Windows XP, the install location is C:\Documents and Settings\username\Application Data\IBM\Cognos Insight
|                | On Windows 7, the install location is C:\Users\username\AppData\Roaming\IBM\Cognos Insight
|                | When used with ALLUSERS=1
|                | On Windows XP, the install location is C:\Documents and Settings\All Users\Application Data\IBM\Cognos Insight
|                | On Windows 7, the install location is C:\Program Data\IBM\Cognos Insight |

| NOUPDATE=Yes   | Prevents Cognos Insight users from receiving automatic updates.
|                | This value is recommended when end users do not have write access to the application install location. Auto-updating requires that Cognos Insight users can write to the location specified, or defaulted to, by the TARGETDIR property. |
| NOUPDATE=No    | Allows Cognos Insight users to receive automatic updates. |

An example is shown in the following steps.

**Procedure**

1. Open a command prompt, and navigate to the location of the CognosInsight.msi file.
2. To install Cognos Insight for all users, type the following command
   CognosInsight.msi TARGETDIR="install_location" ALLUSERS=1

**Configuring logging for Cognos Insight**

You can enable logging for IBM Cognos Insight using the same logging framework as other components in IBM Cognos TM1.
Procedure
1. Locate the provagent_NOT.ini and rename the file to provagent.ini.
   This file is located here:
   `C:\Users\<user_name>\AppData\Local\Programs\IBM\Cognos Insight`
2. Edit the provagent.ini to uncomment the following line:
   Change `#app-debug=true` to `app-debug=true`.
3. In this same directory location, open and edit the defaultLog properties file to configure logging.

   Note: By default, logging is configured to log ERROR level messages for day-to-day purposes and typically does not need to be adjusted. This can be changed to WARNING, INFO, or DEBUG level messages to get varying levels of logging information. Work with IBM Customer Support to change the logging configuration to record more specific messages.

Results
Log files are typically written out to the following location:

`%appdata%\IBM\application_name\logs`

Installing Cognos TM1 APIs
Use the TM1 API installation option to install the required files that enable programmers to work with the Cognos TM1 application programming interfaces (APIs). This installation option can also be installed on Cognos Business Intelligence (BI) servers to enable Cognos BI reporting against Cognos TM1 data sources.

About this task
This option installs files for the following Cognos TM1 APIs:

**TM1 API**
- Allows developers to create custom C, C++, and VB applications that interact with TM1.

**TM1 Java API**
- Allows developers to create custom Java applications that interact with TM1.

**TM1 .NET API**
- Allows developers to create custom Microsoft .NET applications that interact with TM1.

Attention: For information about using the TM1 APIs to enable Cognos BI reporting against Cognos TM1 data sources, see “Cognos TM1 as a datasource with Cognos BI” on page 66.

Procedure
1. Run either the full IBM Cognos TM1 installation program or the client-only installation program:
   - On Microsoft Windows Vista, Windows 7, or Windows Server 2008 operating system software, right-click the issetup.exe file and click Run as Administrator.
• For other Windows operating systems, double-click the `issetup.exe` file.

2. Select the installation location on the **Installation Location** page:
   • If you are planning on using the TM1 APIs for programming, accept the default installation.
   • If you are using the TM1 APIs to enable Cognos BI reporting against Cognos TM1 data sources, select an adjacent directory on the Cognos BI server that is running report services on Microsoft Windows.

3. On the **Component Selection** page:
   a. Expand the **TM1 Client Tier** and select the **TM1 APIs** option.
   b. Unselect the check boxes for all the other components.

4. Follow the prompts and click **Finish** to complete the installation.

---

### Configuring client computers to export Cognos TM1 data in PDF format

To export IBM Cognos TM1 data to Adobe PDF format from IBM Cognos TM1 client applications running in Microsoft Windows, set PDFCamp as your default printer. These steps apply to IBM Cognos TM1 Perspectives, IBM Cognos TM1 Architect, and IBM Cognos TM1 Web.

**Before you begin**

Verify that PDFCamp is installed correctly by confirming that *PDFCamp Printer Driver* exists in the Windows *Printers and Faxes* configuration.

**Procedure**

1. In Windows, open the *Printers and Faxes* configuration window.
2. Right-click *PDFCamp Printer Driver* and select *Set as Default Printer*. 
Chapter 13. Cognos TM1 sample databases installation

IBM Cognos TM1 samples illustrate product features and technical and business best practices. You can also use them for learning the product, testing, and troubleshooting.

Cognos TM1 samples overview

Cognos TM1 samples are available for a variety of uses and are optimized for different clients. Some of the samples are ready to use right after installation while others require extra steps to use them. By default Cognos TM1 samples are installed in two different locations. If selected in the installation wizard, the product samples are installed as follows:

SData, Planning Sample, GO_New_Stores, GO_Scorecards, and Proven_Techniques

These samples are installed by default in the tm1_location\samples\tm1 location.

SData and Planning Sample were specifically designed to be used with Cognos TM1.

To use them, start each sample database in Cognos Configuration after installation.

GO_New_Stores and Proven_Techniques are designed to highlight Cognos TM1 Performance Modeler, TM1 Applications, and Cognos Insight features.

The Proven_Techniques sample highlights cube calculations and functions. You can also import multiple applications in the portal and view them using Cognos Insight Connected mode.

The GO_Scorecards sample includes data that is optimized for use with the IBM Cognos Scorecard features found in Cognos TM1 Performance Modeler.

See “Using the sample databases installed by default” on page 170 for more information.

PData, Rules_Guide_Data, TI_Data

These samples are also designed specifically for Cognos TM1, however to use them you must first add each server in Cognos Configuration and then start them individually. They are installed into the tm1_location\samples\tm1 location.

GO_Contributor.zip, sample_outdoiors.zip, advanced_techniques.zip, greatoutdoors.zip, and GreatOutdoorsSales.zip

These samples are installed to the tm1_location\webcontent\samples\datasources\cubes\amdtool directory.

The GreatOutdoorsSales.zip samples require you to restore a database and connect to the database using an OLAP data source. The database files are installed with the samples, and are provided for IBM DB2®, Microsoft SQL Server, and Oracle databases.

The other samples are based on .csv files for their content and do not require a database to be restored. See “Using the GO_Contributor and Outdoors Company sample databases” on page 170 for more information.
**HumanResources.cdd, Orders.cdd and Training.cdd.**

A set of .cdd and data samples have been specifically designed for use with Cognos Insight workspace builder. These samples with localized versions are available TM1 installation location\webcontent\samples\datasources\cubes\amdtool\Source_files\desktop.

On UNIX, use the "./startup_tm1s.sh" command to start sample database servers. See “Starting a UNIX TM1 Server” and “Stopping a UNIX TM1 Server” in the IBM Cognos TM1 Operation Guide for more details.

---

**Using the sample databases installed by default**

The following sample databases are installed by default and can all be started from Cognos Configuration.

**About this task**

These databases are installed by default into the sample database location.

For example C:/Program Files/IBM/cognos/tm1/samples/tm1/SData

**SData** Data designed for use with TM1.

**Planning Sample**

Data designed for use with the Planning clients.

**GO_New_Stores**

Data designed for use with TM1 Applications, Cognos Insight, and Cognos TM1 Performance Modeler.

**GO_Scorecards**

Data designed for use the TM1 Scorecarding in TM1 Performance Modeler.

**Proven_Techniques**

This sample database uses cube calculations and features from more recent releases. This database is also designed for use with the TM1 Scorecard features in Cognos TM1 Performance Modeler.

**Procedure**

1. In Cognos Configuration, right click the database you want to start and select **Start**.
2. To open the databases, in TM1 Architect or TM1 Performance Modeler, double-click the database and use the default username of **admin** and password of **apple**.

---

**Using the GO_Contributor and Outdoors Company sample databases**

The following GO_Contributor and Outdoors Company samples are installed as .zip files that you must unzipped in order to use them.

**Procedure**

1. On the computer where you installed the TM1 server component, go to the tm1_location\webcontent\samples\datasources\cubes\amdtool folder.
2. Extract the contents of the GO_Contributor.zip or the Outdoors_Company.zip file. Be sure to do the extraction close to the root location such as c: so that the file path is not too long.
3. In the folder where you extracted the file, go to the Data Files folder, and open the tm1s.cfg file in a text editor.
   a. Ensure that the DatabaseDirectory location, the LoggingDirectory location, and the DistributedPlanningOutputDir use the correct path for the Data Files folder location where you extracted the Go_Contributor.zip and Outdoors_Company.zip files.
   b. Save and close the files.
4. Open IBM Cognos Configuration.
5. In the Explorer panel, under Data Access, right click TM1 Server, and click New Resource > TM1 Server Instances.
   a. In the Name box, enter GO Contributor or Outdoor Company.
   b. For the TM1 Server configuration path value, enter the path to the Data Files folder where you extracted the files.
      For example, tm1_location\samples\GO_Contributor
   c. In the Explorer panel, right-click GO Contributor or Outdoor Company and click Start.
6. Test that the new servers are available to Architect.
   a. Open Architect.
   b. Double click the server.
   c. In the Server Login box, enter admin in the UserName box and apple in the Password box.
7. To test that the new servers are available in the IBM Cognos Applications portal:
   a. Open the portal by typing the following: http://server_name:9510/pmpsvc.
   b. Click the Administer IBM Cognos TM1 Application icon.
   c. Under Server Names, click Add.
   d. Type the server name in Admin Host and then click the Refresh button.
   e. Select the sample you just added, and click OK.

Using the Great Outdoors Sales server samples based on the sample database

The Great Outdoors Sales sample uses data from a database. To use this sample you must restore the database, create an ODBC connection to the database, and then add the sample server to your system.

The database is provided for IBM DB2, Microsoft SQL Server, and Oracle.

The sample database and the Cognos TM1 server using the database are installed with Cognos TM1 server in the tm1_location/webcontent/samples/datasources folder.

When you create your ODBC connection, use GOSALES as the data source name. On Microsoft Windows operating systems, create the ODBC connection as a System DSN.

Restoring backup files for IBM DB2

Use the script that is provided to restore sample databases on IBM DB2.

To set up the sample database, you must extract the GS_DB.tar.gz file, customize a configuration file, and run the setup script.
Procedure
1. Go to the $tm1_location/webcontent/samples/datasources folder.
2. Extract the GS_DB.tar.gz file and retain the original directory structure.
   If you use WinZip to extract the GS_DB.tar.gz file on a Microsoft Windows operating system, ensure that the TAR file smart CR/LF conversion option is not selected.
3. On Linux and UNIX operating systems, modify the file permissions on the setupGSDB.sh file so that it is executable.
   For example, chmod u+x setupGSDB.sh
4. If you want to change the sample configuration file to use settings other than the default values, edit the GOSalesConfig file.
   The configuration file on Windows is GOSalesConfig.bat. The configuration file on Linux and UNIX is GOSalesConfig.sh.
   The GOSalesConfig configuration file contains the default configuration options that are used when creating the GOSALES data. The default configuration settings are listed in the following table

Table 24. Default configuration settings for GOSALES data

<table>
<thead>
<tr>
<th>Configuration Setting</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GOSALES_INST</td>
<td>GS_DB</td>
<td>Used to set the name or alias of the database.</td>
</tr>
<tr>
<td>GOSALES_CREATEDB</td>
<td></td>
<td>Optional: Causes an existing database with the same name to be dropped.</td>
</tr>
<tr>
<td>GOSALES_DB_TERRITORY</td>
<td>US</td>
<td>When creating a database this is the territory of the UTF-8 database that is created.</td>
</tr>
<tr>
<td>GOSALES_BP</td>
<td>GOSALES_BP</td>
<td>Optional: Enter the buffer pool and tablespace name, if these are to be created by the script.</td>
</tr>
<tr>
<td>GOSALES_TS</td>
<td>GOSALES_TS</td>
<td></td>
</tr>
<tr>
<td>GOSALES_GRANTEES</td>
<td>GOSALES, DB2ADMIN</td>
<td>Enter the list of users, groups or PUBLIC that will have CONTROL permissions for the GOSALES, GOSALESHR, GOSALESMR and GOSALESRT schemas. This string needs to follow the syntax of the GRANT command.</td>
</tr>
<tr>
<td>GOSALES DW_GRANTEES</td>
<td>GOSALES DW</td>
<td>Enter the list of users, groups or PUBLIC that will have CONTROL permissions for the GOSALES DW schema.</td>
</tr>
<tr>
<td>GOSALES_DPF</td>
<td>N</td>
<td>Change to ‘Y’ if installing a database partitioned environment (DPF)</td>
</tr>
</tbody>
</table>
Table 24. Default configuration settings for GOSALES data (continued)

<table>
<thead>
<tr>
<th>Configuration Setting</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GOSALES_SCHEMA</td>
<td>GOSALES</td>
<td>Enter the names to be used for each schema.</td>
</tr>
<tr>
<td>GOSALESHR_SCHEMA</td>
<td>GOSALESHR</td>
<td></td>
</tr>
<tr>
<td>GOSALESMR_SCHEMA</td>
<td>GOSALESMR</td>
<td></td>
</tr>
<tr>
<td>GOSALESRT_SCHEMA</td>
<td>GOSALESRT</td>
<td></td>
</tr>
<tr>
<td>GOSALESDW_SCHEMA</td>
<td>GOSALESDW</td>
<td></td>
</tr>
</tbody>
</table>

By default, the GS_DB database name is used and permissions are granted to the DB2ADMIN (Linux, UNIX, Windows) and GOSALES users.

5. To run the setupGSDB script in interactive mode, run following command:
   - On Windows computers, in an IBM DB2 command window, change to the GS_DB\win directory and run the setupGSDB.bat script.
   - On UNIX computers, from a shell prompt, source the db2profile, change to the GS_DB/unix directory, and run the setupGSDB.sh script.

The script displays a summary of your choices before you commit to changes to your environment. If you approve the choices, press Enter.

6. To run the setupGSDB script from the command line, run the following command:
   - On Windows computers, run the setupGSDB.bat script.
   - On UNIX computers, run the setupGSDB.sh script.

You can run the setupGSDB script with the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-createdb</td>
<td>Creates the database. This option drops any existing database with the same name. It creates the required buffer pool and table space.</td>
</tr>
<tr>
<td>-database database name</td>
<td>Specifies the name of the database. This value overrides the default value of GS_DB.</td>
</tr>
<tr>
<td>-userid administration_user_ID</td>
<td>Specifies the name of the DB2 administrator user ID that is used to create the database.</td>
</tr>
<tr>
<td>-password administration_user_ID</td>
<td>Specifies the password for the DB2 administrator user ID.</td>
</tr>
<tr>
<td>-noprompt</td>
<td>Indicates that no prompt will display. This option runs the script in silent mode. Any missing information causes the script to fail. You will not be prompted for any confirmations.</td>
</tr>
</tbody>
</table>

For example, if you are an IBM DB2 administrator and want to create the default GS_DB database on the local node, use the following command:

```
setupGSDB -createDB -noprompt
```

If you want to create the tables in an existing database named SAMPLE, and you want to use the administrator user ID db2admin, run the following command:

```
setupGSDB -database SAMPLE -userid db2admin
```
The script prompts you for the password when it connects to the database. The script will replace any tables that already exist in the database, unless you choose to drop the database.

7. If the GS_DB sample database is installed on a remote server in your environment, you can link to it by cataloging the remote database on your local computer and then running the setup script locally.
   a. If the sample database does not yet exist on the remote server, create it by using `CREATE DATABASE` command.
      The database requires a UTF-8 codeset and a default table space with apagesize of 16 KB or larger. For example, on the remote server, create the database by running the following command:
      ```sql
      CREATE DATABASE GS_DB USING CODESET UTF-8 TERRITORY US PAGESIZE 16k
      ```
   b. On your local computer, catalog the remote database by using the following command:
      ```bash
      db2 catalog tcpip node nodename remote ipaddr server port_number
db2 catalog database GS_DB as GS_DB at node nodename
      ```
   c. On your local computer, run the following command:
      ```bash
      setupGSDB -database GS_DB -userid administration_user_ID
      ```
      You are prompted for a password to connect to the database.

**Restoring backup files for Oracle**

Use the scripts that are installed with TM1 to quickly and conveniently restore backup files for sample databases in Oracle.

**About this task**

To set up the sample database, you must extract the GS_DB_ORA.tar.gz, file, customize a configuration file, and run the setup script.

**Procedure**

1. Go to the `tm1_location/webcontent/samples/datasources`.
2. Extract the GS_DB_ORA.tar.gz file and retain the original directory structure.
3. On Linux and UNIX operating systems, modify the file permissions on the `setupGSDB.sh` file so that it is executable:
   ```bash
   chmod u+x setupGSDB.sh
   ```
4. Ensure that the user ID used to set up the Oracle database has authority to create users and run the import utility.
5. Optional - If you want to change the sample configuration file to use settings other than the default values, edit the `GOSalesConfig` file.
   The configuration file on Windows is `GOSalesConfig.bat`. The configuration file on UNIX is `GOSalesConfig.sh`.
   The `GOSalesConfig` configuration file contains the default configuration options that are used when creating the GOSALES data. The default configuration settings are listed in the following table.
Table 25. Default configuration settings for GOSALES data

<table>
<thead>
<tr>
<th>Configuration Setting</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GOSALES_IMP_CMD</td>
<td>imp</td>
<td>If necessary can be modified to specify the complete path to the correct version of the import utility.</td>
</tr>
<tr>
<td>GOSALES_INST</td>
<td></td>
<td>Oracle host string.</td>
</tr>
<tr>
<td>GOSALES_TS</td>
<td>GOSALES_TS</td>
<td>If users are created by scripts, used to enter the tablespace name to assign to users.</td>
</tr>
<tr>
<td>GOSALES_CREATE_TS</td>
<td></td>
<td>Optional: Used to create the default tablespace for users.</td>
</tr>
<tr>
<td>GOSALES_TEMP_TS</td>
<td></td>
<td>If users are created by scripts, used to name a temporary tablespace to assign to users. Leave blank to use the default temporary tablespace.</td>
</tr>
<tr>
<td>GOSALES_SCHEMA</td>
<td>GOSALES</td>
<td>Used to enter the username and password for the GOSALES user. You will be prompted for a password if not entered.</td>
</tr>
<tr>
<td>GOSALES_SCHEMA_PW</td>
<td>GOSALESPW</td>
<td></td>
</tr>
<tr>
<td>GOSALESHR_SCHEMA</td>
<td>GOSALESHR</td>
<td>Used to enter the username and password for the GOSALESHR user. You will be prompted for a password if not entered.</td>
</tr>
<tr>
<td>GOSALESHR_SCHEMA_PW</td>
<td>GOSALESHRPW</td>
<td></td>
</tr>
<tr>
<td>GOSALESMR_SCHEMA</td>
<td>GOSALESMR</td>
<td>Used to enter the username and password for the GOSALESMR user. You will be prompted for a password if not entered.</td>
</tr>
<tr>
<td>GOSALESMR_SCHEMA_PW</td>
<td>GOSALESMRPW</td>
<td></td>
</tr>
<tr>
<td>GOSALESRT_SCHEMA</td>
<td>GOSALESRT</td>
<td>Used to enter the username and password for the GOSALESRT user. You will be prompted for a password if not entered.</td>
</tr>
<tr>
<td>GOSALESRT_SCHEMA_PW</td>
<td>GOSALESRTPW</td>
<td></td>
</tr>
<tr>
<td>GOSALESDW_SCHEMA</td>
<td>GOSALESDW</td>
<td>Used to enter the username and password for the GOSALESDW user. You will be prompted for a password if not entered.</td>
</tr>
<tr>
<td>GOSALESDW_SCHEMA_PW</td>
<td>GOSALESDWPW</td>
<td></td>
</tr>
</tbody>
</table>
Table 25. Default configuration settings for GOSALES data (continued)

<table>
<thead>
<tr>
<th>Configuration Setting</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GOSALES_GRANTEES</td>
<td>GOSALES</td>
<td>Used to enter the users that will have SELECT, INSERT, DELETE, UPDATE, and ALTER permissions for GOSALES, GOSALESHR, GOSALESMR and GOSALESRT schemas.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note</strong>: The owner of the GOSALES_SCHEMA will always be granted SELECT, INSERT, DELETE, UPDATE and ALTER privilege on all schemas.</td>
</tr>
<tr>
<td>GOSALESIW_GRANTEES</td>
<td>GOSALESIW</td>
<td>Used to enter the users that will have SELECT, INSERT, DELETE, UPDATE and ALTER permissions for GOSALESIW schema.</td>
</tr>
</tbody>
</table>

6. To run the setupGSDB script in interactive mode, run following command:
   - On Windows computers, in a DOS command window, change to the GS_DB_ORA\win directory and run the setupGSDB.bat script.
   - On UNIX computers, from a shell prompt, change to the GS_DB_ORA/unix directory, and run the setupGSDB.sh script.

   Press Enter to proceed. The script displays a summary of your choices before you commit to changes to your environment. If you approve the choices, press Enter and the script makes the changes.

7. To run the setupGSDB script from the command line, run the following command:
   - On Windows computers, run the setupGSDB.bat script.
   - On UNIX computers, run the setupGSDB.sh script.

   You can run the setupGSDB script with the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-createdb</td>
<td>Creates the database. This option drops any existing database with the same name. It creates the required buffer pool and table space.</td>
</tr>
<tr>
<td>-database database name</td>
<td>Specifies the name of the database. This value overrides the default value of GS_DB.</td>
</tr>
<tr>
<td>-userid administration_user_ID</td>
<td>Specifies the name of the DB2 administrator user ID that is used to create the database.</td>
</tr>
<tr>
<td>-password administration_user_ID</td>
<td>Specifies the password for the DB2 administrator user ID.</td>
</tr>
<tr>
<td>-noprompt</td>
<td>Indicates that no prompt will display. This option runs the script in silent mode. Any missing information causes the script to fail. You will not be prompted for any confirmations.</td>
</tr>
</tbody>
</table>
For example, if you are an Oracle administrator and want to create the default sample database schemas, run the following command:
```sh
done -createDB -noprompt
```
You want to create the tables in the existing schemas specified in the configuration file, and you want to use the administrator user ID sys. run the following command:
```sh
done -YourOracleInstance-userid sys -sysdba
```
The script prompts you for the password when it connects to the Oracle instance. The script deletes any existing tables or views in the specified schemas and replaces them.

Restoring backup files for Microsoft SQL Server
Use the Microsoft SQL Server database management tool to quickly and conveniently restore backup files for sample databases.

**Procedure**
1. On the computer where you installed TM1 server, go to the following directory:
   ```bash
tml_location/webcontent/samples/datasource/Source files/sqlserver
   ```
2. If required, copy the backup files for the samples databases to your database backup directory.
3. Restore the database from a device, and ensure that the restore locations are correct for the `.ldf` and `.mdf` database files.
   For more information, see the Microsoft SQL Server documentation or the IBM Cognos Knowledge Base on the IBM Cognos [Customer Center](http://ibmcognos.com).
4. Create at least one user who has select permissions for all the tables in the restored databases.

Setting up Great Outdoors Sales sample
The Great Outdoors Sales sample uses data from the database you restored.

**Procedure**
1. Create an ODBC data source connection to the restored database.
   Use `GOSALESDB` as the data source name. On Windows operating systems, create the ODBC connection as a System DSN.
2. On the computer where you installed the TM1 server component, go to the `tml_location/webcontent/samples/datasources/cubes/amdtool` folder.
3. Extract the contents of the `GreatOutdoorsSales.zip` file. Be sure to do the extraction close to the root location such as `c:` so that the file path is not too long.
4. In the folder where you extracted the `GreatOutdoorsSales.zip` file, go to the `DataFiles` folder, and open the `tm1s.cfg` file in a text editor.
   a. Ensure that the `DatabaseDirectory` location and the `LoggingDirectory` location use the correct path for the location where you extracted the `GreatOutdoorsSales.zip` file.
   b. Save and close the file.
5. Open IBM Cognos Configuration.
6. In the **Explorer** panel, under **Data Access**, right click **TM1 Server**, and click **New Resource** > **TM1 Server Instances**.
   a. In the **Name** box, enter `GreatOutdoorsSales`.
   b. For the TM1 Server configuration path value, enter the path to the `DataFiles` folder where you extracted the `GreatOutdoorsSales.zip` file.
For example, `tm1_location\webcontent\samples\datasources\cubes\amdtool\GreatOutdoorsSales\DataFiles`

c. In the Explorer panel, right-click GreatOutdoorSales and click Start.

7. Test that the new GreatOutdoorsSales server is available to Architect.
   a. Open Architect.
   b. Double click the GreatOutdoorsSales server.
   c. In the Server Login box, enter admin in the Username box and apple in the Password box.

8. Test that the new GreatOutdoorsSales server is available in the IBM Cognos Applications portal.
   a. Open the portal by typing the following: `http://server_name:9510/pmpsvc`.
   b. Click the Administer IBM Cognos Application icon on the far right hand side.
   c. Under Server Names, click Add.
   d. Type the server name in Admin Host and then click the Refresh button.
   e. Select the GreatOutdoorsSales sample you just added, and click OK.
Chapter 14. Cognos TM1 tools installation

A set of Cognos tools and utilities are installed when the TM1 Application Tier > TM1 Tools component is selected during installation.

These tools are optional components that you can choose not to install by unselecting the TM1 Tools component during installation. These tools are installed in <TM1_location>/bin

The tools installed in this group include:

- **TM1RunTI**
  
  TM1RunTI is a command line interface tool that can initiate a TM1 TurboIntegrator (TI) process from within any application capable of issuing operating system commands.
  
  Location: <TM1_location>/bin
  
  Filename: tm1runti.exe
  
  See the “Editing Advanced Procedures” chapter of the IBM Cognos TM1 TurboIntegrator Guide.

- **tm1xfer**
  
  The tm1xfer utility compresses and moves IBM Cognos TM1 server objects from one platform to another platform while preserving mixed case names for objects on both Microsoft Windows and UNIX platforms.
  
  Location: <TM1_location>/bin
  
  Filename: tm1xfer.cmd and tm1xfer.jar
  
  See the “Tools and Utilities” chapter of the IBM Cognos TM1 Operation Guide.

Other tools available for Cognos TM1 include:

- **Cognos TM1 Operations Console**
  
  The Cognos TM1 Operations Console can monitor multiple TM1 servers and provides extensive formatting capabilities for log files. The Cognos TM1 Operations Console has its own component that can be selected in the installation. See the IBM Cognos TM1 Operations Console Guide for details.

- **TM1 Top**
  
  TM1 Top monitors a single Cognos TM1 server. Installed by default. See the “System Performance and Monitoring” chapter of the IBM Cognos TM1 Operation Guide for details.

- **odbc_test**
  
  The odbc_test tool is used to diagnose and test an IBM Cognos TM1 ODBC connection on UNIX. See the “Tools and Utilities” chapter of the IBM Cognos TM1 Operation Guide for details.
Chapter 15. Security configuration

After you install IBM Cognos TM1, you can configure the specific authentication and security modes that you want to use.

This section describes authentication and data transmission security which are considered part of the overall installation and configuration process. The steps for user, group, and object security are typically done after the initial installation and configuration process and are described in separate documentation.

**Authentication security**

Authentication or login security configuration includes selecting the type of login security that will control user access to the different Cognos TM1 components.

**Data transmission security**

Security configuration includes optionally configuring Cognos TM1 to use SSL for secure data transmission.

**User and Group security**

Cognos TM1 manages security by organizing TM1 users into groups. TM1 includes a set of three predefined administrative groups and also allows you to create your own custom groups. Users can belong to one or multiple groups.

For information about configuring user and group security, see the *IBM Cognos TM1 Operation Guide*.

**Object security**

Another level of Cognos TM1 security is object security. This type of security allows you to control access to the specific TM1 objects in your data model, but it is not configured during the initial installation and configuration process.

For more information about the procedures required to set security for Cognos TM1 objects, see the *IBM Cognos TM1 Developer Guide*.

**Authentication security**

Authentication or login security configuration includes selecting the type of login security that will control user access to the different IBM Cognos TM1 components.

**Overview to authentication**

You can configure the IBM Cognos TM1 server to use a specific authentication mode to control user login access.

By default, when you install the Cognos TM1 server it is configured to use the standard Cognos TM1 authentication.

After you install the Cognos TM1 server, you can change the authentication method by changing the parameters in the TM1 configuration files.
Table 26. Cognos TM1 server authentication methods

<table>
<thead>
<tr>
<th>Authentication Methods</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TM1 Authentication</td>
<td>Cognos TM1 server asks you for a user name and password, and validates the login information against the security cube login information.</td>
</tr>
<tr>
<td>Integrated Login</td>
<td>Microsoft Windows performs the Cognos TM1 authentication.</td>
</tr>
<tr>
<td>LDAP Authentication</td>
<td>Cognos TM1 server asks you for a user name and password, and validates the login information against an external LDAP server.</td>
</tr>
<tr>
<td>IBM Cognos Security</td>
<td>The Cognos TM1 server authenticates users using IBM Cognos security.</td>
</tr>
</tbody>
</table>

**Standard Cognos TM1 authentication overview**

With IBM Cognos TM1 authentication, the Cognos TM1 server checks the user name and password against the user names and passwords in the Cognos TM1 database.

**Standard TM1 Security**

![Diagram of Standard TM1 Security]

**Integrated Login overview**

With Integrated Login, IBM Cognos TM1 uses the Microsoft Windows network authentication to access your Cognos TM1 data. After you log in to your Microsoft Windows workstation, you can access Cognos TM1 without entering a user name and password again.

Integrated Login is supported on Microsoft Windows only. You cannot use Integrated Login to access a Cognos TM1 server that is running on a UNIX operating system.
LDAP Authentication overview

With LDAP authentication, an LDAP security service that is external to IBM Cognos TM1 authenticates a login (as of Cognos TM1 version 8.2.2). You can add, modify, and delete user security information from one location - the LDAP server or Microsoft Windows Active Directory.

Authentication using LDAP

Cognos Security

The IBM Cognos TM1 server can authenticate users using IBM Cognos security.

Cognos security is a component of the IBM Cognos framework that manages user access to data. Cognos security manages authorization and authentication through
third-party security providers, such as LDAP or Active Directory. When a user is authenticated through Cognos security, they are provided with a Cognos security "passport." This passport is then used by Cognos TM1 applications to determine the user's permissions (role and group membership) and identity.

**Security considerations when using Cognos TM1 Applications**

You can use either IBM Cognos TM1 standard security authentication or IBM Cognos security for the Cognos TM1 servers you use with Cognos TM1 Applications.

Do not use a combination of different security authentication modes for the same installation of Cognos TM1 Applications.

Determine the security mode before you configure Cognos TM1 Applications to use a Cognos TM1 server and use that same security mode with any additional servers you add.

For details about using Cognos security, see: "Using Cognos TM1 Applications with Cognos security" on page 214.

**Using the IntegratedSecurityMode parameter with Cognos TM1 Applications**

To set the Cognos TM1 security authentication mode use the IntegratedSecurityMode parameter in the Tm1s.cfg file of each Cognos TM1 server you want to use.

**Important:** The Cognos TM1 Applications component is compatible only with Cognos TM1 security authentication modes 1 and 5.

For example, to use Cognos TM1 standard security authentication, set the IntegratedSecurityMode parameter to 1 for each server.

IntegratedSecurityMode=1

To use IBM Cognos security, set the IntegratedSecurityMode parameter to 5.

IntegratedSecurityMode=5

For more details about the IntegratedSecurityMode parameter, see the "TM1 System Configuration" section in the IBM Cognos TM1 Operations Guide.

If **IntegratedSecurityMode=5** is used for the IBM Cognos TM1 Server and IBM Cognos TM1 Applications, it is not possible to assign rights to native TM1 groups within the Manage rights dialog. Only Cognos Groups imported into the TM1 Server, are available. This means you cannot use native TM1 groups and Cognos groups in parallel because the SecMode is limiting which groups can be used.

**Configuring Cognos TM1 Applications security for multiple Cognos TM1 Servers**

If you want to use multiple Cognos TM1 servers with Cognos TM1 Applications, they must all be configured to use the same security authentication (either Cognos TM1 standard authentication or Cognos security) and include the same administrator user name and password.
For more details, see “Configuring Cognos TM1 Application Web to use Multiple Cognos TM1 Servers” on page 150.

ETLDAP utility

The ETLDAP utility enables you to move information from your LDAP (Lightweight Directory Access Protocol) directory to IBM Cognos TM1.

You can use ETLDAP to add LDAP users to Cognos TM1 when using Cognos TM1 with Integrated Login and LDAP authentication.

Note: You can only use the ETLDAP utility to add new LDAP users to Cognos TM1. ETLDAP does not modify, update or delete existing users in Cognos TM1.

ETLDAP, an LDAP load tool, provides the following functionality:

- Extracts user information from an LDAP or Active Directory server.
- Creates the element UniqueID in the }ClientProperties dimension.
- Adds users to the }ClientProperties cube.
- Populates the UniqueID field in the }ClientProperties cube with the domain-qualified user name of the user you add to IBM Cognos TM1 database. For example, ETLDAP writes the name robert@company.com to the }ClientProperties cube.

As the Cognos TM1 administrator, you can perform these tasks using ETLDAP:

- Add many user names from an LDAP server to the Cognos TM1 database quickly.
- Migrate information from a legacy LDAP database to Cognos TM1.
- Perform one or more queries to specify the users you want to create in Cognos TM1, and then export the users into the Cognos TM1 security cubes.
- Update Cognos TM1 with new users that have been added to the LDAP server since the initial load of user data into Cognos TM1.

Note: The ETLDAP utility is not available when the Cognos TM1 server is configured to use IBM Cognos Access Manager (CAM) authentication.

Modifying LDAP attributes

The value of an attribute you retrieve from an LDAP directory may not precisely match what you want to enter in the IBM Cognos TM1 security cube.

If so, you must modify certain LDAP attributes before you can run ETLDAP.

For example, you could combine all users from the R&D, Quality Assurance, and Documentation LDAP groups into a single Cognos TM1 group named Engineering. To support these requirements, you can extend a Java class with a single method you need to override.

The stringFilter class contains one method with the following signature:

String filterString(String attrName, String value)

At run time, this method is passed the name of each LDAP attribute that matches a mapping entry and its value. The String it returns is added to the Cognos TM1 database.
The following code demonstrates the implementation of the stringFilter class, combining all users from the R&D, Quality Assurance, and Documentation LDAP groups into a single Cognos TM1 group named Engineering.

The stringFilter class looks for instances of the LDAP ou attribute, which is the Cognos TM1 Group names field. If the value is **R&D**, **Quality Assurance**, or **Documentation**, it returns **Engineering**. The users from any of the 3 LDAP groups is added to a single Cognos TM1 **Engineering** group. Any other group value remains unchanged.

```java
// The stringFilter class provides the ability to transform strings
// which are read from the LDAP database before they are inserted into // TM1's datastore.
// To implement this feature, create a class which extends stringFilter
// and contains a method 'filterString' with the following signature:

// String filterString(String attrName, String value)

public class myStringFilter extends stringFilter {
    public String filterString(String attrName, String value)
    {
        if (attrName.equals("ou"))
            {
                if ( (attrName.equals("R&D")) ||
                    (attrName.equals("Quality Assurance")) ||
                    (attrName.equals("Documentation"))
                )
                    return "Engineering";
                else
                return value;
        }
        else
        return value;
    }
}
```

After you write and compile the Java code, put the class somewhere in your Classpath. Then click **Edit > Options** and enter its name in the **Class Name** field.

**Running ETLDAP**

You can run ETLDAP from the Microsoft Windows operating system or the DOS command window with command-line parameters.

**Procedure**

1. If you want to run ETLDAP from the Microsoft Windows operating system, complete the following actions:
   - Click **Start > Programs > IBM Cognos > TM1 > Administration > ETLDAP**.
   - Set the elements that you require.
Table 27. Elements in the LDAP Load Tool dialog box.

<table>
<thead>
<tr>
<th>Field or Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search DN</td>
<td>Displays the LDAP node at which the search originates. ETLDAP does not search for entries above this level in the tree.</td>
</tr>
<tr>
<td>Filter</td>
<td>Displays the query string that filters the entries in the directory and generates the matching records.</td>
</tr>
</tbody>
</table>
| Attributes      | Displays the attribute values for LDAP entries that assist in validating the records returned by the search. When you export the LDAP information to TM1, ETLDAP retrieve the attributes required to create valid TM1 users.  
<Note>: The attributes are for display purposes only. |
| Search Scope    | Specifies the starting point of the search, and the search level. Select One level to specify all entries one level below the base Search DN, but not the base DN itself. Select Sub-tree level to search all entries beneath the base DN, including the base DN. |
| Results Table   | Displays the search results. Click the column headers to sort the data, or right-click in a row and click View Entry to examine all attributes for that entry. |
| Search Button   | Performs the search using the parameters you select. |
| Export Button   | Exports the displayed set of users to TM1 based on the settings in the Options dialog box. |

2. If you want to run ETLDAP from the DOS command window, complete the following actions:
   - Click Start > Programs > Accessories > Command Prompt.
   - Enter the following command line:
     `java etldap options`
   - Add the parameters that you require.

Table 28. Supported command-line parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-f filename</td>
<td>Passes the name of a saved session file to load all configuration settings from a previous session. When you run ETLDAP in unattended (batch) mode, you must include a name for the session save file. If this file does not contain the passwords necessary to connect to the LDAP and Cognos TM1 server, an error message is written to the log file and the session is terminated.</td>
</tr>
<tr>
<td>-batch</td>
<td>Runs ETLDAP in command-line mode with no user interface. Requires the -f option.</td>
</tr>
</tbody>
</table>
Table 28. Supported command-line parameters (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-secure</td>
<td>When you run ETLDAP in batch mode, passing this flag removes all passwords from the session file referenced by the -f flag after they have been read. This parameter reads the save file at the beginning of the session, and then re-writes the file with the passwords removed. While in use, you would run ETLDAP and specify the passwords with the user interface. Then you would exit ETLDAP and run the command line version specifying the ‘-secure’ option. This would insure that the passwords were only available for the short period of time it takes for the utility to initialize.</td>
</tr>
<tr>
<td>-help</td>
<td>Displays online Help for these command-line parameters.</td>
</tr>
</tbody>
</table>

Configuring the LDAP login parameters

You can configure the LDAP login parameters.

Procedure

1. In the LDAP Load Tool dialog box, click File > Connect.
2. Enter the following host and user information.

<table>
<thead>
<tr>
<th>Panel</th>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host Info</td>
<td>Host</td>
<td>Enter the host name or IP address of the machine where the LDAP server is running.</td>
</tr>
<tr>
<td></td>
<td>Port</td>
<td>The port on which the LDAP server is running. If a port is not specified, 636 is used. Cognos TM1 attempts to bind to an LDAP server on the specified secure port. If you do not enter an LDAPPort value, Cognos TM1 uses the default value of port 636.</td>
</tr>
<tr>
<td></td>
<td>Version</td>
<td>ETL LDAP will most likely ignore the version number. Most LDAP servers support version 2 or version 3 type connections, ETL LDAP does not use any functionality specific to either version.</td>
</tr>
<tr>
<td></td>
<td>SSL option</td>
<td>Determines whether the communication between the LDAP server and ETL LDAP happens over a secure encrypted channel. Unless you are viewing secure information over an insecure network, leave this option turned off.</td>
</tr>
</tbody>
</table>
Panel  |  Field  |  Description
--- | --- | ---
 |  Anonymous option  |  Most LDAP servers have some layer of security configuration that requires you to authenticate as a known user. In some systems, anonymous users can browse the directory, but not retrieve the schema. In other systems, an anonymous user might have access to certain insecure areas of the directory, but not others.
 |  User Info  |  User DSN  |  In many cases, your LDAP directory prevents Anonymous users from accessing or modifying data. In this case, you may need a Distinguished Name (DN) and password to complete the extraction of your LDAP security information.

For example, the name Norm Lodin might refer to a person who works at Blodget, Inc. Inside LDAP, he has a Distinguished Name that uniquely distinguishes him from all other entities in the network.

Norm might enter the following information in the User Info field.

uid=nlodin, ou=People, o=Blodget.com

 |  Password  |  Enter a password that corresponds to the User DN.

3. To see if the connection is successful, click Test.
4. Click OK.

You have established a connection to your LDAP server with the parameters you specified.

**Building an LDAP query**

Use an LDAP query to add LDAP users and groups to IBM Cognos TM1.

**Before you begin**

An LDAP query consists of the following major elements:

- **Search DN** - An LDAP directory is organized as a tree structure, with a root node and a number of branches off this root. The Search DN specifies at which node the search originates. Entries above this level in the tree are searched. You must specify the correct base DN to obtain the results you want.

- **Filter** - A query string that filters the entries in the LDAP directory and generates the matching records. You can create complex filters by using a combination of the following symbols:

  & (AND)
  | (OR)
  ! (NOT)
  * wildcard character
  ( ) parentheses for nesting
For instructions on building LDAP filter strings, refer to LDAP books and online resources, including the LDAP standard, RFC 2254, *The String Representation of LDAP Search Filters*.

- **Scope** - While the Search DN specifies the starting point of the search, the Scope attribute indicate the level of depth to which the search occurs. There are two Scope levels:
  - **One Level** - Specifies that LDAP search all entries one level below the base DN, but does not include the base DN itself.
  - **Sub-Tree Level** - Indicates that LDAP search all records at all levels including the base DN.

The following diagram illustrates the effect that the Scope setting has on a search.

![Diagram showing the effect of Scope setting on a search]

- **Attributes** - Describe every LDAP entry and their values. Includes a comma-separated list of values to return for the records that match the filter string. There are two LDAP attributes:
  - **User attribute** - You add this attribute to the LDAP directory. For example, cn or mail.
  - **Operational attribute** - The LDAP server creates and maintains this attribute. For example, numSubordinates.

The attributes for an entry could include:
- Present with no value
- Present with one or more values
- Not present. If an attribute is optional, the attribute may not exist for an entry.

**Note**: Be sure to request only the attributes you need. If you request all attributes, a large result set can significantly increase processing time on the LDAP server and memory requirements on both the server and the client.

**Procedure**

1. Specify the Search DN, Filter String, Attributes, and Scope for your query.
2. Click **Search**.
   - You see a list of entries in the table, unless there are syntax errors or if the filter string does not match any records in the directory.
3. Examine the result set.
   - Does it include names that you do not want to see?
4. Make your changes to the filter string.
5. Click **Search**.
6. Examine the result set.
7. Repeat steps 3 through 6 until you have a list of valuable records.
8. Click **File, Save As** to save your LDAP query as a text file.

   **Note:** You can use the saved LDAP query at a later time. To do so, click **File > Open** in the LDAP Load Tool dialog box. ETLDAP fills in the DN, Filter String, Attributes, and Scope for your LDAP query.

### Connecting to the Cognos TM1 Server

Follow these steps to connect to the IBM Cognos TM1 server.

**Procedure**

1. Click **Edit > Login > TM1**.
2. Enter the following server information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host</td>
<td>The machine name of the server on which your TM1 Admin Server is running.</td>
</tr>
<tr>
<td>SSL port</td>
<td>Enter the port number configure which the admin server will use. The default is 5498</td>
</tr>
<tr>
<td>Server</td>
<td>The name of the TM1 server to which you want to connect. Click <strong>Server</strong> and then the <strong>Browse</strong> button to select a server from the Server list.</td>
</tr>
<tr>
<td>Username</td>
<td>The name of a user with Admin privileges on the target TM1 server.</td>
</tr>
<tr>
<td>Password</td>
<td>The password of the admin user.</td>
</tr>
</tbody>
</table>

3. To see if the connection is successful, click **Test**.
4. Click **OK**.

### Mapping LDAP attributes to Cognos TM1 fields

LDAP directories contain many attributes, some of which you standardize, and others which you add or customize for your environment. You must specify the relationship between the LDAP attributes and the required IBM Cognos TM1 fields manually.

**Before you begin**

You should be familiar with your LDAP schema.
Procedure
1. Click Edit > Mapping > TM1.
2. For each required (red) Cognos TM1 field, select an LDAP schema attribute. For each user, Cognos TM1 requires a unique name and group name. For example, you could map the name attribute in your LDAP schema to the Cognos TM1 user, and map the department attribute to the Cognos TM1 group.
3. Click OK.

Specifying the ETLDAP export options
You can specify the ETLDAP export options.

Procedure
1. Click Edit > Options.
2. Select Enable Integrated Login.
3. Enter the realm name that contains the users you want to transfer.
4. Clear Save Passwords. When you clear Save Passwords, ETLDAP removes all passwords necessary to connect to the servers before the session save file is written. The next time you run ETLDAP, you would have to enter the passwords again.
5. Set Maximum Search Results and Search Time Limit to 0.
6. Click OK.

Exporting LDAP information to Cognos TM1
You can export LDAP information to IBM Cognos TM1.

Procedure
1. Click Export.
   ETLDAP moves the records you retrieved from the LDAP directory into TM1, and logs the data export activity in a log file.

   Note: You can open the log before you export records to track the export progress.
2. Click View, Log to open the Session Log.
   The Session Log shows a summary of the LDAP users that ETLDAP exported and created in Cognos TM1. ETLDAP randomly generates the Cognos TM1 user passwords and adds them to the Cognos TM1 database.

   Note: If you use Integrated Login, Cognos TM1 users do not use the Cognos TM1 passwords, and you do not have to coordinate passwords between Cognos TM1 and Microsoft Windows. If you do not use Integrated Login, Cognos TM1 users must change their password during their first login session. For details, see “Integrated Login” on page 194.

Running ETLDAP in Update mode to add new LDAP users
You can run ETLDAP in Update mode to update IBM Cognos TM1 with new LDAP users that do not already exist in Cognos TM1. To do this, you specify a date in the Filter section of your LDAP query.

About this task
When you run ETLDAP the first time, you must retrieve all records from the LDAP server that meet your organizational requirements. You define these
requirements using the Filter parameter. After you retrieve all user and group records, you load them into the IBM Cognos TM1 database.

After using ETLDAP to initially load LDAP users into Cognos TM1, you can then only use the tool to retrieve and add new LDAP users that do not already exist in Cognos TM1. You cannot use the ETLDAP utility to update or delete existing users in Cognos TM1 based on changes in the LDAP directory.

As new users are added to your LDAP server, you can add them to Cognos TM1 by specifying a date in the Filter section of your LDAP query. Using a date in the Filter section runs ETLDAP in Update mode. You can edit your LDAP Filter to select only new user records that meet your original search requirements since the last time you ran ETLDAP.

**Note:** Running ETLDAP in Update mode only adds new LDAP users that do not already exist in Cognos TM1. ETLDAP does not update user attributes or delete existing Cognos TM1 users.

**Procedure**

1. Determine the last modified record attribute to specify a date in the Filter section of your LDAP query.

   All LDAP servers support a last modified record attribute, which includes these timestamp attributes:
   - **Standard LDAP** - modifytimestamp
   - **Microsoft Active Directory** - whenChanged

   During an export session, ETLDAP examines all records as it processes them and stores the date of the most recently changed record in the Session Log file, as shown in the following sample:

   ```
   newest record modified: Thu Jan 23 07:00:42 EST 2003(20030123070042.0Z)
   ```

2. Locate the newest record line in the LDAP Session Log.

3. Copy the timestamp portion of the string in parentheses from the LDAP Session Log into the Filter section of your LDAP query.

   **Note:** Be sure to adhere to the syntax supported by LDAP Filters. For more information, see the Internet standards protocol document, RFC 2254, “The String Representation of LDAP Search Filters”.

   The following table shows a sample Filter string without any changes, and after modification for both LDAP and Active Directory servers.

   - A standard LDAP server uses the modifytimestamp attribute.
   - An LDAP server with Microsoft Active Directory uses the whenChanged attribute.

<table>
<thead>
<tr>
<th>Sample Filter String</th>
<th>Filter String After Modification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initial string</td>
<td>{(&amp;(objectclass=person)(</td>
</tr>
<tr>
<td>Modified for standard LDAP</td>
<td>{(&amp;(objectclass=person)(modifytimestamp&gt; =20030515162433Z)(</td>
</tr>
<tr>
<td>Sample Filter String</td>
<td>Filter String After Modification</td>
</tr>
<tr>
<td>----------------------</td>
<td>----------------------------------</td>
</tr>
<tr>
<td>Modified for Active Directory</td>
<td></td>
</tr>
</tbody>
</table>

4. After you make the necessary changes to the Filter line, save the session data with a name that clearly identifies it as an incremental update query.
5. Run ETLDAP using the new session data.

**Integrated Login**

Integrated Login enables you to use Microsoft Windows network authentication to control access to IBM Cognos TM1 data.

In this security model, you can use the ETLDAP utility (see Running ETLDAP) or other steps to move user and group Microsoft Windows login information into the Cognos TM1 database. Users who want to access Cognos TM1 data through Cognos TM1 clients must log in to Microsoft Windows first. After they successfully log in to Microsoft Windows, Cognos TM1 does not ask for log in information.

Integrated Login matches the domain-qualified name you use to log in to Microsoft Windows with a name in the UniqueID field of the jClientProperties cube. If there is a match, Cognos TM1 allows you to log in.

As an example, suppose you log in with the user name Robert into the domain company.com. When you double-click a server in Server Explorer, Cognos TM1 looks in the jClientProperties cube and examines the UniqueID field of that cube. Robert has a domain-qualified name of robert@company. As long as Robert logs in to the COMPANY domain with the name Robert, Integrated Login should work for this user.

If Integrated Login cannot match the domain-qualified name you use to log in to Microsoft Windows with a name in the UniqueID field of the jClientProperties cube, Cognos TM1 displays an error message saying that the client name does not exist on the server.

Integrated Login is supported on Microsoft Windows only. You cannot use Integrated Login to access a UNIX version of the Cognos TM1 server.

**Configuring Cognos TM1 to use Integrated Login**

Use the following checklist as an overall guide to configure IBM Cognos TM1 components to use Integrated Login as the login authentication method for all users.

1. Complete the installation of the Cognos TM1 server and make sure you are able to run and log in to it.
2. Run the ETLDAP Utility to extract the user and group login data from your LDAP directory and load that data into the TM1 security cube. ETLDAP creates Cognos TM1 users from the LDAP data that you specify. These users are members of the same group to which they were assigned in your LDAP directory.
   For details, see “Running ETLDAP” on page 186.
3. Configure the Cognos TM1 server and client components to use Integrated Login.
Table 29. Summary of Integrated Login configuration for Cognos TM1 components

<table>
<thead>
<tr>
<th>Component</th>
<th>Required Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cognos TM1 Server</td>
<td>Configure the Integrated Login parameters in the Tm1s.cfg file for any TM1 database that you want to use with Integrated Login. For details, see &quot;Configuring Integrated Login for the Cognos TM1 server&quot; on page 196.</td>
</tr>
<tr>
<td>Cognos TM1 Clients</td>
<td>Enable the Use Integrated Login option for Cognos TM1 Architect and Cognos TM1 Perspectives. For details, see &quot;Configuring Cognos TM1 Perspectives to use Integrated Login&quot; on page 199 and &quot;Configuring Cognos TM1 Architect to use Integrated Login&quot; on page 198.</td>
</tr>
<tr>
<td>Cognos TM1 Web</td>
<td>Configure the following settings for Cognos TM1 Web: [tm1web_config.xml file]: Configure parameters in the tm1web_config.xml file that enable Integrated Login for Cognos TM1 Server Web. Note: You may also need to manually verify and/or configure your Kerberos security settings.</td>
</tr>
</tbody>
</table>

4. Set the access rights for Cognos TM1 users.
   For details, see “Configuring access rights for Cognos TM1 users.”

**Configuring access rights for Cognos TM1 users**

For an IBM Cognos TM1 user to access any data, you might have to assign that user to other Cognos TM1 groups. This topic explains how to add a user to the Admin group.

For example, for a user to publish public objects to the Web through Cognos TM1 Web, the user must be a member of the Cognos TM1 Admin group.

**Procedure**

1. Start Cognos TM1 Architect.
2. Click File > Options.
3. Clear the Use Integrated Login option.
4. Click OK.
5. In the Tree pane of Server Explorer, double-click TM1 to open the list of servers.
6. Double-click a server name.
7. Log in using your administrator login ID and password.
   - **Administrator name (default)** - admin
   - **Administrator password (default)** - apple
8. Right-click the server name, and click Security > Clients and Groups.
9. Select a user to add to the admin group. Use the scroll bar to scroll to the left, where the list of groups displays.
10. To add the user to the Admin group, select the check box in the ADMIN column for that user.
11. Click OK.
Configuring Integrated Login for the Cognos TM1 server

You can modify an IBM Cognos TM1 installation to use Integrated Login without re-installing Cognos TM1. To do so, run ETLDAP and modify several Cognos TM1 configuration files.

Procedure

1. Run ETLDAP and import the user and group information from your LDAP server, as described in “Running ETLDAP” on page 186.
2. Shut down the Cognos TM1 server.
3. Edit the following parameters in the Tm1s.cfg file located in your Cognos TM1 server data directory:
   - Set the IntegratedSecurityMode parameter to 2.
   - Set the SecurityPackageName parameter to the security protocol you use for Integrated Login, such as Kerberos (default).

   In the following example, the server is configured to use Kerberos.

   ```
   [TM1S]
   SecurityLogging=F
   SecurityPackageName=Kerberos
   IntegratedSecurityMode=2
   Servername=myserver
   DatabaseDirectory=C:\Program Files\n   ```

4. Save and exit Tm1s.cfg.
5. Restart the Cognos TM1 server.
6. Configure the different Cognos TM1 clients to use Integrated Login by setting the Use Integrated Login option in the associated user interface.

   - “Configuring Cognos TM1 Architect to use Integrated Login” on page 198.
   - “Configuring Cognos TM1 Perspectives to use Integrated Login” on page 199.

Results

You can now log in to your Cognos TM1 server using Integrated Login through Cognos TM1 Architect or Cognos TM1 Perspectives.

For information on configuring Integrated Login for Cognos TM1 Web, see “Configuring Integrated Login for Cognos TM1 Web using Kerberos.”

Configuring Integrated Login for Cognos TM1 Web using Kerberos

You can set up IBM Cognos TM1 Web to use Integrated Login with the Kerberos security protocol. This is the type of authentication works with TM1 IntegratedSecurityMode=3.

About this task

In Cognos TM1 Web version 10.2, you must enter your Microsoft Windows authentication in the Cognos TM1 Web login dialog box. The login dialog box allows you to choose either native TM1 or Microsoft Windows login.

In order to run Cognos TM1 Web in a Kerberos environment, you must properly configure that environment for Kerberos to work with the Java Runtime that is running the Cognos TM1 Web service.
Cognos TM1 Web version 10.2 uses Java Generic Security Service (JGSS) to support Kerberos Windows Authentication. This is the type of authentication you get when you use the TM1 IntegratedSecurityMode=3. Additional information on how to set up a Kerberos Windows Authentication to work in a Java environment is available at the following link:


Documentation about setting up the LoginModule for acquiring Kerberos Credentials for the IBM Java runtime is described at this link:


**Procedure**

1. Specify a Kerberos Configuration File.
   On a Windows system, the Kerberos Configuration File is krb5.ini. On Linux, the file is krb5.conf.
   An example of the Windows Kerberos Configuration File (krb5.ini):

   ```
   [libdefaults]
   default_realm = <REALM_NAME>
   default_tkt_enctypes = rc4-hmac des-cbc-crc
   default_tgs_enctypes = rc4-hmac des-cbc-crc
   ticket_lifetime = 1200
   [realms]
   <REALM_NAME> = {
   kdc = 9.24.213.202
   admin_server = <server_name.domain_name>
   default_domain = <DOMAIN_NAME>
   }
   [domain_realm]
   .<domain_realm_name> = <DOMAIN_REALM_NAME>
   [appdefaults]
   autologin=true
   forward=true
   forwardable=true
   encrypt=true
   ```

2. Specify the JAAS login feature in the java.security file.
   Example of specifying the JAAS login feature in the java.security file:

   ```
   # Default login configuration file
   #login.config.url.1=file:${user.home}/.java.login.config
   login.config.url.1=file:${java.home}/lib/security/login.config
   # Example of the contents of the login configuration file for the IBM Java Runtime:
   TMISignedOnUserLoginContext {
   com.ibm.security.auth.module.Krb5LoginModule required
   useDefaultCcache=false
   credsType=initiator;
   };
   # Example of the contents of the login configuration file for the SUN Java Runtime:
   ```
3. Specify the login configuration file.


   Ensure that the value associated with the `IntegratedSecurityModuleName` parameter is set to the name of the LoginModule that is associated with the Kerberos environment.

   `<add key="IntegratedSecurityModuleName" value="name of the LoginModule"/>

5. Ensure that the Windows service for the Cognos TM1 Server is owned by an authorized domain account.

6. Ensure that the user that is logging in has the proper ticket set up via the `kinit` procedure.

**Configuring web browsers for Integrated Login**

After configuring IBM Cognos TM1 Web with Integrated Login, you must then configure the Web browsers on the client systems that will access Cognos TM1 Web.

**Procedure**

1. If you are using Microsoft Internet Explorer, specify that the Cognos TM1 Web URL is a trusted site.

   For example, enable the Automatic logon with current username and password option and the Enable Integrated Windows Authentication option in Internet Explorer.

   For more information, see your Microsoft Internet Explorer documentation.

2. If you are using Mozilla Firefox, locate and edit the following preferences so they include a comma separated list of URL prefixes or domains for the location of your TM1 Web server.

   `network.automatic-ntlm-auth.trusted-uris
   network.negotiate-auth.delegation-uris
   network.negotiate-auth.trusted-uris`

   For example, enter `localhost` if you are running Cognos TM1 Web locally or enter the server name if you are running Cognos TM1 Web on a dedicated web server.

   For more information, see your Mozilla Firefox documentation.

**Configuring Cognos TM1 Architect to use Integrated Login**

After you set up Integrated Login for the IBM Cognos TM1 server, you can use it to access your Cognos TM1 data through Cognos TM1 Architect.

**Procedure**

1. Run Cognos TM1 Architect.
2. Click `File > Options`.
3. Verify that the `Use Integrated Login` check box is selected.
4. Click `OK`.
5. In the Tree pane of the Server Explorer, double-click to open the list of servers.
6. Double-click the server into which you exported your LDAP user and group information.
   You should be logged in without being prompted to enter a user name or password.

**Configuring Cognos TM1 Perspectives to use Integrated Login**

After you set up Integrated Login for the IBM Cognos TM1 server, you can use it to access your Cognos TM1 data through Cognos TM1 Perspectives.

**Procedure**

1. Run Microsoft Excel.
2. Click **TM1**, **Server Explorer**.
   The TM1 Server Explorer displays.
3. Click **File > Options**.
4. Verify that the **Use Integrated Login** check box is selected.
5. Click **OK**.
6. In the Tree pane of the Server Explorer, double-click to open the list of servers.
7. Double-click the server into which you exported your LDAP user and group information.
   TM1 Perspectives should automatically log you in to Cognos TM1 without asking for a user name or password.

**Logging into Cognos TM1 Web with Integrated Login**

After you configure a IBM Cognos TM1 server and Cognos TM1 Web to use Integrated Login, you can use this authentication mode to log in and access your data through Cognos TM1 Web. Note that as of TM1 10.2, TM1 Web does not support single sign on; you must provide a username/password combination to log on to TM1 Web.

**Procedure**

1. Run Microsoft Internet Explorer.
2. Enter the following URL in the browser **Address** box:
   - http://web_server_name:port_number/tm1web/
   For example: http://localhost:9510/tm1web/
3. Enter the Cognos TM1 server Admin Server host name in the Admin Host field.
4. Click **Server** arrow.
5. Click **Login**.
6. Enter your user username and password.

**LDAP Authentication**

You can set up IBM Cognos TM1 authentication using an LDAP server.

**Validating users with an LDAP server**

LDAP validation allows you to centralize all of your user passwords in an external LDAP server.

When your IBM Cognos TM1 users log in, the user name and password they provide is validated against the information held in your LDAP server. You can
specify a password and key to use before the server connects for LDAP authentication, or the server can directly connect without the use of a password.

As a prerequisite to setting up LDAP authentication, you must have significant knowledge of LDAP and its role in your network security structure. If you are not the LDAP administrator for your network, consult with your LDAP administrator to properly set up Cognos TM1 to use LDAP authentication.

**Note:** Your LDAP server must be configured to use SSL to successfully communicate with Cognos TM1.

**LDAP authentication parameters**

Use the following parameters in the tm1s.cfg file to configure and support LDAP authentication.

**PasswordSource:**

Compares user-entered password to the stored password.

Parameter type: optional, static

- **Cognos TM1 (Default):** Compares the user-entered password to the password in the Cognos TM1 database.
- **LDAP:** Compares the user-entered password to the password stored in on the LDAP server.

**LDAPHost:**

Specifies the domain name or dotted string representation of the IP address of the LDAP server host.

Parameter type: optional, static

If you do not enter a value for LDAPHost, IBM Cognos TM1 uses the default value, localhost.

**LDAPPasswordFile:**

Defines the password file used when LDAPUseServerAccount is not used. This is the full path of the .dat file that contains the encrypted password for the IBM Cognos TM1 server Admin Server's private key.

Parameter type: optional unless “LDAPUseServerAccount” on page 202=F, static

This parameter uses the full path to a .dat file.

**LDAPPasswordKeyFile:**

Defines the password key used when LDAPUseServerAccount is not used.

Parameter type: optional unless “LDAPUseServerAccount” on page 202=F, static

This parameter uses the full path of the .dat file that contains the key used to encrypt and decrypt the password for the private key.
LDAPPort:

Specifies the port IBM Cognos TM1 uses to bind to an LDAP server.

Parameter type: optional, static

Specify a secure (SSL) port, for example, 636.

Default value: 389 (an unsecured port)

LDAPSearchBase:

Specifies the node in the LDAP tree where IBM Cognos TM1 begins searching for valid users.

Parameter type: optional, static

A base distinguished name (DN) in the LDAP directory. For example:

ou=people,o=company.com

For example, if the distinguished names are of the form:

uid-bjensen, ou=people, o=company.com

then the search base would be:

ou=people, o=company.com

LDAPSearchField:

The name of the LDAP attribute that is expected to contain the name of the IBM Cognos TM1 user being validated.

Parameter type: optional, static

If you do not enter an LDAPSearchField value, the default value is cn, which is also the default value for Microsoft Active Directory.

LDAPSkipSSLCertVerification:

Skips the certificate trust verification step for the SSL certificate used to authenticate to an LDAP server. This parameter is applicable only when LDAPVerifyServerSSLCert=T.

Parameter type: optional, static

If trust verification does not work, you can skip the trust verification step by specifying LDAPSkipSSLCertVerification=T. In this case, TM1 does not verify the server certificate at all but simply accepts it.

Note: Before working with this parameter, you should be familiar with SSL and LDAP.

Default value: F
**LDAPSkipSSLRCRLVerification:**

Skips CRL checking for the SSL certificate used to authenticate to an LDAP server. This parameter is applicable only when LDAPVerifyServerSSLCert=T.

Parameter type: optional, static

This parameter is not required if LDAPVerifyServerSSLCert=F. The Microsoft Windows API can tolerate an empty or non-existent CRL certificate.

**Note:** Before working with this parameter, you should be familiar with SSL and LDAP.

Default value: F

**LDAPUseServerAccount:**

Determines if a password is required to connect to the server when using LDAP authentication.

Parameter type: optional, static

- To connect directly to the LDAP server using integrated authentication, set this parameter to T. Set this parameter to T whenever the IBM Cognos TM1 server and LDAP server exist on the same domain.
- To use a password before connecting, set this parameter to F. When LDAPUseServerAccount is set to F, you must also set the LDAPPasswordFile on page 200 and LDAPPasswordKeyFile on page 200 to successfully connect to the LDAP server using SSL.

**LDAPVerifyCertServerName:**

Specifies a server to use during the SSL certificate verification process for LDAP server authentication. This parameter is applicable only when LDAPVerifyServerSSLCert=T.

Parameter type: optional, static

**Note:** Before working with this parameter, you should be familiar with SSL and LDAP.

Use this parameter to specify the servers TM1 should use to verify the received SSL certificate.

All of the server names you want to use for certificate verification must be listed in separate LDAPVerifyCertServerName entries. The entries must exactly match the name (subject) of the certificate presented to TM1 in the SSL handshake by the server on the other end.

Specify LDAPVerifyCertServerName in the tm1s.cfg file of each TM1 server that is using LDAP.

```
LDAPVerifyCertServerName=<server_cert_subject>
```

Replace `server_cert_subject` with a server name or IP addresses. Create an entry for each server you want to use. For example:
LDAPVerifyCertServerName=abc99.mydomain.com
LDAPVerifyCertServerName=xyz99.mydomain.com

Default value: F

**LDAPVerifyServerSSLCert:**

Delegates the verification of the SSL certificate to TM1. This parameter is useful, for example, when you are using LDAP with a proxy server.

Parameter type: optional, static

**Note:** Before working with this parameter, you should be familiar with SSL and LDAP.

Typically, TM1 leverages the Microsoft Windows API to verify SSL certificates. For this process to succeed, the certificate name and the LDAP server host name must match. If you are using a proxy, however, these names may not match, causing the verification to fail. In this case, you can set LDAPVerifyServerSSLCert=T to have TM1 perform the certificate verification.

When LDAPVerifyServerSSLCert=T, TM1 performs the two steps of verification (verifying the trust relationship to the certificate and checking the CRL) like the Windows API would have done, but with a slightly different approach.

1. Instead of verifying the received certificate against the configured host name, TM1 looks at the list of server names specified by LDAPVerifyCertServerName.
2. If the certificate name matches one of the servers specified by LDAPVerifyCertServerName, TM1 calls the Microsoft Windows API and requests it to verify this single certificate only.

**Note:** The correct trusted root certificate authority (CA) must already have been imported to the Microsoft Windows Certificate Store.

You can skip the trust verification step by specifying LDAPSkipSSLCertVerification=T. In this case, TM1 does not verify the server certificate at all but simply accepts it.

3. Once the trust verification is confirmed (or skipped), TM1 calls the Microsoft Windows API to check the CRL.

**Note:** The CRL certificate for the trusted root must already have been imported to the Microsoft Windows Certificate Store.

If the CRL certificate does not exist in the Microsoft Windows Certificate Store, the process will fail. You can skip the CRL step by specifying LDAPSkipSSLCRLVerification=T.

4. If all the previous steps finish successfully, the SSL handshake is complete. TM1 now attempts to authenticate to the LDAP server.

For troubleshooting information, see "Troubleshooting LDAP authentication" on page 205.

**LDAPWellKnownUserName:**

Specifies the user name used by the IBM Cognos TM1 server to log in to LDAP and look up the name submitted by the user.
The value of this parameter can be any LDAP distinguished name.

For example:
uid=bjensen,ou=people,o=company.com

**Configuring LDAP validation**

To configure LDAP validation, you will change the password in the TM1s.cfg file so that you can then import names from your LDAP directory and modify group assignments for new users. Then change the password back to the LDAP credentials.

**Before you begin**

To configure LDAP validation, you need the following information:

- A name that the Cognos TM1 server can use to log in to LDAP. You can test the validity of this name using ETLDAP.
- The SSL port on which your LDAP server is running. The default is 636.
- The name or IP address of the LDAP server you want to use for validation.

**Procedure**

1. To use your Cognos TM1 credentials to log in, change the password parameter in TM1s.cfg by completing these actions:
   a. Edit TM1s.cfg in your IBM Cognos TM1 server data directory.
   b. Modify `PasswordSource=LDAP` to read `PasswordSource=TM1`
   c. Save and exit TM1s.cfg.
   d. Recycle your Cognos TM1 server.

2. To import names from your LDAP directory into Cognos TM1, complete these actions:
   a. Use the procedure described in "ETLDAP utility" on page 185.
   b. Use the following Cognos TM1 login information:
      - **Admin user (default)** - Admin
      - **Admin password (default)** - apple
      Use the user that you specified during the installation to log in to LDAP.

3. To modify group assignments for new users, complete the following actions:
   a. Log in to Cognos TM1 as an administrator.
   b. Right-click the server name in Server Explorer and click **Security, Clients and Groups**.
   c. Modify the groups assignments for your new users as required.
      For each Cognos TM1 user ETLDAP added to your database, you must assign that user to the same group they belong to in the LDAP directory.
      For example, if Nadiac is a member of the group gymnasts in your LDAP directory, ETLDAP creates the user Nadiac, and creates the group gymnasts within Cognos TM1. Nadiac displays in the Clients/groups dialog box as a member of gymnasts.

4. To change the password back to the LDAP credentials, complete these actions:
   a. Edit TM1s.cfg in your IBM Cognos TM1 server data directory.
   b. Modify `PasswordSource=TM1` to read `PasswordSource=LDAP`
   c. Define the connection status:
To directly connect to the server, add the following line:

`LDAPUseServerAccount=T`

To use a password before connecting to the server, add the following lines:

`LDAPPasswordFile= file`
`LDAPPasswordKey= key`

d. Save and exit TM1s.cfg file.
e. Recycle your Cognos TM1 server.

You should now be able to log in to Cognos TM1 with a name that you added from your LDAP directory.

**Troubleshooting LDAP authentication**

This topic describes error log messages that can arise when `LDAPVerifyServerSSLCert=T` in the tm1s.cfg file.

The following message indicates that the certificate does not match any of the names that are listed in the `LDAPVerifyCertServerName` Verify the certificate name and ensure that it has a `LDAPVerifyCertServerName` entry in the tm1s.cfg file.

```
LDAP ERROR: 0x800b0109 - Error verifying server certificate chain validity
LDAP ERROR: Error verifying server certificate no match for <server>
LDAP ERROR: 0x51 - ldap_connect failed.
```

The following message indicates an issue with the trust of the LDAP server certificate by Microsoft Windows. Ensure that the certificate has been imported into the Microsoft Windows Certificate Store.

```
LDAP ERROR: 0x800b010f - Error verifying server certificate chain validity
LDAP ERROR: Error verifying server certificate no match for <server>
LDAP ERROR: 0x51 - ldap_connect failed.
```

The following message indicates that either the certificate is revoked or TM1 is looking for the CRL certificate but cannot find it in the Microsoft Windows Certificate Store. To correct the error, skip the CRL check (set `LDAPSkipSSLCRLVerification=T`) or import the CRL certificate from the CA into the Microsoft Windows Certificate Store.

```
LDAP ERROR: 0x80092012 - Error verifying server certificate chain validity
LDAP ERROR: Error verifying server certificate no match for <server>
LDAP ERROR: 0x51 - ldap_connect failed.
```

**Using Cognos security with Cognos TM1**

You can use IBM Cognos security with IBM Cognos TM1.

For complete details on Cognos security concepts, terminology, and implementation, see the Cognos Administration and Security Guide.

**Overview to Cognos security**

The IBM Cognos TM1 server can authenticate users using IBM Cognos security.

Cognos security is a component of the IBM Cognos framework that manages user access to data. Cognos security manages authorization and authentication through third-party security providers, such as LDAP or Active Directory. When a user is authenticated through Cognos security, they are provided with a Cognos security "passport." This passport is then used by Cognos TM1 applications to determine the user's permissions (role and group membership) and identity.
When using Cognos security, a Cognos passport is required to connect to Cognos TM1. A user is presented with a logon screen requiring a namespace, a user name, and a password when first logging in to Cognos TM1 or any other Cognos security-enabled components. Once authenticated by Cognos security, a passport is issued to the user. This passport automatically provides the user’s credentials when accessing any other Cognos security-enabled application (including Cognos TM1). Once a user connects to the Cognos TM1 server via a specific Cognos server that has been configured for common logon, no direct user input is required to access additional Cognos TM1 servers (or other Cognos applications) that are configured to reference the same Cognos server.

When a user attempts to access the Cognos TM1 server, the server validates the passport to authenticate the user. This is done by querying a Cognos server for the identity of the passport. If the passport is valid, the query returns a collection of security and authentication information for the user. This information contains the roles and groups that the user has membership to, as well as the account (user name) associated with the passport. If the user name already exists in Cognos TM1, their existing membership will be validated against the existing Cognos TM1 groups. If the user does not exist, they are added and assigned to the appropriate user groups on the Cognos TM1 server.

If a user runs the client program as an administrator (by right-clicking on the program file name and selecting Run as administrator), two new folders are created after the client connects to CAM:

- `installation_location\configuration`
  This folder contains the C8ITK.ini file.
- `installation_location\logs`
  This folder contains the file C8ITK.log, if applicable.

By default, the C8ITK.ini file specifies that no log files are created in the logs folder, unless an error occurs. You can edit the C8ITK.ini file if you want to have log files. You can also change the name of the log file by editing the LogFilePath section. Before your changes can take effect, you must restart your Cognos services.

**Configuring the TM1 Server to use Cognos security**

You can configure the IBM Cognos TM1 server to use IBM Cognos security for authentication instead of the default standard TM1 authentication.

**Before you begin**

To successfully complete these procedures, your IBM Cognos server must not be configured to allow anonymous access. If anonymous access is enabled on the IBM Cognos server, you cannot logon to a namespace from TM1 when importing Cognos groups into TM1.

**About this task**

To enable IBM Cognos security authentication on the IBM Cognos TM1 server, you must add or modify several configuration parameters in the server’s Tm1s.cfg configuration file.

**Note:** If you want to re-configure a TM1 server that is already using Cognos security to use a different instance of Cognos, you must remove any existing
Cognos users and groups that were imported from the first Cognos instance and then import users and groups from the new Cognos instance.

**Procedure**

1. Open the `Tm1s.cfg` configuration file in a text editor.

   The `Tm1s.cfg` file is located in the TM1 server data directory. For more information, see Appendix A, “The tm1s.cfg Server Configuration File,” on page 255.

2. Edit or add the following parameters to the configuration file.

   **Table 30. TM1 server configuration parameters for Cognos security**

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>ServerCAMURI</strong></td>
<td>The URI for the internal dispatcher that the TM1 server should use to connect to IBM Cognos security. The URI is specified in the form: &lt;br&gt;<code>http[s]://host IP address:port/p2pd/servlet/dispatch</code>&lt;br&gt;Examples:&lt;br&gt;<code>http://10.121.25.121:9300/p2pd/servlet/dispatch</code>&lt;br&gt;<code>https://10.121.25.121:9300/p2pd/servlet/dispatch</code>&lt;br&gt;Note: To find the URL, ask your IBM Cognos administrator to perform the following steps:&lt;br&gt;1. On the system hosting IBM Cognos, open IBM Cognos Configuration.&lt;br&gt;2. Click to expand the <strong>Environment</strong> node.&lt;br&gt;3. In the <strong>Properties</strong> pane, locate the <strong>Dispatcher Settings</strong> section and use the value from either the <strong>External dispatcher URI</strong> or the <strong>Internal dispatcher URI</strong> property.</td>
</tr>
<tr>
<td><strong>ClientCAMURI</strong></td>
<td>The URI for the IBM Cognos Server IBM Cognos Connection used to authenticate TM1 clients. The URI is specified in the form:&lt;br&gt;<code>http[s]://host/ibmcognos/cgi-bin/cognos.cgi</code>&lt;br&gt;Note: The values for <code>host</code>, <code>ibmcognos</code>, and <code>cognos.cgi</code> are variables and depend on the exact settings that have been used. Contact your IBM Cognos administrator for more information about these settings.&lt;br&gt;For example: <code>http://10.121.25.121/ibmcognos/cgi-bin/cognos.cgi</code>&lt;br&gt;If your Cognos system is using Microsoft Internet Information Services (IIS):&lt;br&gt;<code>http://10.121.25.121/ibmcognos/cgi-bin/cognosisapi.dll</code></td>
</tr>
<tr>
<td><strong>CAMSSLCertificate</strong></td>
<td>The full path and name of the SSL certificate to be used when connecting to the internal dispatcher.&lt;br&gt;For example: <code>C:\AxTM1\Install_Dir\ssl\CognosCert.cer</code>&lt;br&gt;This parameter is required only if the IBM Cognos server is configured to use SSL.</td>
</tr>
</tbody>
</table>
### Table 30. TM1 server configuration parameters for Cognos security (continued)

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SkipSSLCAMHostCheck</td>
<td>Indicates whether the SSL certificate ID confirmation process can be skipped. The default is FALSE. Important: This parameter should be set to TRUE only if using a generic certificate for demonstration purposes.</td>
</tr>
<tr>
<td>ClientPingCAMPassport</td>
<td>Indicates the interval, in seconds, that a client should ping the IBM Cognos server to keep their passport alive. If an error occurs or the passport expires the user will be disconnected from the TM1 server. Example: ClientPingCAMPassport=900</td>
</tr>
<tr>
<td>CAMPortalVariableFile</td>
<td>The path to the variables_TM1.xml file in your Cognos installation. In most cases, the path will be: CAMPortalVariableFile = portal\variables_TM1.xml The variables_TM1.xml file is included for TM1 iWidgets. For details on installing and configuring iWidgets, see “Cognos TM1 iWidgets and Cognos Workspace” on page 67. The CAMPortalVariableFile parameter is required only when running TM1 Web.</td>
</tr>
</tbody>
</table>

The Tm1s.cfg file should contain parameters similar to the following:
- ServerCAMURI=http://10.111.25.121:9300/p2pd/servlet/dispatch
- ClientCAMURI=http://10.111.25.121/cognos_location/cgi-bin/cognos.cgi
- ClientPingCAMPassport=900
- CAMPortalVariableFile=templates\ps\portal\variables_TM1.xml

3. Set the IntegratedSecurityMode parameter to the default mode of 1.
   
   IntegratedSecurityMode=1  

   **Note:** Setting the IntegratedSecurityMode parameter to 1 allows you to complete additional configuration steps in TM1 using standard TM1 security before switching to Cognos security. After you complete these additional steps you can then change this parameter to either 4 or 5 to use Cognos security.

4. Save and close the Tm1s.cfg file.
5. Restart the Cognos TM1 server.
6. Perform the required steps for your Cognos BI installation.
   - Define a Cognos user to function as a Cognos TM1 administrator.
   - Import Cognos groups into Cognos TM1.
   
   For details, see “Managing TM1 users, groups, and objects when using Cognos security” on page 209.

7. Configure the Cognos TM1 server to start using Cognos authentication.
   a. Shut down the Cognos TM1 server.
   b. Open the Tm1s.cfg configuration file in a text editor.
   c. Set the **IntegratedSecurityMode** parameter to indicate that the server should use Cognos authentication.

   The exact parameter value depends on the specific Cognos TM1 components you are using:
   - If you are not using the Cognos TM1 Applications component, set the parameter to 4.
IntegratedSecurityMode=4

- If you are using Cognos TM1 Applications with Cognos security, set the parameter to 5 to support user groups from both Cognos TM1 and Cognos.

IntegratedSecurityMode=5

d. Save and close the Tm1s.cfg file.
e. Restart the Cognos TM1 server.

What to do next

See the following configuration topics to complete the configuration:

- “Configuring Cognos TM1 clients to use Cognos security” on page 211
- “Configuring Cognos TM1 Web to use Cognos Security” on page 212
- “Using Cognos TM1 Applications with Cognos security” on page 214

Anonymous access with the Cognos TM1 server and Cognos security:

To successfully set configuration settings and procedures to enable IBM Cognos security authentication on the IBM Cognos TM1 server, your Cognos server must not be configured to allow anonymous access.

If anonymous access is enabled on the Cognos server, you cannot logon to a namespace from Cognos TM1 when importing Cognos groups into Cognos TM1.

Managing TM1 users, groups, and objects when using Cognos security

Defining a Cognos user to function as a Cognos TM1 administrator:

To successfully administer IBM Cognos TM1 while using IBM Cognos Business Intelligence (BI) security for authentication, an existing Cognos user must be added to the Cognos TM1 ADMIN group.

This Cognos user will be used to import Cognos groups into Cognos TM1.

Important: The initial steps for this configuration must be done with the Cognos TM1 IntegratedSecurityMode parameter set to 1. You then change this parameter to use Cognos BI security at a later point in the steps.

Procedure

1. Log in to Cognos TM1 as an administrator.
2. From the Server Explorer, click Server > Security > Clients/Groups.
3. From the Clients/Groups dialog box, click Clients > Add New Client.
   The Cognos logon dialog box appears.
4. Enter your Cognos user ID and password, then click OK.
5. In the Name box, click the namespace to which you are currently logged in.

   Note: Only users from the namespace to which you are logged in can be imported into Cognos TM1. Other namespaces may appear in the Name box, but you cannot import users from them.
   The contents of the Name box update to display the directories available on the selected namespace.
6. Enable the Show users in the list option.
7. Navigate to the directory containing the Cognos user you want to define as a Cognos TM1 administrator. In most circumstances, you will define your own Cognos user as a Cognos TM1 administrator, as you must know the Cognos user's ID and password to complete administrative tasks.

8. Select the user.

9. Click the green arrow icon to move the selected user to the Selected Entries list.

10. Click OK to import the Cognos user into Cognos TM1.

   The user appears as a new client in the Client/Groups window, but is not assigned to any Cognos TM1 groups.

11. Assign the new user to the ADMIN group and click OK.

12. Shut down the Cognos TM1 server.

13. Open the Tm1s.cfg configuration file in a text editor.

14. Set the IntegratedSecurityMode parameter to indicate that the server should use IBM Cognos authentication. The exact parameter value depends on the specific Cognos TM1 components you are using:

   • If you are not using the Cognos TM1 Applications component, set the parameter to 4.
   
   ```
   IntegratedSecurityMode=4
   ```

   • If you are using Cognos TM1 Applications with Cognos security, set the parameter to 5 to support user groups from both Cognos TM1 and Cognos.
   
   ```
   IntegratedSecurityMode=5
   ```

15. Save and close Tm1s.cfg.

16. Restart the Cognos TM1 server.

**Importing Cognos groups into Cognos TM1:**

After an IBM Cognos user is defined as the Cognos TM1 administrator, that user can import Cognos groups into Cognos TM1.

You should import only the Cognos groups that you want to allow to access the Cognos TM1 server.

**Procedure**

1. In the Server Explorer, double-click your Cognos TM1 server.

   The Cognos logon dialog box appears.

2. Log on as the Cognos user that you have defined as the Cognos TM1 administrator.

3. From the Server Explorer, click **Server**, then **Security**, then **Clients/Groups**.

4. From the **Clients/Groups** window, click **Groups**, then **Add New Groups**.

5. In the **Names** box, click the namespace to which you are currently connected.

   **Note:** Only groups from the namespace to which you are connected can be imported into Cognos TM1. Other namespaces may appear in the **Name** box, but you cannot import groups from them.

6. Navigate through the directory structure and select the Cognos groups you want to import into Cognos TM1.

7. Click the green arrow icon to move the selected user to the **Selected Entries** list.

8. Click OK to import the Cognos groups into Cognos TM1.
If you review the User Group Assignment section of the Clients/Groups window, you should see the Cognos groups added to your server.

Creating TM1 users when using Cognos security:

When the IBM Cognos TM1 server is configured to use Cognos authentication, you cannot create new clients directly on the Cognos TM1 server.

Instead, all client administration is performed in Cognos.

When a Cognos user accesses Cognos TM1, the user is validated and automatically assigned to the appropriate Cognos TM1 groups. There is no need to manually assign users to groups in Cognos TM1.

Administering Cognos TM1 object security when using Cognos authentication security:

While IBM Cognos authentication automatically manages users on the IBM Cognos TM1 server, the Cognos TM1 administrator must still manage object security to allow Cognos users to view and use Cognos TM1 objects.

For details on administering Cognos TM1 object security, see the Cognos security with Cognos TM1 Developer Guide.

Configuring Cognos TM1 clients to use Cognos security

You must add two parameters to your Tm1p.ini file to allow you to perform IBM Cognos security-related administrative tasks from your Cognos TM1 client.

Procedure

1. Open the Tm1p.ini configuration file in a text editor. For information on the location of the Tm1p.ini file, see “Location of the Tm1p.ini File” on page 311.

2. Add the following parameters to the Tm1p.ini file.

   Table 31. Parameters for the Tm1p.ini file

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CognosGatewayURI</td>
<td>The URI for the Cognos Business Intelligence (BI) Gateway. The URI is specified in the form http[s]://host/cognos_location/cgi-bin/cognos.cgi. For example: <a href="http://10.121.25.121/cognos_location/cgi-bin/cognos.cgi">http://10.121.25.121/cognos_location/cgi-bin/cognos.cgi</a></td>
</tr>
<tr>
<td>AllowImportCAMClients</td>
<td>Determines if Cognos clients can be imported into Cognos TM1. This parameter must be set to T when setting up Cognos security in Cognos TM1.</td>
</tr>
</tbody>
</table>

Your Tm1p.ini file should include parameters similar to the following:

   AllowImportCAMClients = T
   CognosGatewayURI = http://10.111.25.121/cognos_location/cgi-bin/cognos.cgi

3. Save and close Tm1p.ini.
4. Restart your Cognos TM1 client.
Configuring Cognos TM1 Web to use Cognos Security

Follow these steps to configure IBM Cognos TM1 Web to use IBM Cognos authentication security.

Before you begin

Note: If you applied a Cognos Business Intelligence (BI) updater kit to your BI installation, you might need to make specific updates to the tm1web.html file.

The tm1web.html file supports Cognos TM1 Web to use IBM Cognos authentication security. However, it does not get updated when you apply a Cognos BI updater kit. Instead, an updated file that is called tm1web.html.new is placed in the same Cognos BI ...\webcontent\tm1\web directory as the original file. Use the newer version of tm1web.html and update it with any changes you made in the original tm1web.html file.

About this task

These steps include editing configuration files on your Cognos TM1 Web system and copying them over to your Cognos Business Intelligence (BI) system.

Procedure

1. Locate and extract the following files in your Cognos TM1 Web installation directory.
   - variables_TM1.xml.sample
     This file is contained inside the compressed file tm1web_app.zip.
   - tm1web.html.new
     This file is contained inside the compressed file tm1web_gateway.zip.

   The compressed files are located in the following location:
   <TM1 installation location>\webapps\tm1web\bi_files

   For example:
   C:\Program Files\IBM\cognos\tm1_64\webapps\tm1web\bi_files

2. Rename the variables_TM1.xml.sample file to variables_TM1.xml.
3. Rename the tm1web.html.new file to tm1web.html.
4. Copy the files to your Cognos BI installation.

   variables_TM1.xml
   Copy this file to <Cognos location>\templates\ps\portal on your Cognos BI system.

   tm1web.html
   Copy this file to <Cognos location>\webcontent\tm1\web on your Cognos BI system.

5. Edit the tm1web.html file to point to where Cognos TM1 Web is running.

   var tm1webServices = ["http://SystemName:PortNumber"];

   For example:

   var tm1webServices = ["http://mysystem:9510"];

Configuring Cognos TM1 Operations Console to use Cognos security

You can configure IBM Cognos TM1 Operations Console to use IBM Cognos Business Intelligence (BI) security, also called Cognos Access Manager (CAM) authentication.
Before you begin

At least one TM1 server must be configured for IBM Cognos BI security. This is required in order to store the Operations Console user group information. You must know the name of this TM1 server to complete the steps in this topic. For complete details and configuration steps, see "Using Cognos security with Cognos TM1" on page 205 and "Configuring the TM1 Server to use Cognos security" on page 206.

About this task

To configure Operations Console to use IBM Cognos BI security, you work with files on the computers hosting these two components.

Procedure

1. Open Performance Management Hub by going to http://<host>:9510/pm/admin
2. Expand Configurations > com.ibm.ba.pm.opsconsole.monitor.tm1.TM1OpsConsoleMonitor.
3. Click com.ibm.ba.pm.opsconsole.monitor.tm1.TM1OpsConsoleMonitor.dictionary.
4. Verify the values in the DefaultAdminHost, DefaultGroup, and DefaultServer fields. See "Configuring the Cognos TM1 Operations Console" on page 108.
5. Expand com.ibm.ba.pm.resource.security.
6. Click com.ibm.ba.pm.resource.security.dictionary.
7. Set CAMGatewayURL to the Cognos BI Server gateway. You can find this value in Cognos Configuration under Environment > Gateway URI. The value in the ClientCAMURI parameter of the tm1s.cfg file should be similar. For example: http://host.domain.com/ibmcognos/cgi-bin/cognos.cgi
8. Set CAMBIURL to the Cognos BI Server dispatcher URL. You can find this value in Cognos Configuration under Environment > External dispatcher URI. The value in the ServerCAMURI parameter of the tm1s.cfg file should be similar. For example: http://host.domain.com:9300/p2pd/servlet/dispatch
9. Copy the ..\tm1_64\bi_interop\bi_interop.zip file from the TM1 installation location to the root of the Cognos BI Server installation directory (the ..\c10_64 directory). If you are using a distributed Cognos BI server environment, copy the file to the computer that is running the IBM Cognos BI Application tier or Gateway tier.
10. Extract bi_interop.zip so the directory structure is maintained. The pmhub.html file should be in the ..\c10_64\webcontent directory.
11. Edit line 51 in the pmhub.html file to include the fully qualified domain name and port number of the IBM Cognos TM1 Applications Service that runs the TM1 Operations Console.
   • If you are using the Apache Tomcat web server provided with TM1, this is the server where TM1 Application Server is running.
   • If you are using your own web server, this is the server where you deployed pmhub.war.

For example:
var pmhubURLs = ['http://tm1appshost.domain.com:9510'];
You can also include multiple URLs if the TM1 Operations Console is used on multiple systems. For example:
Using Cognos TM1 Applications with Cognos security

You can configure IBM Cognos TM1 Applications to use IBM Cognos Business Intelligence (BI) security. This configuration requires users to log in to Cognos TM1 Applications as a valid user that exists in the Cognos BI server. This configuration also integrates Cognos TM1 Applications with Cognos BI by displaying links to Cognos TM1 Applications in the IBM Cognos Connection portal.

When you use Cognos TM1 Applications with Cognos BI Security, the Cognos TM1 Application Server can be hosted on a web application server in one of the following ways:

- On a different computer with the Apache Tomcat that was provided with the Cognos TM1 installation
- On a different computer with your own installation of Apache Tomcat or IBM Websphere.
- Optionally, you can deploy Cognos TM1 Applications with the Apache Tomcat web server that is supplied with Cognos BI.

In all cases, you must edit the `planning.html` file and copy this file to the Cognos BI server so that the Cognos BI server knows the location of the Cognos TM1 Application Server.

Note: You must have the `TM1_PATH` environment variable specified before connecting to Cognos TM1 under a UNIX environment.

Configuring Cognos TM1 Applications to use Cognos Business Intelligence Security:

To configure IBM Cognos TM1 Applications to use IBM Cognos Business Intelligence (BI) security, you work with files on the computers hosting these two components, plus the computer where the Cognos TM1 Server is running. This configuration also enables the IBM Cognos Connection portal to show links to Cognos TM1 Applications so that users can open the applications that they rights to from within the Cognos Connection portal.

Before you begin

The Cognos TM1 server must be configured to use Cognos BI security.

To use Cognos TM1 Applications with Cognos BI security, the `IntegratedSecurityMode` parameter in the Cognos TM1 `tm1s.cfg` configuration file must be set to 5 to support user groups from both Cognos TM1 and Cognos BI.

For complete details and configuration steps, see "Using Cognos security with Cognos TM1" on page 205 and "Configuring the TM1 Server to use Cognos security" on page 206.

Note: You must configure the `TM1_PATH` environment variable before you can connect to Cognos TM1 under a UNIX environment.

Procedure

1. Extract the content of the `bi_interop.zip` file into your existing Cognos BI installation.
Note: As of Cognos TM1 version 10.2.2, the bi_interop.zip replaces the planning_gateway.zip file that was provided with previous versions of Cognos TM1.

a. Locate the bi_interop.zip file that is provided with the Cognos TM1 installation in the following location.
   Cognos TM1 location\bi_interop\n
b. Extract and merge the content of the bi_interop.zip file into the root directory of your existing Cognos BI installation.
   For example: C:\Program Files\IBM\cognos\c10_64\n
   Note: The bi_interop.zip file contains a directory structure that merges files into the \templates and \webcontent subdirectories.

c. To manually extract and copy the files to your Cognos BI installation, copy the files as follows:
   If you are using a distributed Cognos BI server environment, copy these files to the computer that is running the Cognos BI Application tier or Gateway tier as follows.

   planning.html
   Copy planning.html to C10 Install Dir\webcontent where the Cognos BI Gateway is installed.

   icon_active_application.gif
   Copy icon_active_application.gif to C10 Install Dir\webcontent\ps\portal\images where the Cognos BI Gateway is installed.

   variables_plan.xml
   Copy variables_plan.xml to C10 Install Dir\templates\ps\portal wherever the presentation service (Application tier) is running in a Cognos BI server.

   Note: These files are also installed with newer Cognos BI installations. If the files exist on your Cognos BI server, then you only need to edit them as explained in these steps.

2. Edit the planning.html file.

   Important: The values for the planningServices parameter in this file are required to ensure that the Cognos BI server redirects users to only approved locations. The location of the Cognos TM1 Application Server from where the user logs in must be validated to be one of the approved locations in this file. Otherwise, the Cognos BI server will not redirect the user.

   a. Open the planning.html file and locate the following lines:
      // Update the following to point to the location of the planning service(s)
      var planningServices = ["http://machine.company.com:9510"];

   b. Set the planningServices parameter to the location and port number for the Cognos TM1 Application Server.
      var planningServices = ["http://web_server_address:port_number"];
      Replace web_server_address with the fully qualified domain name (FQDN) for the computer where the Cognos TM1 Application Server is running. For example, myhost.example.com
      - If you are running the Cognos TM1 Application Server with the Apache Tomcat that is provided with the Cognos TM1 installation:
var planningServices = ["http://web_server_address:9510"];

- If you are running the Cognos TM1 Application Server with your own web application server, use the location and port number for that system.

**Tip:** If you are using the same Cognos BI server to authenticate different instances of Cognos TM1 Applications that are running on multiple computers, use a comma-separated list with the fully qualified domain name (FQDN) for each computer. For example:

```javascript
var planningServices = ["http://machine1.example.com:port_number","http://machine2.example.com:port_number"];  
```

**Tip:** If the Cognos TM1 Application Server is running on a web server that belongs to multiple domains, use a comma-separated list to enter the fully qualified domain name for each domain. For example:

```javascript
```

c. Save and close the planning.html file.

3. Configure the session timeout parameters for Cognos TM1 Applications and Cognos BI security to ensure the proper timeout detection.

   For details, see ["Configuring session timeout values for Cognos TM1 Applications and Cognos BI Security"](#) on page 217.

4. Restart the Cognos BI server.

5. Configure Cognos TM1 Applications with values for the IBM Cognos Gateway URI and IBM Cognos Dispatcher URI.

   a. Open Cognos TM1 Applications using the format of the following link:

   ```
   http://web_server_name:port_number/pmpsvc
   ```

   For example: http://localhost:9510/pmpsvc

   b. Log in and open the Cognos TM1 Applications Configuration page:

   - If you are running Cognos TM1 Applications for the first time, the Configuration page opens after you log in.
   - If you already configured Cognos TM1 Applications, open the Configuration page by clicking the **Administer IBM Cognos TM1 Applications** icon on the toolbar of the TM1 Applications portal page.

   c. On the TM1 Applications Configuration page, enter values for the following Cognos TM1 and Cognos BI parameters:

   - Enter values in the TM1 **Admin Host** and **Server Name** fields and configure the options for the data contribution clients that you want to use. For details, see ["Configuring the server and client environment for Cognos TM1 Application Web"](#) on page 134.

   - Set the IBM Cognos **Gateway URI** parameter. For example:

     ```
     http://CognosServerName/ibmcognos/cgi-bin/cognos.cgi
     ```

   - Set the IBM Cognos **Dispatcher URI** parameter. For example:

     ```
     http://CognosServerName:9300/p2pd/servlet/dispatch
     ```

     Replace CognosServerName with the name of the system where the Cognos BI web server is running.
6. To test the configuration, log in to Cognos TM1 Applications using a web browser on a remote computer.

If you see the following error, review your settings for the `planningServices` parameter in the `planning.html` file on the Cognos BI server.

The planning service parameter was not specified or is not one of the configured locations.

**Configuring session timeout values for Cognos TM1 Applications and Cognos BI Security:**

When using IBM Cognos TM1 Applications with IBM Cognos Business Intelligence security, set the `pmpsvc` session timeout to a value higher than the CAM session timeout to ensure the proper timeout detection. If the Cognos TM1 Applications (`pmpsvc`) session timeout is set to a value lower than the Cognos BI security (CAM) session timeout, then Cognos TM1 Applications will not properly detect a CAM session termination and will not timeout.

**About this task**

To ensure that Cognos TM1 Applications can properly detect a CAM session termination, set the `pmpsvc` session timeout to a value higher than the CAM session timeout.

- The `pmpsvc` session timeout is the number of minutes of inactivity after which Cognos TM1 Applications terminates a user session. The default value is 60 minutes (1 hour).
- The CAM session timeout is the number of seconds of inactivity after which Cognos security terminates a user session. The default value is 3600 seconds (1 hour).

**Procedure**

1. Configure the `pmpsvc` session timeout parameter.
   a. Locate the `fpmsvc_config.xml` file in the `WEB-INF/configuration` directory.
      - When Cognos TM1 Applications is deployed with the Apache Tomcat that is provided with the Cognos TM1 installation, the `fpmsvc_config.xml` file is here:
        
        Cognos_TMI_install_location\webapps\pmpsvc\WEB-INF\configuration
      - When Cognos TM1 Applications is deployed with a separate version of Apache Tomcat, the file is here:
        
        C:\Program Files\Apache Software Foundation\Tomcat_version_number\webapps\pmpsvc\WEB-INF\configuration
   b. Enter a value for the `timeout` attribute of the `service / session` element.
      Use the format for the `service / session / timeout` attribute as defined in the XML schema definition file `fpmsvc_config.xsd` located in the same directory.
      For example:
      
      `<session timeout="60"/>

2. On your Cognos BI system, configure the CAM session timeout using IBM Cognos Configuration.
   Enter a value in the **Inactivity timeout in seconds** field in the Security/Authentication section of Cognos Configuration.
**Administrator considerations when using Cognos authentication**

IBM Cognos TM1 administrators should be aware of the some issues when configuring the Cognos TM1 server to use IBM Cognos authentication.

The issues are as follows:

- Review the description of Cognos TM1 security modes 4 and 5 for the `IntegratedSecurityMode` parameter. You should understand how these different modes control whether or not Cognos users can belong to Cognos TM1 user groups. For details, see the description of the `IntegratedSecurityMode` parameter in the IBM Cognos TM1 *Operation Guide*.

- You cannot use Cognos TM1 to permanently assign a Cognos user to another Cognos group. Any user assignment you make in Cognos TM1 to a Cognos group is not saved back to Cognos. When a Cognos user logs in to Cognos TM1, the group assignments in Cognos override any Cognos group assignments made in Cognos TM1.

- If you rename a Cognos user after importing that user to Cognos TM1, you must then delete the user in Cognos TM1 in order to update Cognos TM1 with the new user name. After deleting the user in Cognos TM1, the new name will appear the next time the user logs in.

**User considerations when using Cognos authentication**

IBM Cognos TM1 users should be aware of issues that may arise when accessing the Cognos TM1 server configured to use IBM Cognos authentication.

**Authentication behavior:**

Rules govern authentication behavior when logging on to the IBM Cognos TM1 server that uses IBM Cognos authentication.

The rules are as follows:

- If common logon is enabled in IBM Cognos and you have previously logged in to an IBM Cognos application and maintain an active session, you are not prompted for credentials when logging on to the Cognos TM1 server.

- If common logon is enabled in IBM Cognos and you have not previously logged in to an IBM Cognos application, you are prompted for credentials when logging on to the Cognos TM1 server.

- If common logon is not enabled in IBM Cognos, you are prompted for credentials when logging on to the Cognos TM1 server, even if the server is configured to use IBM Cognos authentication.

**Private Cognos Security sessions:**

When an IBM Cognos server is configured to use common logon, you will be challenged only once for credentials.

Any subsequent connections to other IBM Cognos security-enabled applications (including Cognos TM1) which are configured to reference the same IBM Cognos server will automatically occur, provided your Cognos security passport is valid.

For example, if you have three available Cognos TM1 servers, all configured to use the same IBM Cognos server, once you connect to the first server as user X in namespace Y, all connections to the other Cognos TM1 servers will automatically occur using the passport of user X from namespace Y.
In some circumstances, you might want to log on to the Cognos TM1 server as a user other than the one identified by your Cognos security passport. To accommodate this, the Logon As option lets you override the automatic authentication that usually occurs with a passport, while maintaining the validity of the passport for later use. When you log on to the Cognos TM1 server using the Logon As option, a private session is established. The credentials used to establish the private session are not stored in a passport and are not shared with any other application. Any existing passport remains valid and can be used to access other IBM Cognos security-enabled applications.

**Procedure**
1. From the Server Explorer, click Server, then Logon As.
2. In the Cognos Logon window, enter the User ID and Password you want to use to log on to the Cognos TM1 server.
3. Click OK.

**Establishing a replication with Cognos security:**

When establishing a replication connection to the IBM Cognos TM1 server that uses IBM Cognos authentication, you must provide the IBM Cognos Namespace ID of the namespace. Do not provide the descriptive name of the namespace.

### Using SSL for data transmission security

You can configure IBM Cognos TM1 to use SSL for secure data transmission.

**Overview to using SSL for data transmission security**

All IBM Cognos TM1 components communicate with the Cognos TM1 Admin Server using SSL.

The Admin Server supports older Cognos TM1 clients that cannot use SSL by listening on two ports; one secured, the other unsecured. Cognos TM1 clients that can use SSL connect to the Admin Server via the secured port, while older clients that are incapable of using SSL connect to the Admin Server via the unsecured port.

When the Cognos TM1 server registers with the Admin Server, the Cognos TM1 server specifies whether it is using SSL or not. When a Cognos TM1 client contacts the Admin Server, the list of available Cognos TM1 servers will vary according to which port the client uses to connect to the Admin Server. If the client uses the secured port, the Admin Server responds with a list of all Cognos TM1 servers available on the network. If the client uses the unsecured port, the Admin Server responds with a list of only those Cognos TM1 servers that do not use SSL.
Generated certificates

When you install IBM Cognos TM1, all certificates and other files required to implement SSL are placed in the TM1_install_dir\bin\SSL directory.

The certificates contained in this directory are issued by the Applix, Inc. certificate authority, which was created using OpenSSL. The password used was "applix".

When you install Cognos TM1, the Admin Server, Cognos TM1 server, and Cognos TM1 client are all configured to use SSL, relying on the certificates installed in the TM1_install_dir\bin\SSL directory. While the Cognos TM1 certificates allow an out-of-the-box SSL implementation, you should replace these certificates with your own certificates (as well as a certificate revocation list) if you want to maximize security. For Cognos TM1 Web, all root certificates must be installed in the certificate store on the machine that the servers are using to run Cognos TM1 Web.

The TM1_install_dir\bin\SSL directory contains the following certificates and files. Files with a .pem extension are Privacy Enhanced Mail format. Files with a .der extension are Distinguished Encoding Rules.

- Applixca.pem - the public root authority certificate
- Applixcacrl.pem - the certificate revocation list
• Applixca.der - the public root authority certificate in DER format used for Java certificate stores
• tm1admsvrcert.pem - the Admin Server certificate containing the public/private key pair
• tm1svrcert.pem - the Cognos TM1 server certificate containing the public/private key pair
• dh512.pem - the file that contains the pre-generated Diffie-Hellman 512 bit key
• dh1024.pem - the file that contains the pre-generated Diffie-Hellman 1024 bit key
• dh2048.pem - the file that contains the pre-generated Diffie-Hellman 2048 bit key
• tm1store - the Java certificate store containing the public root authority certificate
• tm1cipher.dat - the encrypted file containing the password used to access the server's private key
• tm1key.dat - the key used to encrypt and decrypt tm1cipher.dat

**Configuring the Cognos TM1 Admin Server to use SSL**

Use IBM Cognos Configuration to configure the IBM Cognos TM1 Admin Server to use SSL.

**Note:** As of IBM Cognos TM1 version 10.1, these parameters are set exclusively in Cognos Configuration and no longer set in the Tm1admsrv.ini configuration file.

Open Cognos Configuration and edit the SSL-related parameters as described in the following table.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Support non-SSL clients?</td>
<td>This parameter determines if the Admin Server supports non-SSL Cognos TM1 clients.</td>
</tr>
<tr>
<td></td>
<td>Set this parameter to True to configure the Admin Server to support non-SSL clients and to listen for client connections on both secured (SSL) and unsecured ports.</td>
</tr>
<tr>
<td></td>
<td>Set this parameter to False to configure the Admin Server to support only SSL client connections on a single secured port.</td>
</tr>
<tr>
<td>TM1 Admin Server certificate authority file location</td>
<td>The full path and name of the Cognos TM1 Admin Server's certificate authority file.</td>
</tr>
<tr>
<td>Certificate file location</td>
<td>The full path of the Cognos TM1 Admin Server's certificate file, which contains the public/private key pair.</td>
</tr>
<tr>
<td>Diffie-Hellman 512 bit key file location</td>
<td>The full path name of the file that contains a pre-generated Diffie-Hellman 512 bit key.</td>
</tr>
<tr>
<td></td>
<td>The generation of Diffie-Hellman parameters can be computationally expensive. To minimize the consumption of resources and to reduce the amount of time required to load the Cognos TM1 server, the Diffie-Hellman 512 bit key should be pre-generated and stored in a file that is called when the Admin Server starts.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
</tr>
<tr>
<td>Diffie-Hellman 1024 bit key file location</td>
<td>The full path of the file that contains a pre-generated Diffie-Hellman 1024 bit key. The generation of Diffie-Hellman parameters can be computationally expensive. To minimize the consumption of resources and to reduce the amount of time required to load the Cognos TM1 server, the Diffie-Hellman 1024 bit key should be pre-generated and stored in a file that is called when the Admin Server starts.</td>
</tr>
<tr>
<td>TM1 Admin Server private key password file location</td>
<td>The full path of the file that contains the encrypted password for the Cognos TM1 Admin Server’s private key.</td>
</tr>
<tr>
<td>TM1 Admin Server password key file location</td>
<td>The full path of the file that contains the key used to encrypt and decrypt the password for the private key.</td>
</tr>
</tbody>
</table>
| Export TM1 Admin Server certificate? | Specifies whether the Cognos TM1 Admin Server’s certificate should be exported from the Windows certificate store.  
If this parameter is set to True, the Admin Server’s certificate is exported from the Windows certificate store when the certificate is requested by the Admin Server.  
For details on using your own security certificates and exporting certificates from the Windows certificate store, see “Using independent certificates with SSL and Cognos TM1” on page 235. |
| TM1 Admin Server certificate ID | Specifies the name of the principal to whom the Cognos TM1 Admin Server’s certificate is issued to. |
| Certificate revocation file location | The full path of the Cognos TM1 Admin Server’s certificate revocation file.  
A certificate revocation file will only exist in the event that a certificate has been revoked. |
| TM1 Admin Server export key ID | Specifies the identity key used to export the Admin Server’s certificate from the Microsoft Windows certificate store.  
This parameter is required only if you choose to use the certificate store. |
### Configuring the Cognos TM1 Server to use SSL

To configure an IBM Cognos TM1 server to use SSL, you must set several parameters in `Tm1s.cfg`, a Cognos TM1 server’s configuration file.

The following table describes SSL-related parameters that can be set in the `Tm1s.cfg` configuration file. Note that this table describes only the `Tm1s.cfg` parameters that are related to SSL; all other `Tm1s.cfg` parameters are described in “Parameters in the `tm1s.cfg` File” on page 256.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
</table>
| UseSSL                        | Enables or disables SSL on the Cognos TM1 server.  
This parameter is enabled by default.  
Set `UseSSL=F` to disable SSL. With this setting, clients will be able to connect to the server in insecure mode. |
| AdminSvrSSLCertID             | Specifies the name of the principal to whom the Cognos TM1 Admin Server’s certificate is issued.  
The value of this parameter should be identical to the `TM1 Admin Server Certificate ID` parameter set in IBM Cognos Configuration.  
If `AdminSvrSSLCertID` is incorrectly configured, the server pull-down menu in Cognos TM1 Web displays as empty and an error is logged to the TM1web.log file. |
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AdminSvrSSLCertAuthority</td>
<td>The full path of the certificate authority file that issued the Cognos TM1 Admin Server's certificate.</td>
</tr>
<tr>
<td>AdminSvrSSLCertRevList</td>
<td>The full path of the certificate revocation file issued by the certificate authority that originally issued the Cognos TM1 Admin Server's certificate. A certificate revocation file will exist only in the event a certificate had been revoked.</td>
</tr>
<tr>
<td>ExportAdminSvrSSLCert</td>
<td>Specifies whether the Cognos TM1 Admin Server's certificate should be exported from the Microsoft Windows certificate store.</td>
</tr>
<tr>
<td></td>
<td>If ExportAdminSvrSSLCert=T, the Admin Server's certificate is exported from the Microsoft Windows certificate store when the certificate is requested by the Cognos TM1 server.</td>
</tr>
<tr>
<td></td>
<td>If ExportAdminSvrSSLCert=T, you must also set the following tm1s.cfg parameters:</td>
</tr>
<tr>
<td></td>
<td>• AdminSvrSSLCertID</td>
</tr>
<tr>
<td></td>
<td>• AdminSvrSSLExportKey</td>
</tr>
<tr>
<td></td>
<td>• SvrSSLExportKeyID</td>
</tr>
<tr>
<td></td>
<td>• SSLCertificateID</td>
</tr>
<tr>
<td></td>
<td>• SSLCertificateFile</td>
</tr>
<tr>
<td></td>
<td>• SSLPrivateKeyFile</td>
</tr>
<tr>
<td></td>
<td>• SSLPrivateCertificate</td>
</tr>
<tr>
<td>AdminSvrSSLExportKeyID</td>
<td>Specifies the identity key used to export the Admin Server's certificate from the Microsoft Windows certificate store.</td>
</tr>
<tr>
<td></td>
<td>This parameter is required only if you choose to use the certificate store by setting ExportAdminSvrSSLCert=T.</td>
</tr>
<tr>
<td>SSLCertificate</td>
<td>The full path of the certificate file that contains the public/private key pair.</td>
</tr>
<tr>
<td>SSLCertAuthority</td>
<td>The name of the Cognos TM1 server's certificate authority file. This file must reside on the computer where the Cognos TM1 server is installed.</td>
</tr>
<tr>
<td>SSLCertRevocationFile</td>
<td>The name of the Cognos TM1 server's certificate revocation file. A certificate revocation file will exist only in the event a certificate has been revoked. This file must reside on the computer where the Cognos TM1 server is installed.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>SSLCertificateID</td>
<td>The name of the principal to whom the Cognos TM1 server's certificate is issued.</td>
</tr>
<tr>
<td>CertificateVersion</td>
<td>Specifies which version of the TM1 generated SSL certificates to use.</td>
</tr>
<tr>
<td></td>
<td>Change this parameter only if you want to use the new 2048-bit encryption version of the default certificates.</td>
</tr>
<tr>
<td></td>
<td>You can use the new version with old and new TM1 clients, but you must configure the clients to use the new certificate authority file.</td>
</tr>
<tr>
<td></td>
<td>Valid values include</td>
</tr>
<tr>
<td>v1</td>
<td>1 - Enables certificate authority for 1024-bit encryption with sha-1 (default value)</td>
</tr>
<tr>
<td>v2</td>
<td>2 - Enables certificate authority for 2048-bit encryption with sha-256</td>
</tr>
<tr>
<td>ExportSvrSSLCert</td>
<td>Specifies whether the Cognos TM1 server's certificate should be exported from the Microsoft Windows certificate store.</td>
</tr>
<tr>
<td></td>
<td>If ExportSvrSSLCert=T, the Cognos TM1 server's certificate is exported from the Windows certificate store when the certificate is requested by the Cognos TM1 server.</td>
</tr>
<tr>
<td></td>
<td>If ExportSvrSSLCert=T, you must also set the following tm1s.cfg parameters:</td>
</tr>
<tr>
<td></td>
<td>• AdminSvrSSLCertID</td>
</tr>
<tr>
<td></td>
<td>• AdminSvrSSEnryptKey</td>
</tr>
<tr>
<td></td>
<td>• SvrSSLEntryptKeyID</td>
</tr>
<tr>
<td></td>
<td>• SSLCertificateID</td>
</tr>
<tr>
<td></td>
<td>• SSLPrivateKeyID</td>
</tr>
<tr>
<td></td>
<td>• SSLPrivateKeyPwdFile</td>
</tr>
<tr>
<td></td>
<td>• SSLCertAuthority</td>
</tr>
<tr>
<td></td>
<td>• ClientExportSSLSvrCert</td>
</tr>
</tbody>
</table>
|                      | For details on using your own security certificates and exporting certificates from the Microsoft Windows certificate store, see “Using independent certificates with SSL and Cognos TM1” on page 235.
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SvrSSLExportKeyID</td>
<td>The identity key used to export the Cognos TM1 server's certificate from the Microsoft Windows certificate store.</td>
</tr>
<tr>
<td></td>
<td>This parameter is required only if you choose to use the certificate store by setting ExportSvrSSLCert=T.</td>
</tr>
<tr>
<td>SSLPrivateKeyPwdFile</td>
<td>The full path of the .dat file that contains the encrypted password for the private key.</td>
</tr>
<tr>
<td>SSLPwdKeyFile</td>
<td>The full path of the .dat file that contains the key used to encrypt and decrypt the password for the private key.</td>
</tr>
<tr>
<td>ClientExportSSLSvrCert</td>
<td>Specifies whether the Cognos TM1 client should retrieve the certificate authority certificate, which was originally used to issue the Cognos TM1 server's certificate, from the Microsoft Windows certificate store. If ClientExportSSLSvrCert=T, the certificate authority certificate is exported from the certificate store on the client computer when requested by the Cognos TM1 client.</td>
</tr>
<tr>
<td>ClientExportSSLSvrKeyID</td>
<td>The identity key used by the TM1 client to export the certificate authority certificate, which was originally used to issue the Cognos TM1 server's certificate, from the Windows certificate store.</td>
</tr>
<tr>
<td>DHFile-512</td>
<td>The full path of the file that contains the pre-generated Diffie-Hellman 512 bit key.</td>
</tr>
<tr>
<td></td>
<td>The generation of Diffie-Hellman parameters can be computationally very expensive. To minimize this cost, the Diffie-Hellman 512 bit key can be pre-generated and stored in a file that is called when the Cognos TM1 server starts.</td>
</tr>
<tr>
<td>DHFile-1024</td>
<td>The full path name of the file that contains the pre-generated Diffie-Hellman 1024 bit key.</td>
</tr>
<tr>
<td></td>
<td>The generation of Diffie-Hellman parameters can be computationally very expensive. To minimize this cost, the Diffie-Hellman 1024 bit key can be pregenerated and stored in a file that is called when the Cognos TM1 server starts.</td>
</tr>
</tbody>
</table>
### Parameter Description

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DHFile-2048</td>
<td>The full path name of the file that contains the pre-generated Diffie-Hellman 2048 bit key. The generation of Diffie-Hellman parameters can be computationally very expensive. To minimize this cost, the Diffie-Hellman 2048 bit key can be pregenerated and stored in a file that is called when the Cognos TM1 server starts.</td>
</tr>
</tbody>
</table>

### Configuring Cognos TM1 clients to use SSL

To configure IBM Cognos TM1 Architect or Perspectives clients to use SSL, you must set several options on the Cognos TM1 Options dialog box.

1. Open Cognos TM1 Architect or Cognos TM1 Perspectives, Server Explorer.
2. In Server Explorer, click **File > Options**.
3. Edit the SSL options in the **Admin Server Secure Socket Layer (SSL)** section.

The following table describes all SSL-related options that can be set in the TM1 Options dialog box and lists the corresponding Tm1p.ini parameters.

<table>
<thead>
<tr>
<th>Option Name</th>
<th>Corresponding Tm1p.ini Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Certificate Authority</td>
<td>AdminSvrSSLCertAuthority</td>
<td>The full path of the certificate authority file that issued the Cognos TM1 Admin Server’s certificate.</td>
</tr>
<tr>
<td>Certificate Revocation List</td>
<td>AdminSvrSSLCertRevList</td>
<td>The full path of the certificate revocation file issued by the certificate authority that originally issued the Cognos TM1 Admin Server’s certificate. A certificate revocation file will only exist in the event a certificate had been revoked.</td>
</tr>
<tr>
<td>Certificate ID</td>
<td>AdminSvrSSLCertID</td>
<td><strong>Note:</strong> The name of the principal to whom the Cognos TM1 Admin Server’s certificate is issued. The value of this parameter should be identical to the SSLCertificateID parameter for the IBM Cognos TM1 Admin Server as set in IBM Cognos Configuration.</td>
</tr>
<tr>
<td>Option Name</td>
<td>Corresponding Tm1p.ini Parameter</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>----------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Use Certificate Store</td>
<td>ExportAdminSvrSSLCert</td>
<td>Select this option if you want the certificate authority certificate which originally issued the Cognos TM1 Admin Server's certificate to be exported from the Microsoft Windows certificate store at runtime. Selecting this option in the Cognos TM1 Options dialog box is equivalent to setting ExportAdminSvrSSLCert=T in the Tm1p.ini file. When this option is selected, you must also set a value for Export Certificate ID in the Cognos TM1 Options dialog box.</td>
</tr>
<tr>
<td>Export Certificate ID</td>
<td>AdminSvrSSLExportKeyID</td>
<td>The identity key used to export the certificate authority certificate, which originally issued the Cognos TM1 Admin Server's certificate, from the certificate store. This parameter is required only if you choose to use the certificate store by setting ExportAdminSvrSSLCert=T.</td>
</tr>
</tbody>
</table>

### Configuring Cognos TM1 Web to use SSL

To enable SSL in IBM Cognos TM1 Web, you must add a certificate in the Java Runtime Environment (JRE) keystore.

**Before you begin**

By default, Cognos TM1 Web uses the standard, default SSL certificates that are included as part of your Cognos TM1 installation. To use your own custom SSL certificates, add your certificate in the Java Runtime Environment (JRE) keystore.

**Procedure**

1. Open IBM Cognos Configuration and enter the secure HTTPS URL for the following parameters:
   - **TM1 Application Server Gateway URI** - For example, `http://system_name:9514/pmpsvc`
   - **External server URI** - For example, `http://system_name:9514`
      Enter the system name and port numbers for your specific configuration.

2. For 32-bit installations:
   a. Open a command prompt and change directory to the JRE location that was provided with the Cognos TM1 installation.
      `tm1_location\bin\jre\7.0\bin`
   b. For example:
      `C:\Program Files\IBM\cognos\tm1\bin\jre\7.0\bin>`
b. Run the Java keytool command to import the certificate into the keystore.

   **Note:** For formatting purposes the command is shown here with line breaks but you should enter the command all on one line.

   ```cmd
   keytool.exe -import -trustcacerts -file
   "c:\Program Files\ibm\cognos\tm1\bin\ssl\your_certificate.pem"
   -alias your_certificate -keystore
   "c:\Program Files\ibm\cognos\tm1\bin\jre\7.0\lib\security\cacerts"
   
   Replace your_certificate.pem and your_certificate with the file name and name of your own certificate.
   
   Enter yes when prompted to trust or add the certificate.
   
   The following message displays: **Certificate was added to keystore.**

3. For 64-bit installations:

   **Attention:** On 64-bit computers, be sure to add the certificates to the bin64 folder.

   a. Open a command prompt and change directory to the JRE location that was provided with the Cognos TM1 installation.

   ```cmd
   C:\Program Files\ibm\cognos\TM1_64\bin64\jre\7.0\bin
   ```

   b. Run the Java keytool command to import the certificate into the keystore.

   For 64-bit installations, target the 64-bit folder when dealing with the certificates. If you do not correctly target the 64-bit locations for certificates when running a 64-bit installation, you receive a warning message indicating that you cannot contact the servers.

   **Note:** For formatting purposes this command is shown with line breaks but you should enter the command all on one line.

   ```cmd
   keytool.exe -import -trustcacerts -file
   "c:\\Program Files\\ibm\\cognos\\TM1_64\\bin64\\ssl\\your_certificate.pem"
   -alias your_certificate -keystore
   "c:\\Program Files\\ibm\\cognos\\TM1_64\\bin64\\jre\\7.0\\lib\\security\\cacerts"
   
   Replace your_certificate.pem and your_certificate with the file name and name of your own certificate.
   
   Enter yes when prompted to trust or add the certificate.
   
   The following message displays: **Certificate was added to keystore.**

4. Use IBM Cognos Configuration to restart the TM1 Application Server and have the change take effect.

   a. In Cognos Configuration, expand the **Environment** node, right-click **TM1 Application Server**, and select **Stop**.

   b. Right-click **TM1 Application Server**, and select **Start**.

   **Remember:** Re-add certificates any time you reinstall Cognos TM1.

**Results**

Log in to Cognos TM1 Web using the secure HTTPS URL to confirm that you can connect to Cognos TM1 using this configuration.

For this example, log in using https://system_name:9514/tm1web.
Configuring Cognos TM1 Applications to use SSL

To configure IBM Cognos TM1 Applications to use SSL, you configure SSL for the other Cognos TM1 components that interact with Cognos TM1 Applications, configure the web servers that support Cognos TM1 Applications, and edit the Cognos TM1 Applications configuration.

Before you begin

Install and configure Cognos TM1 Applications without SSL and ensure that you can run and log in to the program.

About this task

Some of the tasks to use a certificate from another certificate authority use a command-line tool named ThirdPartyCertificateTool. This tool is located in C:\Program Files\ibm\cognos\tm1_64\bin. For more information about this tool, see "ThirdPartyCertificateTool command-line reference" on page 239.

Procedure

1. Configure TM1 Admin Server to use SSL.
   See "Configuring the Cognos TM1 Admin Server to use SSL" on page 221.
2. Configure TM1 Server to use SSL.
   See "Configuring the Cognos TM1 Server to use SSL" on page 223.
3. Configure TM1 Web to use SSL.
   See "Configuring Cognos TM1 Web to use SSL" on page 228.
4. Copy your certificate files into the Cognos TM1 Applications SSL folder:Cogos TM1 install location\webapps\pmpsvc\WEB-INF\bin\ssl
5. If you are using your own certificates, import them as follows.
   a. On the computer running Cognos TM1 Admin Server, use IBM Cognos Configuration to update the SSL parameters for the Admin Server.
      See "Editing SSL parameters in Cognos Configuration to use independent certificates" on page 236.
   b. On the computer running Cognos TM1 Server, run the tm1crypt.exe tool
      See "Running the TM1Crypt utility" on page 235.
   c. For Cognos TM1 Applications, see "Importing third-party CA SSL certificates into TM1 Application Server" on page 231.
6. In the Cognos Configuration tool change the TM1 Application Server Gateway URI and External Server URI to use the https prefix.
7. Save the configuration and restart the TM1 Applications Server.
8. On the computer running the Cognos TM1 Application Server, edit the Cognos TM1 Applications configuration file, fpmsvc_config.xml.
   a. Open the fpmsvc_config.xml file:
      i. If you deployed Cognos TM1 Applications with the provided Apache Tomcat, look for the file here:
         Cognos TM1 install location\webapps\pmpsvc\WEB-INF\configuration
      ii. If you deployed with a different web application server, look for the file here:
         program files for web application server\webapps\pmpsvc\WEB-INF\configuration
   b. Edit or add the following entry under the </tm1><servers> section:
where authority_file_name is the name of the certificate file and id_name is the certificate name. This file is expected to be found in the folder:
Cognos TM1 install location\webapps\pmpsvc\WEB-INF\bin\ssl

Remember: You must manually copy this file to this location.

c. To specify an SSL certificate revocation list, use the optional revocationList attribute. If specified, the file with the same name is expected to be in the \pmpsvc\WEB-INF\bin\ssl folder.

d. To specify authority and certificate id for a Cognos TM1 Admin Server, add the same <certificate authority /> section under the admin_host section. If a certificate is not specified, the default one is used.

9. Update the URL configuration for the Cognos TM1 Application Web client:
   a. Log in to Cognos TM1 Applications.
   b. Click the Administer IBM Cognos TM1 Applications icon on the toolbar of the Cognos TM1 Applications main page.
   c. Click the TM1 Application Web check box and then click Edit.
   d. Update the value in the URL field to the secure URL for your installation of Cognos TM1 Web. For example:
      https://web server name:9510/tm1web/Contributor.jsp
   e. Click OK.

10. Import TM1 Applications SSL certificate to the Java client keystore.
    a. Export the TM1 Applications root SSL certificate:
       Line breaks shown for publishing purposes only.
       cd <install>\tm1_64\bin
       ThirdPartyCertificateTool.bat -E -T -r c:\tmp\cacert.cer -k "<install>\tm1_64\configuration\signkeypair\jCIAkeystore" -p NoPassWordSet

    b. Import the ssl certificate to the Java keystore.
       cd <install>\tm1_64\bin64\jre\7.0\bin
       keytool -import -file c:\tmp\cacert.cer -keystore "<install>\tm1_64\bin64\jre\7.0\lib\security\cacerts"
       -storepass changeit -alias TM1ApplicationsSSL

**Importing third-party CA SSL certificates into TM1 Application Server**

Use these general instructions as an example to import and use third-party certificate authority (CA) SSL certificates with the TM1 Application Server.

**About this task**

The exact steps depend on which third-party tools you use.

Some of the tasks to use a certificate from another certificate authority use a command-line tool named ThirdPartyCertificateTool. This tool is located in C:\Program Files\ibm\cognos\tm1 64\bin. For more information about this tool, see "ThirdPartyCertificateTool command-line reference" on page 239.

**Procedure**

1. Create a self-signed CA certificate.
For example, the following sample uses OpenSSL to create a self-signed CA certificate named app_ca.pem.

```bash
openssl req -new -x509 -extensions v3_ca -keyout app_ca/private/app_cakey.pem -out app_ca/app_ca.pem -days 3650 -config ./bi_ca_openssl.cnf
```

2. Create the certificate signing request for the signing key.
   For example, use the following line as a template.

   ```bat
   ThirdPartyCertificateTool.bat -java:local -c -s -d
   "CN=TM1_Signer,O=IBM_TM1,ST=MA,C=US" -r signRequest.csr -D "c:\Program Files\ibm\cognos\tm1_64\configuration\signkeypair" -p password
   ..\bin\jre\7.0\bin\java.exe
   com.cognos.accman.jcam.utilities.ThirdPartyCertificateTool -c -s -d
   "CN=TM1_Signer,O=IBM_TM1,ST=MA,C=US" -r signRequest.csr -D "Program Files\ibm\cognos\tm1_64\configuration\signkeypair" -p password
   ```

3. Create the certificate signing request for the encryption key.

   ```bat
   ThirdPartyCertificateTool.bat -java:local -c -e -d
   "CN=aplxprince.swg.usma.ibm.com,O=IBM_TM1,ST=MA,C=US" -r encryptRet.csr -D "c:\Program Files\ibm\cognos\tm1_64\configuration\encryptkeypair" -p password
   ```

4. Copy the signRequest.csr and encryptRequest.csr files to a directory that is accessible by your certificate authority.

5. Input the signRequest.csr and encryptRequest.csr files into the certificate authority and generate the certificates.
   For example, the following sample uses OpenSSL for this step.

   ```bash
c:\openssl.exe ca -out signRequest.pem -config ./bi_ca_openssl.cnf -infiles signRequest.csr

c:\openssl.exe ca -out encryptRequest.pem -config ./bi_ca_openssl.cnf -infiles encryptRequest.csr
```

6. Rename signRequest.pem, encryptRequest.pem, and app_ca.pem.
   For this example, the files are renamed to signCertificate.cer, encryptRequest.cer, and ca.cer.

7. Input the three CA certificates into the IBM Cognos certificate store.

   ```bat
   ThirdPartyCertificateTool.bat -java:local -i -s -r signCertificate.cer -D "c:\Program Files\ibm\cognos\tm1_64\configuration\signkeypair" -p password -t ca.cer

   ThirdPartyCertificateTool.bat -java:local -i -e -r signCertificate.cer -D "c:\Program Files\ibm\cognos\tm1_64\configuration\encryptkeypair" -p password -t ca.cer

   ThirdPartyCertificateTool.bat -java:local -i -T -r ca.cer -D "c:\Program Files\ibm\cognos\tm1_64\configuration\signkeypair" -p password
   ```

8. Open Cognos Configuration and set the `StandaloneCertificateAuthority` advanced property to `true`.
   a. Select Local Configuration, click the click to edit button and then click Add.
   b. Type `StandaloneCertificateAuthority` in the Name box.
   c. Type True in the Value box.
   d. Click OK.
Attention: If you do not set the StandaloneCertificateAuthority advanced property to true, when you try to save the configuration in Cognos Configuration, the following message appears:

[Cryptography] [ ERROR ] CAM-CRP-1132 An error occurred while attempting to request a certificate from the Certificate Authority service. The Certificate Authority service returned the following error: CAM-CRP-1039 Unable to generate a new certificate. An error occurred when the certificate authority Serial Number was updated. Reason: java.io.FileNotFoundException 9.

In Cognos Configuration, make sure the TM1 Application Server Gateway URI is set to localhost.

a. Expand the Environment > TM1 Application Server node.

b. Check the value of the TM1 Application Server Gateway URI property.

http://localhost:9510/pmpsvc

10. In Cognos Configuration, enter the same password that you used in the other steps into the following locations:

- Security > Cryptography > Cognos > Signing key settings > Signing key store password
- Security > Cryptography > Cognos > Encryption key settings > Encryption key store password

11. Restart TM1 Application Server.

a. In Cognos Configuration, expand the Environment > TM1 Application Server node.

b. Right-click on TM1 Application Server and select Stop and then Start.

Configuring the TM1 C API to Use SSL

Several public routines are available as part of the TM1 C API. You can use these routines to configure a client to communicate with the Admin Server using SSL.

For further details, see “Configuring the TM1 C API to Use SSL” in the IBM Cognos TM1 API Guide.

Configuring the Cognos TM1 Java API to use SSL

The certificates used by a Java client to validate the server must reside in either the Java system cacerts truststore file or be specified on the application command line.

The Java system cacerts truststore resides in the Java \lib\security directory.

For example:

C:\Program Files\Java\JDK1.5.0_04\lib\security

The default password for cacerts is “changeit”. Java provides an executable named keytool.exe for this very purpose. For example:

keytool -keystore ..\lib\security\cacerts -alias Companyca -import -file Companyca.der

Optionally, if access is restricted to the system cacerts truststore, a truststore can be created. For example:

keytool -keystore tmistore -alias Companyca -import -file ACompanyca.der
When starting the Java application this keystore must be specified. If a password is required it must be provided as well. For example:

```
java -Djavax.net.ssl.trustStore=bin\ssl\tm1store -Djavax.net.ssl.trustStorePassword=Company
com.mycompany.MyApp
```

Further information is provided in the API specification for the Java 2 Platform Standard Edition. The minimum Java version supported is 1.4.2.

### Configuring the Cognos TM1 ETLDAP Utility to use SSL

Before you can connect to the LDAP server using SSL, you must run the following command to add your certificate to the IBM Cognos TM1 store in the TM1_install_dir\axajre\bin directory:

```plaintext
Example:
C:\Program Files\Cognos\Tm1\axajre\bin >keytool -keystore "C:\Program Files\Cognos\Tm1\bin\ssl\tm1store" -alias Applixldapca -import -file c:\temp\certificate_name.cer
```

In the above command, substitute the name of your certificate file for `certificate_name.cer`.

When prompted for the keystore password, enter 'applix'.

You will receive confirmation that the certificate was added to the Cognos TM1 keystore.

When connecting to the LDAP server, you must select the **SSL** option.

If you do not select the SSL option, the LDAP server will not be able to authenticate your user information.

When running the ETLDAP utility from a command line, you must use the following two parameters to enable SSL:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-Djavax.net.ssl.truststore</td>
<td>Use this parameter to specify the full path to the Java certificate store containing the public root authority certificate. For example, to use the Java certificate store installed with Cognos TM1, use the parameter <code>-Djavax.net.ssl.truststore=C:\Program Files\Cognos\TM1\bin\ssl\tm1store</code></td>
</tr>
<tr>
<td>-Djavax.net.ssl.trustStorePassword</td>
<td>Use this parameter to specify the password used to create the Java certificate store. For example, to specify the password used to create the Java certificate store installed with Cognos TM1, use the parameter <code>-Djavax.net.ssl.trustStorePassword=applix</code></td>
</tr>
</tbody>
</table>
Using independent certificates with SSL and Cognos TM1

Though a standard IBM Cognos TM1 installation is configured to use SSL by relying on the certificates installed in the TM1_install_dir\bin\SSL directory, you should use your own certificates to maximize security.

The following sections describe how to use independent certificates to implement SSL.

Adding your certificate to the Microsoft Windows certificate store

You can add an independent certificate to the Microsoft Windows certificate store and configure IBM Cognos TM1 to use the certificate in the store.

Procedure

1. From the Windows Start menu, click Start > Run and enter mmc to open the Microsoft Management Console.
2. Click File > Add/Remove Snap-in from the Microsoft Management Console.
3. Click Add.
4. Select Certificates and click Add.
5. Select My User Account and click Finish. Click OK.
6. Right-click Personal under Certificates - Current User and select All Tasks > Import. Click Next.
7. Click Browse and select the .pfx file that contains your certificate information. Click Next.
8. Enter a password for the private key and select the Mark this key as exportable option. Click Next.
9. Configure the screen as required and click Next.

Running the TM1Crypt utility

The TM1Crypt utility (TM1Crypt.exe) encrypts the password that is needed by the IBM Cognos TM1 server to access the private key.

The password is encrypted using Advanced Encryption Standard, 256 bit, Cipher Block Chaining (AES-256-CBC).

Location

The TM1Crypt utility, tm1crypt.exe, is installed in the directory:

TM1_install_dir\bin

Syntax

Run the TM1Crypt utility from a command prompt using the following syntax:

tm1crypt.exe -pwd password -keyfile filename -outfile filename -validate
Command options

Table 32. Options for the TM1Crypt utility

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-pwd</td>
<td>The password for the private key. This should be the same password you used to encrypt your certificate.</td>
</tr>
<tr>
<td>-keyfile</td>
<td>The name of the .dat file that will be generated to contain the key used to encrypt and decrypt the password for the private key. If this parameter is not specified, TM1Crypt generates a file named tm1key.dat.</td>
</tr>
<tr>
<td>-outfile</td>
<td>The name of the .dat file that will be generated to contain the encrypted password for the private key. If this parameter is not specified, TM1Crypt generates a file named tm1cipher.dat.</td>
</tr>
<tr>
<td>-validate</td>
<td>If you include the -validate parameter, the utility will decrypt the encrypted password and display the results as clear text. The displayed text should correspond to the password you specified with the -pwd parameter. This parameter does not allow validation of exiting files.</td>
</tr>
</tbody>
</table>

Example

For example, the command

tm1crypt.exe -pwd abc123 -keyfile btkey.dat -outfile btprk.dat -validate

generates two files:
- btkey.dat - contains the key used to encrypt/decrypt the password for the private key
- btprk.dat - contains the encrypted password for the private key.

The generated files are written to the TM1_install_dir\bin directory.

Editing SSL parameters in Cognos Configuration to use independent certificates

After adding your certificate to the Microsoft Windows Certificate Store, use IBM Cognos Configuration to update the SSL parameters for the Cognos TM1 Admin Server.

Note: As of IBM Cognos TM1 version 10.1, these parameters are set exclusively in Cognos Configuration and no longer set in the Tm1admsrv.ini configuration file.
### Table 33. SSL Parameters in Cognos Configuration that support independent certificates

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Export TM1 Admin Server certificate?</td>
<td>This parameter must be set to True to enable the Admin Server to retrieve the certificate from the Certificate Store.</td>
</tr>
<tr>
<td>TM1 Admin Server certificate authority file location</td>
<td>The full path and name of the certificate authority file that issued the TM1 Admin Server’s certificate. You can determine this value by referring to the Microsoft Management Console and clicking Certificates &gt; Personal &gt; Certificates. The authority name displays in the Issued By column of the Properties pane.</td>
</tr>
<tr>
<td>TM1 Admin Server certificate ID</td>
<td>The name of the principal to whom the IBM Cognos TM1 Admin Server’s certificate is issued. You can determine this value by referring to the Microsoft Management Console and clicking Certificates &gt; Personal &gt; Certificates. The principal name displays in the Issued To column of the Properties pane.</td>
</tr>
<tr>
<td>TM1 Admin Server private key password file location</td>
<td>The full path to the .dat file that contains the encrypted password for the private key. <strong>Note:</strong> The name of this file is specified by the -outfile parameter when you run the TM1Crypt utility. For example, if you run the TM1Crypt utility from the following command: <code>tm1crypt.exe -pwd abc123 -keyfile btkey.dat -outfile btprk.dat -validate</code> the correct parameter value is: <code>C:\Program Files\Cognos\TM1\bin\btprk.dat</code></td>
</tr>
<tr>
<td>TM1 Admin Server password key file location</td>
<td>The full path to the .dat file that contains the key used to encrypt and decrypt the password for the private key. <strong>Note:</strong> The name of this file is specified by the -keyfile parameter when you run the TM1Crypt utility. For example, if you run the TM1Crypt utility from the following command: <code>tm1crypt.exe -pwd abc123 -keyfile btkey.dat -outfile btprk.dat -validate</code> the correct parameter value is: <code>C:\Program Files\Cognos\TM1\bin\btkey.dat</code></td>
</tr>
<tr>
<td>TM1 Admin Server export key ID</td>
<td>Specifies the identity key used to export the Admin Server’s certificate from the Windows certificate store. In most cases, the value for <strong>TM1 Admin Server export key ID</strong> will be identical to the value for <strong>TM1 Admin Server certificate ID</strong>.</td>
</tr>
</tbody>
</table>

### Editing SSL parameters in the Tm1s.cfg file to use independent certificates

After adding your certificate to the Microsoft Windows Certificate Store, add the required SSL parameters to the Tm1s.cfg file.
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>AdminSvrSSLCertID</td>
<td>Specifies the name of the principal to whom the IBM Cognos TM1 Admin Server's certificate is issued.</td>
</tr>
<tr>
<td>AdminSvrSSLExportKeyID</td>
<td>Specifies the identity key used to export the Admin Server's certificate from the Microsoft Windows Certificate Store.</td>
</tr>
<tr>
<td>ClientExportSSLSvrCert</td>
<td>Specifies whether the Cognos TM1 client should retrieve the certificate authority certificate, which was originally used to issue the Cognos TM1 server's certificate, from the Microsoft Windows Certificate Store.</td>
</tr>
<tr>
<td>ClientExportSSLSvrKeyID</td>
<td>The identity key used by the Cognos TM1 client to export the certificate authority certificate, which was originally used to issue the Cognos TM1 server's certificate, from the Microsoft Windows Certificate Store.</td>
</tr>
<tr>
<td>ExportAdminSvrSSLCert</td>
<td>Specifies whether the Cognos TM1 Admin Server's certificate should be exported from the Microsoft Windows Certificate Store.</td>
</tr>
<tr>
<td>ExportSvrSSLCert</td>
<td>This parameter must be set to T to enable the Cognos TM1 server to retrieve the certificate from the Microsoft Windows Certificate Store.</td>
</tr>
<tr>
<td>SSLCertAuthority</td>
<td>The name of the authority that issued your certificate. You can determine this value by referring to the Microsoft Management Console and clicking Certificates &gt; Personal &gt; Certificates. The authority name is displayed in the Issued By column of the Properties pane.</td>
</tr>
<tr>
<td>SSLCertificateID</td>
<td>The name of the principal to whom the Cognos TM1 Server's certificate is issued. You can determine this value by referring to the Microsoft Management Console and clicking Certificates &gt; Personal &gt; Certificates. The principal name is displayed in the Issued To column of the Properties pane.</td>
</tr>
<tr>
<td>SSLPrivateKeyPwdFile</td>
<td>The full path to the .dat file that contains the encrypted password for the private key. <strong>Note:</strong> The name of this file is specified by the -outfile parameter when you run the TM1Crypt utility. For example, if you run the TM1Crypt utility from the following command: tm1crypt.exe -pwd abc123 -keyfile btkey.dat -outfile btprk.dat -validate the correct parameter value is SSLPrivateKeyPwdFile=C:\Program Files\Cognos\TM1\bin\btprk.dat.</td>
</tr>
</tbody>
</table>
Table 34. SSL Parameters for the Tm1s.cfg file (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>SSLPwdKeyFile</td>
<td>The full path to the .dat file that contains the key used to encrypt and decrypt the password for the private key.</td>
</tr>
<tr>
<td>Note:</td>
<td>The name of this file is specified by the -keyfile parameter when you run the TM1Crypt utility.</td>
</tr>
<tr>
<td></td>
<td>For example, if you run the TM1Crypt utility from the following command:</td>
</tr>
<tr>
<td></td>
<td>tm1crypt.exe -pwd abc123 -keyfile btkey.dat -outfile btprk.dat -validate</td>
</tr>
<tr>
<td></td>
<td>the correct parameter value is SSLPwdKeyFile=C:\Program Files\Cognos\TM1\bin\btkey.dat</td>
</tr>
<tr>
<td>SvrSSLExportKeyID</td>
<td>Specifies the identity key used to export the Cognos TM1 server’s certificate from the Microsoft Windows certificate store.</td>
</tr>
<tr>
<td></td>
<td>In most cases, the value for SvrSSLExportKeyID will be identical to the value for SSLCertificateID.</td>
</tr>
</tbody>
</table>

Using independent certificates on your file system
You can implement SSL using independent certificates stored on your file system.

Simply add your certificate, certificate authority, password files, etc. to the TM1_install_dir\bin\SSL directory and modify the appropriate IBM Cognos TM1 configuration parameters to point to your independent files.

ThirdPartyCertificateTool command-line reference
Some of the tasks to use a certificate from another certificate authority use a command-line tool named ThirdPartyCertificateTool.

This tool is located in the following Cognos TM1 installation \bin location.

For example: C:\Program Files\IBM\cognos\tm1_64\bin

On UNIX or Linux operating systems, use the following format:

ThirdPartyCertificateTool.sh parameters

On Microsoft Windows operating systems, use the following format:

ThirdPartyCertificateTool.bat parameters

The following tables lists the options for this command-line tool.

Table 35. Main operation mode

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-c</td>
<td>Create a new CSR</td>
</tr>
<tr>
<td>-i</td>
<td>Import a certificate</td>
</tr>
</tbody>
</table>
Table 36. Operation modifiers

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-s</td>
<td>Work with the signing identity</td>
</tr>
<tr>
<td>-e</td>
<td>Work with the encryption identity</td>
</tr>
<tr>
<td>-T</td>
<td>Work with the trust store (only with -i)</td>
</tr>
</tbody>
</table>

Table 37. Information flags

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-d</td>
<td>DN to use for certificate</td>
</tr>
<tr>
<td>-r</td>
<td>CSR or certificate file location (depends on mode)</td>
</tr>
<tr>
<td>-t</td>
<td>Certificate authority certificate file (only with -i)</td>
</tr>
<tr>
<td>-p</td>
<td>Key Store password</td>
</tr>
<tr>
<td>-a</td>
<td>Key pair algorithm: either RSA or DSA. RSA is the default value.</td>
</tr>
<tr>
<td>-D</td>
<td>Directory location</td>
</tr>
</tbody>
</table>

The sample values from the following table are used:

Table 38. Sample values

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Signing certificate distinguished name (DN)</td>
<td>A unique value, formatted like the following:</td>
</tr>
<tr>
<td></td>
<td>CN=SignCert, O=MyCompany, C=CA</td>
</tr>
<tr>
<td>Encryption certificate DN</td>
<td>A unique value, formatted like the following:</td>
</tr>
<tr>
<td></td>
<td>CN=EncryptCert, O=MyCompany, C=CA</td>
</tr>
<tr>
<td>Key store password</td>
<td>password</td>
</tr>
</tbody>
</table>
Chapter 16. Maintenance of your Cognos TM1 installation

After successfully installing IBM Cognos TM1, you can perform maintenance tasks such as installing additional components, backing up and restoring your data and configuration files, and uninstalling the current version.

Installing additional components
You can return to the Cognos TM1 Installation Wizard to install additional components that are not installed.

Backing up data and configuration files
You should regularly back up your data and configuration files, especially before upgrading to a new version of Cognos TM1.

Uninstalling the current version
Depending on which Cognos TM1 components you installed, you might have to perform separate steps to remove them. For example, IBM Cognos Insight and IBM Cognos TM1 Performance Modeler are uninstalled differently than the other IBM Cognos TM1 components.

Backing up data and configuration files for Cognos TM1

This topic describes how to backup your data and configuration files for IBM Cognos TM1 version 10.2 components.

About this task
Each Cognos TM1 component has its own set of related data and configuration files. Review and follow the steps below to backup the data and configuration information for the components you are using.

For example:
• For each IBM Cognos TM1 server you are running, backup your Cognos TM1 data directory and configuration files.
• If you are using Cognos TM1 Web, you should back up the related data and configuration files for that component.
• If you are using Cognos TM1 Applications, you should export your applications and backup any other related files.

Procedure
1. Export configuration settings from IBM Cognos Configuration:
   If you used the Cognos Configuration utility to run and manage your Cognos TM1 components, such as the Cognos TM1 Admin Server, Cognos TM1 servers, or the Cognos TM1 Application Server, you can save an XML file of your configuration information.
   a. Open Cognos Configuration.
   b. Click File > Export As.
   c. Select a location and enter a file name for the XML file.
   d. Click Save.
2. Back up Cognos TM1 Server databases:
Save a copy of the contents of your IBM Cognos TM1 database data directories and subdirectories to a secure location. These directories contain both data and configuration files. For example, the Cognos TM1 sample database directories and subdirectories are located here:

\<TM1 Install\>\samples\tm1

3. Back up additional Cognos TM1 configuration files:
   Save a copy of any Cognos TM1 configuration files you may want to retain, such as the Cognos TM1 Admin Server logging properties file, tm1admsrv-log.properties, located in the \<TM1 Install\>\bin\directory.

4. Back up Cognos TM1 Web:
   If you use Cognos TM1 Web, backup the tm1web_config.xml file and any custom Cognos TM1 Web server pages to a secure location. The default location for these files is:
   \<TM1 Install\>\webapps\tm1web\bin\...
   \<TM1 Install\>\webapps\tm1web\web-inf\configuration\......

5. Back up Cognos TM1 Architect and Cognos TM1 Perspectives:
   If you are using Cognos TM1 Architect or Cognos TM1 Perspectives, save the Tm1p.ini client configuration file from:
   • %ALLUSERSPROFILE%\Application Data\Applix\TM1\Tm1p.ini
   • %USERPROFILE%\Application Data\Applix\TM1\Tm1p.ini
   In most cases, the full paths to these files are:
   • C:\Documents and Settings\All Users\Application Data\Applix\TM1\Tm1p.ini
   • C:\Documents and Settings\<username>\Application Data\Applix\TM1\Tm1p.ini

6. Back up Cognos TM1 Applications:
   If you use Cognos TM1 Applications, see the following steps to backup the related data and configuration files.
   • “Backing up your Cognos TM1 Applications data” on page 245
   • “Exporting applications from Cognos TM1 Applications” on page 245

### Modifying Cognos TM1 installed components

You can modify your current installation by reinstalling components or adding components that are not already installed.

#### About this task

You can only install components using the install wizard, you cannot remove components using this method.

**Note:** Program maintenance does not include changing the location of the Cognos TM1 installation directory. To change the location of the installation directory, remove all Cognos TM1 files and reinstall Cognos TM1 in another location.

#### Procedure

1. To start the installation:
   • Go to the download location for the Cognos TM1 installation program.
   • Or, insert the IBM Cognos TM1 product disk.
If the installation wizard does not open automatically, go to the operating system directory to locate the isssetup.exe file.

2. Depending on your operating system software, right-click or double-click the isssetup.exe file:
   - On Microsoft Windows Vista, Windows 7, or Windows Server 2008 operating system software, right-click the isssetup.exe command and click Run as Administrator.
   - For all other Windows operating system software, double-click isssetup.exe.

3. Click Next to advance to the Component Selection screen.
   If prompted, respond to the following questions:
   - Confirm that you want to install to the same location as a previous installation.
   - Confirm whether or not you want to create a backup of all files from the existing installation.

4. On the Component Selection screen, select the Cognos TM1 components you want to install and click Next.
   The Component Selection screen shows the current state of your Cognos TM1 installation.
   - Items that are currently installed display with a red X icon next to the component name.
   - Items that are not currently installed display with a green check mark next to the name. These items are automatically selected for installation.

5. Click Next to start the modifications.
6. Click Finish when the modifications are completed.

---

**Uninstalling Cognos TM1**

To remove and uninstall all components of IBM Cognos TM1 version 10.x, follow these steps.

**Note:** If you are uninstalling Cognos TM1 Applications, see the section “Uninstalling and undeploying Cognos TM1 Applications” on page 244 for additional required steps.

**Before you begin**

Before you start to uninstall Cognos TM1 10.1, you must have completed the backup of all Cognos TM1 data.

For details, see:
- “Backing up data and configuration files for Cognos TM1” on page 241.
- “Backing up your Cognos TM1 Applications data” on page 245.

**About this task**

Depending on which components you installed, you might have to perform separate steps to remove them. For example, IBM Cognos Insight and IBM Cognos TM1 Performance Modeler are uninstalled differently than the other IBM Cognos TM1 components.
**Procedure**

1. Uninstall Cognos Insight:
   a. From the Windows Control Panel, choose Add or Remove Programs.
   b. In the list of currently installed programs, select IBM Cognos TM1 Insight.
   c. Click Remove and follow the instructions to complete the process.
   d. Check program files directory to see if any files remain. If so delete them manually.

2. Uninstall Cognos TM1 Performance Modeler:
   a. From the Windows Control Panel, choose Add or Remove Programs.
   b. In the list of currently installed programs, select IBM Cognos Performance Modeler.
   c. Click Remove and follow the instructions to complete the process.
   d. Check program files directory to see if any files remain. If so delete them manually.

3. Uninstall core TM1 components:
   These steps uninstall all of the following components in a single procedure:
   - Cognos TM1 Admin Server
   - Cognos TM1 Server
   - Cognos Configuration
   - Cognos TM1 Web
   - Cognos TM1 Architect
   - Cognos TM1 Perspectives
   - Cognos TM1 Applications
   - Cognos TM1 Operations Console
   a. From the Microsoft Windows Start menu, click Programs > IBM Cognos TM1 > Uninstall IBM Cognos TM1 > Uninstall IBM Cognos TM1.
   b. Select the language for the uninstall wizard and click Next.
   c. On the Select the packages you wish to uninstall screen, click the check box for the IBM Cognos TM1 option, then select Next.
      The uninstall program removes the components and may take some time. When completed, you will be prompted to restart your computer.
   d. Choose to restart now or later, then click Finish.
   e. Check the Cognos TM1 installation directory to see if any files or sub-directories remain. If so delete them manually.
      For example, check C:\Program Files\IBM\cognos\tm1.

**Uninstalling and undeploying Cognos TM1 Applications**

The IBM Cognos TM1 Applications needs several steps to do a complete backup and export of data if you want to keep your applications data.

The tasks described here enable you to:
- Backup your Cognos TM1 Applications data
- Export your Cognos TM1 Applications data
- Stop all related services
- Uninstall Cognos TM1 Applications
- Undeploy Cognos TM1 Application from Apache Tomcat if used.
- Undeploy Cognos TM1 Applications from WebSphere if used.
Backing up your Cognos TM1 Applications data

This topic describes how to manually backup your data and configuration files for Cognos TM1 Applications.

About this task

Manually backing up your application files allows you to preserve state data about the applications such as current node ownership and submitted status.

Note: If you only want to save a definition of your application structure without any state data, use the export feature. See “Exporting applications from Cognos TM1 Applications.”

Procedure

1. Back up your Cognos TM1 Server databases that are used by your applications.
   Save a copy of the contents of your IBM Cognos TM1 database data directories and subdirectories to a secure location. These directories contain both data and configuration files. For example, the Cognos TM1 sample database directories and subdirectories are located here:
   `<TM1_Install>\samples\tm1`

2. Save a backup copy of the Cognos TM1 Applications applications folder and the `pmpsvc_config.xml` and `fpmsvc_config.xml` configuration files.
   The typical locations for these items are:
   • `<TM1_Install>\webapps\pmpsvc\WEB-INF\applications`
   • `<TM1_Install>\webapps\pmpsvc\WEB-INF\configuration\pmpsvc_config.xml`
   • `<TM1_Install>\webapps\pmpsvc\WEB-INF\configuration\fpmsvc_config.xml`
   If you are using IBM Cognos BI security with Cognos TM1 Applications, these items are located in the following location: `<Your Program Files>\cognos\cx\webapps\pmpsvc`
   where `x` is the version of Cognos BI you are using.

Exporting applications from Cognos TM1 Applications

You can export the basic definition of an application from IBM Cognos TM1 Applications 10.x to save a backup copy or to move the application to another instance of Cognos TM1 Applications. Exporting allows you to save a template of an application without any of the current user activity or state data. Only the structure and security definition of the application is exported. After you export, you can then import and reuse the application at a later point for something like a new budget planning period.

About this task

An archive is created and contains the XML files that describe the structure and security of your application.

Important: The export process does not preserve state data about the application such as current node ownership and submitted status. If you use the export/import process, this information is not preserved.

If you want to preserve state data about your applications, manually backup the files as described in “Backing up your Cognos TM1 Applications data.”
Procedure
1. Open the TM1 Cognos Applications portal.
2. Click the Export Application icon under the Actions column.
3. From the File Download dialog box, click Save.
4. Navigate to the directory to where you want to save the export file.
5. Click Save.

Stopping related services in Cognos TM1
This topic describes how to stop related services in version 10.2 of IBM Cognos TM1.

Procedure
1. Open Cognos Configuration.
2. Stop all of the following services:
   • TM1 Admin Server
   • all instances of the TM1 server service
   • TM1 Application Server

   Note: Stopping the TM1 Application Server also stops other TM1 components if they are installed on the same computer. This step stops all of the related web application components; Cognos TM1 Applications, Cognos TM1 Web, and Cognos TM1 Operations Console. This step also stops the support services that allow Cognos TM1 to communicate with Cognos TM1 Mobile Contributor and IBM Cognos Analysis for Microsoft Excel.
3. If you are using IBM Cognos Business Intelligence security with Cognos TM1 Applications, stop the IBM Cognos BI service.
4. If you are running any Cognos TM1 services that were not initially configured and started through Cognos Configuration, stop those services in the Windows services console.

Uninstalling Cognos TM1 Applications
If you installed and deployed IBM Cognos TM1 Applications with the default Apache Tomcat that was provided with the Cognos TM1 installation, use the following steps to uninstall Cognos TM1 Applications.

Before you begin
Ensure that you backed up your Cognos TM1 Applications data and stopped the related services in IBM Cognos Configuration.

About this task
These steps only apply if you are using IBM Cognos TM1 Applications with the default version of the Apache Tomcat web application server that was provided with the Cognos TM1 installation.

If you installed and deployed Cognos TM1 Applications to a web application server other than the default one provided, use those tools to undeploy. For details, see the following topics:

- "Undeploying Cognos TM1 Applications in Apache Tomcat" on page 247
- "Undeploying Cognos TM1 Applications in WebSphere" on page 248
Attention: These steps will also remove the following Cognos TM1 components if they are installed on the same computer:

- Cognos TM1 Admin Server
- Cognos TM1 Server
- Cognos Configuration
- Cognos TM1 Web
- Cognos TM1 Architect
- Cognos TM1 Perspectives
- Cognos TM1 Operations Console

Procedure
1. From the Microsoft Windows Start menu, click Programs > IBM Cognos TM1 > Uninstall IBM Cognos TM1 > Uninstall IBM Cognos TM1.
2. Select the language for the uninstall wizard and click Next.
3. On the Select the packages you wish to uninstall screen, click the check box for the IBM Cognos TM1 option, then select Next.

   The uninstall program removes the components and may take some time. When completed, you will be prompted to restart your computer.
4. Choose to restart now or later, then click Finish.
5. Check the Cognos TM1 installation directory to see if any files or sub-directories remain. If so delete them manually.

   For example, check C:\Program Files\IBM\cognos\tm1\webapps\pmpsvc.

Undeploying Cognos TM1 Applications in Apache Tomcat

Use these steps to undeploy IBM Cognos TM1 Applications if you used a separate version of Apache Tomcat and did not use the one provided with the Cognos TM1 installation.

Procedure
1. Open the Tomcat Manager.
2. Click Undeploy for the /pmpsvc entry in the Applications list.
3. Click OK to confirm.

   The application is undeployed and removed from the Tomcat Manager Applications list.

   Tip: If the /pmpsvc entry is still shown in the Applications list after undeploying, stop and restart Tomcat and then click Undeploy for a second time.
4. Verify that the following Cognos TM1 Application Web application folders and files have been deleted. Stop Tomcat and delete these files if they still exist.

Folders
- C:\Program Files\Apache Software Foundation\webapps\pmpsvc
- C:\Program Files\Apache Software Foundation\Tomcat 6.0\webapps\pmpsvc
- C:\Program Files\Apache Software Foundation\Tomcat 6.0\work\Catalina\localhost\pmpsvc

Files
- C:\Program Files\Apache Software Foundation\Tomcat 6.0\webapps\pmpsvc.war
If you are using IBM Cognos Business Intelligence security with Cognos TM1 Applications, these items are located in the following locations:

- `C:\Program Files\cognos\cx\webapps\pmpsvc`
- `C:\Program Files\cognos\cx\tomcat4.1.27\work\Standalone\localhost\pmpsvc`

where x is the version of Cognos BI you are using.

**Undeploying Cognos TM1 Applications in WebSphere**

Use these steps to undeploy IBM Cognos TM1 Applications if you used IBM WebSphere and did not use the default Apache Tomcat that was provided with the Cognos TM1 installation.

**Procedure**

1. Open the WebSphere Administrative Console.
2. In the Console Navigation pane, locate the Applications section and click Web App WARs.
   - The Installed Web Applications page opens.
3. Locate the entry for /pmpsvc in the URL column and click Uninstall.
4. Click OK to confirm the uninstall.

WebSphere displays the following message when complete:

Uninstalled application
default/pmpsvc

**Restoring data and configuration files in Cognos TM1 version 10.2.2**

After installing the newer version of IBM Cognos TM1, complete these steps to restore your previous Cognos TM1 10.2.x configuration and data files.

**Before you begin**

Install the new version of the product.

**About this task**

These steps apply only to restoring data and configuration files for Cognos TM1 version 10.2.2.

If you need to restore information from version 9.x into version 10.2.2, see "Restoring data and configuration files from Cognos TM1 version 9.x into the current version" on page 58.

**Procedure**

1. Restore Cognos TM1 Server data:
   - For each Cognos TM1 server that you want to restore, copy its data directory and subdirectories to the new location for data: `<TM1_Install>\samples\tm1`.
2. Restore configuration information in IBM Cognos Configuration:
   - This includes configuration information for Cognos TM1 Admin Server, Cognos TM1 Application Server, and each Cognos TM1 server you want to run.
     a. Open IBM Cognos Configuration.
b. In the Cognos Configuration Explorer pane, expand Local Configuration > Environment.

c. Click TM1 Admin Server and update the parameters in the Properties pane.

d. Click TM1 Application Server and update the parameters in the Properties pane.

e. Click Data Access > TM1 Server and add an entry for each Cognos TM1 server that you want to use.

For details, see “Adding an existing Cognos TM1 server in Cognos Configuration” on page 95.

f. Click File > Save.

3. Restore Cognos TM1 Architect and Cognos TM1 Perspectives configuration files:

If you want to restore any settings from your previous installation of Cognos TM1 Architect or Cognos TM1 Perspectives, copy the values from your old Tm1p.ini file into the new Tm1p.ini file.

Attention: If you leave your old Tm1p.ini files in place, you might need to update the directory path in the file for the AdminSvrSSLCertAuthority parameter. For example, if you are using the default Cognos TM1 SSL certificate, manually change the value for this parameter to the new install path C:\Program Files\IBM\cognos\tm1\bin\ssl\applixca.pem.

a. Update the new system default Tm1p.ini file located here:

%ALLUSERSPROFILE%\Application Data\Applix\TM1\Tm1p.ini

For example: C:\Documents and Settings\All Users\Application Data\Applix\TM1\Tm1p.ini

b. Update the new user-specific Tm1p.ini file located here:

%APPDATA%\Applix\TM1\Tm1p.ini

For example: C:\Documents and Settings\user name\ApplicationData\Applix\TM1\Tm1p.ini

4. Restore your Cognos TM1 Web files:

Note: As of IBM Cognos TM1 version 10.2.0, the default installation directory for Cognos TM1 Web is <TM1_Install>\webapps\tm1web.

- Restoring files from Cognos TM1 Web version 10.2.0 or newer:

Open your old tm1web_config.xml file and selectively merge the lines and parameters that you want to use into the new tm1web_config.xml file located in <TM1_Install>\webapps\tm1web\web-inf\configuration.

- Restoring files from a pre-10.2.0 version of Cognos TM1 Web:

Note: Cognos TM1 Web version 10.2.0 uses a new configuration file named tm1web_config.xml. This file replaces the web.config file from previous Cognos TM1 Web versions. For more information, see “Modifying Cognos TM1 Web Configuration Parameters” on page 114.

Open your old Web.config file and selectively merge the lines and parameters that you want to use into the new tm1web_config.xml file located in <TM1_install>\webapps\tm1web\web-inf\configuration.

5. Restore your application and configuration files in Cognos TM1 Applications:

For details, see:

- “Restoring application and configuration files in Cognos TM1 Applications” on page 250
Restoring application and configuration files in Cognos TM1 Applications

You can manually restore backup copies of your application and configuration files into an existing version of IBM Cognos TM1 Applications.

**Before you begin**

The Cognos TM1 server that your application depends on must be restored and running before you restore the application files for Cognos TM1 Applications.

**Procedure**

1. Restore your applications for Cognos TM1 Applications:
   - Copy your application files here:
     `<TM1_Install>\webapps\pmpsvc\WEB-INF\applications`

2. Restore your configuration files for Cognos TM1 Applications:
   - Copy your backup copies of the `pmpsvc_config.xml` and `fpmsvc_config.xml` configuration files to here:
     - `<TM1_Install>\webapps\pmpsvc\WEB-INF\configuration\pmpsvc_config.xml`
     - `<TM1_Install>\webapps\pmpsvc\WEB-INF\configuration\fpmsvc_config.xml`

3. In Cognos Configuration:
   a. Start the TM1 Application server.
   b. Start the TM1 servers that are related to your application.

4. Log in to the Cognos TM1 Applications portal and add the related TM1 server to the configuration page if it is not already listed.
   a. Click the **Administer IBM Cognos TM1 Applications** icon on the toolbar of the Cognos TM1 Applications main page.
   b. Under the **Server Names** section, click **Add** and enter the information for the related TM1 server.
   c. Click **OK**.

      The applications in the `webapps/pmpsvc/WEB-INF/application` folder will be upgraded and added to Cognos TM1 Applications.

**Note:** The upgrade process may take some time depending on the amount of rights that need to be applied in the application. For more information, see “Saving security rights when importing or restoring a Cognos TM1 Application” on page 60.

---

Importing an application definition in Cognos TM1 Applications

You can import an application definition that was exported from IBM Cognos TM1 Applications back into IBM Cognos TM1 Applications.

**Procedure**

1. Open the **Cognos TM1 Applications** portal.
2. Click the **Import Application** button.
3. Select the Cognos TM1 server onto which you want to import the application.
4. Next to the **Application file** field, click **Browse**.
5. Navigate to the application (.zip) file, then click Open.
6. Select the Import application security option if you want to import security settings with the application.

   **Note:** If you import security settings, the rights-saving operation may take longer to process depending on the amount of rights that need to be applied in the application. For more information, see “Saving security rights when importing or restoring a Cognos TM1 Application” on page 60.
7. Select the Import application properties option if you want to import property settings with the application.
8. Click Import.
Chapter 17. Accessibility features

Accessibility features help users who have a physical disability, such as restricted mobility or limited vision, to use information technology products.

See the IBM Accessibility Center for more information about the commitment that IBM has to accessibility.

The IBM Accessibility Center is available online at [http://www.ibm.com/able](http://www.ibm.com/able)

**Keyboard shortcuts for the installation wizard**

Keyboard shortcuts, or shortcut keys, provide you with an easier and often faster method of navigating and using software.

The installation wizard uses standard Microsoft Windows operating system navigation keys in addition to application-specific keys.

**Note:** The following keyboard shortcuts are based on US standard keyboards.

The following table lists the keyboard shortcuts that you can use to perform some of the main tasks in the installation wizard on the Windows operating system.

<table>
<thead>
<tr>
<th>Action</th>
<th>Shortcut key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move to the next field on a page</td>
<td>Tab</td>
</tr>
<tr>
<td>Return to the previous field on a page</td>
<td>Shift+Tab</td>
</tr>
<tr>
<td>Close the installation wizard</td>
<td>Alt+F4</td>
</tr>
<tr>
<td>Move to the next configuration step</td>
<td>Alt+N</td>
</tr>
<tr>
<td>Return to the previous configuration step</td>
<td>Alt+B</td>
</tr>
<tr>
<td>Move to the next selection in a list</td>
<td>Down arrow</td>
</tr>
<tr>
<td>Move to the previous selection in a list</td>
<td>Up arrow</td>
</tr>
</tbody>
</table>

The following table lists the keyboard shortcuts you can use to perform some of the main tasks in the installation wizard on the UNIX or Linux operating system.

<table>
<thead>
<tr>
<th>Action</th>
<th>Shortcut key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move to the next field on a page</td>
<td>Tab</td>
</tr>
<tr>
<td>Return to the previous field on a page</td>
<td>Shift+Tab</td>
</tr>
<tr>
<td>Close the installation wizard</td>
<td>Alt+F4</td>
</tr>
<tr>
<td>Move to the next selection in a list</td>
<td>Down arrow</td>
</tr>
<tr>
<td>Move to the previous selection in a list</td>
<td>Up arrow</td>
</tr>
</tbody>
</table>

The following table lists the keyboard shortcuts you can use to perform some of the main tasks in the License Agreement page of the installation wizard.

<table>
<thead>
<tr>
<th>Action</th>
<th>Shortcut key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accept the license agreement</td>
<td>Alt+A</td>
</tr>
</tbody>
</table>
### Keyboard shortcuts for Cognos Configuration

Keyboard shortcuts, or shortcut keys, provide you with an easier and often faster method of navigating and using software.

The following keyboard shortcuts are based on US standard keyboards.

The following table lists the keyboard shortcuts that you can use to perform some of the main tasks in IBM Cognos Configuration on the Windows operating system.

<table>
<thead>
<tr>
<th>Action</th>
<th>Shortcut key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Decline the license agreement</td>
<td>Alt+D</td>
</tr>
<tr>
<td>Quit the installation wizard</td>
<td>Alt+x</td>
</tr>
<tr>
<td>Save the current configuration</td>
<td>Ctrl+S</td>
</tr>
<tr>
<td>Close Cognos Configuration</td>
<td>Alt+F4</td>
</tr>
<tr>
<td>Rename the selected item</td>
<td>F2</td>
</tr>
<tr>
<td>Display the File menu</td>
<td>Alt+F</td>
</tr>
<tr>
<td>Display the Edit menu</td>
<td>Alt+E</td>
</tr>
<tr>
<td>Display the View menu</td>
<td>Alt+V</td>
</tr>
<tr>
<td>Display the Actions menu</td>
<td>Alt+A</td>
</tr>
<tr>
<td>Display the Help menu</td>
<td>Alt+H</td>
</tr>
</tbody>
</table>

The following table lists the keyboard shortcuts you can use to perform some of the main tasks in Cognos Configuration on the UNIX or Linux operating system.

<table>
<thead>
<tr>
<th>Action</th>
<th>Shortcut key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save the current configuration</td>
<td>Tab</td>
</tr>
<tr>
<td>Close Cognos Configuration</td>
<td>Shift+Tab</td>
</tr>
<tr>
<td>Rename the selected item</td>
<td>Alt+F4</td>
</tr>
</tbody>
</table>
Appendix A. The tm1s.cfg Server Configuration File

The tm1s.cfg file is an ASCII file that specifies environment information for an IBM Cognos TM1 server.

A default tm1s.cfg file is created in the Cognos TM1 server data directory when you install a copy of the Cognos TM1 server. Most of the available parameters are documented in the configuration file. If a parameter is not installed by default, the parameter is commented out in the configuration file. You can edit the tm1s.cfg file to reflect the environment of the associated remote server by un-commenting the parameter you wish to use and setting the correct value.

For an alphabetical listing of all the parameters in the server configuration file, see “Parameters in the tm1s.cfg File” on page 256.

Location of the tm1s.cfg File

The location of the tm1s.cfg file depends on the type of server you are using.

• If you are using the IBM Cognos Configuration tool to start and stop your IBM Cognos TM1 servers, you can view the configuration path for a Cognos TM1 server by clicking the server name in the Explorer tree of Cognos Configuration.

• If you are running the Cognos TM1 remote server as a Microsoft Windows service (Tm1sd.exe), and you used the Cognos TM1 installation program to install the server, the system uses the tm1s.cfg file that is located in the server data directory you specified during installation.

• If you are running the Cognos TM1 remote server as a Windows application (Tm1s.exe), you specify the location of the tm1s.cfg file by using the -z parameter in the command line when you start the server, either from a shortcut or from a command prompt.

For example, this command specifies that Cognos TM1 will use the tm1s.cfg file located in the c:\salesdata directory:

c:\Program Files\Cognos\TM1\bin\tm1s.exe
-z c:\salesdata

If the -z parameter points to a directory containing spaces, you must enclose the directory in double quotes. For example, -z "c:\sales data".

• If you are running a Cognos TM1 server on UNIX, and you used the Cognos TM1 installation program to install the server, the system uses the tm1s.cfg file that is located in the server data directory you specified during installation.

Sample tm1s.cfg File

This is a sample tm1s.cfg file.

Your tm1s.cfg file may also include comments that describe the parameters.

#Security mode
#(there are typically some information comments here.)
[TM1S]
ServerLogging=F
SecurityPackageName=Kerberos
IntegratedSecurityMode=1
UseSSL=T
ServerName=Planning Sample
DataBaseDirectory=C:\Program Files\Cognos\TM1\Custom\TM1Data\PlanSamp\nAdminHost=xxxxxxxx
PortNumber=12345
ClientMessagePortNumber= 5433
Language=ENG
Savetime=
Downtime=
ProgressMessage=True
AuditLogOn=F
AuditLogMaxFileSize= 100 MB
AuditLogUpdateInterval=60
#ServerCAMURI=http://L3L0833-6457A26:9300/p2pd/servlet/dispatch
#ClientCAMURI=http://L3L0833-6457A26/ibmcognos/cgi-bin/cognos.cgi
#ClientPingCAMPassport=900
#Optional CAM parameters
#CAMSSLCertificate=
#SkipSSLCAMHostCheck=TRUE
#SkipSSLCAMHostCheck=TRUE

Parameters in the tm1s.cfg File

The parameters in the tm1s.cfg file are described here.

Dynamic parameter

Dynamic parameter values can be edited while the IBM Cognos TM1 server is running.

The Cognos TM1 server continuously polls the tm1s.cfg file at 60 second intervals to determine if any dynamic parameter values have changed. If the server detects a parameter value change, the new value is applied immediately. Dynamic parameters are identified with a statement describing them as "dynamic" in this list.

Static parameter

Static parameter values are read from the tm1s.cfg file only when the IBM Cognos TM1 server starts. If you want to change a static parameter value, you must shut down the Cognos TM1 server, edit the value in the tm1s.cfg file, and then restart the server.

Most parameters in the tm1s.cfg file are static.

Spaces in values

If a parameter value contains spaces, enclose the parameter values within double quotes.
AdminHost

Specifies the computer name or IP address of the Admin Host on which an Admin Server is running.

Parameter type: required, static

To specify multiple Admin Hosts, separate each host name with a semicolon when running on Microsoft Windows or with a colon when running on a UNIX. For example:

- Use the format AdminHost=hostname1;hostname2 on a Windows Cognos TM1 server.
- Use the format AdminHost=hostname1:hostname2 on a UNIX Cognos TM1 server.

Some other examples include:

- AdminHost=boston;newyork
- AdminHost=192.168.1.17;192.168.1.22
- AdminHost=boston;192.168.1.17;192.168.1.22;myserver;192.168.1.40

Note: The string specifying the admin host or hosts is limited to 1020 characters or bytes.

AdminSvrSSLCertAuthority

Specifies the full path and name of the certificate authority file that issued the IBM Cognos TM1 Admin Server's certificate.

Parameter type: optional (required for SSL), static

Example:

AdminSvrSSLCertAuthority = C:\Program Files\Cognos\TM1\bin64\ssl\applixca.pem

AdminSvrSSLCertID

Specifies the name of the principal to whom the IBM Cognos TM1 Admin Server's certificate is issued.

Parameter type: optional (required for SSL), static

The value of this parameter should be identical to the TM1 Admin Server Certificate ID parameter as set in IBM Cognos Configuration.

If the AdminSvrSSLCertID is incorrectly configured, the server pull-down menu in TM1 Web displays as empty and an error is logged to the TM1web.log file.

Example:

AdminSvrSSLCertID = tm1adminserver

AdminSvrSSLCertRevList

Specifies the full path of the certificate revocation file issued by the certificate authority that originally issued the IBM Cognos TM1 Admin Server's certificate.

Parameter type: optional (required for SSL), static
A certificate revocation file will exist only in the event that a certificate has been revoked.

**AdminSvrSSLExportKeyID**

Specifies the identity key used to export the IBM Cognos TM1 Admin Server's certificate from the Microsoft Windows certificate store.

Parameter type: optional (required if ExportAdminSvrSSLCert is enabled), static

This parameter is required only if you choose to use the certificate store by setting ExportAdminSvrSSLCert=T.

**AllowReadOnlyChore Reschedule**

Provides users with READ access to a chore, and the ability to activate, deactivate, and reschedule chores.

Parameter type: optional, static

When the line AllowReadOnlyChoreReschedule=T is added to the Tm1s.cfg file for a server, users with READ access to a chore can right-click a chore in Server Explorer, and toggle the Activate Schedule option or choose the Edit Chore option. The Edit Chore option is available only when a chore is not activated.

When a user with READ access to a chore selects the Edit Chore option, only the scheduling screen of the Chore Setup Wizard opens.

The scheduling screen lets the user set scheduling parameters for the chore, but does not allow the user to edit the list of processes that compose the chore.

**AllowSeparateNandCRules**

When enabled, this parameter lets you specify rule expressions for N: and C: levels on separate lines using identical AREA definitions.

Parameter type: optional, static

For example,

```
['Budget','Argentina']=N:Expression;
['Budget','Argentina']=C:Expression;
```

are both valid rules statements when you include the AllowSeparateNandCRules parameter in the Tm1s.cfg file and set to T.

This parameter also effects how numeric and string rules are applied to cells. Without this parameter, the first rule statement that is encountered for a given AREA definition is applied to the cells within the scope of that definition. If any cell within the AREA definition is numeric and the rule is a string rule, then the cell is considered not rule-derived because there was a match that did not apply to the cell.

For example, consider the statements:

```
['1 Quarter']=s:'str_value';Not following.
['1 Quarter']=n:77;
```
If the AllowSeparateNandCRules parameter is not set (or is set to F), then the first rule statement will match any cell that uses '1 Quarter' as one of its elements. If the cell is a string cell, the value of the cell will be set to 'str_value'. If the cell is a numeric cell, the cell will not be considered rule derived, since a match was found (the first rule) but the rule itself did not apply.

If the AllowSeparateNandCRules parameter is set to T, then string cells which use '1 Quarter' will be set to 'str_value' and numeric cells which use '1 Quarter' will be set to 77.

To set the parameter to T, add the following line to Tm1s.cfg:
AllowSeparateNandCRules=T

AllRuleCalcStargateOptimization
The AllRuleCalcStargateOptimization parameter can improve performance in calculating views that contain only rule-calculated values.

Parameter type: optional, static

Typically, Cognos TM1 performs calculations for standard consolidations and then calculates values for rule-based consolidations, which may end up overriding values in the standard consolidations. The AllRuleCalcStargateOptimization parameter provides optimization that first checks if every value in the view is rule-calculated and then proceeds as follows:
- If every value in the view is rule-calculated, then Cognos TM1 skips the unnecessary calculations for standard consolidations and just performs the rule-calculated consolidations.
- If the view contains even a single value which is not rule-calculated, then this optimization parameter will have no effect.

When this parameter is set to True, some additional processing will take place for every view that is requested to first check if the view contains only rule-calculated values. For most views, this additional processing is minimal since the optimization is stopped after the first value in the view is found to be not rule-calculated.

To enable this parameter, set the parameter's value to T in the Cognos TM1 server configuration file, Tm1s.cfg, as follows:
AllRuleCalcStargateOptimization=T

The default setting is disabled (F).

ApplyMaximumViewSizeToEntireTransaction
Applies MaximumViewSize to the entire transaction instead of to individual calculations.

Parameter type: optional, dynamic

By default MaximumViewSize checks individual view processing. For example, if 10 views are processed in a single transaction, the threshold is crossed only if the processing of any single view crosses the threshold. See “MaximumViewSize” on page 289.
With this parameter set to True, the cumulative memory usage of all views processed in a single transaction is compared against the threshold value. This allows the memory size threshold to catch more transactions that consume large amounts of memory.

Note: TI process execution counts as a single transaction, including all child TI processes.
ApplyMaximumViewSizeToEntireTransaction=T

Default value is F.

AuditLogMaxFileSize
Indicates the maximum file size that an audit log file can grow to before it is closed and a new file is created.

Parameter type: optional, dynamic

This value must include units of KB (kilobytes), MB (megabytes), or GB (gigabytes). For example, to limit the log file size to 100 MB, enter the following:

AuditLogMaxFileSize=100 MB

The range of values include:
- Default value: 100 MB
- Minimum value: 1 KB
- Maximum value: 2 GB

AuditLogMaxQueryMemory
Indicates the maximum amount of memory that IBM Cognos TM1 can use when running an audit log query and retrieving the set of results.

Parameter type: optional, dynamic

This value must include units of KB (kilobytes), MB (megabytes), or GB (gigabytes). For example:

AuditLogMaxQueryMemory=100 MB

The range of values include:
- Default value: 100 MB
- Minimum value: 1 KB
- Maximum value: 2 GB

AuditLogOn
Turns audit logging on (T) or off (F).

Parameter type: optional, static

For example:
- To enable audit logging, set AuditLogOn=T
- To disable audit logging, set AuditLogOn=F
The default setting is F.

**AuditLogUpdateInterval**

Indicates the maximum amount of time, in minutes, that IBM Cognos TM1 waits before moving the events from the temporary audit file into the final audit log.

Parameter type: optional, dynamic

For example:

AuditLogUpdateInterval=60

The default value is 60 (sixty minutes).

The minimum value is 1 (one minute).

Note: You can manually update the audit log with the latest events anytime you want by using the Process Audit Log Events command in Server Explorer. For details, see “Updating the Audit Log with the Latest Events” in the  *IBM Cognos TM1 Operation Guide*.

**AutomaticallyAddCubeDependencies**

Determines if cube dependencies are set automatically or if you must manually identify the cube dependencies for each cube.

Parameter type: optional, static

The IBM Cognos TM1 server establishes dependencies so it can properly invalidate cube calculation caches when data in cubes is changed. For more details, see “Understanding Cube Dependency” in the  *TM1 Operation Guide*.

When set to true (the default), rule-based inter-cube DB(...) dependencies are detected and set automatically at server startup time. Further, after a rule edit, save, or recompile, the dependencies expressed in that rule, whether from DB(), ATTRS(), or ATTRN() functions, are automatically re-established.

When set to false, rule based inter-cube DB(...) dependencies are not detected and are set at server startup time. Dependencies are established when a query is run. This can cause a query to block others because of a new dependency.

AutomaticallyAddCubeDependencies=F

Default value: T

**CacheFriendlyMalloc**

Allows for memory alignment that is specific to the IBM Power Platform.

Parameter type: optional, static

Testing has shown that enabling this parameter provides the most benefit for high user count usage scenarios. Single or low user count usage scenarios may see little to no benefit. By default, CacheFriendlyMalloc=F.

To enable the option, add the following line to your tm1s.cfg file:

CacheFriendlyMalloc=T
**CalculationThresholdForStorage**

Defines a minimum number of rule calculations required for a single cell or Stargate view, beyond which the IBM Cognos TM1 server stores the calculations for use during the current server session.

Parameter type: optional, dynamic

For example, when a user requests rule-derived values from the Cognos TM1 server, either from a single cell or a Stargate view, the server usually has to perform multiple rule calculations to arrive at the requested rule-derived values.

CalculationThresholdForStorage has a direct effect on memory consumption and performance. A high parameter value results in decreased memory consumption and slower performance. A low parameter value results in increased memory consumption and faster performance.

If you do not include CalculationThresholdForStorage in Tm1s.cfg, the default calculation threshold is 50.

**CAMPortalVariableFile**

The path to the variables_TM1.xml file in your IBM Cognos installation.

Parameter type: Required for IBM Cognos interoperability, static

The CAMPortalVariableField parameter is required only when using IBM Cognos Business Intelligence (BI) with Cognos TM1 Web and the Cognos TM1 Server.

Set this parameter with a relative path as follows:

\[\text{CAMPortalVariableFile}=\text{portal}\backslash\text{variables_TM1.xml}\]

**Note:** The exact file location on the IBM Cognos BI server is: Cognos_location\templates\ps\portal\variables_TM1.xml.

**CAMSSLCertificate**

The full path and name of the SSL certificate to be used when connecting to the internal dispatcher.

For example, C:\AxTM1\Install_Dir\ssl\CognosCert.cer.

Parameter type: static

Required only when CAM server is configured to use SSL.

**CertificateVersion**

Specifies which version of the SSL certificates installed with IBM Cognos TM1 to use.

Parameter type: optional, static

**Note:** This parameter does not apply if you are using your own SSL certificates. This parameter applies only to the certificates installed with TM1.
By default, the 1024-bit encryption version of the certificates is used. Change this parameter only if you want to use the new 2048-bit encryption version of the certificates.

You can use the new version with old and new TM1 clients, but you must configure the clients to use the new certificate authority file. See “Configuring Cognos TM1 Web to use SSL” on page 228 and “Configuring Cognos TM1 clients to use SSL” on page 227.

Valid values include:
- 1 - Enables certificate authority for 1024-bit encryption with sha-1 (default value)
- 2 - Enables certificate authority for 2048-bit encryption with sha-256

Default value: 1

**CheckFeedersMaximumCells**

Limits the number of cells checked by the Check Feeders option in the Cube Viewer.

The CheckFeedersMaximumCells is an optional parameter that you can add to Tm1s.cfg. If you do not include this parameter in Tm1s.cfg, Check Feeders checks 3,000,000 cells, by default.

Parameter type: optional, dynamic

When Cognos TM1 checks feeders from a highly consolidated cell, it must check all intersections that apply to the cell. In large applications, the Cognos TM1 server will be unavailable for a significant amount of time while Cognos TM1 is checking all intersections.

To limit the number of cells checked when using Check Feeders (which in turn limits the amount of time the Cognos TM1 server is unavailable), add CheckFeedersMaximumCells to Tm1s.cfg and set the parameter to the number of cells you want to check.

For example, to limit Check Feeders to 1,000,000 cells, enter the following line:

```
CheckFeedersMaximumCells=1,000,000
```

**ClientCAMURI**

The URI for the IBM Cognos Server IBM Cognos Connection used to authenticate Cognos TM1 clients.

Parameter type: optional, static

The URI is specified in the form `http[s]://<host>/<cognos_location>/cgi-bin/<cognos.cgi`.

For example, `http://10.121.25.121/ibmcognos/cgi-bin/cognos.cgi`

**ClientExportSSLSvrCert**

Specifies whether an IBM Cognos TM1 client should retrieve the certificate authority certificate, which was originally used to issue the TM1 server's certificate, from the Microsoft Windows certificate store.
Parameter type: optional (required for SSL), static

If ClientExportSSLServerCert=T, the certificate authority certificate is exported from the certificate store on the client computer when requested by the TM1 client.

Default value: F

**ClientExportSSLServerCert**

Specifies the identity key used by an IBM Cognos TM1 client to export the certificate authority certificate, which was originally used to issue the TM1 server's certificate, from the Microsoft Windows certificate store.

Parameter type: optional (required for SSL), static

**ClientPingCAMPassport**

Indicates the interval, in seconds, that a client should ping the Cognos Authentication Management server to keep their passport alive.

Parameter type: optional, static

If an error occurs or the passport expires the user will be disconnected from the Cognos TM1 server.

**ClientMessagePortNumber**

Identifies a secondary port used to accept client messages concerning the progress and ultimate cancellation of a lengthy operation without tying up thread reserves.

Parameter type: optional, static for changes, dynamically set

If no port number is specified in the configuration file, the port number is dynamically chosen and set at server startup. However, it cannot be changed while the server is running.

This additional port ensures that other server requests can continue to process while waiting for a cancellation from the user.

By default, this port number is automatically and dynamically assigned when the Cognos TM1 server starts. You do not have to set ClientMessagePortNumber to a specific number unless firewalls or other network issues require the listener port to be a well-known number.

**CAUTION:**
If you choose to set a specific value for the ClientMessagePortNumber parameter, instead of having it dynamically assigned, be sure to assign unique port numbers for all the Cognos TM1 server and client message ports you are using. If you have two servers running on the same machine using the same port number, the message activity may cause a system conflict or hang.

See also, "PortNumber" on page 294 and "ProgressMessage" on page 294.

**ClientPropertiesSyncInterval**

Specifies the frequency (in seconds) at which client properties are updated in the ClientProperties control cube. Set to 1800 seconds to update cube every 30 minutes.
Frequent updating can cause unnecessary consumption of CPU time and may cause users from connecting/disconnecting until operation completes.

Parameter type: optional, dynamic

**ClientVersionMaximum**

Specifies the maximum client version that can connect to the IBM Cognos TM1 server.

Parameter type: optional, dynamic

The ClientVersionMaximum parameter value is expressed as a version string using the following format:

\[ m.n.tffhh \]

- \( m \) = major release number,
- \( n \) = minor release number
- \( t \) = maintenance release number
- \( ff \) = fix pack number
- \( hh \) = hot fix number

Using this format, setting `ClientVersionMaximum = 9.4.10305` specifies that the maximum client version that can connect to the server is 9.4.1.

If your Tm1s.cfg file does not include a ClientVersionPrecision parameter value, only the major release number, minor release number, and maintenance release number are used to enforce compatibility between client and server. Using the above example,

If ClientVersionMaximum is not explicitly set, the default value is equal to the currently installed server version.

Valid parameter values fall within the range \( x00 \) up to the currently installed server version, where \( x \) is the major release number of the currently installed TM1 server. For example, valid parameter values for TM1 server 9.0 SP3 fall within the range 900 - 903.

You cannot set ClientVersionMaximum to a value greater than the currently installed server version. You cannot connect newer client versions to older server versions.

**ClientVersionMinimum**

Specifies the minimum client version that can connect to the IBM Cognos TM1 server.

Parameter type: optional, dynamic

The ClientVersionMinimum parameter value is expressed as a version string using the following format:
Using this format, setting `ClientVersionMinimum = 9.4.10305` specifies that the minimum client version that can connect to the server is 9.4.1.

If your `Tm1s.cfg` file does not include a `ClientVersionPrecision` parameter value, only the major release number, minor release number, and maintenance release number are used to enforce compatibility between client and server.

If the `ClientVersionMinimum` parameter is not explicitly set, the default value is 8.4.00000, which corresponds to version 8.4.

You should not set `ClientVersionMinimum` to a value lower than the major release number of the currently installed Cognos TM1 server. There is no upper limit for `ClientVersionMinimum`. However, if `ClientVersionMinimum` is larger than `ClientVersionMaximum`, only clients with a version number equal to `ClientVersionMaximum` can connect to the server.

**ClientVersionPrecision**

This parameter lets you more precisely identify the minimum and maximum versions of clients that can connect to the IBM Cognos TM1 server.

Parameter type: optional, dynamic

The `ClientVersionMinimum` and `ClientVersionMaximum` parameter values are expressed as a version string using the following format:

\[ m.n.tffhh \]

\( m \) = major release number,
\( n \) = minor release number
\( t \) = maintenance release number
\( ff \) = fix pack number
\( hh \) = hot fix number

Using this format, the version string 9.4.10305 indicates major release 9, minor release 4, maintenance release 1, fix pack 3, and hot fix 5.

If `ClientVersionPrecision` is not set in `Tm1s.cfg` or if it is set to 0, only the major release number, minor release number, and maintenance release number are used.
to enforce compatibility between client and server. In this case, any client from major release 9, minor release 4, maintenance release 1 and more recent can connect to the server.

You can enforce more precise server and client version compatibility by adding ClientVersionPrecision to the Tm1s.cfg file and setting the parameter to one of the following values.

- 1 - Indicates that the fix pack number will be enforced, but not the hot fix number.
- 2 - Indicates that both the fix pack number and hot fix number will be enforced.

**Examples**

If ClientVersionMinimum = 9.4.10305 and ClientVersionPrecision = 1, only clients from major release 9, minor release 4, maintenance pack 1, fix pack 3 or later can connect to the server. In this case, the hot fix number is not enforced when determining server/client compatibility.

If ClientVersionMinimum = 9.4.10305 and ClientVersionPrecision = 2, only clients from major release 9, minor release 4, maintenance pack 1, fix pack 3, hot fix 5 or later can connect to the server. In this case, both the fix pack and hot fix numbers are enforced when determining server/client compatibility.

**CognosMDX.AggregateByAncestorRef**

When possible, replaces aggregation over a member set with a reference to an ancestor, if the aggregated member set comprises a complete set of descendants and all members have the weight 1.

For example, the aggregation `aggregate(children(<Member>))` might be replaced with a reference to `<Member>`.

Parameter type: optional, static

This parameter is applicable only when using TM1 with IBM Cognos Business Intelligence.

To enable **CognosMDX.AggregateByAncestorRef**, add the following line to the tm1s.cfg file:

```
CognosMDX.AggregateByAncestorRef=true
```

Default value: false

**CognosMDX.CellCacheEnable**

Allows the IBM Cognos MDX engine to modify TM1 consolidation and calculation cell cache strategies.

Parameter type: optional, static

This parameter is applicable only when using TM1 with Cognos BI.

Default value: true
**CognosMDX.PrefilterWithPXJ**

Expands the data source provider cross join approach to nested filtered sets.

Parameter type: optional, static

This parameter is applicable only when using TM1 with IBM Cognos BI.

This parameter is active only in the following cases:

- **CognosMDX.UseProviderCrossJoinThreshold** has a value greater than 0 in the tm1s.cfg file
- **UseProviderCrossJoinThreshold** has a value greater than 0 in the Cognos BI qfs_config.xml configuration file.

To enable **CognosMDX.PrefilterWithPXJ**, add the following line to the tm1s.cfg file:

CognosMDX.PrefilterWithPXJ=true

Default value: false

**CognosMDX.SimpleCellsUseOPTSDK**

Applies IBM Cognos MDX engine consolidation and calculation cell cache strategies to all cells in query results.

Parameter type: optional, static

This parameter is applicable only when using TM1 with Cognos BI.

When CognosMDX.SimpleCellsUseOPTSDK is not enabled, consolidation and calculation cell cache strategies are applied only to query result cells associated with calculated members.

Default value: true

**CognosMDX.UseProviderCrossJoinThreshold**

Applies the data source provider cross join strategy, even if it is not explicitly enabled in IBM Cognos BI.

Parameter type: optional, static

This parameter is applicable only when using TM1 with Cognos BI.

When you enable **CognosMDX.UseProviderCrossJoinThreshold**, this has the same effect as enabling the **UseProviderCrossJoinThreshold** parameter in the qfs_config.xml file of Cognos BI.

**UseProviderCrossJoinThreshold** controls whether combinations of members on an edge, which have no measure values, are retrieved from the TM1 server. **UseProviderCrossJoinThreshold** is enabled when it has a value greater than 0.

**Note:** If **UseProviderCrossJoinThreshold** is enabled in the Cognos BLqfs_config.xml, it takes precedence over the **CognosMDX.UseProviderCrossJoinThreshold** parameter in the tm1s.cfg file.

To enable **CognosMDX.UseProviderCrossJoinThreshold**, add it to the tm1s.cfg file and specify a value greater than 0, for example:
CognosMDX.UseProviderCrossJoinThreshold=1000

Default value: 0

**CognosTM1InterfacePath**

Specifies the location of the IBM Cognos Business Intelligence server to use when importing data from a Cognos Package to TM1 using the IBM Cognos TM1 Package Connector.

See the *IBM Cognos TM1 TurboIntegrator Guide* for more information.

Parameter type: optional except when using the Cognos TM1 Package Connector, static

**DataBaseDirectory**

Specifies the data directory from which the server loads cubes, dimensions, and other objects.

You can list multiple data directories by separating them with semicolons.

Parameter type: required, static

For details, see “Data directory overview” on page 27.

**DefaultMeasuresDimension**

Identifies if a measures dimension is created. IBM Cognos TM1 does not require that a measures dimension be defined for a cube. You can optionally define a measures dimension by modifying the cube properties.

For more information, see the topic, “CubeProperties”, in the *IBM Cognos TM1 Operation Guide*.

Parameter type: optional but some OLAP applications may require this parameter (see description below for details), static

Some OLAP applications do require that a measures dimension be present in all cubes, and may fail if such a dimension is not present. To accommodate these applications, set `DefaultMeasureDimension=T` to instruct the Cognos TM1 server to automatically define the last dimension in a cube as the measures dimension when a new cube is created on the Cognos TM1 server.

If `DefaultMeasureDimension` is set to F or is omitted from `Tm1s.cfg`, a measures dimension is not defined for when a cube is created.

**DHFile-512**

Specifies the full path name of the file that contains the pre-generated Diffie-Hellman 512 bit key.

Parameter type: optional (required for SSL), static

The generation of Diffie-Hellman parameters can be computationally very expensive. To minimize this cost, the Diffie-Hellman 512 bit key can be pre-generated and stored in a file that is called when the IBM Cognos TM1 server starts.
**DHFile-1024**
Specifies the full path name of the file that contains the pre-generated Diffie-Hellman 1024 bit key.

Parameter type: optional (required for SSL), static

The generation of Diffie-Hellman parameters can be computationally very expensive. To minimize this cost, the Diffie-Hellman 1024 bit key can be pre-generated and stored in a file that is called when the IBM Cognos TM1 server starts.

**DHFile-2048**
Specifies the full path name of the file that contains the pre-generated Diffie-Hellman 2048 bit key.

Parameter type: optional, static

The generation of Diffie-Hellman parameters can be computationally very expensive. To minimize this cost, the Diffie-Hellman 2048 bit key can be pre-generated and stored in a file that is called when the IBM Cognos TM1 server starts.

**DisableMemoryCache**
Disables the memory cache used by IBM Cognos TM1 memory manager.

Parameter type: optional, static

Enable this parameter only to debug memory leaks. When you enable this parameter, there might be a decrease in server performance.

For example, when `DisableMemoryCache=T` is set it disables the memory cache used by IBM Cognos TM1 memory manager. The default setting is `DisableMemoryCache=F`.

**DisableSandboxing**
Determines if users have the ability to use sandboxes across the server.

Parameter type: optional, dynamic

By default, this parameter is not present in the configuration file which enables the sandbox capability for all users.
`DisableSandboxing=F`

When sandboxing is turned on in this way, administrators can Deny or Grant the use of Personal Workspaces or multiple sandboxes on a per usergroup basis using Capability Assignments. For more details, see “Capability Assignments” in the *IBM Cognos TM1 Operation Guide*.

To put all usergroups into Direct Writeback mode, add the following line to `Tm1s.cfg`:
`DisableSandboxing=T`

When `DisableSandboxing=T`, the Capability Assignments are ignored.
Important: Do not use DisableSandboxing=T in the TM1 server configuration file for any TM1 Server that deploys and supports TM1 Applications. TM1 Servers that deploy and support TM1 Applications require that the sandbox feature is enabled in the TM1 server configuration file.

Display_Info_DBType_R8

Display_Info_DBType_R8 instructs the IBM Cognos TM1 server to store DISPLAY_INFO column data as DBTYPE_R8.

Parameter type: optional, static

Please contact customer support to determine if this parameter is applicable to your Cognos TM1 system.

By default, Cognos TM1 stores the DISPLAY_INFO as DBTYPE_UI4. When the Cognos TM1 OLE DB provider processes a request from ADO 2.7 for the DISPLAY_INFO column data, the provider has to convert Cognos TM1 column data from DBTYPE_UI4 to a DBTYPE_R8. The Cognos TM1 OLE DB provider then returns the converted column data to the OLE DB client (ADO in this case).

ADO 2.7 expects IRowset::GetData to return an integer, and uses only the first 4 bytes of the converted column data. However, the returned data is an 8-byte real number, and as a result, all information in the last 4 bytes is lost. This causes ADO 2.7 to return zeroes for all the items of the DISPLAY_INFO column.

When you include the Display_Info_DBType_R8 parameter in the Tm1s.cfg file and set the parameter to T, the Cognos TM1 server stores DISPLAY_INFO column data as DBTYPE_R8 with the relevant 4 bytes of information in the first 4 bytes. The Display_Info_DBType_R8 parameter ensures that the information is not lost when ADO converts the data back to an integer of 4 bytes. The parameter also ensures that ADO 2.7 returns the correct values for the properties of an axis rowset member. Additionally, the parameter ensures that any OLE DB client (such as ADO 2.6) requesting the DISPLAY_INFO property as a 4 byte value, gets the correct values.

DistributedPlanningOutputDir

DistributedPlanningOutputDir defines the directory to which TUnits are written when a Cognos Insight distributed application is deployed.

Parameter type: optional, static

Cognos Insight distributed clients need information called "tunits". This data is created when an application is deployed and is updated as the Cognos TM1 server runs. The location of the directory used for this purpose is set using this parameter.

In order to deploy Cognos Insight distributed client applications using this database, uncomment or add this parameter as DistributedPlanningOutputDir=<location of the tunit directory>.

The pathname specified can be absolute, or relative to the Cognos TM1 server data directory.

For example:
### Table 39. Directory pathname examples for the DistributedPlanningOutputDir parameter

<table>
<thead>
<tr>
<th>Sample setting</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>DistributedPlanningOutputDir=tunit</td>
<td>Creates a directory tunit under the Cognos TM1 server data directory.</td>
</tr>
<tr>
<td>DistributedPlanningOutputDir=../tunit</td>
<td>Creates a directory tunit as a sibling to the Cognos TM1 server data directory.</td>
</tr>
<tr>
<td>DistributedPlanningOutputDir=C:\Program Files\IBM\cognos\tm1\samples\tm1\GO_New_Stores\tunit</td>
<td>Creates a directory tunit at the specified location.</td>
</tr>
</tbody>
</table>

#### DownTime

Specifies a time when the server will come down automatically.

Parameter type: optional, dynamic

The format of the DownTime parameter is *dd:hh:mm* where:

- *dd* is the number of days from today. (For example, 00 is today, and 01 is tomorrow.)
- *hh:mm* is the time of day in 24-hour format.

For example, `DownTime = 01:03:30` specifies that you want to bring the server down on the following day at 3:30 in the morning.

The DownTime parameter is not available when you run the Cognos TM1 server as a Windows service.

When you use the DownTime parameter on the UNIX Cognos TM1 server, you must set the `RunningInBackground` parameter to T. If `RunningInBackground=F`, the server prompts for confirmation before shutting down and cannot shut down without manual confirmation from an administrator.

#### EnableODBCProxy

EnableODBCProxy makes 32-bit data source names available to TurboIntegrator processes on 64-bit machines.

Parameter type: optional, static

EnableODBCProxy is useful if a 64-bit driver is not available. Each proxied connection creates a 32-bit `tmlodbcproxy.exe` process during the connection.

EnableODBCProxy is true by default but you can disable the feature by including `EnableODBCProxy=false` in the `tm1s.cfg`.

#### ExcelWebPublishEnabled

Enables the publication of Microsoft Excel files to IBM Cognos TM1 Web, as well as the export of Excel files from Cognos TM1 Web, when Excel is not installed on the Web Server.

Parameter type: optional, static
If ExcelWebPublishEnabled=T, Excel files in Cognos TM1 Applications can be published to Cognos TM1 Web without using Excel on the web server. Similarly, Websheets and Cubeviewers can be exported from Cognos TM1 Web without using Excel on the Web server.

When Excel is not available on the web server, Excel files in Cognos TM1 Applications must be explicitly published to Cognos TM1 Web.

For details about the procedure required to publish Excel files, see the IBM Cognos TM1 Developer Guide.

For details about limitations exporting from Cognos TM1 Web without using Excel on the web server, see the IBM Cognos TM1 User Guide.

Restriction: You cannot publish Excel 2007 .xlsx files to Cognos TM1 Web when Excel is not available on the web server. These files must be saved in Excel 2003 .xls format if you want to publish them to Cognos TM1 Web.

Default value: F

ExportAdminSvrSSLCert
Specifies whether or not the IBM Cognos TM1 Admin Server's certificate should be exported from the Microsoft Windows certificate store.

Parameter type: optional (required for SSL), static

If ExportAdminSvrSSLCert=T, the TM1 Admin Server’s certificate is exported from the Microsoft Windows certificate store when the certificate is requested by a TM1 server.

If ExportAdminSvrSSLCert=T, you must also set the following tm1s.cfg parameters:
• AdminSvrSSLCertID
• AdminSvrSSLEExportKey
• SvrSSLEExportKeyID
• SSLCertificateID
• SSLPwKeyFile
• SSLPrivateKeyPwdFile
• SSLCertAuthority
• ClientExportSSLsSvrCert

ExportSvrSSLCert
Specifies whether the IBM Cognos TM1 server’s certificate should be exported from the Microsoft Windows certificate store.

Parameter type: optional (required for SSL), static

If ExportSvrSSLCert=T, the TM1 server’s certificate is exported from the Microsoft Windows certificate store when the certificate is requested by the TM1 server.

If ExportSvrSSLCert=T, you must also set the following tm1s.cfg parameters:
• AdminSvrSSLCertID
• AdminSvrSSLEExportKey
ForceReevaluationOfFeedersForFedCellsOnDataChange

When this parameter is set, a feeder statement is forced to be re-evaluated when data changes.

Parameter type: optional, static

When the IBM Cognos TM1 server computes feeders, the process can be a "chain" of feeders, where cell A feeds cell B, and there is a feeder rule for cell B, so that rule runs and feeds cell C, etc. Feeders for numeric cells are evaluated only when a cell goes from empty to some non-zero value since any non-zero value in the cell would already have set any feeders.

There is no need to re-evaluate the feeders when a cell changes from one non-zero value to another.

Normally, when evaluating feeders, if a feeder rule is evaluated and the target cell is already fed, the feeding process stops.

Feeder rules are not processed any further since the presence of the feeder in the target cell indicates that the feeder rules for the target cell have already been run, and there is no need to run them again.

Consider the following feeder rules:
['A']=>['B'];

The feeder rule for cell B depends on some cube data value:
[B]=>DB(cube-name,ldim1,DB(cube2-name,...),ldim2);['C']=>['D'];['X']->['B'];

When the feeder rule for B is initially evaluated, the DB(cube2-name,...) is evaluated to produce an element name, such as C. Therefore B feeds C and then C feeds D. When that cell X goes from zero to non-zero. This change also feeds B. But B is already fed, so the feeding process stops, and the feeder rule for B never evaluates, so any "change" in the output of the rule, which may come about because of an underlying data change targeted by the DB(...) statement will not be evaluated. If the parameter ForceReevaluationOfFeedersForFedCellsOnDataChange is set, then the presence of a feeder in cell B will not terminate feeder processing. Rather, the feeder rule for B will run. Because the feeder rule for B is data dependent, the target for the feeder may be the former C, or may be some other cell, and that cell will be fed. Note that setting this parameter will force more feeder evaluations, which may have a performance impact.

To turn on this parameter set ForceReevaluationOfFeedersForFedCellsOnDataChange=T.
HTTPPortNumber
Sets the port number on which the TM1 Server listens for incoming HTTP(S) requests.

Parameter type: optional, static

The IBM Cognos TM1 Server services the REST API using this HTTP(S) channel. The server accepts either standard HTTP or SSL secured HTTPS connections depending on the UseSSL parameter (see “UseSSL” on page 307). If UseSSL is set to T, switching the use of SSL on, then the server will accept only HTTPS connections. If UseSSL is set to F, the server will accept unsecured, HTTP connections.

When you install a TM1 Server, the HTTP port is not set by default. In the tm1s.cfg file, add the following line:

```
HTTPPortNumber = XXXX
```

Replace XXXX with a valid port number.

Note: Port numbers must be unique across all services running on a computer, not just across TM1 servers and not just across the HTTP ports of TM1 servers.

HTTPSessionTimeoutMinutes
Sets the timeout value for authentication sessions for the IBM Cognos TM1 REST API.

Parameter type: optional, dynamic

When you use the TM1 REST API, your application needs to authenticate with the TM1 Server. This parameter sets the timeout, in minutes, for this authentication. If a session times out, requests made with the old session ID return 401 Unauthorized.

The default value is 20.

IdleConnectionTimeOutSeconds
Specifies a timeout limit for idle client connections, in seconds.

Parameter type: optional, dynamic

For example, if you include the following line in Tm1s.cfg, the server disconnects idle client connections after 900 seconds.

```
IdleConnectionTimeOutSeconds=900
```

IntegratedSecurityMode
This parameter sets the user authentication mode to be used by the IBM Cognos TM1 server.

Parameter type: optional, static

Although the parameter name focuses on Integrated Security Mode, the 2, 3 and 4 settings are used to set other kinds of security.
**Note:** If you change the security mode without restarting the IBM Cognos TM1 server, the change applies only to new client connections. If you want to ensure that all clients are authenticated with the new security mode, all clients must be logged off by the administrator.

Use the following format to set this parameter:

```
IntegratedSecurityMode=x
```

where $x$ can be a value for one of the following security modes.

Cognos Business Intelligence 8 and 10 are supported.

<table>
<thead>
<tr>
<th>Security Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>The server uses secure mode (standard Cognos TM1 security). With this authentication, the Cognos TM1 server checks the user name and password against the user names and passwords in the Cognos TM1 database.</td>
</tr>
<tr>
<td>2</td>
<td>This mode allows you to switch back and forth between integrated login and native Cognos TM1 security.</td>
</tr>
<tr>
<td>3</td>
<td>The server uses Integrated Login. Integrated Login uses Microsoft Windows network authentication to control access to Cognos TM1 data. If you use this security mode, you must also set the &quot;SecurityPackageName&quot; on page 298 parameter. For more details, see &quot;Integrated Login&quot; on page 194.</td>
</tr>
<tr>
<td>4</td>
<td>The server uses IBM Cognos BI security authentication. Considerations when using this mode: In Cognos TM1, Cognos BI users can belong only to Cognos BI groups and any of the three internal Cognos TM1 administrator groups (ADMIN, DataAdmin and SecurityAdmin). Membership in Cognos TM1 user (non-administrator) groups is not supported for Cognos BI users when they log in to Cognos TM1. You can not use Cognos TM1 to permanently assign a Cognos BI user to another Cognos BI group. Any user assignment you make in Cognos TM1 to a Cognos BI group is not saved back to Cognos BI. When a Cognos BI user logs in to Cognos TM1, the group assignments in Cognos BI override any Cognos BI group assignments made in Cognos TM1.</td>
</tr>
</tbody>
</table>
### Security Mode Description

<table>
<thead>
<tr>
<th>Security Mode</th>
<th>Description</th>
</tr>
</thead>
</table>
| 5             | The server uses IBM Cognos BI security authentication and supports user groups from both Cognos TM1 and Cognos BI. Use security mode 5 when you are running IBM Cognos TM1 Applications with IBM Cognos BI security. Considerations when using this mode:  
  - In Cognos TM1, Cognos BI users can belong to both Cognos BI and Cognos TM1 groups.  
  - You can not use Cognos TM1 to permanently assign a Cognos BI user to another Cognos BI group. Any user assignment you make in Cognos TM1 to a Cognos BI group is not saved back to Cognos BI. When a Cognos BI user logs in to Cognos TM1, the group assignments in Cognos BI override any Cognos BI group assignments made in Cognos TM1.  
  - If IntegratedSecurityMode=5 is used for the IBM Cognos TM1 Server and IBM Cognos TM1 Applications, it is not possible to assign rights to native TM1 groups within the Manage rights dialog. Only Cognos Groups, imported into the TM1 Server, are available. |

---

### IPAddress

This parameter lets you specify multiple IP addresses for an individual IBM Cognos TM1 server.

For example, a server can use one IP address for clients within a firewall and a different IP address for clients outside the firewall.

Parameter type: optional, static

**Note:** When this parameter is used in the Tm1s.cfg file, both the Cognos TM1 Server and Admin Server must run on the same computer. If this parameter is used in the Tm1s.cfg file, but the Cognos TM1 Server and Admin Server reside on different computers, Cognos TM1 clients will receive an error when they attempt to log in to the Cognos TM1 Server.

The syntax for Microsoft Windows uses a semicolon as the element separator, for example the following setting specifies two IP addresses for the TM1 server:

` IPAddress="130.5.32.0; 130.5.64.0"`

**Attention:** The addresses must be enclosed in a single set of quotation marks and separated by a semicolon.

When you specify multiple IP addresses for a server, the associated Admin Server recognizes all addresses but displays only the first IP address in the Admin Server window.

The syntax for UNIX uses a colon as the element separator. For example

` IPAddress=130.5.32.0: 130.5.64.0`
**IPVersion**

This parameter indicates the Internet protocol used by the IBM Cognos TM1 server to identify IP addresses on the network.

For example, to specify that your network uses the IPV6 protocol, add the parameter `IPVersion=ipv6` to the `tm1s.cfg` file.

Parameter type: optional, static

Valid settings are:

- `ipv4`
  - Default setting. Used for IPv4 networks.

- `dual`
  - Used to transition from IPv4 to IPv6. Both protocols are supported.

- `ipv6`
  - Used for IPv6 networks.

**Configuration notes**

If you set this parameter to `ipv6` or `dual`, use the Cognos Configuration tool to change the **TM1 Admin Server IP support** option to reflect the change.

To allow clients to recognize this change, add and set the `TM1_IPVersion` environment variable in the operating system to `ipv6` or `dual`.

Setting this parameter to `dual` or `IPV6` without having the appropriate network running can result in performance degradation.

**Note:** In some cases, depending on your network environment and DNS configuration, you may need to also add the IPv6 address to the `/etc/hosts` operating system file on UNIX and Microsoft Windows to successfully run the Cognos TM1 Admin Server and Cognos TM1 Server in IPv6 mode.

For complete details on configuring all Cognos TM1 components to use IPv6, see “Configuring Cognos TM1 to use IPv6” on page 98.

**JavaClassPath**

Use this parameter to make third-party Java libraries available to the IBM Cognos TM1 Server.

Parameter type: optional, static

For example, to allow a Java extension to use classes inside a file called `db2cc4.jar` file (a DB2 JDBC driver), use the following:

```
JavaClassPath=C:\Development\Java\DB2JDBC\db2jcc4.jar
```

You can specify multiple references by separating them with semicolons.

**JavaJVMArgs**

Specifies a comma-separated list of arguments to pass to the Java Virtual Machine (JVM).

Parameter type: optional, static
For example, if you want to debug a process, you might specify these arguments:
JavaJVMArgs=-Xrunjdwp:transport=dt_socket,server=y,suspend=n,address=1044

The arguments you can use depend the specific JVM you are using.

**JavaJVMPath**

This parameter sets the path to the Java Virtual Machine .dll file (jvm.dll), which is required to run Java from IBM Cognos TM1 TurboIntegrator.

Parameter type: optional, **dynamic**

By default, this parameter is not present in the tm1s.cfg file.

To enable Java integration with TurboIntegrator, add the following line to your tm1s.cfg file:

```
JavaJVMPath=<full_path_to_jvm.dll>
```

**Note:** If you are using a 64-bit version of tm1s.exe you must use a 64-bit version of jvm.dll. A 32-bit version of tm1s.exe requires a 32-bit version of jvm.dll.

**JobQueuing**

Turns on queueing for Personal Workspace or Sandbox submissions.

Parameter type: optional, **static**

Set this parameter to `JobQueuing=T` to have all sandbox submissions to process using the Job Queue. When this parameter is set to `F` or not in the configuration file, sandbox submissions do not process in a queue.

When this parameter is turned on, the submission icon displays on the toolbar.

See the Job Queuing description in the Sandbox and Writeback chapter of the *IBM Cognos TM1 User Guide* for details.

**JobQueueMaxWaitTime**

When the queue thread runs, it blocks all incoming requests to ensure it can get the locks necessary to process a job on the queue. New requests are blocked for the amount of time set in the JobQueueMaxWaitTime parameter.

Parameter type: optional, **static**

If the currently executing requests have not completed in this time, the queue thread goes back to sleep for JobQueueThreadSleepTime and incoming requests are allowed to proceed.

To give the queue thread higher priority, set the JobQueueMaxWaitTime to a larger number.

If the JobQueueMaxWaitTime parameter is set to zero in the configuration file and Job Queuing is turned on, the queue will keep trying until it can process, effectively locking out any other activity until it is complete.

See Job Queuing in the *IBM Cognos TM1 User Guide* for more details.
Default value: 100ms

**JobQueueThreadPoolSize**

The `JobQueueThreadPoolSize` parameter enables IBM Cognos TM1 to use multiple threads to process the Cognos TM1 Job Queue, providing greater throughput and processing of sandbox requests.

Parameter type: optional, static

By default, if this parameter is not set, then Cognos TM1 uses a value of 1 and the Cognos TM1 server uses only a single thread to process requests in the Job Queue.

Configure this parameter in the `tm1s.cfg` file using the following format:

```
JobQueueThreadPoolSize=x
```

where `x` represents the number of threads you want to use for processing Cognos TM1 Job Queue requests.

For example:

```
JobQueueThreadPoolSize=3
```

Default value: 1

**JobQueueThreadSleepTime**

Determines the frequency with which the thread processing the queue runs when there are queued jobs.

Parameter type: optional, static

Default value: 10 seconds

**Language**

Sets the language used for the IBM Cognos TM1 server. This parameter applies to messages generated by the server and is also used in the user interface of the server dialog box when you run the server as an application instead of a Windows service.

Parameter type: optional, static

Valid values currently are:

<table>
<thead>
<tr>
<th>Language</th>
<th>Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Brazilian Portuguese</td>
<td>bra</td>
</tr>
<tr>
<td>Croatian</td>
<td>hrv</td>
</tr>
<tr>
<td>Czech</td>
<td>csi</td>
</tr>
<tr>
<td>Chinese (Simplified)</td>
<td>sch</td>
</tr>
<tr>
<td>Chinese (Traditional)</td>
<td>tch</td>
</tr>
<tr>
<td>Danish</td>
<td>dan</td>
</tr>
<tr>
<td>Dutch</td>
<td>nld</td>
</tr>
<tr>
<td>German</td>
<td>deu</td>
</tr>
<tr>
<td>Finnish</td>
<td>fin</td>
</tr>
<tr>
<td>Language</td>
<td>Code</td>
</tr>
<tr>
<td>----------------</td>
<td>------</td>
</tr>
<tr>
<td>French</td>
<td>fra</td>
</tr>
<tr>
<td>Hungarian</td>
<td>hun</td>
</tr>
<tr>
<td>Italian</td>
<td>ita</td>
</tr>
<tr>
<td>Japanese</td>
<td>jpn</td>
</tr>
<tr>
<td>Kazakh</td>
<td>kaz</td>
</tr>
<tr>
<td>Korean</td>
<td>kor</td>
</tr>
<tr>
<td>Norwegian</td>
<td>nor</td>
</tr>
<tr>
<td>Polish</td>
<td>pol</td>
</tr>
<tr>
<td>Romanian</td>
<td>rom</td>
</tr>
<tr>
<td>Russian</td>
<td>rus</td>
</tr>
<tr>
<td>Spanish</td>
<td>esp</td>
</tr>
<tr>
<td>Slovenian</td>
<td>slov</td>
</tr>
<tr>
<td>Swedish</td>
<td>sve</td>
</tr>
<tr>
<td>Thai</td>
<td>tha</td>
</tr>
<tr>
<td>Turkish</td>
<td>trk</td>
</tr>
</tbody>
</table>

**LDAPHost**

Specifies the domain name or dotted string representation of the IP address of the LDAP server host.

Parameter type: optional, static

If you do not enter a value for LDAPHost, IBM Cognos TM1 uses the default value, localhost.

**LDAPPasswordFile**

Defines the password file used when LDAPUseServerAccount is not used. This is the full path of the .dat file that contains the encrypted password for the IBM Cognos TM1 server Admin Server's private key.

Parameter type: optional unless “LDAPUseServerAccount” on page 202=F, static

This parameter uses the full path to a .dat file.

**LDAPPasswordKeyFile**

Defines the password key used when LDAPUseServerAccount is not used.

Parameter type: optional unless “LDAPUseServerAccount” on page 202=F, static

This parameter uses the full path of the .dat file that contains the key used to encrypt and decrypt the password for the private key.

This file must be generated using the tm1crypt utility, as described in “Running the TM1Crypt utility” on page 235.
**LDAPPort**

Specifies the port IBM Cognos TM1 uses to bind to an LDAP server.

Parameter type: optional, static

Specify a secure (SSL) port, for example, 636.

Default value: 389 (an unsecured port)

**LDAPSearchBase**

Specifies the node in the LDAP tree where IBM Cognos TM1 begins searching for valid users.

Parameter type: optional, static

A base distinguished name (DN) in the LDAP directory. For example:

ou=people,o=company.com

For example, if the distinguished names are of the form:

uid-bjensen, ou-people, o=company.com

then the search base would be:

ou-people, o=company.com

**LDAPSearchField**

The name of the LDAP attribute that is expected to contain the name of the IBM Cognos TM1 user being validated.

Parameter type: optional, static

If you do not enter an LDAPSearchField value, the default value is cn, which is also the default value for Microsoft Active Directory.

**LDAPSkipSSLCertVerification**

Skips the certificate trust verification step for the SSL certificate used to authenticate to an LDAP server. This parameter is applicable only when LDAPVerifyServerSSLCert=T.

Parameter type: optional, static

If trust verification does not work, you can skip the trust verification step by specifying LDAPSkipSSLCertVerification=T. In this case, TM1 does not verify the server certificate at all but simply accepts it.

**Note:** Before working with this parameter, you should be familiar with SSL and LDAP.

Default value: F

**LDAPSkipSSLCRLVerification**

Skips CRL checking for the SSL certificate used to authenticate to an LDAP server. This parameter is applicable only when LDAPVerifyServerSSLCert=T.
Parameter type: optional, static

This parameter is not required if LDAPVerifyServerSSLCert=F. The Microsoft Windows API can tolerate an empty or non-existent CRL certificate.

Note: Before working with this parameter, you should be familiar with SSL and LDAP.

Default value: F

LDAPUseServerAccount

Determines if a password is required to connect to the server when using LDAP authentication.

Parameter type: optional, static

- To connect directly to the LDAP server using integrated authentication, set this parameter to T. Set this parameter to T whenever the IBM Cognos TM1 server and LDAP server exist on the same domain.
- To use a password before connecting, set this parameter to F. When LDAPUseServerAccount is set to F, you must also set the “LDAPPasswordFile” on page 200 and “LDAPPasswordKeyFile” on page 200 to successfully connect to the LDAP server using SSL.

LDAPVerifyCertServerName

Specifies a server to use during the SSL certificate verification process for LDAP server authentication. This parameter is applicable only when LDAPVerifyServerSSLCert=T.

Parameter type: optional, static

Note: Before working with this parameter, you should be familiar with SSL and LDAP.

Use this parameter to specify the servers TM1 should use to verify the received SSL certificate.

All of the server names you want to use for certificate verification must be listed in separate LDAPVerifyCertServerName entries. The entries must exactly match the name (subject) of the certificate presented to TM1 in the SSL handshake by the server on the other end.

Specify LDAPVerifyCertServerName in the tm1s.cfg file of each TM1 server that is using LDAP.

LDAPVerifyCertServerName=<server_cert_subject>

Replace server_cert_subject with a server name or IP addresses. Create an entry for each server you want to use. For example:

LDAPVerifyCertServerName=abc99.mydomain.com
LDAPVerifyCertServerName=xyz99.mydomain.com

Default value: F
**LDAPVerifyServerSSLCert**

Delegates the verification of the SSL certificate to TM1. This parameter is useful, for example, when you are using LDAP with a proxy server.

Parameter type: optional, static

**Note:** Before working with this parameter, you should be familiar with SSL and LDAP.

Typically, TM1 leverages the Microsoft Windows API to verify SSL certificates. For this process to succeed, the certificate name and the LDAP server host name must match. If you are using a proxy, however, these names may not match, causing the verification to fail. In this case, you can set `LDAPVerifyServerSSLCert=T` to have TM1 perform the certificate verification.

When `LDAPVerifyServerSSLCert=T`, TM1 performs the two steps of verification (verifying the trust relationship to the certificate and checking the CRL) like the Windows API would have done, but with a slightly different approach.

1. Instead of verifying the received certificate against the configured host name, TM1 looks at the list of server names specified by `LDAPVerifyCertServerName`.
2. If the certificate name matches one of the servers specified by `LDAPVerifyCertServerName`, TM1 calls the Microsoft Windows API and requests it to verify this single certificate only.

**Note:** The correct trusted root certificate authority (CA) must already have been imported to the Microsoft Windows Certificate Store.

You can skip the trust verification step by specifying `LDAPSkipSSLCertVerification=T`. In this case, TM1 does not verify the server certificate at all but simply accepts it.

3. Once the trust verification is confirmed (or skipped), TM1 calls the Microsoft Windows API to check the CRL.

**Note:** The CRL certificate for the trusted root must already have been imported to the Microsoft Windows Certificate Store.

If the CRL certificate does not exist in the Microsoft Windows Certificate Store, the process will fail. You can skip the CRL step by specifying `LDAPSkipSSLCRLVerification=T`.

4. If all the previous steps finish successfully, the SSL handshake is complete. TM1 now attempts to authenticate to the LDAP server.

For troubleshooting information, see “Troubleshooting LDAP authentication” on page 205.

**LDAPWellKnownUserName**

 Specifies the user name used by the IBM Cognos TM1 server to log in to LDAP and look up the name submitted by the user.

Parameter type: optional unless `LDAPUseServerAccount` on page 202=F, static

The value of this parameter can be any LDAP distinguished name.

For example:
**LockPagesInMemory**
When this parameter is enabled, Windows trims pages from the IBM Cognos TM1 process space, but does not page them to disk.

Parameter type: optional, static

If a Cognos TM1 server running on a Windows 64-bit operating system is idle for a long period of time, physical memory taken up by the Cognos TM1 server will page out to disk. This is a function of the Windows 64-bit operating system and not Cognos TM1. This can cause performance degradation in large Cognos TM1 databases when trying to access data after an idle period.

To maximize performance when running a large Cognos TM1 database on 64-bit Windows, set `LockPagesInMemory=T` in the `Tm1s.cfg` file.

When this parameter is enabled, Windows still trims pages from the Cognos TM1 process space, but does not page them to disk. This benefits Cognos TM1 server performance because objects are no longer placed in virtual memory, but instead remain in physical RAM.

**LoggingDirectory**
Specifies the directory to which the server saves its log files.

If you do not supply this parameter, the log files are saved to the first data directory specified by the `DataBaseDirectory` parameter.

Parameter type: optional, static

**Note:** The value of parameter `LoggingDirectory` must be encapsulated by quotes if it uses spaces, for example `LoggingDirectory=C:/Data Files/Logfiles`. The Cognos TM1 Server startup will fail if quotes are not used in that case. Note also that other parameters, such as `DataBaseDirectory`, do not necessarily require quotes when a value contains spaces.

**LogReleaseLineCount**
Sets the number of lines that a search of the Transaction Log will accumulate in a locked state before releasing temporarily so that other Transaction Log activity can proceed.

Parameter type: optional, static

Default value: 5000 lines

**MagnitudeDifferenceToBeZero**
Sets the order of magnitude of the numerator relative to the denominator, above which the denominator equals zero when using a safe division operator.

Parameter type: optional, static

In rules and TurboIntegrator, there is a safe division operator (the backslash). With this, if you try to divide by zero, the result is zero, not undefined. If the denominator to the division is a calculated quantity, the result can be very close to
zero, but not exactly zero, for example, .0000000000000004. By setting the `MagnitudeDifferenceToBeZero` parameter, you can specify how close a number can be to zero, relative to the magnitude of the numerator, to be considered as zero for the safe division operator.

Consider this example:
- In the file Tm1s.cfg, set `MagnitudeDifferenceToBeZero=14`
- The operation is `A \ B`

**Note:** Backslash (`\`) is the safe division operator in TurboIntegrator.
- `A = 1000  B = 1.5e-15`
- `B` is 18 orders of magnitude less than `A`
- `18 > 14`, therefore the safe division operator returns `B=0`

**MaskUserNameInServerTools**

Determines whether or not user names in server administration tools (Operations Console) are masked until a user is explicitly verified as having administrator access.

Parameter type: optional, static

When `MaskUserNameInServerTools` is set to TRUE, user names are masked in server administration tools until the user who is working in the administration tool is explicitly verified as an administrator. Refer to the *IBM Cognos TM1 Operations Console Guide* for details on verifying administrator access to the Operations Console.

When `MaskUserNameInServerTools` is set to FALSE, user names are displayed in server administration tools to all users regardless of administrator status.

Default value: false

**MaximumCubeLoadThreads**

Specifies whether the cube load and feeder calculation phases of server loading are multi-threaded, so multiple processor cores can be used in parallel.

This results in decreased server load times.

Parameter type: optional, static

To run in multi-threaded mode, you should set `MaximumCubeLoadThreads` to the number of processor cores on the Cognos TM1 server that you want to dedicate to cube loading and feeder processing.

Generally, the best performance is achieved when the parameter is set to a value equal to `(number of available processor cores) - 1`. For example, if the Cognos TM1 server is running on a computer with four processor cores, `MaximumCubeLoadThreads` should be set to 3. This ensures that one processor core is available to run other applications while the Cognos TM1 server is loading.

When `MaximumCubeLoadThreads` is set to 0, cube loading and feeder processing is NOT multi-threaded. This is the default behavior when `MaximumCubeLoadThreads` is not explicitly set in the Tm1s.cfg file.
Note: When MaximumCubeLoadThreads is enabled, Cognos TM1 cannot manage the order in which feeders are calculated. There may be cases where processing order has an adverse effect on your application due to some order-of-evaluation dependencies in the multi-threaded environment.

If your Cognos TM1 model uses conditional feeders where the condition clause contains a fed value, you should set MaximumCubeLoadThreads=0 or exclude the parameter from the Tm1s.cfg file to disable the use of multiple threads at load time.

**MaximumLoginAttempts**

Sets the maximum number of failed user login attempts permissible on the server.

If you do not include MaximumLoginAttempts in Tm1s.cfg, by default, the server allows three login attempts.

Parameter type: **optional, dynamic**

For example, if you add the line `MaximumLoginAttempts=5` to Tm1s.cfg, the server enforces a limit of five failed login attempts per user. If a user does not successfully log in to the Cognos TM1 server within the specified number of attempts, the server issues an error.

After a user has exceeded the specified maximum number of failed login attempts, the Cognos TM1 server rejects any subsequent login attempts by the user.

The MaximumLoginAttempts parameter is enforced per server session. If a user exceeds the maximum number of attempts, he cannot log in to the current Cognos TM1 server session, unless the Cognos TM1 administrator changes his password. However, after the Cognos TM1 server recycles, the user can log in with his existing password.

**MaximumMemoryForSubsetUndo**

Sets the maximum amount of memory, in kilobytes, to be dedicated to storing the Undo/Redo stack for the Subset Editor.

For example, adding the line `MaximumMemoryForSubsetUndo=20480` to the configuration file instructs the server to allot 20480 kilobytes (20 MB) of memory for the Undo/Redo stack.

Parameter type: **optional, dynamic**

Generally, larger subsets require greater amounts of memory to store a usable Undo/Redo stack. If you find that the Cognos TM1 server is not storing a sufficient number of Undo/Redo steps for your subsets, increase the value of MaximumMemoryForSubsetUndo.

If this parameter is not explicitly set in the Tm1s.cfg file, the maximum amount of memory dedicated to the Undo/Redo feature of the Subset Editor is 10240 kilobytes (10 MB).

**MaximumSynchAttempts**

Sets the maximum number of times a synchronization process on a planet server will attempt to reconnect to a network before the process fails.
Parameter type: optional \texttt{static}

You can use the \texttt{MaximumSynchAttempts} parameter to improve the stability of a synchronization process that is running over an unstable network connection such as a long distance wide area network (WAN) with high latency, poor bandwidth and poor transmission quality.

To specify the maximum number of times a synchronization process should attempt to make a network connection, add the following line to Tm1s.cfg for the planet server:

\begin{verbatim}
MaximumSynchAttempts=n
\end{verbatim}

where \( n \) represents the number of network connection attempts that the synchronization process should make before the process fails.

The default value is 1 which means the synchronization process will only attempt to connect once and will not attempt to reconnect if the connection is lost. This default behavior is the same behavior as Cognos TM1 versions prior to 9.5.1 where a synchronization process would fail if the network connection was lost.

A value of 0 means unlimited network connection attempts.

You can configure this parameter to work with the \texttt{SyncUnitSize} parameter. For more information, see “\texttt{SyncUnitSize}” on page 304.

The following example shows how to use the \texttt{MaximumSynchAttempts} parameter with the \texttt{SyncUnitSize} parameter:

\begin{verbatim}
SyncUnitSize=2000
MaximumSynchAttempts=100
\end{verbatim}

\section*{MaximumTILockObjects}

A server configuration parameter that sets the maximum lock objects for a TurboIntegrator process. Used by the \texttt{synchronized()} TurboIntegrator function.

The server maintains a list of created TurboIntegrator lock objects. Every time the user calls the \texttt{synchronized()} function on a lock object, the server first checks to see if the lock object is already in the list. If not, the server creates a new lock object and inserts it into the list.

For more details, see the topic “Serializing TurboIntegrator processes using \texttt{synchronized()}” in the \textit{IBM Cognos TM1 TurboIntegrator Guide}.

Even after all the TurboIntegrator processes that have referenced a lock object have exited, the lock object may not be removed from the list to free the memory immediately. This is because it is likely that sometime later, either the same process or some other process may call the \texttt{synchronized()} function on that same lock object.

The server configuration parameter \texttt{MaximumTILockObjects} in tmls.cfg controls the growth of the list of created TurboIntegrator lock objects. When the number of lock objects in the list has reached \texttt{MaximumTILockObjects}, the server starts a cleanup operation. It removes some lock objects from the list if they are not used by any TurboIntegrator process at that moment.
If the MaximumTILockObjects parameter is not explicitly set in tm1s.cfg, a default value of 2000 is assumed.

Parameter type: optional

**MaximumUserSandboxSize**

Sets the maximum amount of RAM memory (in MB) to be allocated per user for personal workspaces or sandboxes.

If you do not set the MaximumUserSandboxSize parameter, the default maximum size is 100 MB on a 32-bit system, and 500 MB on a 64-bit system.

Parameter type: optional

To specify a maximum amount of memory allocation for personal workspaces or sandboxes, add the following line to Tm1s.cfg:

```
MaximumUserSandboxSize=n
```

where n represents the amount of memory in MB to be allocated.

**MaximumViewSize**

Sets the maximum amount of memory (in MB) to be allocated when a user accesses a view.

If you do not set the MaximumViewSize parameter, the default maximum view size is 100MB on a 32-bit system, and 500 MB on a 64-bit system.

Parameter type: optional

To specify a maximum amount of memory allocation for views, add the following line to tm1s.cfg:

```
MaximumViewSize=n
```

where n represents the amount of memory in MB to be allocated.

See also "ApplyMaximumViewSizeToEntireTransaction" on page 259.

**MessageCompression**

Enables message compression for large messages that significantly reduces network traffic.

The parameter is enabled by default.

Parameter type: optional

To disable message compression, add the following line to Tm1s.cfg:

```
MessageCompression=F
```

**MTQ**

Sets the maximum number of threads per TM1 query.

Parameter type: optional
To specify a maximum number of threads to use when processing queries, add the following line to Tm1s.cfg:

\[ \text{MTQ=}n \]

where \( n \) represents the number of threads to be used for a single query.

Alternatively, use \( \text{MTQ=}\text{All} \) (case insensitive), which sets the value to the maximum number of cores available on a server. The result is a dynamic system setting that consumes all cores.

If you set MTQ equal to a negative number, that is, \( \text{MTQ=} -n \), the number of threads that will be used is defined by the following equation: \( T=M-N+1 \), where \( T= \) the number of threads to be used by the system and \( M= \) the number of threads on the server.

For example, if your server has 64 cores and you set MTQ= -10, the system will use 55 cores.

\[ T=64-(10)+1 \]

If you set MTQ=1 or MTQ=0, multi-threaded query execution is turned off.

For more information, see "Multi-Threaded Queries" in the IBM Cognos TM1 Operation Guide.

MTQ is turned off by default.

**Note:** Multi-threaded queries can improve performance on numeric cubes, where consolidation is optimized. As TM1 does not consolidate string values, the MTQ parameter has no impact on the performance of string cubes.

**MTQ.OperationProgressCheckSkipLoopSize**

Use this parameter to fine-tune multi-threaded query processing.

Parameter type: optional, dynamic

This parameter specifies the number of cells to be processed before checking whether multi-threaded splits are needed.

Default value is 10000.

**MTQ.SingleCellConsolidation**

Use this parameter to fine-tune multi-threaded query processing.

Parameter type: optional, dynamic

Set this parameter to FALSE to disallow multi-threaded query processing for single cell consolidations. This is applicable, for example, if you model contains complex rules (rules that have cross-cube references with a recursive depth greater than two).

Single cell consolidation is often invoked for the computation of rules referencing consolidated values as arguments. Single cell consolidation is also used to compute title only views.

Default value is TRUE.
NetRecvBlockingWaitLimitSeconds

Use this parameter to have the server perform the wait period for a client to send the next request as a series of shorter wait periods. This parameter changes the wait from one long wait period to shorter wait periods, so that a thread can be canceled if needed.

Parameter type: optional, static

The parameter is enabled by default.

By default the server can wait for a long time for input, which can result in long-held threads and other problems.

This parameter instructs the Cognos TM1 server to perform the wait as a series of repeated shorter waits and gives the server the opportunity to cancel or pause the thread. When set to zero (the default) the legacy behavior of one long wait is used.

Default value: 0

NetRecvMaxClientIOWaitWithinAPIsSeconds

Specifies the maximum time for a client to do I/O within the time interval between the arrival of the first packet of data for a set of APIs through processing until a response has been sent.

Parameter type: optional, static

This parameter requires the client to handle I/O in a reasonably timely fashion after initiating API requests. This parameter is designed to protect against connections that go dead but do not raise a socket error or create other possibilities such as a hung client.

Default value is 0, which means no time limit.

ODBCLibraryPath

Specifies the name and location of the ODBC interface library (.so file) on UNIX.

Parameter type: optional (required to support ODBC on UNIX), static

This parameter is applicable only to TM1 running on UNIX, Linux, or AIX.

In the tm1s.cfg file, add the following line:

`ODBCLibraryPath= location/file`

Replace location/file with the absolute path and filename of the library.

For example:

`ODBCLibraryPath=/usr/local/lib/unixODBC/lib/libodbc.so`

OracleErrorForceRowStatus

Use this parameter to ensure the correct interaction between IBM Cognos TM1 TurboIntegrator processes and Oracle ODBC data sources.

Parameter type: optional, static
The format of the parameter is as follows:

```
OracleErrorForceRowStatus=x
```

Replace `x` with one of the following values:

0  Cognos TM1 auto-detects the version of Oracle you are connecting to.
1  Cognos TM1 handles the connection to Oracle the same way as other drivers.
2  Cognos TM1 connects to Oracle and uses SQLULEN instead of SQLUSMALLINT.

The default is 0.

**ParallelInteraction**

Turns Parallel Interaction on or off for all of the user-created and control cubes in an IBM Cognos TM1 server.

Parallel Interaction is a Cognos TM1 server-related feature that allows for greater concurrency of read and write operations on the same cube object. For more details, see “Using Parallel Interaction with a Cognos(r) TM1(r) server” in the *IBM Cognos TM1 Operation Guide*.

Parameter type: optional, static

As of Cognos TM1 version 10.1, Parallel Interaction is enabled by default which uses Parallel Interaction for all cubes in the TM1 server.

To manually disable Parallel Interaction for all cubes, set ParallelInteraction=F.

**PasswordMinimumLength**

Specifies a minimum password length for clients accessing the server.

Parameter type: optional, dynamic

For example, set `PasswordMinimumLength=8` to enforce a minimum password length of 8 characters.

**Note:** This parameter only affects passwords set or changed after the parameter had been set. It has no effect on old, unchanged passwords having less characters as enforced by PasswordMinimumLength.

**PasswordSource**

Compares user-entered password to the stored password.

Parameter type: optional, static

Cognos TM1 (Default): Compares the user-entered password to the password in the Cognos TM1 database.

LDAP: Compares the user-entered password to the password stored in on the LDAP server.
**PerfMonIsActive**

Use this parameter to turn updates to TM1 performance counters on or off.

Parameter type: optional, dynamic

You can view performance counters using the TM1 PerfMon utility or the Microsoft Windows Performance Monitor. For more details, see “Using TM1 Performance Counters” in the *TM1 Operation Guide*.

Capturing performance counters in TM1 can impact performance under a heavy multi-user workload (with 100 or more active users). Use this parameter to turn off updates to performance counters if performance is an issue.

Default value is T.

**PerformanceMonitorOn**

Automatically starts populating the \{Stats\} control cubes when a server starts.

The control cubes contain statistics that you can review to monitor the system performance. For details on control cubes, see “Control Cubes” in the *IBM Cognos TM1 Operation Guide*.

Parameter type: optional, static

For example, to enable Performance Monitor set `PerformanceMonitorOn=T`. To disable the Performance Monitor set `PerformanceMonitorOn=F`.

**PersistentFeeders**

To improve reload time of cubes with feeders, set the PersistentFeeders configuration parameter to true (T) to store the calculated feeders to a .feeders file.

Any installation with server load times of over 5 minutes can probably improve their performance using this parameter.

Parameter type: optional, static

When this parameter is set to T and the server encounters a persistent feeder file, it loads the saved feeders which reduces the time normally taken to recalculate those feeders. Feeders are saved when the data is saved or rules are edited. You do not explicitly save the feeders.

For installations with many complex feeder calculations persisting feeders and then re-loading them at server startup will improve performance. For simple feeders, the time taken to read feeders from disk may exceed the time to re-calculate the feeders but most installations will benefit.

Using the Persistent Feeders feature will increase your system size on disk only. Memory size is not affected by the use of this parameter.

Default value is T.

For more information, see “Using Persistent Feeders” in the *IBM Cognos TM1 Operation Guide*. 

---

Appendix A. The tm1s.cfg Server Configuration File  293
**PortNumber**

Sets the server port number used to distinguish between multiple servers running on the same computer.

When multiple IBM Cognos TM1 servers are installed on a single computer, each server must use a unique port number.

Parameter type: optional, static

When you install a Cognos TM1 server, the default port number is 12345. Valid port numbers are between 5001 and 49151.

If the Tm1s.cfg file does not contain the PortNumber parameter, the Cognos TM1 server uses port 5000. Local Cognos TM1 servers use port 5000. The port used for Client Messages must also be a unique port number and is set to 5001 by default when the ClientMessagePortNumber parameter is used.

**PrivilegeGenerationOptimization**

When the TM1 server generates security privileges from a security control cube, it reads every cell from that cube.

If the security control cube is sparsely populated, this results in unnecessary processing and a longer loading time. An example of a sparsely populated security cube would be one that has a greater ratio of default security settings compared to defined security settings.

Parameter type: optional, static

To address this issue, the PrivilegeGenerationOptimization parameter can be added to the Tm1s.cfg file as follows:

```
PrivilegeGenerationOptimization=T
```

When this parameter is set to T, the Cognos TM1 server will read only the populated cells in security cubes. In the case of a sparsely populated security cube, this will dramatically shorten the Cognos TM1 server's load time.

**Note:** If you populate the security settings via rules and want to use this parameter, you must write feeders for the rules that populate your security cubes. Because security settings are stored as strings, the rules that populate your security cubes must include the FeedStrings function.

**ProgressMessage**

This parameter determines whether users have the option to cancel lengthy view calculations.

When a user opens a view that takes a significant amount of time to calculate (usually a view with high levels of consolidation or complex rules), IBM Cognos TM1 monitors the progress of the process. When ProgressMessage=T a dialog box opens that allows the user to Stop Building View.

Parameter type: optional, static

If the user clicks Stop Building View, the view is discarded on the client, but view calculation continues on the server. In some instances, this can tie up the server.
• If ProgressMessage=F, the Stop Building View option is not offered and the user cannot cancel lengthy operations. This setting helps avoid potential server tie-ups in versions 9.1 SP3 through 9.4.

• When ProgressMessage=T or is not present in the Tm1s.cfg file, the Stop Building View option opens during lengthy view calculations so the user can cancel the process if necessary. For versions 9.4 or later, the user can assign a unique Port Number using ClientMessagePortNumber. This additional port allows these progress messages to travel via a secondary port so that server processing can continue without tying up thread reserves.

Note: To avoid potentially tying up servers, Cognos TM1 9.1 SP3 through 9.4 have ProgressMessage=F inserted into the Tm1s.cfg file during server installation. As of Cognos TM1 9.4, progress messages can travel via the secondary port assigned by ClientMessagePortNumber so Cognos TM1 9.4 and later have ProgressMessage=T set by default.

**ProportionSpreadToZeroCells**

Allows you to perform a proportional spread from a consolidation without generating an error when all the leaf cells contain zero values.

In this case, Cognos TM1 applies an equal spread to the empty cells when the ProportionSpreadToZeroCells parameter is enabled. This functionality is enabled by default.

Parameter type: optional, static

**Behavior when ProportionSpreadToZeroCells is enabled**

This parameter and functionality are enabled by default, allowing you to complete a spread operation without an error when you perform a proportional spread on a consolidation where all the leaf cells are zero. In this scenario, Cognos TM1 converts the typed entry of "P###" to "LS###" and applies the spread as an equal spread.

When this parameter is enabled and data exists in any of the leaf cells, the behavior is the same as previous versions of Cognos TM1 when performing a proportional spread.

This parameter is on by default and it is not necessary to enable it. However, if you want to explicitly configure it, set the ProportionSpreadToZeroCells parameter to T (True) in the Tm1s.cfg configuration file as follows.

ProportionSpreadToZeroCells=T

**Behavior when ProportionSpreadToZeroCells is disabled**

Setting this parameter to F (False) disables this feature. An error displays when you try to perform one of the following proportional spreading operations:

• In TM1 Contributor - Enter a number in a consolidated cell where all of the leaf cells for that consolidation contain zeros.

• In TM1 Contributor and other TM1 clients - Perform a proportional spread operation by either entering a spreading code and number such as "P###" in a cell, or access a proportional spread from the right-click menu or TM1 menu (TM1 Perspectives only) when the leaf cells for that consolidation all contain zeros.
These operations make the TM1 server perform a proportional spread, but the operation fails because all of the leaf cells contain zeros.

To disable this functionality, set the ProportionSpreadToZeroCells parameter to False in the Tm1s.cfg configuration file as follows.

```
ProportionSpreadToZeroCells=F
```

**RawStoreDirectory**

Indicates the location of the temporary, unprocessed log file for audit logging if logging takes place in a directory other than the data directory.

Parameter type: optional, dynamic

If this parameter is not entered, by default the unprocessed audit log file is saved in the directory listed in the `DataBaseDirectory` parameter.

For details on other audit logging parameters, see “AuditLogMaxFileSize” on page 260, “AuditLogMaxQueryMemory” on page 260, “AuditLogOn” on page 260, and “AuditLogUpdateInterval” on page 261.

**ReceiveProgressResponseTimeoutSecs**

The ReceiveProgressResponseTimeoutSecs parameter configures the server to sever the client connection and release resources during a long wait for a Cancel action.

Parameter type: optional, dynamic

When the Cognos TM1 server is performing lengthy operations for a client, periodic "progress" messages are sent to the Cognos TM1 client application. The client responds to these messages with an indication of whether the user has pressed the Cancel button, in which case the lengthy operation is terminated. These responses are generated automatically by the network code in the client application; there is no user interaction involved. After sending the progress message the server waits for a response from the client application. As the server is waiting, the client's thread will continue to hold resource locks on the Cognos TM1 server, preventing other users from making other server requests which require the same resource locks.

In some particular situations, most notably running Cognos TM1 clients under a Citrix environment, the response from the client application never arrives back at the Cognos TM1 server, causing the server to wait for an infinite amount of time. This results in a system lockup, because the client's thread holds resource locks that are never released.

The ReceiveProgressResponseTimeoutSecs parameter lets you configure your server to detect this situation and to sever the client connection, releasing the resources. When the parameter is set to a valid interval (in seconds), the server process will terminate the client connection, releasing any resource locks, if the server does not detect the client application's response within the specified interval.

For example, if ReceiveProgressResponseTimeoutSecs=20 and the client application does not respond to the progress message sent from the server within 20 seconds, the client connection is terminated. Again, no user action is required to generate this response. The response is automatically generated by the client application, so
that if the response does not arrive within 20 seconds, it is an indication that there is something seriously wrong with the client or the underlying network.

ReceiveProgressResponseTimeoutSecs is an optional Tm1s.cfg parameter. If the parameter is not present in the Tm1s.cfg file, processes are not terminated when a client does not respond to a progress message from the Cognos TM1 server.

For some Cognos TM1 installations (version 9.4 or later), the ClientMessagePortNumber defines a separate thread to use for cancellation messages without tying up reserves. When ClientMessagePortNumber is available, ReceiveProgressResponseTimeoutSecs is not used.

**RulesOverwriteCellsOnLoad**
Prevents cells from being overwritten on server load in rule-derived data.

Parameter type: optional, static

During the processing of feeders for a cube, a cube's value can be wiped out if there is a rule for that cell. Once the cube which had a cell wiped out is saved, the value is gone so the action has no effect on the cube. However, if the rule is edited but the cube is not subsequently modified, the cube is not saved to disk. In that case, real cell values may be wiped out when the rules run.

The RulesOverwriteCellsOnLoad parameter can be used to prevent the zeroing out action after a rule is edited.

If you are changing rules and the rules may, due to various edits, cause some cells which have data to become rule-derived, add RulesOverwriteCellsOnLoad=F to the configuration file.

If this parameter is set to True or is not present, whenever the server loads, rule-derived cells are wiped to zero. The data value in those cells is lost even if the rule is subsequently changed so that the cell is no longer rule-derived.

By default this parameter is not present in the configuration file or is set to True. RulesOverwriteCellsOnLoad=F

**RunningInBackground**
When you add the line RunningInBackground=T to tm1s.cfg, the UNIX IBM Cognos TM1 server runs in background mode.

Parameter type: optional, static

If you use the startup_tm1s.sh and shutdown_tm1s.sh scripts to start and stop TM1 servers, set RunningInBackground=T.

**SaveTime**
Sets the time of day to execute an automatic save of server data; saves the cubes every succeeding day at the same time. As with a regular shutdown, SaveTime renames the log file, opens a new log file, and continues to run after the save.

Parameter type: optional, dynamic
The SaveTime parameter is not available when running the Cognos TM1 server as a Windows service.

The format of the SaveTime parameter is *dd:hh:mm* where:
- *dd* is the number of days from today that the system will start automatically saving data. For example, 00 is today, 01 is tomorrow.
- *hh:mm* is the time of day in 24-hour format.

**SecurityPackageName**

If you configure the IBM Cognos TM1 server to use Integrated Login, the SecurityPackageName parameter defines the security package that authenticates your user name and password in Microsoft Windows.

Parameter type: optional, static

Valid values are:
- Kerberos (default) - supported versions Microsoft Windows.
- NTLM - Older Microsoft Windows installations, such as Microsoft Windows NT.

For complete descriptions of all login security modes, including Integrated Login, see "Integrated Login" on page 194.

**ServerCAMURI**

Specifies the URI for the internal dispatcher that the IBM Cognos TM1 server should use to connect to Cognos Authentication Manager (CAM).

The URI is specified in the form

http[s]://fully-qualified host IP address:port/p2pd/servlet/dispatch

Parameter type: optional, static

For example,

https://vottbies005.ent.ad.cognos.com:9443/p2pd/servlet/dispatch

For CAM authentication this setting must include the fully-qualified name for the server that the Cognos Business Intelligence (BI) certificate was created for.

To determine the server that the certificate was issued for:
1. Enter the SSL URI to the Cognos BI dispatcher in a browser.
2. Update the ServerCAMURI setting in the tm1s.cfg with the fully-qualified name of that server.
   
   For example:
   
   ServerCAMURI=https://vottbies005.ent.ad.cognos.com:9443/p2pd/servlet/dispatch.

To configure the Cognos TM1 Applications Server to work with CAM SSL,
1. Ensure the following settings are made in Cognos Configuration:
   - **Force Qualified Paths** set to False.
   - **Use Mutual Authentication** set to True
2. Accept the certificate when saving.
ServerCAMURIRetryAttempts

Specifies the number of attempts made before moving on to the next ServerCAMURI entry in the tm1s.cfg file.

Parameter type: optional, static

This parameter is applicable if you are using IBM Cognos TM1 with Cognos BI security and you have defined multiple dispatchers in the tm1s.cfg file. Dispatchers are defined using the ServerCAMURI parameter.

For example, suppose you have three ServerCAMURI parameters specified in the tm1s.cfg file and ServerCAMURIRetryAttempts=7.

ServerCAMURI=http://server1:9300/p2pd/servlet/dispatch
ServerCAMURI=http://server2:9300/p2pd/servlet/dispatch
ServerCAMURI=http://server3:9300/p2pd/servlet/dispatch
ServerCAMURIRetryAttempts=7

The first dispatcher (http://server1:9300/p2pd/servlet/dispatch) is used and tried seven times. If it does not respond, the second one is then used and tried seven times. If it does not respond, the third dispatcher is then tried seven times. If the third one does not respond, the login fails.

Default value: 1

ServerLogging

Generates a log with the security activity details on the IBM Cognos TM1 server that are associated with Integrated Login.

Parameter type: optional, static

The log file, named Tm1server.log, is saved to the Cognos TM1 server data directory. The ServerLogging parameter is useful only if your Cognos TM1 server is configured to use Integrated Login.

Set ServerLogging to T in Tm1s.cfg. Note also that if ServerLogging=T is set, you must rename the Cognos TM1 server message logfile tm1server.log by editing the corresponding parameter in the logger configuration file tm1s-log.properties.

Note: If you change this parameter dynamically (without restarting the TM1 server), logging occurs only for new client sessions.

ServerName

Sets the name of the IBM Cognos TM1 server. If you do not supply this parameter, Cognos TM1 names the server Local and treats it as a local server.

Parameter type: optional, static

ServicePrincipalName

Specifies the service principal name (SPN) when using Integrated Login with TM1 Web and constrained delegation.

Parameter type: optional, static

Use the following format to add the parameter to the Tm1s.cfg file:
ServicePrincipalName=SPN

The value you set here must match the service name that has also been mapped to a domain account on the Active Directory domain controller using the Microsoft command-line tool, setspn.exe.

For example, if you use setspn.exe to add an SPN as follows:

```bash
setsnp -a FPM/TM1 WbSvr_Account
```

then you need to set the ServicePrincipalName parameter like this:

```bash
ServicePrincipalName=FPM/TM1
```

For more information about constrained delegation and SPN configuration, search the Microsoft website for the topic “Kerberos Technical Supplement for Windows”.

**SkipLoadingAliases**

Use SkipLoadingAliases to speed up the loading of the server and updating of views by skipping the loading of aliases.

Parameter type: optional, static

Please contact customer support to determine if this parameter is applicable to your Cognos TM1 system.

Valid values are:

- T - Aliases skipped
- F - Aliases loaded

**SkipSSLCAMHostCheck**

Indicates whether the SSL certificate ID confirmation process can be skipped.

The default is False.

Parameter type: optional, static

**Important:** This parameter should be set to True only if using a generic certificate for demonstration purposes.

**SpreadingPrecision**

Use the SpreadingPrecision parameter to increase or decrease the margin of error for spreading calculations.

Parameter type: optional, dynamic

Floating point arithmetic on computers is not 100% precise. When a computer calculates very small numbers, a margin of error is applied to the calculation. If the computer adds a set of numbers, and the resulting sum is close to the target value within the margin of error, the sum is considered accurate.

The margin of error for certain Cognos TM1 calculations is controlled through the SpreadingPrecision parameter. The default value is SpreadingPrecision=1e-8. This value is used in the following spreading scenarios:
• Spreading from a consolidated cell.
• Spreading in leaf cells whose consolidated value has a hold applied.

**Spreading from a Consolidation**

When you execute a proportional data spread from a consolidated cell, Cognos TM1 writes the numbers to each cell in the range, and rolls up the total to recalculate the consolidation. The total of all cells in the consolidation is then compared to the original value you provided for the spread function. The total might be different from the target value because of the rules applied to the n-level elements or the consolidated cell itself.

If the rules are such that the resultant value does not match the spread desired value, an error will be generated and the spread operation will not be done.

If SpreadingPrecision=1e-8, the total calculated by Cognos TM1 for the consolidation must be within 0.000001% of the target value (99.999999% accurate), or Cognos TM1 displays an error. An error of more than US$0.01 on a consolidated spread of US$1,000,000 results in an error.

You can increase or decrease the margin of error for these types of calculations using the SpreadingPrecision parameter.

The following examples include valid values for the SpreadingPrecision parameter:
• SpreadingPrecision=1e-4
• SpreadingPrecision=1e-8
• SpreadingPrecision=1e-10
• SpreadingPrecision=1e-12

**Spreading and Consolidation Holds**

The SpreadingPrecision parameter also has an effect under these conditions:
• When you spread values to some leaf cells that roll up into a consolidation
• A consolidation with a hold applied to it

For example, suppose you have the consolidation Q1 with values Jan, Feb, and Mar.

If Q1- has a consolidated hold applied, and you spread values to Jan and Feb, Cognos TM1 does the following:
• Applies the spreading to Jan and Feb.
• Adjusts Mar.
• Adds the three n-level elements together.
• Compares the sum of the n-level elements to the value of Q1.

If the sum is accurate to within the margin of error specified by the SpreadingPrecision parameter, the spread succeeds. If the sum falls outside the margin of error specified by the SpreadingPrecision parameter, Cognos TM1 generates an error.

**SSLCertAuthority**

Specifies the name of the IBM Cognos TM1 server's certificate authority file. This file must reside on the computer where the TM1 server is installed.
Parameter type: optional (required for SSL), static

If you are using your own SSL certificates with TM1, you can determine this value by referring to the Microsoft Management Console. Click Certificates > Personal > Certificates. The principal name is displayed in the Issued By column of the Properties pane.

**SSLCertificate**

Specifies the full path of the IBM Cognos TM1 server's certificate file, which contains the public/private key pair.

Parameter type: optional (required for SSL), static

**SSLCertificateID**

Specifies the name of the principal to whom the IBM Cognos TM1 server's certificate is issued.

Parameter type: optional (required for SSL), static

If you are using your own SSL certificates with TM1, you can determine this value by referring to the Microsoft Management Console. Click Certificates > Personal > Certificates. The principal name is displayed in the Issued To column of the Properties pane.

**SSLCertRevocationFile**

Specifies the name of the IBM Cognos TM1 server's certificate revocation file. This file must reside on the computer where the TM1 server is installed.

Parameter type: optional (required for SSL), static

A certificate revocation file will exist only in the event that a certificate has been revoked.

**SSLPkeyKeyPwdFile**

Specifies the full path to the .dat file that contains the encrypted password for the private key.

Parameter type: optional (required for SSL), static

If you are using your own SSL certificates, note that the name of this file is specified by the -outfile parameter when you run the TMICrypt utility.

For example, if you run the TMICrypt utility from the following command:
```
tm1crypt.exe -pwd abc123 -keyfile btkey.dat -outfile btprk.dat -validate
```

the correct parameter value is:
```
SSLPkeyKeyPwdFile=C:\Program Files\Cognos\TM1\bin64\btprk.dat
```

**SSLPwdKeyFile**

Specifies the full path to the .dat file that contains the key used to encrypt and decrypt the password for the private key.

Parameter type: optional (required for SSL), static
If you are using your own SSL certificates, note that the name of this file is specified by the -keyfile parameter when you run the TM1Crypt utility.

For example, if you run the TM1Crypt utility from the following command:
```
tm1crypt.exe -pwd abc123 -keyfile btkey.dat -outfile btpk.dat -validate
```

the correct parameter value is:
```
SSLPwdKeyFile=C:\Program Files\Cognos\TM1\bin\btkey.dat
```

**StartupChores**

StartupChores is a configuration parameter that identifies a list of chores that run at server startup.

Parameter type: optional, static

To run a chore at startup before users login or other scheduled chores run, add this parameter with the names of the chores to run separated by a colon, for example:
```
StartupChores=ChoreName1:ChoreName2:ChoreName3:ChoreNameN
```

If this parameter is not specified, then no Chores will be run. If the name specified does not match an existing Chore then an error is written to the server log and execution continues to the next Chore.

The value of the configuration parameter can be retrieved by a client application as a Server property called StartupChores using the existing TM1ObjectPropertyGet call.

This is a read-only property and set operations are rejected. The value of the property can be changed only by editing the configuration file and restarting the server.

**SubsetElementBreatherCount**

This parameter manages the way IBM Cognos TM1 handles locking behavior for subsets.

Parameter type: optional, dynamic

When

```
SubsetElementBreatherCount=-1
```

The Cognos TM1 server never releases the lock on subsets when other requests for the subset are pending. This setting is the default. It can optimize view performance for a single user, but at the cost of multi-user concurrency.

When

```
SubsetElementBreatherCount=0
```

the Cognos TM1 server releases the lock on subsets when other requests for the subset are pending, then reacquires the lock after pending requests are processed. This setting improves performance when multiple users attempt to access the same subset, particularly when the subset contain more than 100 elements.
**SvrSSLExportKeyID**

Specifies the identity key used to export the IBM Cognos TM1 server's certificate from the Microsoft Windows certificate store.

Parameter type: optional (required if ExportSvrSSLCert is enabled), static

This parameter is required only if you choose to use the certificate store by setting ExportSvrSSLCert=T.

In most cases, the value for **SvrSSLExportKeyID** will be identical to the value for **SSLCertificate**.

**SyncUnitSize**

Sets the frequency of saving a check point during a synchronization process in case there is a network connection failure.

Parameter type: optional, static

**Note:** When you use SyncUnitSize, you must also configure the MaximumSynchAttempts parameter. For more information, see “MaximumSynchAttempts” on page 287.

If you configure both the SyncUnitSize and MaximumSynchAttempts parameters and a synchronization process is interrupted by a network connection failure, the process will attempt to reconnect and complete the synchronization starting from the last check point.

To set this parameter, add the following line to the Tm1s.cfg file for the planet server:

```
SyncUnitSize=n
```

where n represents the number of synchronization records written to the transaction log file, Tm1s.log, after which a check point will be saved.

The default value is 1000.

The minimum recommended value is 500.

**TM1ConnectorforSAP**

Set this parameter to T to use the IBM Cognos TM1 Connector for SAP software.

Parameter type: optional, static

**Note:** This functionality is available only to customers who purchased the IBM Cognos TM1 Connector for SAP software. That software was previously available separately from the IBM Cognos TM1 software. This software is no longer available for sale.

If you have previously purchased this functionality, you must add TM1ConnectorforSAP=T and UseNewConnectorforSAP=T to the tm1s.cfg file to make the software available.

The default value is F.
UnicodeUpperLowerCase

This configuration parameter instructs the TM1 server to identify and handle Unicode object names, preventing the creation of identical Unicode object names that vary only in case.

Parameter type:
- Optional
- Static

If you change this parameter value, restart the TM1 server to apply the new value.

TM1 treats ASCII object names as case-insensitive; the element name SALES is equivalent to sales. A reference to either SALES, sales, or even SaLeS is considered to be a reference to a single element. Similarly, the cube name Projections is equivalent to PROJECTIONS.

However, Unicode object names are *not* treated as case-insensitive. Consequently, a server can contain two identically named objects that varied only in case. For example, the elements NEMÈIJA and nemèija can exist in a single dimension, and each is considered a unique element.

Include the parameter `UnicodeUpperLowerCase=T` in your TM1s.cfg file to prevent the creation of identically named Unicode object names that vary only in case. When `UnicodeUpperLowerCase=T`, Unicode object names are handled just as ASCII object names, and are case-insensitive.

If you have developed applications that rely on Unicode object names that vary only in case, and want to maintain such functionality, you should not add the UnicodeUpperLowerCase configuration parameter to your Tm1s.cfg file. If this parameter is not present in Tm1s.cfg (or is set to F) TM1 will continue to treat Unicode object names as case-sensitive.

UseLocalCopiesforPublicDynamicSubsets

Allows public dynamic subsets to improve performance and reduce locking by using local copies of the subset when possible.

Parameter type: optional, static

By default, or if the parameter is not present in the tm1s.cfg file, `UseLocalCopiesforPublicDynamicSubsets` is enabled. To restore the earlier method of saving dynamic subsets, set this parameter to F.

UseNewConnectorforSAP

Set this parameter to T to use the IBM Cognos TM1 Connector for SAP software.

Parameter type: optional, static

**Note:** This functionality is available only to customers who purchased the IBM Cognos TM1 Connector for SAP software. That software was previously available separately from the IBM Cognos TM1 software. This software is no longer available for sale.
If you have previously purchased this functionality, you must add
UseNewConnectorforSAP=T and TM1ConnectorforSAP=T to the tm1s.cfg file to
make the software available.

The default value is F.

**UserDefinedCalculations**

Enables the **Rollup** and **Insert Subset** options to create user-defined consolidations
in the Subset Editor in IBM Cognos TM1(r) Perspectives and Architect, and enables
the **Create Custom Consolidation** button in TM1(r)Web clients.

Parameter type: optional, dynamic

By default, UserDefinedCalculations is enabled.

To disable user-defined consolidations TM1 Perspectives, Architect, and TM1 Web
clients, add the following line to tm1s.cfg:

```
UserDefinedCalculations=F
```

**Note:** When set to F, users will see the following:

- In Architect and Perspectives, when users click the **Rollup** or **Insert Subset**
  option, they will get an error message stating that user defined calculations are
  not enabled.
- In TM1 Web, the **Create Custom Consolidation** button will be grayed-out.

**UseSQLFetch UseSQLFetchScroll UseSQLExtendedFetch**

These parameters instruct IBM Cognos TM1 to use a particular fetch call.

Parameter type: optional, dynamic

When you run TurboIntegrator process that extracts information from an ODBC
data source, Cognos TM1 tries to use the most efficient SQL fetch call possible.
Cognos TM1 queries the ODBC driver to determine which of the following SQL
Fetch calls to use to extract the data:

- SQLFetch(), an ODBC 1 function
- SQLExtendedFetch(), an ODBC 2 function
- SQLFetchScroll(), an ODBC 3 function

These parameters are all dynamic.

If Cognos TM1 receives no response when it queries the ODBC driver, your
Cognos TM1 process will result in an error unless one of the following parameters
is set to T in your Tm1s.cfg file:

```
UseSQLFetch
UseSQLFetchScroll
UseSQLExtendedFetch
```
These parameters instruct Cognos TM1 to use a particular fetch call. You must ensure that the call specified in Tm1s.cfg is appropriate for the ODBC driver being accessed, and you can specify only one of these parameters in Tm1s.cfg.

For example, to instruct the Cognos TM1 server to use the SQLExtendedFetch() call to extract data from an ODBC source, add the following line to Tm1s.cfg:

```
UseSQLExtendedFetch=T
```

**UseSSL**

Enables or disables SSL on the IBM Cognos TM1 server.

Parameter type: optional (required for SSL), static

This parameter is enabled by default.

To disable SSL, set `UseSSL=F`.

When `UseSSL=T`, you must set several other `tm1s.cfg` parameters that manage SSL implementation. For details on these parameters, see “Using SSL for data transmission security” on page 219.

Default value: T

**UseStargateForRules**

Indicates if a rule uses the Stargate view.

Parameter type: optional, static

By default, any time a rule references a calculated value, the value is retrieved from a Stargate view stored in memory (if available). Using the Stargate view for rules, in most cases, results in a significant improvement in performance. It is more efficient to retrieve a calculated value from memory than to request and retrieve a calculation from the server.

In some unique instances that are difficult, if not impossible, to determine in advance and can only be determined through trial and error, retrieving a calculated value from a Stargate view is actually slower than requesting and retrieving the value from the server. In these instances, add the following line to Tm1s.cfg to instruct the Cognos TM1 rules to always retrieve the calculated values from the server and improve performance.

```
UseStargateForRules=F
```

Contact customer support before adding the `UseStargateForRules` parameter.

**ViewConsolidationOptimization**

Enables or disables view consolidation optimization on the IBM Cognos TM1 server.

Parameter type: optional, static

Using this parameter improves the performance of calculating consolidated elements. By default, `ViewConsolidationOptimization` is enabled on the Cognos TM1 server.
View consolidation optimization stores the consolidated values that use leaf element components on either the row or column axis. For example, consider the dimension structure Year, 1Quarter with values Jan, Feb, and Mar.

When either a row or column subset uses the Jan element, both the 1 Quarter and Year consolidations are calculated and stored for future reference. This improves performance but increases the amount of memory required for a given view.

To disable view consolidation optimization, add the following line to Tm1s.cfg:

```
ViewConsolidationOptimization=F
```

### ViewConsolidationOptimizationMethod

This parameter defines the method used to achieve view consolidation optimization when the ViewConsolidationOptimization parameter is enabled on the IBM Cognos TM1 server.

Parameter type: optional, static

There are two methods that ViewConsolidationOptimization can use to calculate and store consolidations: ARRAY or TREE. The ARRAY method stores consolidations in a temporary array. The TREE method stores consolidations in a tree.

ViewConsolidationOptimizationMethod should be set to TREE in most circumstances. This setting provides the best performance in normal operations.

In rare instances, using the TREE method can result in a degradation of performance. In such an instance, try setting the parameter to ARRAY. For example, in the uncommon circumstance when dimensions have just a few leaf elements rolling up to many consolidations, ViewConsolidationOptimizationMethod should be set to ARRAY.

To set this parameter, add the appropriate line to your configuration file:

```
ViewConsolidationOptimizationMethod=TREE
```

or

```
ViewConsolidationOptimizationMethod=ARRAY
```

If ViewConsolidationOptimizationMethod is not explicitly set in the Tm1s.cfg file, the ARRAY method is used by default, as this maintains consistency with previous version of TM1 before the ViewConsolidationOptimizationMethod parameter was introduced.

### ZeroWeightOptimization

Determines whether consolidated members with a weight of 0 are factored into the computation of consolidated cell values or consolidation functions. Consolidation functions include ConsolidatedCount, ConsolidatedMax, ConsolidatedMin, ConsolidatedAvg, ConsolidatedCount, and ConsolidatedCountUnique.

Parameter type: optional, static

When set to true, members for which the weighting is zero are eliminated from the consolidation list, and are therefore not processed when calculating values for consolidated cells or consolidation functions. This is the default behavior.
When set to `false`, members for which the weighting is zero are included in the consolidation list, and are therefore factored into the calculations.

Default value: true
Appendix B. The Tm1p.ini Client Configuration File

The Tm1p.ini file specifies the environment information for the IBM Cognos TM1 clients (Cognos TM1 Perspectives, Cognos TM1 Architect, and Cognos TM1 Clients).

Location of the Tm1p.ini File

IBM Cognos TM1 installs a system default version of the Tm1p.ini file and also creates a user-specific version of the file.

The two versions of the Tm1p.ini file are stored in different locations.

System default Tm1p.ini file

The system default version of Tm1p.ini allows multiple users to use Cognos TM1 on a given computer. The Tm1p.ini file must be present the first time a user starts Cognos TM1 on the computer, as the parameters in the system default version govern the behavior of the initial startup of the Cognos TM1 client for each user.

The installation location of the system default version of the Tm1p.ini file depends on which version of Microsoft Windows you are using.

For Microsoft Windows XP or Windows Server 2003:

The location of the system default version of the Tm1p.ini file is:

%ALLUSERSPROFILE%\Application Data\Applix\TM1\Tm1p.ini

For example:

C:\Documents and Settings\All Users\Application Data\Applix\TM1\Tm1p.ini

Tip: To determine the value of the %ALLUSERSPROFILE% environment variable, run echo %ALLUSERSPROFILE% from a command line.

For Microsoft Windows 7 and Windows Server 2008:

For newer versions of Microsoft Windows, the location of the system default Tm1p.ini file is determined by the %ProgramData% setting.

%ProgramData%\Applix\TM1\Tm1p.ini

For example:

C:\ProgramData\Applix\TM1\Tm1p.ini

Tip: Run echo %ProgramData% from a command line to see the exact location.

User-specific Tm1p.ini file

After a user starts Cognos TM1 on the computer, a user-specific copy of the Tm1p.ini file is created in their %USERPROFILE% location.
The user-specific copy of Tm1p.ini accepts all parameters settings and changes for the user and governs the behavior of the Cognos TM1 client for all subsequent user sessions of the Cognos TM1 client.

The Cognos TM1 Options dialog box also stores many of these settings. You can change these settings using either the TM1 Options dialog box or by editing the Tm1p.ini file. The Tm1p.ini parameters and TM1 Options are described here.

The exact location for %USERPROFILE% depends on which version of Microsoft Windows you are using.

Tip: Run echo %USERPROFILE% from a command line to see the exact location.

For Microsoft Windows XP or Windows Server 2003:

The location of the user-specific version of the Tm1p.ini file is:

%USERPROFILE%\Application Data\Applix\TM1\Tm1p.ini

For example:

C:\Documents and Settings\user name\Application Data\Applix\TM1\Tm1p.ini

For Microsoft Windows 7 and Windows Server 2008:

For newer versions of Microsoft Windows, the user-specific copy of the Tm1p.ini file is located here:

%USERPROFILE%\AppData\Roaming\Applix\TM1\Tm1p.ini

For example:

C:\Users\ADMIN\AppData\Roaming\Applix\TM1\Tm1p.ini

---

Parameters in the Tm1p.ini file

The following parameters can be used in the Tm1p.ini file.

**AdminHost**
Displays the Admin Host name on which an Admin Server is running. On IBM Cognos TM1 Options, use Login Parameters Admin Host.

**AdminSvrSSLCertAuthority**
The full path of the certificate authority file that issued the IBM Cognos TM1 Admin Server's certificate.

On Cognos TM1 Options, use Certificate Authority.

**AdminSvrSSLCertID**
The name of the principal to whom the IBM Cognos TM1 Admin Server's certificate is issued.

Note: The value of this parameter should be identical to the SSLCertificateID parameter for the Cognos TM1 Admin Server as set in IBM Cognos Configuration.

This parameter can also be set for clients in the Cognos TM1 Options window > Certificate ID field.
**AdminSvrSSLCertRevList**

The full path of the certificate revocation file issued by the certificate authority that issued the IBM Cognos TM1 Admin Server's certificate.

A certificate revocation file will only exist in the event a certificate had been revoked. On Cognos TM1 Options, use Certificate Revocation List.

**AdminSvrSSLExportKeyID**

The identity key used to export the certificate authority certificate, which originally issued the IBM Cognos TM1 Admin Server's certificate, from the certificate store.

This parameter is required only if you choose to use the certificate store by setting ExportAdminSvrSSLCert=T.

On Cognos TM1 Options, use Export Certificate ID.

**AdvancedRulesEditor**

Indicates the type of Rules Editor used.

The Advanced Rules Editor has an enhanced interface.

- T - The Enhanced Rules Editor is used.
- F (Default)- The Basic Rules Editor is used.

**AllowImportCamClients**

This parameter is required only when configuring IBM Cognos TM1 to use CAM authentication.

It must be set to T when importing an administrative user from CAM into Cognos TM1.

If your Cognos TM1 server is not configured to use CAM authentication, this parameter should be set to F or omitted from the Tm1p.ini file.

For details, see [“Configuring the TM1 Server to use Cognos security” on page 206](#).

**BrowseDisplayReadsRightToLeft**

Indicates how data is oriented in the Cube Viewer.

Data can display right to left or left to right.

- T - Data is oriented right to left.
- F (Default) - Data is oriented left to right.

**ClassicSliceMode**

Indicates whether the Slice option in the Cube Viewer generates classic slices or dynamic slices.

- T - Slice option generates classic slices.
- F - Slice option generates dynamic slices.

**CognosGatewayURI**

This parameter is required only when configuring IBM Cognos TM1 to use IBM Cognos security (CAM) authentication.
It must be set to the URI of your IBM Cognos gateway. The URI is specified in the form http[s]:/\<host>/cognosx/cgi-bin/cognos.cgi or http[s]:/\<host>/ibmcognos/cgi-bin/cognos.cgi.

For example, http://win2003test/ibmcognos/cgi-bin/cognos.cgi.

If your Cognos TM1 server is not configured to use CAM authentication, this parameter should be omitted from the Tm1p.ini file.

For details, see "Configuring the TM1 Server to use Cognos security" on page 206.

**ConnectLocalAtStartup**

Indicates whether IBM Cognos TM1 Architect or IBM Cognos TM1 Perspectives automatically connects to the local server at startup.

- T (Default) - Cognos TM1 connects to the local server at startup.
- F - Cognos TM1 does not connect to the local server at startup.

**DataBaseDirectory**

Uses the full path to the local server data directory.

You can specify multiple data directories by separating the directory names with semicolons.

**DimensionDownloadMaxSize**

A threshold value of the number of elements in a dimension, beyond which the dimension is downloaded and cached on the IBM Cognos TM1 client.

To improve performance when you work with large dimensions, add DimensionDownloadMaxSize so that large dimensions will cache on the client.

**DisplayApplications**

Indicates whether the Applications group is visible in Server Explorer on startup.

- T - Applications group is visible in Server Explorer.
- F - Applications group does not appear in Server Explorer.

**DisableWritebackOnDisconnect**

When DisableWritebackOnDisconnect is enabled in the Tm1p.ini file, worksheet cells containing TM1 formulas that write to the TM1 server remain active and write to the server as long as an active server connection is available.

However, when this parameter is enabled and the TM1 Perspectives client is not connected to a TM1 server, cells containing TM1 formulas that write to the server are no longer protected. In this case, entering a value in any worksheet cell containing a TM1 formula that writes to the TM1 server results in the TM1 formula being overwritten.

TM1 formulas that write to the server include DBR, DBRW, DBRA, DBS, DBSA, DBSS, and DBSW.

Setting DisableWritebackOnDisconnect=T also restores multiple level undo/redo and multiple copy/paste operations in a worksheet containing TM1 formulas when there is no active server connection.
**DisableWritebackOnDisconnect** has a similar effect as **DisableWritebackOnTM1Formulas**. The important distinction between these two parameters is that **DisableWritebackOnDisconnect** applies only when there is no active server connection, while **DisableWritebackOnTM1Formulas** applies at all times.

**DisableWritebackOnTM1Formulas**

When enabled in the Tm1p.ini file, the **DisableWritebackOnTM1Formula** parameter prevents writeback to the TM1 server when you enter a value in a cell containing a TM1 worksheet formula.

When you set DisableWritebackOnTM1Formula=T in the Tm1p.ini file, entering a value in any worksheet cell containing a TM1 formula that writes to the TM1 server results in the TM1 formula being overwritten.

TM1 formulas that write to the server include DBR, DBRW, DBRA, DBS, DBSA, DBSS, and DBSM.

Setting DisableWritebackOnTM1Formula=T also restores multiple level undo/redo and multiple copy/paste operations in a worksheet containing TM1 formulas.

**DisplayChores**

Indicates whether the Chores group is visible in Server Explorer on startup.

- T - Chores group is visible in Server Explorer.
- F - Chores group does not appear in Server Explorer.

**DisplayControlCubes**

Indicates whether the Control Cube group is visible in Server Explorer on startup.

- T - ControlCube group is visible in Server Explorer.
- F - ControlCube group does not appear in Server Explorer.

**DisplayCubes**

Indicates whether the Cubes group is visible in Server Explorer on startup.

- T - Cubes group is visible in Server Explorer.
- F - Cubes group does not appear in Server Explorer.

**DisplayDimensions**

Indicates whether the Dimensions group is visible in Server Explorer on startup.

- T - Dimensions group is visible in Server Explorer.
- F - Dimensions group does not appear in Server Explorer.

**DisplayExplorerPropertiesWindow**

Indicates whether the Properties pane is visible in Server Explorer on startup.

- T - Properties pane is visible.
- F (Default) - Properties pane does not appear.

**DisplayProcesses**

Indicates whether the Processes group is visible in Server Explorer at startup.

- T - Processes group is visible in Server Explorer.
- F - Processes group does not appear in Server Explorer.
**DisplayReplications**
Indicates whether the Replications group is visible in Server Explorer at startup.
- T - Replications group is visible in Server Explorer.
- F - Replications group does not appear in Server Explorer.

**ExpandRowHeaderWidth**
Indicates if the Row Headers will automatically expand to accommodate the width of the longest entry in the column.
- T (Default) - Row headers auto-expand.
- F - Row header must be manually expanded when necessary.

**ExportAdminSvrSSLCert**
Select this option if you want the certificate authority certificate which originally issued the IBM Cognos TM1 Admin Server's certificate to be exported from the Microsoft Windows certificate store at runtime.
- T (Default) - Original certificate is exported from the Windows certificate store.
- F - Original certificate is not exported.

In Cognos TM1 Options, select Use Certificate Store.

When this option is selected, you must also set a value for Export Certificate ID in the Cognos TM1 Options dialog box or AdminSvrSSLExportKeyID.

**InSpreadsheetBrowser**
Indicates if the In-Spreadsheet Browser or the Cube Viewer is the default browser.
- T - In-Spreadsheet Browser is the default browser. When you double-click a cube or view, it opens in an Excel document.
- F (Default) - Cube Viewer is the default browser. When you double-click a cube or view, it opens in the Cube Viewer.

**IntegratedLogin**
Indicates if your IBM Cognos TM1 client uses Integrated Login or the standard Cognos TM1 security to log in to the Cognos TM1 server and other Cognos TM1 components.
- T - Client uses Integrated login, where your Microsoft Windows login username and password are used to access the Cognos TM1 server and other components.
- F (Default) - Client uses standard Cognos TM1 security, where a username and password must be explicitly provided, when logging in to the Cognos TM1 server and other components.

Before you enable this parameter, consult with your Cognos TM1 administrator to determine if Integrated Login is implemented on your Cognos TM1 server.

On Cognos TM1 Options, use Integrated Login.

**Language**
Indicates the language used in the IBM Cognos TM1 client interface.
Clients will try to read from the locale and use that to set the language. That language will be used if it matches one of the supported languages. If the language entered does not match a supported language, English is used.

To override the default you can set the Language explicitly in the tm1p.ini using the following codes:

<table>
<thead>
<tr>
<th>Language</th>
<th>Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Brazilian Portuguese</td>
<td>bra</td>
</tr>
<tr>
<td>Croatian</td>
<td>hrv</td>
</tr>
<tr>
<td>Czech</td>
<td>csy</td>
</tr>
<tr>
<td>Chinese (Simplified)</td>
<td>sch</td>
</tr>
<tr>
<td>Chinese (Traditional)</td>
<td>tch</td>
</tr>
<tr>
<td>Danish</td>
<td>dan</td>
</tr>
<tr>
<td>Dutch</td>
<td>nld</td>
</tr>
<tr>
<td>German</td>
<td>deu</td>
</tr>
<tr>
<td>Finnish</td>
<td>fin</td>
</tr>
<tr>
<td>French</td>
<td>fra</td>
</tr>
<tr>
<td>Hungarian</td>
<td>hun</td>
</tr>
<tr>
<td>Italian</td>
<td>ita</td>
</tr>
<tr>
<td>Japanese</td>
<td>jpn</td>
</tr>
<tr>
<td>Kazakh</td>
<td>kaz</td>
</tr>
<tr>
<td>Korean</td>
<td>kor</td>
</tr>
<tr>
<td>Norwegian</td>
<td>nor</td>
</tr>
<tr>
<td>Polish</td>
<td>pol</td>
</tr>
<tr>
<td>Romanian</td>
<td>rom</td>
</tr>
<tr>
<td>Russian</td>
<td>rus</td>
</tr>
<tr>
<td>Spanish</td>
<td>esp</td>
</tr>
<tr>
<td>Slovenian</td>
<td>slv</td>
</tr>
<tr>
<td>Swedish</td>
<td>sve</td>
</tr>
<tr>
<td>Thai</td>
<td>tha</td>
</tr>
<tr>
<td>Turkish</td>
<td>trk</td>
</tr>
</tbody>
</table>

**LocalServerNetworkProtocol**

Determines the protocol that the local IBM Cognos TM1 server uses to communicate with clients. Currently, the only valid setting is TCP.

**MainWindowLayoutInfo**

Generates dimension and position coordinates for the Server Explorer window; allows Server Explorer dimensions and position to be maintained between sessions.

The coordinates are automatically generated when you move or resize the Server Explorer window.
**PreviousAdminHosts**
Lists up to six of the most recently accessed Admin Hosts from the IBM Cognos TM1 Options Admin Host list.

**PreviousDataDirectories**
Lists up to six of the most recently accessed data directories in the Local Server Data Directory list from the IBM Cognos TM1 Options window.

The directories accessed within a single session are separated by semicolons. The directories accessed in different sessions are separated by commas.

**SecurityAssignmentWindowLayoutInfo**
Generates dimension and position coordinates for the Clients/Groups window; allows Clients/Groups dimensions and position to be maintained between sessions.

The coordinates are automatically generated when you move or resize the Clients/Groups window.

**SentMsgsToServerCountWarning**
The SentMsgsToServerCountWarning parameter is for development use only. The parameter is set to F by default.

Be sure not to change the default setting.

**ShowAdminHostChangeWarning**
Between session storage of whether to display or suppress a warning when the AdminHost is changed.
- T (Default)- When an AdminHost is changed, a warning message displays.
- F - No message is displayed when the AdminHost is changed.

**ShowAliasAttributeWarning**
Between session storage of whether to display or suppress a warning when the Alias Attribute is changed.
- T (Default)- When an Alias Attribute is changed, a warning message displays.
- F - No message is displayed when the Alias Attribute is changed.

**ShowChoresSchedulingWarning**
Between session storage of whether to display or suppress a warning when a chore schedule is changed.
- T (Default)- When a chore schedule is changed, a warning message displays.
- F - No message is displayed when a chore schedule is changed.

**ShowCubeReplicationWarning**
Between session storage of whether to display or suppress a warning when a cube is replicated.
- T (Default)- When a cube is replicated, a warning message displays.
- F - No message is displayed when a cube is replicated.
ShowDimDeleteElementWarning
Between session storage of whether to display or suppress a warning when a
dimension element is deleted.
- T (Default) - When a dimension element is deleted, a warning message displays.
- F - No message is displayed when a dimension element is deleted.

ShowDimensionAccessWarning
Between session storage of whether to display or suppress a warning when a
dimension is accessed.
- T (Default) - When a dimension is accessed, a warning message displays.
- F - No message is displayed when a dimension is accessed.

ShowDynamicSubsetWarning
Between session storage of whether to display or suppress a warning when a
Dynamic Subset is changed.
- T (Default) - When a Dynamic Subset is changed, a warning message displays.
- F - No message is displayed when a Dynamic Subset is changed.

ShowPickOperationWarning
Between session storage of whether to display or suppress a warning when data is
copied using the Pick Elements option.
- T (Default) - A warning message displays any time data is copied using the Pick
  Elements option.
- F - No message displays when data is copied using the Pick Elements option.

ShowProcessUNASCIIWarning
Between session storage of whether to display or suppress a warning when an
ASCII datasource is processed.
- T (Default) - When an ASCII datasource is processed, a warning message
displays.
- F - No message is displayed when an ASCII datasource is processed.

ShowProcessUNODBCWarning
Between session storage of whether to display or suppress a warning when an
ODBC datasource is processed.
- T (Default) - Any time an ODBC datasource is processed, a warning message
displays.
- F - No message displays when an ODBC datasource is processed.

SliceNewWorkbook
Determines how slices are generated from the Cube Viewer.
- T - Inserts slices in a new workbook.
- F (Default) - Inserts slices in a new sheet of the current workbook.

SubsetWindowLayoutInfo
Generates dimension and position coordinates for the Subset Editor window;
allows Subset Editor dimensions and position to be maintained between sessions.
The coordinates are automatically generated when you move or resize the Subset Editor window.

**TM1RebuildDefault**

Determine if worksheets recalculate on opening by default

By default, when you slice a view into Microsoft Excel from IBM Cognos TM1, the workbook contains a workbook level named variable, TM1RebuildOption, that is set to 1 by default. This causes the worksheets in the book to be rebuilt on opening (which forces a recalculation to happen on each sheet in the book). This action is necessary if the sheets contain Active Forms. If you are not working with Active Forms, you may not want all workbooks to use this default behavior.

All worksheets recalculate when a Cognos TM1 workbook is opened. The workbook was created by slicing from Cognos TM1 Perspectives and contains the workbook level named variable TM1RebuildOption = 1.

By default, as of Cognos TM1 9.4.1 all new books created by slicing have a workbook level named variable TM1RebuildOption=1 in them. This makes the workbook rebuild on open, causing a recalculation of all sheets, which is important for Active Forms but may not be the desired behavior if you are primarily working with non-Active Form worksheets.

To prevent sheets from using the default to always rebuild when slicing, change TM1RebuildDefault from T to F (or add TM1RebuildDefault=F if it doesn't already exist) in your tm1p.ini file. When TM1RebuildDefault=F the books get the workbook level named variable set to TM1RebuildOption=0 on slicing. This is equivalent to how Cognos TM1 worked prior to the introduction of Active Forms.

If this option is set to T or doesn't exist, slicing from a view in Cognos TM1 Perspectives sets the TM1RebuildOption workbook level named variable to 1 which forces a rebuild on open. If this option is F, the name variable TM1RebuildOption is set to 0, which does not rebuild. For a particular report, for example, an Active Form, you can set the name variable to 1 instead of the default 0.

By default, a new install does not have the TM1RebuildDefault parameter at all which provides the default behavior of slicing with TM1RebuildOption=1.
Appendix C. Setting up unattended installations and configurations

Set up an unattended installation and configuration to install an identical configuration across several computers on your network, or automate the installation and configuration process by specifying options and settings for users.

Before you set up an unattended installation and configuration, ensure that all the system requirements and prerequisites are met and that all third-party products are installed and configured.

Procedure
1. Configure a transfer specification file (.ats) to specify installation options.
2. Run the installation tool in silent mode.
3. Use a pre-configured configuration file from another computer.
4. Run the configuration tool in silent mode.

Unattended installations

Use a transfer specification file (.ats) to copy IBM Cognos components to your computer without being prompted for information.

By default, each time you install IBM Cognos components using the installation wizard, the options you select are recorded in a transfer specification file. Therefore, if you already installed IBM Cognos components on a sample computer, you can use the generated transfer specification file as a template for unattended installations on different computers.

If you do not use the installation wizard to install components, you can use the default transfer specification file named response.ats that is available on the disk. You must modify the response.ats file for your environment before you can use it for an unattended installation.

You can check if the unattended installation was successful by checking the return status. A value of zero (0) indicates success and all other values indicate that an error occurred.

Setting up an unattended installation

Use the following TM1 product codes for an unattended installation.

Procedure

Follow the instructions described in Setting up Unattended Installation (http://publib.boulder.ibm.com/infocenter/cbi/v10r1m0/index.jsp?topic= %2Fcom.ibm.swg.im.cognos.inst_cr_winux.10.1.0.doc %2Finst_cr_winux_id28690c8bi_SetUpUnattendedInstallation.html) substituting the following TM1 product codes.
Table 40. TM1 product codes for an unattended installation

<table>
<thead>
<tr>
<th>Product Code</th>
<th>Product</th>
</tr>
</thead>
<tbody>
<tr>
<td>TM1APPTIER_APP=1</td>
<td>TM1 Applications Tier</td>
</tr>
<tr>
<td>TM1SERVER_APP=1</td>
<td>TM1 Server</td>
</tr>
<tr>
<td>TM1ADMINSERVER_APP=1</td>
<td>TM1 Admin Server</td>
</tr>
<tr>
<td>TM1TOOLS_APP=1</td>
<td>TM1 Tools</td>
</tr>
<tr>
<td>TM1WEBAPPTIER_APP=1</td>
<td>TM1 Web Applications Tier</td>
</tr>
<tr>
<td>TM1CONTRIBGATEWAY_APP=1</td>
<td>TM1 Applications Gateway</td>
</tr>
<tr>
<td>TM1CONTRIBSERVICE_APP=1</td>
<td>TM1 Applications Server</td>
</tr>
<tr>
<td>TM1WEB_APP=1</td>
<td>TM1 Web</td>
</tr>
<tr>
<td>TM1OPERATIONSCONSOLE_APP=1</td>
<td>TM1 Operations Console</td>
</tr>
<tr>
<td>TM1CLIENTTIER_APP=1</td>
<td>TM1 Client Tier</td>
</tr>
<tr>
<td>TM1PERSPECTIVES_APP=1</td>
<td>TM1 Perspectives</td>
</tr>
<tr>
<td>TM1COGNOSINSIGHT_APP=1</td>
<td>Cognos Insight</td>
</tr>
<tr>
<td>TM1APIS_APP=1</td>
<td>TM1 API</td>
</tr>
<tr>
<td>TM1DEVTIER_APP=1</td>
<td>TM1 Developer Tier</td>
</tr>
<tr>
<td>TM1ARCHITECT_APP=1</td>
<td>TM1 Architect</td>
</tr>
<tr>
<td>TM1PERFMOD_APP=1</td>
<td>TM1 Performance Modeler</td>
</tr>
<tr>
<td>TM1SAMPLETIER_APP=1</td>
<td>TM1 Sample Tier</td>
</tr>
</tbody>
</table>

You can see the contents of this file in the `tm1_location/instlog` location in the `.ats` file.

Setting up an unattended configuration

Before you set up an unattended configuration, you must export a configuration from another computer that has the same IBM Cognos TM1 components installed. You can then run IBM Cognos Configuration in silent mode.

The exported configuration contains the properties of the Cognos TM1 components that you installed on the source computer. If you made changes to the global configuration, you must also copy the global configuration file from the source computer to the computer where you plan to run an unattended configuration.

Before you begin

Ensure that the configuration settings on the local computer are appropriate to use to configure another computer with the same installed components.

Procedure

1. In IBM Cognos Configuration, from the File menu, click Export as.
2. If you want to export the current configuration to a different folder, in the Look in box, locate and open the folder.
3. In the File name box, type a name for the configuration file.
4. Click Save.
5. Copy the exported configuration file from the source computer or network location to the `tm1_location/configuration` directory on the computer where you plan to do an unattended configuration.
6. Rename the file to `cogstartup.xml`. 

322 Installation and Configuration Guide
7. If you changed the global configuration on the source computer, copy the
coglocale.xml file from the source computer to the tm1_location/
configuration directory on the computer where you plan to do an unattended
collection.
8. Go to tm1_location/bin directory.
9. Type the configuration command:
   cogconfig.bat -s
   To view log messages that were generated during an unattended configuration,
   see the cogconfig_response.csv file in the tm1_location/logs directory.

Results
You can check if the unattended configuration was successful by checking the
return status. A value of zero (0) indicates success and all other values indicate that
an error occurred.

Cognos Configuration applies the configuration settings specified in the local copy
of cogstartup.xml, encrypts credentials, generates digital certificates, and if
applicable, starts the IBM Cognos service or process.

Setting up an unattended uninstallation
Set up an unattended uninstallation to automate the removal of components on
several computers that have the same components or to remove components on a
UNIX or Linux environment that does not have Microsoft XWindows.

Procedure
1. Go to tm1_location/instlog.
2. Open the transfer specification .ats file for the product in a text editor.
   The filename format of the transfer specification .ats file is
ts-product_code-version-yyyyymmdd_hhmm.ats
   See "Setting up an unattended installation" on page 321 for a list of the TM1
   product codes.
   You need to edit only one .ats file per product.
3. In the section named [Component List], specify the components to remove.
   • To remove the component, type 1
   • To leave the component installed, type 0
   By default, all installed components are set to be removed.
4. Save and close the file.
5. Repeat steps 2 to 4 for each installed product.
6. From the operating system command line, change to the tm1_location/
   uninstall directory.
7. At the command prompt, type the following command:
   • On Windows,
     uninst -u -s
   • On UNIX or Linux,
     ./uninst -u -s
   • On UNIX or Linux without XWindows,
     ./uninstnx -u -s
Appendix D. Troubleshooting a problem

Troubleshooting is a systematic approach to solving a problem. The goal of troubleshooting is to determine why something does not work as expected and how to resolve the problem.

Answering the following questions can help you to identify the source of a problem that is occurring with an IBM Cognos product:

1. Is the configuration supported?
2. What are you doing when the problem occurs?
   - Planning
   - Installing the product
   - Upgrading or migrating the product
   - Doing system administration or configuration tasks
   - Developing applications
   - Launching or deploying the product
   - Running the product
   - Installing or making changes to related hardware or software products
   - Recovering or restarting the product or system
   - Diagnosing a problem or running diagnostic aids
3. Is the problem related to IBM Cognos software? If so, what, if any, error messages or error codes were issued?
4. Can you reproduce the problem to ensure that it is not just a simple error?
5. Did you check file locations, directories, paths, and access?
6. Have you reviewed all relevant documentation, including release notes and technotes?
7. Did you check to see if any recent changes in your computing environment might be responsible for the problem.
8. If these questions and answers do not guide you to a resolution, you might need additional information or you might need to collect diagnostic data. This data is necessary for an IBM technical-support representative to effectively troubleshoot and assist you in resolving the problem.

Cognos Information Centers

IBM Cognos Information Centers include documentation for each release. This documentation is also available through product help menus.

To find documentation on the web, including all translated documentation, access IBM Knowledge Center [http://www.ibm.com/support/knowledgecenter].

To find links to the latest known problems and authorized program analysis reports (APARs), access the release notes.

Support Portal

The IBM Support Portal is a unified, centralized view of all technical support tools and information for all IBM systems, software, and services.
The IBM Support Portal lets you access all the IBM support resources from one place. You can tailor the pages to focus on the information and resources that you need for problem prevention and faster problem resolution. Familiarize yourself with the IBM Support Portal by viewing the demo videos.

Find the Cognos content that you need by selecting your products from the IBM Support Portal.

**Gathering information**

Before contacting IBM Support, you will need to collect diagnostic data (system information, symptoms, log files, traces, and so on) that is required to resolve a problem. Gathering this information will help to familiarize you with the troubleshooting process and save you time.

Information on what data to collect is available in the form of MustGather technotes.

**Service requests**

Service requests are also known as Problem Management Reports (PMRs). Several methods exist to submit diagnostic information to IBM® Software Technical Support.

To open a PMR or to exchange information with technical support, view the IBM Software Support Exchanging information with Technical Support page. PMRs can also be submitted directly by using the Service requests (PMRs) tool or one of the other supported methods detailed on the exchanging information page.

**Support Assistant Lite**

IBM Support Assistant is a complimentary software offering that provides you with a workbench to help you with problem determination.

IBM Cognos currently supports IBM Support Assistant Lite. This utility automates product-specific data collection. It identifies the data files that IBM Support analysts need to diagnose and recover from occasional operational problems with IBM products.

**Cognos Customer Center**

The IBM Cognos Customer Center provides Cognos-specific information, updates, and troubleshooting resources.

To view Cognos troubleshooting information, access the Cognos Customer Center and view the information under "Contacting Support" or "Troubleshooting Resources".

**Fix Central**

Fix Central provides fixes and updates for your software, hardware, and operating system.

Use the pull-down menu to navigate to your product fixes on Fix Central. You can also view Fix Central help.
Problem determination tools

Several IBM Cognos problem determination tools are available to diagnose and troubleshoot common problems.

These tools can be downloaded from the Cognos Diagnostic Utilities page. IBM Education Assistant provides video and other training resources on some of these diagnostic tools on the IBM Education Assistant Problem Determination website.

Forums and communities

IBM Cognos product forums offer a place to share ideas and solutions with your peers in the IBM Cognos community.

Active Cognos forums are available at Cognos forums and communities.

Software Support RSS feeds

IBM Software Support RSS feeds are a quick, easy, and lightweight format for monitoring new content added to websites.

After you download an RSS reader or browser plug-in, you can subscribe to IBM product feeds at IBM Software Support RSS feeds.

Searching and navigating Cognos products

Access to IBM Cognos product information can now be configured in the IBM Support Portal, which provides the ability to see all of your links on a single page.

Best practices for searching and navigating for Cognos product information are available on the IBM Cognos Support Portal and Technote Search Best Practices page.
Notices

This information was developed for products and services offered worldwide.

This material may be available from IBM in other languages. However, you may be required to own a copy of the product or product version in that language in order to access it.

IBM may not offer the products, services, or features discussed in this document in other countries. Consult your local IBM representative for information on the products and services currently available in your area. Any reference to an IBM product, program, or service is not intended to state or imply that only that IBM product, program, or service may be used. Any functionally equivalent product, program, or service that does not infringe any IBM intellectual property right may be used instead. However, it is the user’s responsibility to evaluate and verify the operation of any non-IBM product, program, or service. This document may describe products, services, or features that are not included in the Program or license entitlement that you have purchased.

IBM may have patents or pending patent applications covering subject matter described in this document. The furnishing of this document does not grant you any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan Ltd.
19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other country where such provisions are inconsistent with local law: INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically made to the information herein; these changes will be incorporated in new editions of the publication. IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this publication at any time without notice.
Any references in this information to non-IBM Web sites are provided for convenience only and do not in any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of the materials for this IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the exchange of information between independently created programs and other programs (including this one) and (ii) the mutual use of the information which has been exchanged, should contact:

IBM Software Group
Attention: Licensing
3755 Riverside Dr.
Ottawa, ON
K1V 1B7
Canada

Such information may be available, subject to appropriate terms and conditions, including in some cases, payment of a fee.

The licensed program described in this document and all licensed material available for it are provided by IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. Therefore, the results obtained in other operating environments may vary significantly. Some measurements may have been made on development-level systems and there is no guarantee that these measurements will be the same on generally available systems. Furthermore, some measurements may have been estimated through extrapolation. Actual results may vary. Users of this document should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of those products, their published announcements or other publicly available sources. IBM has not tested those products and cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or withdrawal without notice, and represent goals and objectives only.

This information contains examples of data and reports used in daily business operations. To illustrate them as completely as possible, the examples include the names of individuals, companies, brands, and products. All of these names are fictitious and any similarity to the names and addresses used by an actual business enterprise is entirely coincidental.

If you are viewing this information softcopy, the photographs and color illustrations may not appear.
This Software Offering does not use cookies or other technologies to collect personally identifiable information.

**Trademarks**

IBM, the IBM logo and ibm.com are trademarks or registered trademarks of International Business Machines Corp., registered in many jurisdictions worldwide. Other product and service names might be trademarks of IBM or other companies. A current list of IBM trademarks is available on the Web at "Copyright and trademark information" at www.ibm.com/legal/copytrade.shtml.

The following terms are trademarks or registered trademarks of other companies:

- Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States, and/or other countries.
- Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation in the United States, other countries, or both.
- Linux is a registered trademark of Linus Torvalds in the United States, other countries, or both.
- UNIX is a registered trademark of The Open Group in the United States and other countries.
- Java and all Java-based trademarks and logos are trademarks or registered trademarks of Oracle and/or its affiliates.

Microsoft product screen shot(s) used with permission from Microsoft.
# Index

## Special characters

| .blb file extension | 26 |
| .cfg file          | 28, 255 |
| .cho file extension | 26 |
| .cub file extension | 26 |
| .dim file extension | 26 |
| .dit file extension | 26 |
| .ini file          | 28, 311 |
| .NET Framework     | 17 |
| .pro file extension | 26 |
| .rej file          | 25 |
| .rux file extension | 26 |
| .sub file extension | 26 |
| .tbu file extension | 26 |
| .tgu file extension | 26 |
| .tru file extension | 26 |
| .vue file extension | 26 |
| .xdi file extension | 26 |
| .xlsx worksheet    | 59 |
| .xru file extension | 26 |

## Numerics

| 32-bit            | 35 |
| 32-bit Windows installation | 7 |
| 64-bit            | 35 |
| 64-bit system commands | 103 |
| 64-bit Windows installation | 7 |

## A

| access privileges, data directory | 27 |
| accessibility features | 253 |
| add and remove programs | 53 |
| adding a server | 94 |
| additional components | 241 |
| Admin Server | 24, 25, 36 |
| Admin Server service | 52 |
| AdminHost | 257, 312 |
| AdminHost parameter | 227 |
| SSL | 223 |
| administration tm1web_config.xml | 114 |
| administrator privileges | 74 |
| AdminSvrSSLCertAuthority | 223, 257, 312 |
| AdminSvrSSLCertID | 223, 257, 312 |
| AdminSvrSSLCertRevList | 223, 257, 313 |
| AdminSvrSSLExportKeyID | 223, 258, 313 |
| AdvancedRulesEditor | 313 |
| Allow provisioned installs | 135 |
| Allow provisioned updates | 135 |
| AllowImportCamClients | 313 |
| AllowImportCAMClients | 211 |
| AllowReadOnlyChore Reschedule | 258 |
| AllowSeparateNandCRules | 77, 258 |
| AllowRuleCalcStargateOptimization | 259 |
| Apache tomcat | undeploy | 247 |
| Application tier component | 9 |
| ApplyMaximumViewSizeToEntireTransaction | 259 |
| Architect | 27 |
| Architect upgrade | 55 |
| architecture | 23 |
| ASCII characters in directory names | 74 |
| AuditLogMaxFileSize | 260 |
| AuditLogMaxQueryMemory | 260 |
| AuditLogOn | 260 |
| AuditLogUpdateInterval | 261 |
| authentication | 181, 183, 205 |
| importing groups into TM1 | 210 |
| integrated login | 181 |
| integrated login diagram | 182 |
| authentication, LDAP | 181 |
| authentication, LDAP diagram | 183 |
| AutomaticallyAddCubeDependencies | 261 |

## B

| Back up data | 52 |
| backing up data | 241 |
| backup TM1 Applications | 241, 245 |
| BI service | 52 |
| BrowseDisplayReadsRightToLeft | 313 |

## C

| CacheFriendlyMalloc | 261 |
| CalculationThresholdForStorage | 262 |
| CAMID | 183, 205 |
| CAMPortalVariableFile | 262 |
| CAMSSLCertificate | 262 |
| certificate | 234 |
| authority | 221 |
| revocation | 221 |
| store | 221 |
| certificates | 220, 235 |
| CertificateVersion | 223, 262 |
| character encoding | 90 |
| CheckFeedersMaximumCells | 263 |
| ClassicSliceMode | 313 |
| classpath | 103 |
| client components | 8 |
| client installation | 7, 155 |
| Client tier | 11 |
| ClientCAMURI | 263 |
| ClientExportSSLSvrCert | 223, 264 |
| ClientExportSSLSvrKeyID | 223, 264 |
| ClientMessagePortNumber | 264 |
| ClientPingCAMPassport | 264 |
| ClientPropertiesSyncInterval | 265 |
| clients | 24, 27 |
| ClientVersionMaximum | 265 |
| ClientVersionMinimum | 265 |
| ClientVersionPrecision | 266 |
| Cognos Analysis for Microsoft Excel | 68, 69 |
| proxy | 151 |
| Cognos authentication | 183, 205 |
| defining an administrator | 209 |
Cognos BI security
   with TM1 Applications 214
Cognos Configuration 74, 84, 135
Cognos Connection 75
Cognos Connection Folder Name 135
Cognos Connection portal 70
Cognos Insight 74
   installing 78, 164
   logging 167
   running 78
Cognos Insight ping frequency (seconds) 135
Cognos Query Studio 66
Cognos Report Studio 66
Cognos security 205, 213
   administrator considerations 218
   anonymous access 209
   user considerations 218
   with TM1 Applications session timeout 217
Cognos security passport 183, 205
Cognos TM1 Application server
   starting 133
Cognos TM1 Applications
   architecture overview 31
Cognos TM1 Operations Console 103
Cognos TM1 Performance Modeler
   installing 159
   logging 162
Cognos Workspace 67
CognosGatewayURI 211, 314
CognosMDX.AggregateByAncestorRef 267
CognosMDX.CellCacheEnable 267
CognosMDX.PrefilterWithPXJ 268
CognosMDX.SimpleCellsUseOPTSDK 268
CognosMDX.UseProviderCrossJoinThreshold 268
CognosTM1InterfacePath 269
CognosTM1InterfacePath configuration parameter 66
   components 73
   components modify 242
   configuration 19
Configuration files 20
   configuration parameters
      TM1 Web 115
      configure 75, 84
      configure login page 118
      configuring components 88
      configuring validation 204
      connecting to a server 191
      ConnectLocalAtStartup 314
      Contributor upgrade to TM1 Applications 56
      converting .xls 59
Cube Viewer
   page size 127
   Cube Viewer, export sheets 127
   CubeViewerStringWrap 127

D
   data directory
      access privileges 27
      definition 27
      local server 28
      multiples 28
      path 27
      remote server 28
      required network access 27
      security 27
   DataBaseDirectory 269, 314
   decrypt 221
   default printer 81, 168
   default settings 17
   DefaultMeasuresDimension 269
   deploy 33
   deploying
      TM1 Application Server 144
      TM1 Applications Web 112
      TM1 Operations Console 102, 104, 105, 106, 107
      TM1 Web 112
deployment options 35
   Developer tier 12
   DHFile-1024 223, 270
   DHFile-2048 223, 270
   DHFile-512 223, 269
   Diffie-Hellman 221
   DimensionDownloadMaxSize 314
   DisableMemoryCache 270
   DisableSandboxing 270
   DisableWritebackOnDisconnect parameter 314
   DisableWritebackOnTM1Formulas parameter 315
   Dispatch URI 64
   Display_Info_DBType_R8 271
   DisplayApplications 314
   DisplayChores 315
   DisplayControlCubes 315
   DisplayCubes 315
   DisplayDimensions 315
   DisplayExplorerPropertiesWindow 315
   DisplayProcesses 315
   DisplayReplications 316
distributed installation 36
   DistributedPlanningOutputDir 77, 271
domains
   account 37
      installing without 22
   DOS command window 186
   dot as local domain 22
   DownTime 272
E
   editing tm1web_config.xml 114
Enable Business Viewpoint 135
Enable macros 76
Enable publish from Cognos Insight 135
EnableODBCproxy 272
encrypt 221
ETLDAP
   Attributes field 186
      building LDAP query 189
      configuring LDAP login parameters 188
      connecting to a server 191
      Export button 186
      export options 192
      exporting LDAP users to TM1 192
      Filter field 186
      LDAP modified record attribute 192
      LDAP query elements 189
      mapping LDAP attributes to TM1 fields 191
      modifying LDAP attributes 185
      Results table 186
      running from DOS 186
      running in update mode 192
      Search button 186
      Search DN field 186
      Search Scope option 186
ETLDAP (continued)
  updating TM1 with new LDAP users 192
ETLDAP utility 185
ETLDAP, LDAP authentication 204
Excel service 52
ExcelWebPublishEnabled 272
ExpandRow/HeaderText 316
export
  maximum sheets 127
ExportAdminSrvrSSLCert 223, 273, 316
exporting PDF data 81, 168
ExportSrvrSSLCert 223, 273

F
  file extensions 26
  finding information xi
  Firefox 198
  Force qualified paths 135

G
  Gateway URI 64
  GO_Contributor 170
  GO_New_Stores
    starting 75, 84
  GOSALES sample database 171
  group assignments 204

H
  heartbeat interval 24
  HTTPPortNumber 275
  HTTPSessionTimeoutMinutes 275

I
  IBM AIX
    memory resource limits 89
    performance tuning 89
    running TM1 with 88
    unsupported commands with TM1 90
  identity key 221
  IdleConnectionTimeOutSeconds 275
  initialization file 28, 311
  Insight
    TurboIntegrator function restrictions 151
  InSpreadsheetBrowser 316
  install scenario 73
  install TM1 Operations Console on separate machine 102
  installation 17
  installed sample database 170
  installing 179
  IBM Cognos BI 321
  unattended install 321
  using transfer specification file (.ats) 321
  installing TM1 clients 155
  integrated login (continued)
    TM1 Web 199
    UniqueID field 194
    IntegratedLogin 316
    IntegratedSecurityMode 275
    Internet Explorer 198
    interoperability 262
    introduction xi
    IP address 278
    IPAddress 277
    iWidgets 67, 262

J
  Java 39
  SSL 233
  JavaClassPath 278
  JavaJVMArgs 278
  JavaJVMPath 279
  Job Queuing 279
  JobQueueMaxWaitTime 279
  JobQueueThreadPoolSize 280
  JobQueueThreadSleepTime 280

K
  keyboard shortcuts 253
  Cognos Configuration 254

L
  language 37
  Language 280
  language codes 91, 92
  language configuration 91, 93
  language for clients 317
  Language parameter for clients 93
  Language parameter for server 93
  LDAP
    authentication 181, 183
    building a query 189
    configuring login parameters 188
    exporting users to TM1 192
    mapping attributes to TM1 fields 191
    modified record attribute 192
    modifying attributes 185
    running ETLDAP in update mode 192
    updating TM1 with new users 192
  LDAP authentication 205
    configuring validation 204
    ETLDAP 204
    modifying group assignments 204
    parameters 200
    TM1S.cfg 204
    validating users 199
  LDAP Authentication 199
  LDAP Load Tool dialog box 186
  LDAPHost 200, 281
  LDAPPasswordFile 200, 281
  LDAPPasswordKeyFile 200, 281
  LDAPPort 200, 201, 282
  LDAPSearchBase 200, 201, 282
  LDAPSearchField 200, 201, 282
  LDAPSkipSSLCertVerification 200, 201, 282
  LDAPSkipSSLCArCRLVerification 200, 202, 205, 283
  LDAPUseServerAccount 200, 202, 283
LDAPVerifyCertServerName 200, 202, 205, 283
LDAPVerifyServerSSLCert 200, 203, 205, 284
LDAPWellKnownUserName 200, 204, 284
Limiting 30
Linux installation 86
start TM1 server 88
TM1 server installation 86
Linux server upgrade 54
local machine syntax 22
localsecond 37
LocalServerNetworkProtocol 317
locations 17
LockPagesInMemory 285
log file 25
Logging in 108
LoggingDirectory 285
login credentials 77
login page configuring 118
log, integrated 194
Logon As 219
logon rules 218
LogReleaseLineCount 285
MagnitudeDifferenceToBeZero 285
maintain installation 241
MainWindowLayoutInfo 317
MaskUserNameInServerTools 286
MaximumCubeLoadThreads 286
MaximumLoginAttempts 287
MaximumMemoryForSubsetUndo 287
MaximumSynchAttempts parameter 288
MaximumTILockObject 288
MaximumUserSandboxSize 289
MaximumViewSize 289
MessageCompression 289
metadata 25
Microsoft .NET 74
Microsoft Internet Explorer 198
Microsoft Visual C++ 74
modify installation 242
modifying
  group assignments 204
  monitoring 9.5.2 servers 101
Mozilla 198
MTQ 289
MTQ.OperationProgressCheckSkipLoopSize 290
MTQ.SingleCellConsolidation 290
multiple Admin Hosts 24
multiple computer install 83
multiple computer web install 110
multiple servers 30

Non-ascii characters and moving 90
Non-ascii names and locale 91
non-SSL clients 221
Notifications provider 135

O
ODBCLibraryPath 291
OLE DB 35
Operations Console 105, 106, 107
Cognos security 213
Optional Tm1s.cfg parameter 200, 281
  AdminSvrSSLCertAuthority 257
  AdminSvrSSLCertID 257
  AdminSvrSSLCertRevList 257
  AdminSvrSSLEnryptKeyID 258
  AllowReadOnlyChore Reschedule 258
  AllowSeparateNandCRules 258
  AllRuleCalcStargateOptimization 259
  ApplyMaximumViewSizeToEntireTransaction 259
  AuditLogMaxFileSize 260
  AuditLogMaxQueryMemory 260
  AuditLogOn 260
  AuditLogUpdateInterval 261
  AutomaticallyAddCubeDependencies 261
  CacheFriendlyMalloc 261
  CalculationThresholdForStorage 262
  CAMSSLCertificate 262
  CertificateVersion 262
  CheckFeedersMaximumCells 263
  ClientCAMURI 263
  ClientExportSSLCert 264
  ClientExportSSLKeyID 264
  ClientMessagePortNumber 264
  ClientPingCAMPassport 264
  ClientPropertiesSyncInterval 265
  ClientVersionMaximum 265
  ClientVersionMinimum 265
  ClientVersionPrecision 266
  CognosMDX.AggregateByAncestorRef 267
  CognosMDX.CellCacheEnable 267
  CognosMDX.PrefilterWithPXJ 268
  CognosMDX.SimpleCellsUseOPTSDK 268
  CognosMDX.UseProviderCrossJoinThreshold 268
  CognosTM1InterfacePath 269
  DefaultMeasuresDimension (OLAP may require) 269
  DHFile-1024 270
  DHFile-2048 270
  DHFile-512 269
  DisableMemoryCache 270
  DisableSandboxing 270
  Display_Info_DBType_R8 271
  DistributedPlanningOutputDir 271
  DownTime 272
  EnableODBCproxy 272
  ExcelWebPublishEnabled 272
  ExportAdminSvrSSLCert 273
  ExportSvrSSLCert 273
  ForceReevaluationOfFeedersForFedCellsOnDataChange 274
  HTTPPortNumber 275
  HTTSessionTimeoutMinutes 275
  IdleConnectionTimeOutSeconds 275
  IntegratedSecurityMode 275
  IPAddress 277
  IPv6 278
  JavaClassPath 278
  JavaVMArgs 278
  JavaVMPath 279

Installation and Configuration Guide

336
Optional Tm1s.cfg parameter (continued)

- JobQueueMaxWaitTime 279
- JobQueueThreadPoolSize 280
- JobQueueThreadSleepTime 280
- JobQueuing 279
- Language 280
- LDAPHost 200, 281
- LDAPPasswordKeyFile 200, 281
- LDAPPort 201, 282
- LDAPSearchBase 201, 282
- LDAPSearchField 201, 282
- LDAPSkipSSLCertVerification 202, 283
- LDAPUseServerAccount 202, 283
- LDAPVerifyCertServerName 202, 283
- LDAPVerifyServerSSLCert 203, 284
- LDAPWellKnownUserName 204, 284
- LockPagesInMemory 285
- LoggingDirectory 285
- LogReleaseLineCount 285
- MagnitudeDifferenceToBeZero 285
- MaskUserNameInServerTools 286
- MaximumCubeLoadThreads 286
- MaximumLoginAttempts 287
- MaximumMemoryForSubsetUndo 287
- MaximumSyncAttempts 288
- MaximumTILockObject 288
- MaximumUserSandboxSize 289
- MaximumViewSize 289
- MessageCompression 289
- MTQ 289
- MTQ.OperationProgressCheckSkipLoopSize 290
- MTQ.SingleCellConsolidation 290
- NetRecvBlockingWaitLimitSeconds 291
- NetRecvMaxClientIOWaitWithinAPIsSeconds 291
- ODBCLibraryPath 291
- OracleErrorForceRowStatus 291
- PasswordMinimumLength 292
- PasswordSource 200, 292
- path data directory 27
- PerfMonIsActive 293
- PerformanceMonitorOn 293
- PersistentFeeders 293
- PortNumber 294
- PrivilegeGenerationOptimization 294
- ProgressMessage 294
- ProportionSpreadToZeroCells 295
- RawStoreDirectory 296
- ReceiveProgressResponseTimeoutSecs 296
- RulesOverwriteCellsOnLoad 297
- RunningInBackground 297
- SaveTime 297
- SecurityPackageName 298
- ServerCAMURI 298
- ServerCAMURIRetryAttempts 299
- ServerLogging 299
- ServerName 299
- ServicePrincipalName 299
- SkipLoadingAliases 300
- SkipSSLCamHostCheck 300
- SpreadingPrecision 300
- SSLCertAuthority 302
- SSLCertificate 302
- SSLCertificateID 302
- SSLCertRevocationFile 302
- SSLPrivateKeyPwdFile 302
- StartupChores 303
- SubsetElementBreatherCount 303
- SvrSsLExportKeyID 304
- SyncUnitSize 304
- TM1ConnectorforSAP 304
- UnicodeUpperLowerCase 305
- UseExtendedFetch 306
- UseLocalCopiesforPublicDynamicSubsets 305
- UseNewConnectorforSAP 305
- UserDefinedCalculations 306
- UseSQLFetch 306
- UseSQLFetchScroll 306
- UseSSL 307
- UseStargateForRules 307
- ViewConsolidationOptimization 307
- ViewConsolidationOptimizationMethod 308
- ZeroWeightOptimization 308
- OracleErrorForceRowStatus 291
- Outdoors Company 170

P

Package Connector Windows 7  64
Parallel Interaction
  JobQueueThreadPoolSize parameter 280
  ParallelInteraction parameter 292
parameters, tm1web_config.xml 114
passport 183, 205
password
default for samples 17
PasswordMinimumLength 292
PasswordSource 200, 292
path data directory 27
pdata 27
PerfMonIsActive 293
Performance Modeler 74
  installing 78
performance tuning 89
PerformanceMonitorOn 293
PersistentFeeders 293
Perspectives upgrade 55
Planning 7
Planning Sample
  starting 75, 84
pmhub.war 105
pmpsvc.war 144, 145
port numbers 17
PortNumber 294
prerequisite software 74
Previous version back up 52
PreviousAdminHosts 318
PreviousDataDirectories 318
private key 221
PrivilegeGenerationOptimization 294
privileges in Service Account 21
product codes 321
ProgressMessage 294
ProportionSpreadToZeroCells 295
Provisioning URI 135
proxy 151

Q

query elements
  LDAP 189
  Queuing 279
R
RawStoreDirectory 296
ReceiveProgressResponseTimeoutSecs 296
regional setting 37
remote server 255
data directory 28
operations 25
Remove previous version 53
replication connection 219
Required Tm1s.cfg parameter
  AdminHost 257
  CAMPortalVariableFile 262
  CAMSSLCertificate (depends on CAM) 262
DataBaseDirectory 269
requirements 17
response.ats file 321
restore backup files for Oracle 174
restore sample database on DB2 172
restoring backup sample files for Microsoft SQL 177
restoring data after upgrading 58, 248
revoke 221
Rollup 306
RulesOverwriteCellsOnLoad 307
Run as Administrator 74
RunningInBackground 297

S
samples 169
Samples component 13
SAP 304
SAP connectivity 64
SaveTime 297
saving data 25
sdata 27
SData
  starting 75, 84
security 182
security authentication mode
  TM1 Application Web 133, 142, 147
  TM1 Applications 37, 184
SecurityAssignmentWindowLayoutInfo 318
SecurityPackageName 298
SentMsgsToServerCountWarning 318
server 25, 36
multiple 30
server components 8
ServerCAMURI 298
ServerCAMURIReTryAttempts 299
ServerLogging 299
ServerName 299
servers
  adding 94
Service Account TM1 21
ServicePrincipalName 299
services 19
Session timeout (min) 135
shortcut keys 253
IBM Cognos Configuration 254
ShowAdminHostChangeWarning 318
ShowAliasAttributeWarning 318
ShowChoresSchedulingWarning 318
ShowCubeReplicationWarning 318
show DimDeleteElementWarning 319
show DimensionAccessWarning 319
show DynamicSubsetWarning 319
show PickOperationWarning 319
show ProcessUNASCIIWarning 319
show ProcessUNODBCWarning 319
silent installation 321
single computer upgrade 54
SkipLoadingAliases 300
SkipSSLCAMHostCheck 300
SliceNewWorkbook 319
SliceNewWorkbook 319
SSL 219, 221, 236
SSL parameters
  AdminSvrSSLCertAuthority 257
  AdminSvrSSLCertID 257
  AdminSvrSSLCertRevList 257
  AdminSvrSSLExportKeyID 258
  CertificateVersion 262
  ClientExportSSLSvrCert 264
  ClientExportSSLSvrKeyID 264
  DHFile-1024 270
  DHFile-2048 270
  DHFile-512 269
  ExportAdminSvrSSLCert 273
  ExportSvrSSLCert 273
  SSLCertAuthority 302
  SSLCertificate 302
  SSLCertificateID 302
  SSLCertRevocationFile 302
  SSLPrivateKeyPwdFile 302
  SSLPwdKeyFile 302
  SvrSSLExportKeyID 304
  UseSSL 307
  SSL port 17
  SSLCertAuthority 223, 302
  SSLCertificate 223, 302
  SSLCertificateID 223, 302
  SSLCertRevisionFile 223, 302
  SSLPrivateKeyPwdFile 223, 302
  SSLPwdKeyFile 223, 302
  start IBM Cognos Configuration 88
starting
  Cognos TM1 Application server 133
  services 75, 84
StartupChores 303
stop services 52, 246
stop TM1 Contributor 52
SubsetElementBreatherCount 303
SubsetWindowLayoutInfo 320
SvrSSLExportKeyID 223, 304
SyncUnitSize parameter 304

T
TEMP system variable 74
ThirdPartyCertificateTool 239
tier 2 33
tier 3 33
TM1
  Cognos security 62
  TM1 Admin Server
    starting 75, 84
  TM1 Admin Server Certificate Version 221
TM1 APIs
installing 167
TM1 Application
installing on separate computers 39
TM1 Application Server 39
deploying on IBM WebSphere 145
deployment options 37
logging 139
TM1 Application Service Dispatcher URI 135
TM1 Application Web 138
running 77, 79
security authentication mode 133, 142, 147
server configuration 134, 142, 148
URL 136
using with multiple TM1 servers 150
TM1 Applications 244
Cognos Connection portal 70
data tier 33
deployment options 37
installing on a single computer 39
restoring applications files 250
restoring configuration files 250
saving security rights 60
security authentication mode 37, 184
third-party SSL certificates 231
uninstalling Applications 246
using with Cognos BI security 214
with IBM Cognos BI security 214
with IBM Cognos security session timeout 217
TM1 Applications install 33
TM1 Applications Web 112
TM1 Architect
running 77
TM1 components 8
TM1 integration 61
TM1 interoperability 61
TM1 iWidgets 262
TM1 Mobile Contributor
deploying 41
displaying TM1 cubes 42
impact diagrams 43
overview 41
scorecarding cubes 43
scorecarding watchlist 45
watchlist 45
with TM1 Servers 42
TM1 object names 90
TM1 OLE DB 14
TM1 Operations Console 79, 108
adding certificates 103
installing 101
starting 102
TM1 Package Connector 62, 79
TM1 Package Connector requirements 63
TM1 Perspectives
running 76
TM1 server
starting on Linux 88
starting on UNIX 88
TM1 Server
Cognos security 206
starting 75, 84
with Cognos security and anonymous access 209
TM1 server install on Linux 86
TM1 server install on Unix 86
TM1 server installation on Windows 83
TM1 Server Service 52

TM1 Components 8
TM1 Integration 61
TM1 Interoperability 61
TM1 iWidgets 262
TM1 Mobile Contributor
deploying 41
displaying TM1 cubes 42
impact diagrams 43
overview 41
scorecarding cubes 43
scorecarding watchlist 45
watchlist 45
with TM1 Servers 42
TM1 Object Names 90
TM1 OLE DB 14
TM1 Operations Console 79, 108
adding certificates 103
installing 101
starting 102
TM1 Package Connector 62, 79
TM1 Package Connector Requirements 63
TM1 Perspectives
running 76
TM1 Server
starting on Linux 88
starting on UNIX 88
TM1 Server
Cognos Security 206
starting 75, 84
with Cognos Security and Anonymous Access 209
TM1 Server Install on Linux 86
TM1 Server Install on Unix 86
TM1 Server Installation on Windows 83
TM1 Server Service 52

TM1 Service Account 21
TM1 Web 112
Cognos Security 212
configuration parameters 115
homepage 120
Integrated Login 196
Kerberos 196
running 77
SSL 228
startup parameters 124
UNIX 111
web browser configuration 128
TM1_Package_Connector environment variable 65
TM1ConnectorforSAP 304
TMICrypt 235
TMIFunctions.cfg 152
tm1p.ini
location 311
parameters 311
Tm1p.ini file 28, 311
TM1RebuildDefault 320
TM1s.cfg 204
Tm1s.cfg file 28, 255
location 255
parameters 256
sample 255
tm1web_config.xml
defined 114
editing 118
startup parameters 124
tm1web.html 212
tm1web.war 112
tm1xfer 90
Tools 179
transaction log file 25
translated documentation 13
Troubleshooting 325
TurboIntegrator
restricting function execution 151
TurboIntegrator functions 151
restricting execution of 152
types of installations 7

U
unattended installation 321, 323
UnidecodeUpperLowerCase 305
uninstall 243, 244, 323
UNIX
installation 86
server 255
start TM1 server 88
TM1 server installation 86
UNIX installation 7
Unix server upgrade 54
UNIX-related Tm1s.cfg parameter
ODBCLibraryPath 291
RunningInBackground 297
upgrade overview 47
upgrade planning 48
upgrading 101
upgrading to Cognos TM1 Applications 56
UseNewConnectorforSAP 305
User ID and Password 135
user name
default for samples 17
UserDefinedCalculations 306

Index 339